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Avertissements et consignes de sécurité

Avvertenze e norme di sicurezza

Consignes d'utilisation du camécope Sport

A

L
L

Veuillez tenir compte des consignes d'utilisation suivantes :

Rangez cet appareil dans un endroit siir. Ce caméscope est en effet
équipé d’un objectif pouvant étre endommagé en cas de choc.
Tenez le caméscope hors de portée des enfants.

Ne rangez pas votre appareil dans un endroit humide. L’humidité et 'eau

risqueraient d’entrainer des dysfonctionnements.

Pour éviter tout risque de choc électrique, assurez-vous que vos mains ne

sont pas mouillées avant de manipuler 'appareil ou le cordon d’alimentation.

Ne déclenchez pas le flash prés des yeux d'une personne. Le flash émet une

lumiére violente, laquelle peut avoir sur la vue des effets aussi néfastes que

ceux provoqués par la lumiere directe du soleil. Lorsque vous photographiez des
nouveau-nés, veillez a ce que le flash se trouve & 1 m minimum de votre sujet.

Si l'appareil ne fonctionne pas correctement, veuillez contacter le revendeur

ou le centre agréé de service aprés-vente Samsung le plus proche. Ne tentez

pas de démonter vous-méme I'appareil : vous risqueriez de provoquer des
dégats difficilement réparables.

Nettoyez I'appareil a I'aide d’un chiffon doux et sec. Les taches pourront

étre 6tées au moyen d'un chiffon doux imbibé d’une solution détergente non

agressive. N'utilisez aucun solvant, quel qu'il soit, en particulier du benzéne ;

vous risqueriez d’endommager les finitions.

Protégez votre caméscope de la pluie et de 'eau de mer. Nettoyez I'appareil

apres utilisation. L'eau de mer est corrosive.

Pour débrancher 'appareil de la prise murale en toute sécurité, retirez la prise

méle de la prise femelle ; c’est pourquoi la prise murale doit étre facilement

accessible.

L'utilisation prolongée de I'écouteur ou du casque peut fortement réduire votre

acuité auditive.

- Si vous vous exposez a un volume sonore supérieur a 85 dB pendant une
durée prolongée, votre ouie sera irrémédiablement endommagée. Plus le
son est élevé, plus votre acuité auditive diminue (une conversation ordinaire
a un niveau sonore compris entre 50 et 60 dB alors que celui provenant d’
une route est d'environ 80 dB).

- Il est fortement recommandé d'utiliser un volume sonore moyen (le volume
moyen est habituellement inférieur de 2/3 au volume maximal).

Si vous ressentez des bourdonnements dans les oreilles, réduisez le volume

ou n'utilisez plus I'écouteur ou le casque.

N'utilisez pas I'écouteur lorsque vous conduisez une bicyclette, une

automobile ou une motocyclette.

- Dans le cas contraire, vous risqueriez de provoquer un accident grave. En
outre, son utilisation est interdite par la loi dans certaines régions.

- L'utilisation de I'écouteur dans la rue, particulierement sur les passages pour
piétons, pourrait entrainer des accidents graves.

Pour votre propre sécurité, assurez-vous que le cable de I'écouteur n’entrave

pas vos mouvements ou ne s'accroche pas dans des objets environnants

lorsque vous faites de I'exercice ou lorsque vous vous promenez.

Avvertenze per I'utilizzo della videocamera Sport

Ld
L3

Si prega di tenere presenti le seguenti precauzioni di utilizzo:
Tenere 'apparecchiatura in un posto sicuro. Gli urti possono
danneggiare I'obiettivo.

Tenere 'apparecchio lontano dalla portata dei bambini.

Non conservare I'app arecchiatura in un posto umido. L'umidita e I

acqua possono causare anomalie di funzionamento.

Per evitare il rischio di scariche elettriche, non toccare con le mani

bagnate I'apparecchio o il cavo di alimentazione.

Non utilizzare il flash vicino agli occhi di una persona. Il flash emette

una luce forte che pud causare danni alla vista simili a quelli causati

dalla luce diretta del sole. Se si fotografano neonati, assicurarsi che il

flash sia a piu di un metro di distanza dal soggetto.

Se I'apparecchiatura non funziona correttamente, consultare il

rivenditore o il centro servizi autorizzato Samsung pil vicini.

Non smontare 'apparecchio; in caso contrario si potrebbero causare

danni molto difficili da riparare.

Pulire 'apparecchio con un panno morbido e asciutto. Per rimuovere

le macchie, utilizzare un panno morbido inumidito con una soluzione

detergente delicata.

Non utilizzare alcun tipo di solvente, in particolare benzene, in quanto

potrebbe danneggiare seriamente la finitura.

Non esporre I'apparecchio a pioggia o acqua salmastra. Dopo 'uso,

pulire l'apparecchio. L'acqua salmastra potrebbe corrodere alcune parti

dell'apparecchio.

Per scollegare 'apparecchio dall'alimentazione, estrarre la spina dalla

presa di rete.

L'uso prolungato di auricolari o cuffie pud causare seri danni all’udito.

- L’esposizione prolungata a suoni superiori a 85db crea effetti
indesiderati all'udito. Piu alto sara il volume, piu gravi saranno i danni
riportati (il suono di una conversazione normale € compreso tra 50 e
60 db, mentre il rumore del traffico € di circa 80 db).

-Si con5|gI|a vivamente di impostare un volume medio (generalmente
inferiore di 2/3 rispetto al livello massimo).

Se si avverte un ronzio alle orecchie, abbassare il volume o interrompere

I'uso di auricolari o cuffie.

Né&o utilize os auriculares enquanto andar de bicicleta, automével ou

motociclo.

- Caso contrario, pode provocar um acidente grave. Além disso, em
algumas zonas, € proibido por lei.

- O uso de auriculares na via publica, sobretudo em passadeiras, pode
dar origem a um grave acidente.

Para sua seguranca, enquanto estiver a fazer exercicio ou a andar,

tenha cuidado para que o fio dos auriculares nao fique preso no seu

brago nem em outros objectos a sua volta.



Avertissements et consignes de sécurité

Avvertenze e norme di sicurezza

Remarques concernant les DROITS D’AUTEUR

% Les programmes télévisés, cassettes VHS pré-enregistrées,
DVD, films et autres supports d'image peuvent étre protégés
par des droits d’auteur. La copie non autorisée de ces supports
peut porter atteinte aux droits des propriétaires concernés et
constitue une infraction a la Iégislation sur les droits d’auteur.

% Toutes les appellations commerciales et marques déposées
citées dans ce manuel ou dans toute documentation fournie
avec votre appareil Samsung appartiennent a leurs propriétaires
respectifs.

Remarques concernant la formation de condensation

< Une brusque hausse de la température de I'air peut
entrainer la formation de condensation a I'intérieur du
caméscope Sport.

Exemple :
< Sivous entrez dans un endroit chauffé ou en sortez alors qu'il
fait froid a I'extérieur, de la condensation peut se former a
Fintérieur de 'appareil.
% Pour empécher ce phénomene, placez I'appareil dans un étui ou
un sac en plastique afin de ne pas I'exposer a un changement
de température brutal.

Remarques concernant le caméscope Sport

1. N’exposez pas le caméscope Sport a des températures
trop élevées (supérieures a 60°C°).
Ex. : voiture fermée en été ou lumiére directe du soleil.

2. Ne projetez pas de liquides sur le caméscope Sport.
Conservez le caméscope Sport a I'abri de la pluie, de I'eau
de mer ou de toute autre forme d’humidité.

En plongeant le caméscope Sport dans I'eau ou en I'exposant
a des taux d’humidité élevés, vous risquez de 'endommager.

Avvertenze riguardanti il COPYRIGHT

% | programmi televisivi, i DVD, i filmati e altri materiali possono
essere protetti da copyright.
La registrazione di materiale protetto da copyright puo ledere
i diritti del pro prietario dei diritti d’autore e pud costituire una
violazione della legge sui copyright.

% Tutti i nomi commerciali e i marchi registrati citati in questo
manuale o in altri documenti forniti con i prodotti Samsung
sono dei rispettivi proprietari.

Avvertenze riguardanti la formazione di condensa

< Un improvviso innalzamento della temperatura atmosferica
puo provocare il generarsi di condensa all’interno della
videocamera Sport.

Ad esempio:

% Entrando o uscendo da un ambiente riscaldato in una giornata
fredda si potrebbe verificare la formazione di condensa all'interno
della videocamera.

< Per impedire cio conservare I'apparecchio in una borsa o in una
busta di plastica prima di esporlo ad un'improvvisa escursione
termica.

Avvertenze riguardanti la videocamera Sport

1. Non lasciare la videocamera Sport esposta ad alte
temperature (oltre 60°C o 140°F).
Ad esempio, in un’auto parcheggiata al sole o esponendola alla
luce solare diretta.

2. Non far inumidire la videocamera Sport.
Tenere la videocamera Sport lontano da pioggia, acqua
salata o qualsiasi altro tipo di umidita.
Se immersa nell'acqua o soggetta ad alti livelli di umidita,
I'apparecchiatura si danneggia.

A



Avertissements et consignes de sécurité

Avvertenze e norme di sicurezza

Remarques concernant la batterie

L)

L

L)

Nous vous recommandons d'utiliser une batterie d’origine,
disponible auprés de votre revendeur.

Assurez-vous que la batterie est complétement chargée avant
de commencer votre enregistrement.

Afin d’économiser la batterie, éteignez votre caméscope
lorsque vous ne I'utilisez pas.

Si vous laissez votre appareil en mode STBY (PSE) pendant
plus de cing minutes sans 'utiliser, il s'éteindra automatiquement
afin d’éviter toute consommation inutile d’énergie.

Vérifiez que la batterie est insérée correctement.

La batterie neuve fournie avec I'appareil n’est pas chargée.
Avant de l'utiliser, il vous faut donc la charger complétement.

Ne laissez jamais tomber la batterie. Vous risqueriez de I
endommager.

Les éléments internes des batteries lithium-polymere s’abiment
en cas de décharge complete. La batterie risque de fuir si elle
est complétement déchargée.

Pour éviter ce probléme, prenez soin de la retirer lorsqu’elle est
vide.

Eliminez les corps étrangers des bornes avant d'insérer la batterie.

Lorsque la batterie arrive en fin de vie, adressez-vous a votre
revendeur le plus proche.

La batterie doit étre jetée avec les déchets chimiques.

Prenez garde a ne pas laisser tomber la batterie lorsque vous
la sortez du caméscope Sport.

Avvertenze riguardanti il gruppo batterie

L

L
L
L

Si raccomanda ['utilizzo di un gruppo batterie originale
disponibile presso il rivenditore da cui si & acquistato il prodotto.
Prima di iniziare la registrazione, accertarsi che la batteria sia
completamente carica.

Per conservare la carica della batteria, tenere la videocamera
Sport spenta quando non si riprende.

Se l'apparecchio viene lasciato in STBY per piu di 5 minuti,
questo si spegne automaticamente per evitare un consumo
inutile della batteria.

¢ Accertarsi che la batteria sia inserita correttamente nell'apposito

alloggiamento.

% Le batterie nuove fornite insieme allapparecchio non sono

cariche.

Prima di utilizzarle, &€ necessario caricarle completamente.
Non far cadere la batteria. Le batterie, se lasciate cadere,
possono danneggiarsi.

Lasciare scaricare completamente le batterie al litio pud
danneggiare le celle interne della batteria. Se completamente
scarica, una batteria al litio puo perdere liquidi.

Se completamente scarica, rimuovere la batteria per evitare di
danneggiare il gruppo batterie.

Prima di inserire il gruppo batterie, pulire il terminale per
rimuovere sostanze estranee.

Quando la ricarica della batteria non viene piu eseguita,
rivolgersi al proprio rivenditore di fiducia.
Le batterie vanno smaltite come rifiuti chimici.

Staccando il gruppo batterie dalla videocamera Sport, fare
attenzione a non farlo cadere.



Avertissements et consignes de sécurité

Avvertenze e norme di sicurezza

Remarques concernant I’objectif

« Norientez pas I'objectif du caméscope en direction du soleil
lorsque vous filmez une séquence.
La lumiere directe du soleil est susceptible d’'endommager la
mémoire a transfert de charges (capteur d'image CCD).

Remarques concernant I’écran LCD

1. L’écran LCD est un composant de haute précision. Il se peut
toutefois que de minuscules points (rouges, bleus ou verts)
apparaissent sur celui-ci. Ce phénomeéne est parfaitement normal
et n"affecte aucunement image enregistrée.

2. Lorsque vous utilisez 'écran LCD en plein soleil ou a I'extérieur, il
se peut que limage soit difficile a distinguer.

3. La lumiére directe peut endommager I'écran LCD.

Précautions relatives aux réparations

< Ne tentez pas de réparer vous-méme ce caméscope Sport.

< Enouvrant ou en retirant les capots, vous risquez entre autre de
vous électrocuter.

% Confiez toute réparation & un technicien qualifié.

Précautions relatives aux piéces de rechange

% Lorsque des piéces nécessitent d'étre remplacées, assurez-vous
que le réparateur utilise des piéces de rechange spécifiées par
le fabricant et dotées des mémes caractéristiques que celles d'origines.

< L'utilisation de toute piéce de rechange non agréée pourrait
notamment occasionner un incendie ou une électrocution.

Comment éliminer ce produit
(déchets d’équipements électriques et électroniques)

(Applicable dans les pays de I'Union Européen et aux autres pays
européens disposant de systémes de collecte sélective)

Ce symbole sur le produit ou sa documentation indique qu'il ne doit pas

étre éliminé en fin de vie avec les autres déchets ménagers. L'élimination
incontrolée des déchets pouvant porter préjudice a 'environnement ou a la
santé humaine, veuillez le séparer des autres types de déchets et le recycler
de facon responsable. Vous favoriserez ainsi la réutilisation durable des
ressources matérielles. Les particuliers sont invités a contacter le distributeur
leur ayant vendu le produit ou a se renseigner auprés de leur mairie pour
savoir ol et comment ils peuvent se débarrasser de ce produit afin qu'il

soit recyclé en respectant I'environnement. Les entreprises sont invitées a
contacter leurs fournisseurs et a consulter les conditions de leur contrat de
vente. Ce produit ne doit pas étre éliminé avec les autres déchets commerciaux.

Avvertenze riguardanti I’obiettivo

% Non filmare con I'obiettivo della videocamera Sport puntato
direttamente verso il sole.
Poiché la luce solare diretta pud danneggiare il sensore CCD
(Dispositivo ad accoppiamento di carica).

Avvertenze riguardanti il display LCD

1. Il display LCD e stato realizzato utilizzando tecnologie ad alta
precisione. Tuttavia sul display LCD potrebbero apparire minuscoli
puntini (rossi, blu o verdi). Cid & normale e non pregiudica in alcun
modo la qualita delle immagini registrate.

2. Se si utilizza il display LCD sotto la luce diretta del sole o all'aperto,
puo essere difficile vedere chiaramente limmagine.

3. Laluce solare diretta pud danneggiare il display LCD.

Avvertenze riguardanti la manutenzione

% Non tentare di riparare da soli la videocamera Sport.

% L’apertura o la rimozione dei coperchi puo esporre al rischio di gravi
scosse elettriche o altri pericoli.

% Per qualsiasi tipo di assistenza rivolgersi a personale qualificato.

Avvertenze riguardanti i ricambi

% Quando sono necessari alcuni ricambi, assicurarsi che il tecnico
dell'assistenza abbia utilizzato i ricambi specificati dal costruttore e
che questi abbiano le stesse caratteristiche della parte originale.

% L'utilizzo di parti di ricambio non autorizzate pud provocare rischio
di incendio, di scosse elettriche o altri pericoli.

Corretto smaltimento del prodotto (rifiuti elettrici ed elettronici)

(Applicabile in i paesi dell’Unione Europea e in quelli con sistema di
raccolta differenziata)

Il marchio riportato sul prodotto o sulla sua documentazione indica che il
prodotto non deve essere smaltito con altri rifiuti domestici al termine del
ciclo di vita. Per evitare eventuali danni all'ambiente o alla salute causati
dall'inopportuno smaltimento dei rifiuti, si invita I'utente a separare questo
prodotto da altri tipi di rifiuti e di riciclarlo in maniera responsabile per favorire
il riutilizzo sostenibile delle risorse materiali. Gli utenti domestici sono invitati a
contattare il rivenditore presso il quale ¢ stato acquistato il prodotto o l'ufficio
locale preposto per tutte le informazioni relative alla raccolta differenziata e

al riciclaggio per questo tipo di prodotto. Gli utenti aziendali sono invitati a
contattare il proprio fornitore e verificare i termini e le condizioni del contratto
di acquisto. Questo prodotto non deve essere smaltito unitamente ad altri rifiuti
commerciali.

a



Familiarisez-vous avec votre Caméscope Sport

Informazioni generali sulla Videocamera Sport

Fonctionnalités

Fonction Caméscope numérique/DSC intégrée

Dispositif interne d'imagerie numérique capable de convertir le caméscope numérique

en appareil photo numérique ; manipulation simple et conviviale.

Qualité d’image haute résolution (Camera numérique)

Utilisation d’une mémoire CCD 800 000 pixels pour une résolution maximale de

640X480.

Zoom numérique 100x

Permet de grossir une image jusqu’a 100 fois sa taille d'origine.

Ecran LCD-TFT couleur

L'écran LCD-TFT couleur haute résolution (230 000 pixels) offre une image nette et

vous permet de visionner vos fichiers enregistrés immédiatement.

Stabilisateur électronique d’image (EIS)

Votre caméscope Sport vous permet de réduire ['instabilité de image en

compensant les mouvements naturels de votre main.

Effets spéciaux numériques divers

Grace a la fonction DSE (effets spéciaux numériques), vous pouvez apporter a votre

film une touche d'originalité en lui ajoutant divers effets spéciaux.

Interface USB pour le transfert de données

Vous pouvez transférer des fichiers photo, vidéo ou autres vers un ordinateur a I’

aide de linterface USB.

Fonction Web cam pour plus de convivialité

Vous pouvez utiliser votre caméscope Sport comme Web cam pour participer & des

conversations en ligne, communiquer par visioconférence, etc.

Enregistrement vocal/Lecture de données vocales grace a une mémoire de

grande capacité

Vous pouvez effectuer des enregistrements vocaux et les stocker dans la mémoire

interne, la carte mémoire (non fournie) et lire les fichiers vocaux enregistrés.

Télécharger et écouter des fichiers MP3

Le caméscope Sport vous permet de lire des fichiers MP3 contenus dans la

mémoire interne ou dans la carte mémoire (non fournie).

Ecoutez vos chansons favorites grace a votre caméscope Sport.

Un caméscope a vocation sportive équipé d’'un module caméra externe

Ce caméscope Sport est équipé d'un module caméra externe qui vous permet d’

enregistrer directement lorsqu'il est raccordé a 'unité principale.

Protégé contre les intempéries (modul éra externe uniq )

Le module caméra externe est étanche, conformément a la norme [P42.

Indice de protection IP42.

4- La caméra externe est protégée contre tout contact avec des objets solides
mesurant plus d'1 mm de diamétre.

2- La caméra externe est également protégée contre les projections d’eau qui
atteindraient sa face supérieure (témoin d’alimentation en haut) sur une amplitude
de 15°.

Affichage a I’écran en plusieurs langues

Plusieurs langues sont disponibles pour I'affichage du menu et des informations.

Vous pouvez sélectionner la langue d’affichage de votre choix parmi la liste qui

apparait a I'écran.

Prise multifonction

La prise multifonction sert de prise pour les écouteurs, 'entrée/sortie AV ou le

module caméra externe.

Vous pouvez utiliser plusieurs fonctions & l'aide d'une seule prise.

Funzioni

il digital

Funzic ) integrato gi DSC

Un dispositivo digitale integrato che consente una facile conversione dalla modalita

Videocamera digitale Sport alla modalita Fotocamera digitale per una registrazione

comoda e facile.

Qualita dell'immagine ad alta risoluzione (fotocamera digitale Sport)

Mediante I'utilizzo di un sensore CCD da 800K pixel, & possibile ottenere una

risoluzione massima di 640X480.

Zoom digitale 100x

Permette di ingrandire un'immagine fino a 100 volte la dimensione originale.

Display LCD TFT a colori

Un display LCD TFT a colori ad alta risoluzione (230K) garantisce immagini nitide,

oltre alla possibilita di rivedere immediatamente i file registrati.

Stabil. immagine elettronico (EIS)

Con la videocamera Sport & possibile ridurre 'instabilita delle immagini evitando le

vibrazioni dovute ai movimenti involontari della mano.

Vari effetti digitali

La funzione DSE (Digital Special Effects) permette di conferire alla pellicola un

aspetto particolare aggiungendo diversi effetti speciali.

Interfaccia USB per trasferimento dati

Per mezzo dellinterfaccia USB & possibile trasferire immagini e file video o altri file

suun PC.

Videocamera per PC

E possibile utilizzare I'apparecchiatura come una videocamera per PC per chat,

video conferenze e altre applicazioni video per PC.

Registrazione e riproduzione vocale con ampia memoria

E possibile registrare la voce e memorizzarla nella memoria interna o sulla scheda di

memoria (non fornita in dotazione) e riprodurre i file.

Download e ascolto dei file MP3

Con la videocamera Sport & possibile riprodurre file MP3 memorizzati nella memoria

interna o sulla scheda di memoria (non fornita in dotazione).

Con la videocamera Sport & possibile ascoltare le canzoni preferite.

Una videocamera Sport dotata di modulo videocamera esterna

La videocamera Sport € dotata di un modulo videocamera esterna che permette di

registrare direttamente quando si € collegati all'unita principale

Impermeabile all’acqua (solo modulo videocamera esterna)

Il modulo videocamera esterna é resistente alle intemperie in conformita con lo

standard 1P42.

Grado di protezione IP

4- La videocamera esterna & protetta dagli urti contro oggetti solidi con un
diametro superiore a 1 mm.

2- Sulla parte superiore centrale (LED Power rivolto verso I'alto) la videocamera
esterna é protetta dagli spruzzi d'acqua verticali con un’angolatura di 15 gradi.

Lingue del display OSD

Supporta diverse lingue straniere per la visualizzazione del menu e delle

informazioni. Da OSD List (Elenco OSD), & possibile selezionare la lingua desiderata

per visualizzare gli OSD.

Multijack

Il multijack funziona come jack cuffie, jack ingresso/uscita AV o jack modulo

videocamera esterna.

E possibile utilizzare diverse funzioni con un unico jack.



Familiarisez-vous avec votre Caméscope Sport

Informazioni generali sulla Videocamera Sport

Accessoires fournis avec le Caméscope Sport

% Vérifiez que les accessoires suivants ont bien été fournis avec
votre caméscope Sport.

Accessori in dotazione con la Videocamera Sport

% Assicurarsi che nella confezione della videocamera Sport
siano presenti i seguenti accessori base.

Accessoires principaux 1. Lithium Polymer Battery pack | 2. AC Power Adapter

1. Batterie lithium-
polymere

3. Audio/Video Cable

4. USB Cable

Accessori base

Gruppo batterie ai
polimeri di litio

2. Adaptateur CA AN Alimentatore CA

3. Cable audiovidéo - Cavo audiovideo

4. Céble USB 5. Earphones 6. Hand Strap 7. Instruction Book/Quick Guide Cavp USB

5. Ecouteurs Cuffie

6. Dragonne Cinghia da polso

7. Manuel d'utilisation/ / Manuale di istruzioni/
Guide de prise en Guida rapida
main rapide 8. CD Software

8. CD q’mSta"atlon de 9. Lens Cover 10. External Camera Module [ 11. Rubber Mount 12. Long Mount Band 9. Tappo COPI'IObIGﬂIVO
logiciels 10. Modulo videocamera

9. Cache-objectif

esterna

10. Module caméra 11. Supporto in gomma
externe 12. Cinghia di supporto

11. Support antivibratoire lunga

12. Bande de fixation 13. Carying Case T TR 13. Borsa da trasporto
longue

13. Etui

Accessory en option
14. Batterie longue durée

[ Remarques ]
L

Les pieces et les accessoires sont disponibles chez votre revendeur
Samsung le plus proche et aupres du centre de service technique.
Vous pouvez télécharger les programmes, le dernier logiciel du
pilote et les CODECs audio/vidéo via la page Web de Samsung
Electronics. (www.samsung.com)

L

Accessori opzionali
14. Gruppo batterie a lunga durata

Note
[z- Coanponenti e accessori sono disponibili presso i rivenditori o icentri
di assistenza autorizzati SAMSUNG.
% E possibile scaricare i programmi, la versione aggiornata del driver
software e i CODEC audio/video dal sito di Samsung Electronics.
(www.samsung.com)

pisN



Emplacement des commandes

Posizione dei comandi

Vue arriere gauche

Vista posteriore e sinistra

Earphones

=
S
S}
R
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m DOW @

®E®

Connect the
earphones to the
multi jack as shown
in the diagram.

How to Connect

Ecran LCD

Bouton DELETE

Bouton DISPLAY
Haut-parleur intégré
Bouton POWER
Interrupteur HOLD du
module caméra externe/
MP3

7. Témoin d’enregistrement/
d’alimentation/de charge

oorwN A

[ Remarque ]

10.
1.

12.
13.
. Prise d’entrée CC
15.

Bouton PLAY

Bouton Record/Stop
Interrupteur [W/T]
Joystick (en haut, en bas,
a gauche, a droite, OK)
Bouton MENU

Bouton MODE

Prise multifonction

% La prise multifonction sert de prise & la fois pour les écouteurs,
ﬁ I'entrée/sortie AV et le module caméra externe.

Display LCD

Tasto DELETE

Tasto DISPLAY
Altoparlante integrato
Tasto di ACCENSIONE
Interruttore HOLD MP3/
Modulo videocamera
esterna

7. Indicatore di registrazione/
alimentazione/carica

[ Nota]

oorwN =

Tasto PLAY
Tasto di Registrazione
[Arresto

. Interruttore [W/T]
. Joystick (su, giu, sinistra,

destra, OK)

. Tasto MENU
. Tasto MODE
. Jack DC IN
. Multijack

Il multijack & unico per jack cuffie, jack ingresso/uscita AV e jack

modulo videocamera esterna.




Emplacement des commandes

Posizione dei comandi

Vue de cété et de dessous

Vista posteriore e laterale

A\SLY

A\L\m\c\m@

Hanging Lens Cover on the
Sports Camcorder

Objectif

Flash

Batterie
Interrupteur
d’éjection de la
batterie

Cache avant

6. Port USB

Eall ol

o

9.

10.

Microphone
intégré

Fente pour la
carte mémoire
Emplacement
pour trépied
Emplacement
pour la dragonne

Cartes mémoire
utiliSables (2 Go maxi.)

Schede di memoria
utilizzabili (2GB Max)

SD

MMC

Eal ol

Obiettivo

Flash

Gruppo batterie
Interruttore di
estrazione della
batteria
Coperchio
anteriore

Porta USB
Microfono
integrato

Slot per scheda
di memoria
Predisposizione
cavalletto

10. Aggancio cinghia

pi-N



Emplacement des commandes

Posizione dei comandi

Présentation du module caméra externe

Visualizzazione modulo videocamera esterna

OO

o

Microphone intégré
Objectif

Support antivibratoire
Systéme de rotation
des images

Témoin d’
enregistrement/d’
alimentation

Bouton Power/Record/

' Stop

Fixation

: Cable du module

caméra externe
Emplacement pour le
support antivibratoire

agrLp =

Microfono integrato
Obiettivo

Supporto in gomma
Rotatore

Indicatore di registrazione/
alimentazione

Tasto di ACCENSIONE /
registrazione/arresto
Aggancio

Cavo modulo videocamera
esterna

Predisposizione supporto
in gomma




Emplacement des commandes : Ecran LCD

Posizione dei comandi: Display LCD

Affichage a 'écran en modes Movie record (Enreg. vidéo) ou Movie Play (Lect. vidéo)

Mode Movie Record (Enreg. vidéo)

NGO HWN

Mode

Taille de limage

Qualité de limage

Fonction White Balance (Bal. blancs)
Fonction Program AE (Prog. AE)
Horodatage

Effet

Fonction BLC (CCJ) *

Mise au point *

. Fonction EIS (SEI)

. Etat de la batterie

. Type de mémoire

. Compteur (temps écoulé/temps restant)
. Avertissements et remarques

. Enregistrement/Arrét

. Zoom optique

. Zoom numérique

Mode Movie Play (Lect. vidéo)

CONOITHWN

Mode

Verrouillage

Image actuellement affichée
Move (Dépl.) (touche Help)
Play (Lire) (touche Help)
Nom du fichier endommagé
Barre de défilement
Sélection multiple

Etat de la batterie

. Type de mémoire

. Compteur d'images (image actuellement affichée)

. Taille d'image

. Horodatage

. Volume

. Compteur (temps écoulé/durée de I'enregistrement)

[ Remarques ]

Les réglages S|gnales par le symbole * ne sont
pas gardés en mémoire lorsque le caméscope
Sport est éteint.

Les témoins d’affichage a I'écran de cet appareil
sont basés sur le modéle VP-X205L.

Les témoins d’affichage a I'écran sont basés sur
la mémoire interne.

Movie Record Mode

1
2
3
4
5
Movie Play Mode
11 10 9
1
2 8
3
7
EMove I3 Play
12 2
14

08D (On Screen Display in modalita di registrazione/riproduzione video)

Modalita di registrazione video

©ON®D W=

Indicatore di modalita

Indicatore delle dimensioni dellimmagine
Indicatore della qualita dellimmagine
Indicatore del bilanciamento del bianco
Indicatore di esposizione automatica
programmata

Indicatore data/ora

Indicatore degli effetti

Indicatore di compensazione del controluce *
Indicatore di messa a fuoco *

Indicatore stabilizzatore digitale delle immagini

. Indicatore di durata della batteria

. Indicatore del tipo di memoria

. Contatore (tempo trascorso/tempo restante)
. Indicatore messaggi d’avviso e informazioni
. Indicatore di registrazione/arresto

Indicatore dello zoom ottico

. Indicatore dello zoom digitale

Modalita di riproduzione video

1. Indicatore di modalita

2. Indicatore di blocco

3. Indicatore della visualizzazione corrente
4. Move (Sposta) (tasto Guida)

5. Play (Riproduci) (tasto Guida)

6. Indicatore file danneggiato

7. Barra di scorrimento

8. Indicatore multiselezione

9. Indicatore di durata della batteria

10. Indicatore del tipo di memoria

11. Contatore delle immagini (immagine corrente)
12. Indicatore dimensione immagine

13. Indicatore data/tempo

14. Indicatore volume

15. Contatore (tempo trascorso/regitrato)

[ Note ]

Una volta spenta la videocamera Sport, le
impostazioni contrassegnate da * non vengono
mantenute.

< Gli indicatori OSD di questo prodotto si basano

sul modello VP-X205L.

< Gli indicatori OSD si basano sulla memoria interna.



Emplacement des commandes : Ecran LCD | Posizione dei comandi: Display LCD

Affichage & I'écran en modes Photo Capture (Prise photo) ou Photo View (Aff. photo) | OSD (On Screen Display in modalita di ripresa/visualizzazione foto)

Mode Photo Capture (Prise photo)

©COND>OT AN =
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15.

Mode

Fonction White Balance (Bal. blancs)
Fonction Program AE (Prog. AE)
Horodatage

Effet

Fonction BLC (CCJ) *

Mise au point *

Fonction EIS (SEI)

Etat de la batterie

. Type de mémoire

. Avertissements et remarques

. Fonction Mutli Shot (Prises multiples)
. Flash

. Zoom optique

Zoom numérique

Mode Photo View (Aff. photo)

S0 NoOR~WN

12.
13.

0.
1. Fonction DPOF (Digital Print Order Format)

Mode

Verrouillage

Image actuellement affichée

Move (Dépl.) (touche Help)

View (Voir) (touche Help)

Barre de défilement

Sélection multiple

Etat de la batterie

Type de mémoire

Compteur d'images (image actuellement affichée)

(protocole de commande d'impression numérique)
Horodatage
Témoin du diaporama

[ Remarques ]

oo

&

PicN

Les réglages signalés par le symbole *

ne sont pas gardés en mémoire lorsque le
caméscope Sport est éteint.

Les témoins d'affichage a I'écran sont basés
sur la mémoire interne.

Photo Capture Mode Modalita di ripresa foto

Indicatore di modalita

Indicatore del bilanciamento del bianco
Indicatore di esposizione automatica
programmata

Indicatore data/ora

Indicatore degli effetti

Indicatore di compensazione del controluce *
Indicatore di messa a fuoco *
Indicatore stabilizzatore digitale delle
immagini

9. Indicatore di durata della batteria

10. Indicatore del tipo di memoria

PN~ W~

11. Indicatore messaggi d'avviso e informazioni
12. Indicatore multiscatto

710 9 8 13. Indicatore flash
14. Indicatore dello zoom ottico
15. Indicatore dello zoom digitale

7 Modalita di visualizzazione foto

Indicatore di modalita

Indicatore di blocco

Indicatore della visualizzazione corrente
Move (Sposta) (tasto Guida)

Indicatore barra di scorrimento
Indicatore multiselezione

Indicatore di durata della batteria
Indicatore del tipo di memoria

1
2
3
4.
BMove W View 5. View (Visualizza) (tasto Guida)
6
7
8
9
1

0. Indicatore contatore immagini

(immagine corrente)

11. Indicatore DPOF

2 12. Indicatore data/ora

13. Indicatore foto

[ Note ]

< Una volta spenta la videocamera Sport, le
impostazioni contrassegnate da * non
vengono mantenute.

% Gli indicatori OSD si basano sulla memoria
interna




Emplacement des commandes : Ecran LCD | Posizione dei comandi: Display LCD

Affichage a I’écran en mode MP3
Mode MP3

OSD (On Screen Display in modalita MP3)

MP3 Mode Modalita MP3

1. Mode . . .
2. Nom du fichier 2 Incioaore nome e
Z' \hﬁ%cg%lg%%?) (touche Help) i Jid (=) 00:12 3. Indicatore di blocco _
5. Play (Lie) (touche Help) 2 i & Move (Sposia) (tasto Gida)
6. Barre de défilement 3 & Everytime.mp3 - Play (Riproduci) (tasto Guida)
7 Etat de la batterie & Toxic.mp3 6 6. Ind!catore bgrra di scorrimento .
8. Type de mémoire & Don't push me.mp3 7. Indicatore di durata della batteria
' v jou. 8. Indicatore del tipo di memoria
9. Compteur (temps écoulé) " 6 Love yemiis)
10. Fonction Repeat (Répét.) ElVlove  E@Play 9. Contatore (tempo trascorso)
11. Témoin de la sélection multiple 10. Indicatore di ripetizione
4 5 11. Indicatore Multi-selezione
Mode MP3 T -
Modalita MP3
1. Mode MP3 Mode 1. Indicatore di modalita
;23' Nom gu {'Chler 16 1514 2. Indicatore nome file
. Nom de l'artiste ' . ]
; " . it hinai = ; 3. Indicatore artista
g E{reec(i]g;ncedechanhllonnage/deblt binaire ; JLUfu — 1/10 M i3 g Frgqutenzad difcampionaturt alfrequenza di bit
6. Barre davancement 3 S:_,e'stlco,? i 12 | 2. ncicatore di funzionamento
7. Search (Rech.) (touche Help) A Eﬁ&(ﬁmm 6. Indicatore barra di avanzamento
8. Compteur (temps écoulé/durée totale) PR 0;.01.07/00:03:27 1 g 8?{;?0@'82:3?0(:?:Stgo?slg?t:%po
9. List (touche Help) 6 ] : f
; complessivo)
1(1) \Ijl;ﬁ/rlr]’guse (Lire/Pause) (touche Help) e | Gl opams 9. List (Elenco) (tasto Guida)
19 E aliseur 10. Play/Pause (Riproduci/Pausa) (tasto Guida)
13. Vgrrouilla o 7 8 9 10 11. Indicatore del volume
14. Etat de Iagbatterie 12. Indicatore equalizzatore
15: Type de mémoire 13. Indicatore di blocco

16. Numéro de fichier (en cours/total)
[ Remarques ]

% Les réglages sont gardés en mémoire lorsque le caméscope Sport

est éteint.

% Le fichier MP3 qui comprend des informations sous forme d’
étiquette affiche le nom de l'artiste. Pour les fichiers MP3 qui n’en

comprennent pas, I'élément reste vide.

14. Indicatore di durata della batteria
15. Indicatore del tipo di memoria
16. Indicatore numero file (corrente / totale)

[ Note ]

< Una volta spenta la videocamera Sport, le impostazioni vengono
mantenute.

% Il file MP3 con le informazioni sui tag visualizza il nome dell’
artista. | file MP3 che non contengono informazioni sui tag lasciano @
lo spazio vuoto.




Emplacement des commandes : Ecran LCD

Posizione dei comandi: Display LCD

Affichage a I'écran en modes Voice Record (Enreg. voix) ou Voice Play (Lect. voix)

Mode Voice Record (Enreg. voix)

PN~ WD~

Mode

Nom du fichier

Horodatage

Fréquence d’échantillonnage/débit binaire
Lecture

Compteur (Temps écoulé/temps restant)
Etat de la batterie

Type de mémoire

Mode Voice Play (Lect. voix)

©CONOTT AWM=

10.
11.
12.

Mode

Horodatage

Verrouillage

Move (Dépl.) (touche Help)
Play (Lire) (touche Help)

Barre de défilement

Etat de la batterie

Type de mémoire

Numéro de fichier (en cours/total)
Compteur (temps écoulé)
Fonction Repeat (Répét.)
Témoin de la sélection multiple

Mode Voice Play (Lect. voix)

©® NogRWN
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Nom du fichier

Horodatage

Lecture

Barre d’avancement

Search (Rech.) (touche Help)

List (touche Help)

Compteur

(Temps écoulé/durée de I'enregistrement)
Play/Pause (Lire/Pause/Arrét) (touche Help)
Volume

. Verrouillage
. Témoin du numéro de fichier (en cours/total)

[ Remarque ]

L

A

Les réglages sont gardés en mémoire lorsque
le caméscope Sport est éteint.

Voice Record Mode

a s wN

8 7

$

SWAV0001. WAV
2006/01/01 12:00:00 AM

 Stereo] 8.0KHz | 64Kbps |
@ 00:00:12/34:59:48

6

Voice Pllay Mode

11 10 9 8 7

'a"l! [1] 00:12 13 WD

9 © 2006/01/01 12:00:00 AN 7
& 2006/01/01 12:00:10 AM
v & 2006/01/01 12:00:20 AM

BEilove

I3 Play

4 5

Voice Play Mode

& )

SWAV0001.WAV
2006/01/01 12:00:00 AM

[Stereo] 5.0KHz] 64Kbps
» 00:00:02/00:00:12
||

L Search BiList L3 Pause

08D (On Screen Display in modalita di registrazione/riproduzione vocale)

Modalita di registrazione vocale

PN TN =

Indicatore di modalita

Indicatore nome file

Indicatore data/ora

Frequenza di campionatura/frequenza di bit
Indicatore di funzionamento

Contatore (tempo trascorso / tempo restante)
Indicatore di durata della batteria

Indicatore del tipo di memoria

Modalita di riproduzione vocale

©ONOOTA~ LN =

Indicatore di modalita

Indicatore data/ora

Indicatore di blocco

Move (Sposta) (tasto Guida)
Play (Riproduci) (tasto Guida)
Indicatore barra di scorrimento
Indicatore di durata della batteria
Indicatore del tipo di memoria
Indicatore numero file

(corrente / totale)

10. Contatore (tempo trascorso)
11. Indicatore di ripetizione
12. Indicatore Multi-selezione

Modalita di riproduzione vocale

©CONOOT~WN =

Indicatore nome file

Indicatore data/ora

Indicatore di funzionamento

Indicatore barra di avanzamento

Search (Ricerca) (tasto Guida)

List (Elenco) (tasto Guida)

Contatore (tempo trascorso / tempo registrato)
Play/Pause (Riproduci/Pausa/Arresta) (tasto Guida)
Indicatore del volume

10. Indicatore di blocco
11. Indicatore numero file (corrente / totale)

[ Nota ]
¢ Una volta spenta la videocamera Sport, le

impostazioni vengono mantenute.



Emplacement des commandes : Ecran LCD | Posizione dei comandi: Display LCD

Affichage a I’écran en modes File Browser OSD (On Screen Display in modalita di scorrimento
(Explorateur) ou System Settings (Réglage syst.) file/impostazioni di sistema)

Mode File Browser (Explorateur)

1. Mode

2. Dossier actuellement sélectionné
3. Fichier actuellement sélectionné
4. Verrouillage

5. Témoin de la sélection multiple
6. Move (Dépl.) (touche Help)

7. Play (Lire) (touche Help)

8. Barre de défilement

9. Etat de la batterie

10. Type de mémoire

11. Témoin du numéro de fichier(en cours/total)

Mode System Settings (Réglage syst.)

1. Mode

2. Onglet Menu

3. Elément de réglage

4. Move (Dépl.) (touche Help)
5. Select (Sél.) (touche Help)
6. Etat de la batterie
7. Type de mémoire

File Browser

Mode

f@ /DCIM/100SSDVC
n c] DCAI\I()001 JPG

& DCAMO0002.JPG
v @ DCAMO0003.JPG
@ DCAMO0004.JPG

BElMove EXPlay

6 7

1110 9

1/4 FM{ID

|
System Settings Mode

1Y System Settings

=R = oK
Storage Type

Internal

External

S Move [D3Select

7 6

m - {9

Modalita di scorrimento file

Indicatore di modalita
Indicatore cartella selezionata
Indicatore file selezionato
Indicatore di blocco

Indicatore multiselezione
Move (Sposta) (tasto Guida)
Play (Riproduci) (tasto Guida)
Indicatore barra di scorrimento
Indicatore carica della batteria
10 Indicatore tipo di memoria

11. Indicatore numero del file (attuale/totale)

©®O NGO~ W=

Modalita impostazioni di sistema

Indicatore di modalita

Scheda menu

Voce di configurazione

Move (Sposta) (tasto Guida)
Select (Seleziona) (tasto Guida)
Indicatore di durata della batteria
Indicatore del tipo di memoria

Noohr~wh =



Utilisation de la batterie

Uso del gruppo batterie

Insertion/Ejection de la batterie

Il est recommandé d'acheter une ou plusieurs batteries supplémentaires
pour qu’une utilisation continue de votre caméscope Sport soit possible.

Inserimento/estrazione del gruppo batterie

Si consiglia di acquistare uno o piu gruppi batterie di riserva per
consentire un uso continuato dell’apparecchiatura.

<Insert>

 <Eject>

Insertion de la batterie

Faites coulisser la batterie dans la rainure jusqu’a ce que vous
entendiez un déclic.

Ejection de la batterie
Tirez sur l'interrupteur Eject de la batterie pour éjecter la batterie.

Batterie

SB-P120A (1200mAh)
SB-P190A (1900mAh)

[ Remarques ]

< Eliminez les corps étrangers des bornes avant d’insérer la
batterie.

% Sivous n'utilisez pas le caméscope Sport pendant un certain
moment, retirez la batterie.

A

Per inserire il gruppo batterie
Fare scorrere il gruppo batterie nella scanalatura fino al clic.

Per estrarre il gruppo batterie

Premere il tasto di estrazione della batteria per estrarre il gruppo
batterie.

Batteria
SB-P120A (1200mAh)
SB-P190A (1900mAh)

Note
E:- Prir%a di inserire il gruppo batterie, pulire il terminale per rimuovere
ogni traccia di sostanze estranee.
% Se la videocamera Sport non viene utilizzata per un certo periodo
di tempo, togliere le batterie.



Utilisation de la batterie

Uso del gruppo batterie

Entretien de la batterie

% Lors de la mise en charge de la batterie, la température doit étre
comprise ente 0°C et 40°C.

% Ne mettez jamais la batterie en charge lorsque la température
ambiante est inférieure a 0°C.

< Sivous utilisez votre caméscope Sport pendant une période

prolongée a des températures inférieures a 0°C ou supérieures a

40°C, la durée de vie et la capacité de la batterie s’en trouveront

réduites.

Eloignez la batterie de toute source de chaleur (ex. : flammes).

La batterie ne doit étre ni démontée, ni modifiée, ni forcée, ni chauffée.

Evitez de court-circuiter les bornes + et — de la batterie. Des fuites,

des dégagements de chaleur, des incendies ou encore des surchauffes

pourraient en résulter.

< Nous vous recommandons d’utiliser une batterie Samsung d’origine
disponible aupres de votre revendeur.

Durée d’enregistrement en continu selon le type de batterie

oo

L’écran LCD s’éteint automatiquement lorsque vous le rabattez.

Les durées d’enregistrement en continu présentées dans le tableau
ci-dessous sont approximatives. La durée d’enregistrement réelle varie
selon l'utilisation.

Heure

Durée d’enregistrement en continu

Manutenzione del gruppo batterie

% |l gruppo batterie deve essere ricaricato in un ambiente con
temperatura compresa tra 32°F ( 0° C ) e 104°F ( 40° C).

<+ Il gruppo batterie non deve mai essere caricato in un ambiente con
temperatura inferiore a 32°F ( 0° C).

% La vita e la capacita del gruppo batterie vengono ridotti se questo
viene utilizzato a temperature inferiori a 32°F(0°C) o lasciato per
un lungo periodo a temperature superiori a 104°F ( 40°C ).

<+ Non riporre il gruppo batterie vicino a fonti di calore, come ad
esempio fiamme libere o termosifoni.

<+ Non smontare, manomettere o sottoporre a pressione il gruppo
batterie.

% Evitare di mettere in cortocircuito i poli + e — della batteria.
Potrebbe provocare perdita di liquidi, generare calore, incendi e
surriscaldamento.

< Siraccomanda l'utilizzo di un gruppo batterie originale Samsung
disponibile presso il rivenditore da cui si & acquistato il prodotto.

Tempi di registrazione continua in base al tipo di batteria

Una volta chiuso, il display LCD si spegne automaticamente.

| tempi di registrazione continua forniti nella tabella sottostante hanno
un valore approssimativo. Il tempo di registrazione effettivo dipende
dalle modalita d'uso.

Ecran LCD allumé Compensation de

Batterie contre-jour désactivée
SB-P120A (1200mAh) Env. 1h 20 Env. 1h. 40
SB-P190A (1900mAh) Env. 2h 30 Env. 2h. 50

[ Avertissement ]

% Lorsque vous éjectez la batterie du caméscope Sport, tenez-la
fermement afin qu’elle ne tombe pas sur le sol.

[ Remarques ]

% Prévoyez une batterie de rechange si vous utilisez votre
caméscope Sport en extérieur.

< Pour I'achat d'une nouvelle batterie, contactez un revendeur Samsung.

% La durée d’enregistrement raccourcit si vous zoomez vers I'avant
ou vers larriere.

% Les durées d’enregistrement en continu mentionnées sont
approximatives et dépendent des fonctions utilisées (ex. : zoom).

Tempo Tempo di registrazione continua

Retroilluminazione
LCD ATTIVO DISATTIVATA
circa 1h. 20 min.

circa 1h. 40 min.
circa 2h. 30 min. circa 2h. 50 min.

Batteria

SB-P120A (1200mAh)
SB-P190A (1900mAh)

[Avvertenza)

%+ Quando si estrae il gruppo batterie dalla videocamera Sport,
tenerlo saldamente per impedire che cada.

[ Note ]

% Se si utilizza la videocamera Sport allaperto, munirsi di una
batteria di riserva.

% Per l'acquisto di nuovi gruppi batterie rivolgersi ad un rivenditore

Samsung.

L

o

L'uso dello zoom riduce il tempo di registrazione.
Il tempo di registrazione continua visualizzato & approssimativo

e puo variare in base ad alcune funzioni come lo zoom. A



FRANCAIS ITALIANO
Utilisation de la batterie Uso del gruppo batterie
Affichage du niveau de charge de la batterie Livello di batteria sul display
L'affichage du niveau de charge de la batterie permet de visualiser la Il livello di batteria sul display mostra la quantita restante di batteria nel
quantité d’énergie restante a l'intérieur de cette derniere. gruppo batterie.
Niveau de FaRemor 22 [0 dicatore del
charge de la Etat Wessage livello della Stato Messaggio
batterie batteria
Charge compléte - Completamente carica -
m 20 & 40 % utilisés - m Utilizzata al 20~40% -
([ 40 & 60 % utilisés - { 1) Utilizzata al 40~60% -
[] 60 & 80 % utilisés - {1 Utilizzata al 60~80% -
{ 80 & 95 % utiisés - (| Utilizzata al 80~95% -
Batterie épuisée (le : -
témoin de charge clignote) Lyicagfscgﬁirgg?%g':n;?ra
— L’appareil est sur le point R Charge N Pp peg
- de Seteind Lharg entro breve tempo. B
—\ e seteindre. indicator - Sostituire il gruppo
Remplacez votre batterie T batterie non appena
dés que possible. possibile.
(Le témoin clignote) “Low (lampeggiante) ‘Low
- L'appareil va séteindre | yyop, » 'l L'apparecchio si battery
a”‘or%aé'gé‘migt dans | Batt. fole) spegnera dopo 5 (Esaurim
: secondi. Bat)”
Astuces pour déterminer le niveau de charge de la batterie Consigli per I'identificazione della batteria
Si la batterie a été entiérement chargée, le témoin de charge est vert. Se la batteria € stata completamente caricata, 'indicatore & verde.
Si la batterie est en cours de charge, ce témoin est orange. Durante un ciclo di ricarica, il colore dell'indicatore & arancione.
II clignote si la batterie est défectueuse. Se la batteria presenta anomalie, I'indicatore lampeggia.
Durée de charge calculée en fonction du type de batterie Tempo di ricarica in base al tipo di batteria
Capacité Avec L’ADAptateur CA| Avec un cable USB c it Uso dell’alimentatore Uso del USB
apacita so del cavo
SB-P120A (1200mAh) Env. 1h. 50 Env. 3h. 40 P CA
SB-P190A (1900mAh) Env. 3h. 20 Env. 6h. 20 SB-P120A (1200mAh) | circa 1h. 50 min. circa 3h. 40 min.
[ Remarques | SB-P190A (1900mAh) circa 3h. 20 min. circa 6h. 20 min.
% Vous pouvez charger votre caméscope Sport en le reliant & un ordinateur a | [ Note ]
I'aide d'un céble USB. < E possibile caricare la videocamera Sport collegandola ad un PC con il
% Le chargement via un cable USB est impossible si le caméscope est sous cavo USB.
tension. ) ) ) - < Questo non & possibile se la videocamera & accesa.
A La durée de charge avec un cable USB peut varier en fonction de I'ordinateur. % Il tempo di carica con il cavo USB pud variare a seconda del PC.




Utilisation de la batterie

Uso del gruppo batterie

Charge de la batterie

1. Eteignez le caméscope Sport en
appuyant sur le bouton [POWER].

Connecting the AC Power Adapter
|

2. Insérez la batterie dans I'appareil.

3. Ouvrez le cache du connecteur.

4. Chargez la batterie en utilisant un
adaptateur CA ou un cable USB.

Reliez correctement
I'adaptateur CA au
camescope Sport et
branchez 'adaptateur a la
prise murale.

Reliez correctement le

N cable USB au caméscope
Cable USB Sport et a un port USB de
I'ordinateur

[ Remarque ]

Adaptateur
CA

< ATintérieur, vous pouvez utiliser le
caméscope Sport en le branchant a
une prise murale via I'adaptateur CA.

[ Avertissement ]

o Il est recommandé de recharger
entierement la batterie avant toute
utilisation.

% La batterie doit étre rechargée a
une température comprise entre 0°
C et 40°C.

% Sila température ambiante est
trop basse pendant la phase de
chargement, celle-ci necessitera
plus de temps ou ne permettra
pas de charger complétement la
batterie ; le témoin de charge ne
passera donc pas au vert.

< Vérifiez qu'il n'y a pas de corps

étrangers entre les connecteurs
avant de brancher le cable.

Caricamento del gruppo batterie

1. Spegnere la videocamera Sport
premendo il tasto di accensione.

. Inserire il gruppo batterie nell’

unita.

. Aprire il coperchio anteriore dell’

apparecchio.

. Caricare il gruppo batterie con

I'alimentatore CA o il cavo USB.

Collegare I'alimentatore
Alimentatore |CA alla videocamera
Sport e ad una presa a
muro.

Collegare il cavo USB
Cavo USB |alla videocamera Sport e
alla porta USB di un PC.

[ Nota

« E possibile utilizzare la videocamera
Sport caricata dall'alimentatore CA
allinterno.

[Avvertenza]

« Si consiglia di ricaricare
—

completamente il gruppo batterie
prima delluso.

< La batteria va caricata solo in un
ambiente tra 32°F e 104°F.

% Se la temperatura ambiente
troppo bassa, la batteria potrebbe
richiedere pill tempo per caricarsi
0 non caricarsi completamente; in
questo caso la luce verde non si
accende.

Prima di collegare il cavo, assicurarsi
che non ci siano eventuali sostanze
estranee tra i connettori.

A
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Couleur de Ia LED

La couleur de la LED indique I'état de I'alimentation et de la charge.

Témoin d’enregistrement et de charge

Couleur de la Pendant Pendant le )
LED I'enregistrement| chargement | Recording/
Enregistrement Charging Indicator,
<Movie and
Rouge Voice Recorder -
Mode>(Mode
Enreg. film et voix)
Orange - Chargement
: Charge
Vert complete
Témoin d’alimentation
Couleur de la diode Alimentation
Bleu On (Activé)

Préparation du caméscope Sport avant utilisation

Avant d'utiliser votre caméscope Sport, reportez-vous a cette page
pour plus de facilité. La carte mémoire n’est pas fournie.

1.

2.

Insérez la batterie et insérez une carte mémoire dans la fente
prévue a cet effet. wpage 34

Chargez la batterie en reliant directement I’'adaptateur CA au
cameéscope Sport. =page 25

Appuyez sur le bouton [POWER] pour allumer le caméscope Sport.

. Sélectionnez le mode de votre choix en appuyant sur le

bouton [MODE].

. Appuyez sur le bouton [Record / Stop] pour prendre une

photo ou démarrer I’enregistrement vidéo/vocal.

. Lorsque vous avez fini, appuyez sur le bouton [POWER] pour

éteindre le caméscope Sport.

Il colore del LED

Il colore del LED indica lo stato di carica o di alimentazione.

Indicatore di registrazione/carica

Colore del During Durante il
LED Recording | caricamento
Registrazione
<Modalita di
Rosso Registrazione
video/vocale>
Arancione Caricamento
Verde Completamente carica

Spia di alimentazione

Colore del LED Alimentazione

Blu Attiva

Prima di utilizzare la videocamera Sport

Prima di utilizzare la videocamera Sport fare riferimento a questa
sezione. La scheda di memoria non & fornita.

1.

2,

Inserire il gruppo batterie e una scheda di memoria nell’
apposito alloggiamento. =pagina 34

Caricare il gruppo batterie collegando direttamente
I'alimentatore CA alla videocamera Sport. =pagina 25

Per attivare la videocamera Sport, premere il tasto di
accensione.

Selezionare la modalita desiderata premendo il tasto [MODE].

Premere il tasto di registrazione/arresto per scattare una foto,
avviare la registrazione video/vocale.

Al termine delle operazioni premere il tasto di accensione per
spegnere la videocamera Sport.
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Utilisation du bouton MODE

Le bouton Mode permet de passe d’un mode a un autre. Sont disponibles
les modes Movie (Vidéo), Photo, MP3, Voice Recorder (Enreg. voix), File
Browser (Explorateur) et System Settings (Réglage syst.).

Réglage du mode
Réglez le mode de votre choix en appuyant sur le bouton [MODE].
Le mode sélectionné est activé.

Fonctions de chaque mode

PECE 28 ode FICHl Y Mode Voice Recorder
Wovier (il ) & ia (Vidéo) Bl ¥ (Enreg. voix
N Mec:x:gt(Wdeo) .w*;, permet d’gnregistrer
p et d'écouter des

d’enregistreret de lire des fichiers audio.

fichiers vidéo.
Sl @ Mode Photo ¢ J
PN permet de File Browser > ( [l )&
e prendre et de L)
visionner des

W Mode File
Browser (Explorateur)
permet de supprimer,
verrouiller et copier un
fichier et d’afficher les informations qui

photos. lui sont associées.
o u B =g % Mode System
wor (1) % Mode MP3 _ -’0 Settings (Réglage
perm_et qe ({3 5vstem settings » ( ¥ Jd SySt.)
Ll des fichiers slolll Ce mode vous permet de
mp3. régler ou d’'adapter

les parametres relatifs a 'affichage LSD,
I'horodatage, la réinitialisation et la mémoire.

Uso del tasto MODE

Il tasto Mode serve a cambiare la modalita della videocamera Sport. Le

modalita disponibili sono Movie (Video), Photo (Foto), MP3, Voice Recorder

(Registr. Voce), File Browser (Scorri file) e System Settings (Imp di sistema).
Impostazione della modalita

Seleziona il modo desiderato premendo il tasto MODE.
La Videocamera Sport passera' al modo desiderato.

Funzioni per ogni modo

LB @8 Modo R ¢ Modo Voice
[IYNEYN Movie (Video) (NI IL] Recorder (Registr.
& 5 Puoi registrare SS9l Voce)
e riprodurre Puoi registrare e
file video ascoltare degli appunti vocali

-y W WModo File
Browser (Scorri file)
Puoi cancellare,

bloccare, copiare il file e

9 Modo
Photo (Foto)
Puoi scattere e
vedere file di
foto.

J quo MP3 2 Modo System
Puoi riprodurre  EREIERTrSSE< PN Settings (Imp di
file MP3 sistema)

Puoi settare/aggiustare
le impostazioni del dispaly LCD, data/ora,
resettare e gestire la memoria

Photo »

Ji

¢ i
File Browser» ( [ )3
3 &8

vedemne le informazioni.

( Fonction Power Saving (Economie d’énergie) ( Funzione risp armio energetico )
Afin d'éviter toute consommation d’énergie inutile, 'écran LCD s'éteint apres Il display LCD si spegne dopo un certo periodo di tempo (vedere oltre)
écoulement de la période prédéfinie dans chague mode (voir ci-dessous). in ogni modalita per ridurre il consumo della batteria.

kAppuyez sur n'importe quel bouton pour faire réapparaitre ou allumer 'écran LCD. kPremere un tasto qualsiasi per tornare indietro e attivare il display LCD. )

Movi F{Voic(ejz File SSytst.tem Movi Phot Voice File | System
ovie ecorder ettings > | Movie oto Recorder Settings
Mode - Photo | MP3 Browser 2 USB Modalita | . MP3 ; Browser 1 USB
Vidéo (Enreg. (Réglage Video) | (Foto (Registr. )| (mpdi
( ) voix) (Explorateur) syst) ( ) | (Foto) Voce) (Scorri file) sistrma)
Heure | 10min | 3min | 30s | 30s 30s 60 s 60 s Tempo | 10 min. | 3 min. |30 sec.| 30 sec. | 30 sec. | 60 sec. | 60 sec.

a
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Touches de Fonction

Les touches de fonction permettent de faire une sélection, de déplacer
le curseur, de sélectionner des fonctions ou encore de quitter un menu

Touches de fonction

Uso del tasto Funzione

Il tasto Funzione consente di effettuare una selezione, spostare il
cursore, selezionare le varie funzioni e uscire dal menu.

Uso del tasto Funzione

Enregistrement/ Lecture/ Tasto Registrazione/ | Riproduzione/
Prise Visionnage | | Function button Ripresa Visualizzazione
- Ecran Lecture 2 ) - Schermata
Zoom arriére (4) multiple/Liste ‘@ Zoom( |An)d letro Multiplay /
Elen
Zoom avant (V) R Move Upwards —vl co
Move Left — Zoom avanti (V) -
Passage du mode 3 @ Move Right
Enregistrement/ Confirm Selection Move Passaggio da
Prise de photo Lire/Pause Select men ~ Downwards Hegiisir;z;o: o E i/P
au mode Lecture/ u Riprgduzione/ Segui/Fausa
Visionnage de photo Visualizzazione
] Passer du mode Lire/ d?%?ﬁ%f;
Enregistrement | Voir & Enregistrement/ Registrazione Visualizzpazione a
Prise de photo Registrazione/Ripresa
Utilisation du Joystick Uso del Joystick

% Le joystick permet de faire une sélection, de déplacer le curseur,
de sélectionner des fonctions et de quitter un menu.
1. Déplacez le curseur vers la gauche ou la droite a I'aide du [Joystick].
2. Déplacez le curseur vers le haut ou le bas a I'aide du [Joystick].
¢ Vous pouvez régler le volume en déplacant le [Joystick] (vers
le haut et le bas) en modes Movie (Vidéo)/ MP3/ Voice
Recorder (Enreg. voix).
3. Confirmez votre sélection en appuyant sur [Joystick(OK)].

Bouton MENU

1. Sélectionnez le mode de votre choix en appuyant sur le bouton [MODE].

2. Appuyez sur le bouton [MENU].

3. Deéplacez le [Joystick] vers le haut, le bas, la gauche ou la
droite pour sélectionner I'élément de votre choix avec le
curseur, puis appuyez sur [Joystick(OK)] pour confirmer.

4. Appuyez sur le bouton [MENU] pour quitter le menu.

A

< Il joystick consente di effettuare una selezione, spostare il cursore,

selezionare le varie funzioni e uscire dal menu.

Spostare il cursore a sinistra / a destra muovendo il [Joystick].

Spostare il cursore su / giu muovendo il [Joystick].

¢ E possibile regolare il volume muovendo il [Joystick] (su / giu) nelle
modalita di riproduzione Movie (Video) /MP3 /Voice Recorder
(Registr. Voce)

3. Confermare la selezione premendo il [Joystick(OK)].

so del tasto MENU

Impostare la modalita desiderata premendo il tasto [MODE].

2. Premere il tasto [MENU].

3. Spostare il cursore muovendo il [Joystick] su/giu/a sinistra/a
destra per selezionare la voce di menu desiderata, quindi
premere [Joystick(OK)] per confermare.

4. Premere il tasto [MENU] per terminare.

N =

-
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Bouton DISPLAY

Chaque pression sur le bouton [DISPLAY] permet alternativement d’activer
et de désactiver I'affichage a 'écran.

1. Déployez I'écran LCD.

2. Appuyez sur le bouton [POWER] pour allumer le caméscope Sport.

4 L'écran vidéo apparait.

4 Vous pouvez sélectionner le mode Movie (Vidéo) ou Previous (Préc.)
comme mode de démarrage dans System Settings (Réglage syst.).
=page 109

3. Appuyez sur le bouton [DISPLAY].

Si vous appuyez sur le bouton [DISPLAY] en

Uso del tasto DISPLAY
A ogni pressione del pulsante [DISPLAY] si attiva e disattiva I'indicatore OSD.

1. Aprire il display LCD.
2. Per attivare la videocamera Sport, premere il tasto di [accensione].
4 Viene visualizzata la schermata video.

@ E possibile selezionare la modalita Movie (Video) o Previous
(Precedente) come modalita di avviamento in System Settings (Imp
di sistema). wpagina 109

Premere il tasto [DISPLAY].

modes Movie (Vidéo) et Photo

< Une fois : tous les témoins disparaissent de I'écran.
< Deux fois : le rétro-éclairage disparait.
< Trois fois : vous revenez a I'écran initial.

[ Remarque ]
< La description ci-dessus s’applique aux modes
Movie (Vidéo) et Photo.

Si vous appuyez sur le bouton [DISPLAY]
dans un autre mode

% Une fois : le rétro-éclairage est désactivé.
% Deux fois : vous revenez a I'écran initial.

[ Remarque ]
< La description ci-dessus s’applique aux modes
MP3, Voice Recorder (Enreg. voix), File Browser

button

DISPLAY DELETE

U Se si preme il tasto [DISPLAY] nelle
modalita Movie (Video) e Photo (Foto)
< Una volta: Tutti gli indicatori scompaiono
dalla schermata.

< Due volte: La retroilluminazione si
disattiva.

< Tre volte: Riappare la videata iniziale.

[ Nota]

< Quanto descritto sopra vale in modalita
Movie (Video) e Photo (Foto).

Se si preme il tasto [DISPLAY] in un’
altra modalita

< Una volta: Si disattiva la retroilluminazione.
< Due volte: Riappare la videata iniziale.

[ Nota]

button

(Explorateur) et System Settings (Réglage syst.).

Bouton DELETE

Le bouton [DELETE] permet de supprimer des fichiers
enregistrés.

& <OK>: le fichier sélectionné est supprimé.

<Multi Select> (Sélect multi) : Les fichiers
sélectionnés sont supprimés.

<AlI> (Tt) : Tous les fichiers sont supprimés.
<Cancel> (Annul.) : Permet d’annuler 'opération de
suppression.

]

oK
Multi Select
All

B Move

*
*
*

(I3 Select

% Quanto descritto sopra vale in modalita
MP3/Voice Recorder (Registr. Voce)/File Browser (Scorri file)/System
Settings (Imp di sistema).

Uso del tasto DELETE

tasto [DELETE] & utilizzato per eliminare i file salvati.
<OK> : Cancella il file selezionato.

<Multi Select> (Multi selez.) : | file selezionati
vengono eliminati.

<AlI> (Tutti) : Tutti i file vengono eliminati.
<Cancel> (Annul) : Annulla eliminazione.

100-0003" WM {11 l

*e oo

A
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Arborescence des dossiers et des fichiers

Les fichiers vidéo et photo sont stockés dans la mémoire interne ou dans la carte mémoire

comme lindique le schéma ci-dessous.

[ Remarques ]

% Reportez-vous & la page 33 pour plus de
détails concernant la carte mémoire.

% Vous pouvez stocker des données
générales dans les fichiers et dossiers du
caméscope Sport.

Vous pouvez stocker jusqu’a 9 999 fichiers
et 999 dossiers.

Un numéro de fichier est attribué de fagon
séquentielle a chaque dossier enregistré,
le premier portant le numéro DCAMO0001.

% De méme, chaque dossier est numéroté
de fagon séquentielle a partir du numéro
100SSDVC, puis stocké sur la carte mémoire.

% Les noms de fichier sont élaborés en
fonction des normes DCF (Régle de
conception pour le systeme de fichiers de
I’agpareil photo)

% DCAM:kkiisk JPG : fichier photo
SMOV:isiesks AVI: Fichier vidéo
SWAV:iesiesksk WAV: fichier vocal
ekl MP3: fichier MP3

% MISC : stockage des fichiers DPOF.

% Vous pouvez modifier librement les noms
de fichier ou de dossier contenus dans le
dossier Music (Musique).

% Il se peut que ce caméscope Sport ne
prenne pas en charge les fichiers vidéo
créés a partir du materiel d'un autre fabricant.

[ Avertissement ]

% Néteignez pas I'appareil pendant les
phases d’enregistrement, de lecture ou de
suppression des fichiers ou bien au cours
d’'une opération de formatage.

%  Eteignez I'appareil avant d'insérer ou de
retirer la carte mémoire. Dans le cas contraire,
vous risqueriez de perdre ces données.
Enregistrez les fichiers importants sur un
autre support.

Le cartes mémoires sont des produits de
haute technologie. Elles sont sensibles et
vulnérables aux décharges électriques, a la
température et & 'humidité. Pour éviter de
perdre des données, manipulez-les avec
précaution.

% Les données endommagées ne sont pas
toujours récupérables et SAMSUNG n’
assume aucune responsabilité si une telle
situation venait & se produire. Veillez a
sauvegarder les fichiers importants sur un

@ autre support.

Struttura delle cartelle e dei file

| file video e di immagine sono memorizzati nella memoria interna o su una scheda di
memoria come mostrato di seguito.

-

CJEN
—(

DCIM

100SSDVC
101SSDVC

999SSDVC

—D— AUTPRINT.MRK
MISC

—(1— (3
MUS.C—DS

Free

VIDEO

100SSMOV

999SSMOV

VOICE 100SSWAV

999SSWAV

Free.MP3

—— SMOVO0001.AVI

SMOV9999.AVI

—— SWAV0001.WAV

SWAV9999.WAV

"\ [Note]
« Perinformazioni sulla scheda di

memoria vedere a pagina 33. !

E possibile memorizzare dati generali

nei file e nelle cartelle della videocamera

: gport o

DCAM9999.JPG FI posgsgtsle mellwlwonzzare fino a 9.999

ile e 999 cartelle.
DCAMOOO1.JPG Ad ogni file registrato viene assegnato
DCAM9999 JPG Bn numero progressivo a partire da

L
DCAMO001.JPG

Photo file

Ogni cartella viene numerata a partire
da 100SSDVC e registrata in memoria.
Il nome del file € stabilito da .
DCF(standard Design rule for Camera File)
DCAM:ksksisk. JPG: File di immagine
SMOV:ksiesiesk. AVI: File video
SWAV:sieslsk WAV: File audio
seisiesieseelelek MP3: File MP3

MISC: File DPOF <FOSD>.

E possibile cambiare liberamente il
nome del file o della cartella nella
cartella MUSIC (Musica).

| file video registrati su apparecchi di
altri produttori potrebbero non essere
riproducibili su questa videocamera Sport.

[Avvertenza]

% Non spegnere 'apparecchio durante
le registrazione, la riproduzione, la
cancellazione di file o la formattazione.
Spegnere 'apparecchio prima di
inserire o estrarre la scheda di
memoria per evitare la perdita di dati.
Salvare i file pili importanti separatamente.
Le schede di memoria sono realizzate
utilizzando la tecnologia ad alta precisione.
Sono sensibili a temperatura e umidita
€ possono provocare scosse elettriche.
Prestare attenzione ad utilizzarle per
evitare la perdita di dati.

| dati danneggiati non possono

essere recuperati; SAMSUNG non

<

MP3 file

ool

Movie file

&

Voice file

& responsabile per la perdita di dati.
Assicurarsi di eseguire il backup dei file
importanti separatamente sul PC.
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Capacité et durée d’enregistrement Tempo e capacita di registrazione
Durée d’enregistrement vidéo Tempo di registrazione video
o Super Fine (Super fin) . ;" Super Fine
Support Cay 352p 720i/720p Support Capacita 352p 720/720p
512Mo (VP-X205L) environ 21min. environ 14min. . 512MB (VP-X205L) circa 21min. circa 14min.
Mémoire 1Go (VP-X210L) environ 43min. environ 29min. '\f.f:':ﬁ\r;a 1GB (VP-X210L) Girca 43min. circa 29min.
interne 2Go (VP-X220L) environ 86min. environ 58min. 2GB (VP-X220L) circa 86min. circa 58min.
32Mo environ 1min. 20 s environ 50sec. 32MB circa 1min. 20sec. circa 50sec.
64Mo environ 3min. environ 2min. 64MB circa 3min. circa 2min.
128Mo environ 4min. environ 3min. 128MB circa 4min. circa 3min.
Sb/MMC 256Mo environ 11min. environ 7min. SD/MMC 256MB circa 11min. circa 7min.
512Mo environ 21min. environ 14min. 512MB circa 21min. circa 14min.
1Go environ 43min. environ 29min. 1GB circa 43min. circa 29min.
2Go environ 86min. environ 58min. 2GB circa 86min. circa 58min.
Fine (Fin) Normal Fine Normal (Normale)
352p 720i/720p 352p 720i/720p 352p 720i/720p 352p 720i/720p
environ 32min. environ 21min. environ 65min. environ 32min. circa 32min. circa 21min. circa 65min. circa 32min.
environ 65min. environ 43min. environ 131min. environ 65min. circa 65min. circa 43min. circa 131min. circa 65min.
environ 130min. environ 86min. environ 262min. environ 130min. circa 130min. circa 86min. circa 262min. circa 130min.
environ 2min. environ 1min. 20 s. environ 4min. environ 2min. circa 2min. circa 1min. 20sec. circa 4min. circa 2min.
environ 4min. environ 3min. environ 7min. environ 4min. circa 4min. circa 3min. circa 7min. circa 4min.
environ 7min. environ 4min. environ 17min. environ 7min. circa 7min. circa 4min. circa 17min. circa 7min.
environ 17min. environ 11min. environ 32min. environ 17min. circa 17min. circa 11min. circa 32min. circa 17min.
environ 32min. environ 21min. environ 65min. environ 32min. circa 32min. circa 21min. circa 65min. circa 32min.
environ 65min. environ 43min. environ 131min. environ 65min. circa 65min. circa 43min. circa 131min. circa 65min.
environ 130min. environ 86min. environ 262min. environ 130min. circa 130min. circa 86min. circa 262min. circa 130min.
[X‘Remarque$ ] o . o [Note] o N
Les durées et capacités d’enregistrement sont approximatives. i o < | valori relativi al tempo e alla capacita di registrazione sono approssimativi.
% Les durées d'enregistrement indiquées sont des valeurs maximales basées sur 'uilisation | % |l tempo di registrazione indicato & un valore massimo basato sull'uso di una sola
%;Rg faeEéZIE%]ﬁ¥ﬁﬁfsation de plusieurs fonctions réduit ces valeurs. Emzione.ls‘e si utllizzano pit funzioni, si avré una ridzione di questi ?|Ia|_0I'L ini
# Lot docorpression tanbo Syt an rcion (e inage e |+ LACSPECHS 8 comprssinecamba atomatcamerts g seconde delo mnagn
lﬁae ggrr(jgg(gtr] Irae cavpizgl(tj d’enregistrement maximales peuvent étre modifiees dans “Movie utilizzando Fopzione “Movie Record” (Registr. video). .
4+ Ce caméscopg 'Spqrt p'rend en charge les cartes mémoire d'une capacité maximale & IS‘S ‘gﬁgﬁc:gég S(g?;ﬁ:?g%ﬁ fghg?ére' ?2n]rggﬁrllge<:|l?::egapnfgn?e2ﬁi?é Le schede
gﬁ,Sg(iis%;ln?;‘np&sjhbelﬁgcliﬁrf (s:grar\en;ss.supérleures @2 Go ne permettent pas un * Sepsulla memorig interna o su unagscheda di r%emoria si registrano file video con qualita
% Sivous enregistrez des fichiers vidéo de qualité normale (352/720) dans la mémoire normale (352/720), il tempo di registrazione aumenta, ma il video potrebbe essere di
interne ou sur une carte mémoire, la durée d’enregistrement augmente mais la qualité du qualita inferiore rispetto ad altri. X o L
film peut étre amoindrie & d’autres niveaux. < Quando si registrano file video sulla scheda di memoria il tempo e la capacita di
% Ladurée et la capacité d’enregistrement peuvent varier si vous stockez vos fichiers vidéo registrazione possono variare se ci sono settori (sezioni) danneggiati.
sur une carte mémoire dont un secteur est défectueux. A
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Nombre de photos pouvant étre prises Nombre de fichiers MP3 pouvant étre enregistrés | Numero di foto che si possono scattare  Numero di file MP3 che si possono salvare
-, Qualité Support Capacité Fichiers MP3 Qualita ) . .
| ualte | : i — LI File MP3
Support | Capacité 640%480 512Mo (VP-X205L) | environ 128 finiers | | |SUPPOM|  Capacita 640x480 Supporti]  Capacita '
] 512Mo (VP-X205L) | environ 2875 'f:m;e 1Go (VP-X210L) |environ 256 fichers| | | . |512MB (VP-X205L)| circa 2875 512MB (VP-X205L)| circa 128file
Wemaire | 1Go (vP-x210L) | environ 5754 2Go (VP-X220L) [environ 512 fchiers| | | ‘iyterna | 1GB (VP-X210L) | circa 5754 Memoria | 1GB (VP-X210L) | circa 256fie
2Go (VP-X220L) | environ 11511 32Mo environ 8 fichiers 2GB (VP-X220L) | circa 11511 interna | 5GB (VP-X220L) | circa 512file
32Mo environ 177 64Mo environ 16 fichiers 32MB circa 177 32MB circa_8fie
64Mo environ 357 128Mo environ 32 fichiers 64MB circa 357 64MB circa 16file
128Mo environ 716 SD/MMC 256Mo environ 64 fichiers 128MB circa 716 128MB circa 32file
SD/MMC 256Mo environ 1436 512Mo environ 128 fichiers | | | spmme 256MB circa 1436 SD/MMC 256MB circa 64file
512Mo environ 2875 1Go environ 256 fichiers 512MB circa 2875 512MB circa_128file
1Go environ 5754 2Go environ 512 fichiers 1GB circa 5754 1GB circa_256file
2Go environ 11511 2GB circa 11511 2GB circa 512file
Durée d’un enregistrement vocal Tempo di registrazione vocale
Support|  Capacité Heure Supporti|  Capacita Tempo
512Mo (VP-X205L) | environ 17h. 512MB (VP-X205L) circa 17h.
Mémoire [ 4Go (vp-x210L) | environ 35h. Memoria 4GB (vp-x210L) | circa 35h.
interne - interna -
2Go (VP-X220L) | environ 70h. 2GB (VP-X220L) circa 70h.
32Mo environ 1h. 32MB circa 1h.
64Mo environ 2h. 64MB circa 2h.
128Mo environ 4h. 128MB circa 4h.
256Mo environ 8h. 256MB circa 8h.
SD/MMC SD/MMC
512Mo environ 17h. 512MB circa 17h.
1Go environ 35h. 1GB circa 35h.
2Go environ 70h. 2GB circa 70h.
[ Remarques ] [ Nof
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Le nombre de fichiers MP3 pouvant étre enregistrés est basé sur un échantillonnage
de 128 Kbps et une taille de 4 Mo.

La capacité peut varier en fonction de la taille des fichiers.

La carte mémoire doit étre formatée uniquement sur le caméscope Sport. ®page 100
Ne formatez pas la carte mémoire sur un ordinateur.

Si vous allumez la lumiére, le nombre de photos pouvant étre prises sera réduit
Les durées d’enregistrement et le nombre de fichiers sont des valeurs maximales
basées sur ['utilisation d’'une seule fonction.

Dans la réalité, I'utilisation de plusieurs fonctions réduit ces valeurs.

Au cours d'un enregistrement sur une carte mémoire, il se peut que I'opération soit
interrompue et que le message suivant s'affiche : <Low speed card. Please record
at lower quality.> (Carte vit. lente\nEnreg qualité inf.) car la vitesse d'écriture de la
carte mémoire est lente. Nous vous recommandons d'utiliser une carte mémoire d’
une capacité d'au moins 1,25 Mo/s.

te ]

Il numero di file MP3 che si possono salvare dipende dalla frequenza di
campionamento 128Kbps/dimensione 4MB.

La capacita puo variare a seconda delle dimensioni del file.

E necessario solo formattare la scheda di memoria sulla videocamera Sport.

= pagina 100

Non formattare la scheda di memoria sul PC.

Se si imposta il flash, si riduce il numero di foto che si possono scattare.

Il tempo di registrazione e il numero di file registrabili sono valori massimi basati
sulluso di una sola funzione.

Se si utilizzano piu funzioni, si avra una riduzione di questi valori.

< Durante il salvataggio su una scheda di memoria, potrebbe arrestarsi la
registrazione e comparire il messaggio <Low speed card. Please record at lower
quality.> (Scheda bassa vel. Registr a bassa qualita.) Questo perché la velocita di
scrittura della scheda di memoria & bassa. Si consiglia di utilizzare una scheda di
memoria da 1.25MB/sec o superiore.

P B



Premiers pas

Guida introduttiva

Utilisation d’une carte mémoire (SD/MMC) (non fournie)

L

L
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Samsung ne saurait étre tenu responsable en cas de perte de données due a

une utilisation non conforme.

Eteindre 'appareil ou éjecter la carte mémoire pendant des opérations

sollicitant la mémoire, (formatage, suppression, enregistrement et lecture) peut

endommager les données.

Vous pouvez modifier le nom d’'un fichier ou d’un dossier contenu dans la carte

mémoire a l'aide d’un ordinateur. En revanche, il se peut que le caméscope

Sport ne reconnaisse pas les fichiers modifiés.

Pour ne pas risquer de perdre des données, nous vous recommandons d’

éteindre I'appareil avant d'insérer ou de retirer la carte mémoire.

Il se peut que I'utilisation de cartes mémoire formatées sur d’autres appareils soit

ismpossible. Il est important de formater votre carte mémoire sur le caméscope
port.

Enregistrez vos fichiers importants sur d'autres supports (ex. : disquette, disque

dur ou CD).

Doivent étre formatées les cartes mémoires neuves, les cartes mémoires que

le caméscope Sport ne reconnait pas et les cartes contenant des données

enregistrées par d'autres appareils.

Toute carte mémoire dispose d’une durée de vie propre. Au bout d'un certain

temps d'utilisation, il se peut que vous ne puisssiez plus enregistrer de nouvelles

données. Dans ce cas, il convient d’acheter une nouvelle carte mémoire.

Ne pliez pas la carte mémoire, ne la jetez pas ou ne lui faites pas subir de choc

violent.

Ne l'utilisez pas et ne la rangez pas dans un environnement chaud, poussiéreux

ou humide.

Evitez que des corps étrangers ne se posent sur les broches de la carte

mémoire. Utilisez un chiffon doux et sec pour en nettoyer la surface.

Pour éviter tout risque de perte des données, rangez la carte mémoire dans un

boitier de protection, a I'abri des manipulations et de I'électricité statique.

Au bout d'un certain temps d'utilisation, la carte mémoire chauffe. Il ne s’agit pas d’

un dysfonctionnement.

Les données endommagées ne sont pas toujours récupérables et SAMSUNG

n’assume aucune responsabilité si une telle situation venait & se produire.

Veillez a sauvegarder les fichiers importants sur un autre support (ex. : sur votre

ordinateur).

Pour étre utilisées, les cartes de type Mini SD ou RS-MMC doivent étre insérées

dans un adaptateur de carte spécial.

Uso di una scheda di memoria (SD/MMC) (non fornita in dotazione)

L

<

oo

L)

Samsung non & responsabile per la perdita di dati causata da un utilizzo
improprio.

Se si spegne la videocamera/estrae la scheda di memoria durante
operazioni riguardanti la memoria come formattazione, eliminazione,
registrazione e riproduzione, i dati possono essere danneggiati.

E possibile modificare il nome di un file/di una cartella memorizzati sulla
scheda di memoria utilizzando un PC. La videocamera Sport potrebbe non
riconoscere i file modificati.

Si raccomanda di spegnere 'apparecchiatura prima di inserire o estrarre la
scheda di memoria per evitare la perdita di dati.

Non e garantita la possibilita di utilizzo di una scheda di memoria formattata
su altri dispositivi. Assicurarsi di formattare la scheda di memoria utilizzando
la videocamera Sport.

Salvare i file importanti separatamente su altri supporti, come dischetto,
disco rigido o CD.

E necessario formattare schede di memoria appena acquistate, schede

di memoria che la videocamera Sport non puo riconoscere o schede di
memoria su cui sono salvati dati di altri dispositivi.

Una scheda di memoria dura per un certo periodo. Se la si utilizza per molto
tempo, potrebbe risultare impossibile registrare nuovi dati. In questo caso,
acquistarne una nuova.

Non piegare, fare cadere o colpire la scheda di memoria.

Non utilizzare o riporre in ambienti caldi, polverosi o umidi.

Non permettere a sostanze estranee di entrare in contatto con i terminali
della scheda di memoria. Se necessario, utilizzare un panno pulito e asciutto
per pulire i terminali.

Conservare la scheda di memoria in una custodia per evitare che scariche
elettrostatiche causino la perdita di dati.

Se utilizzata per un certo periodo, la scheda di memoria potrebbe
surriscaldarsi. Questo & normale e non rappresenta un malfunzionamento.

| dati danneggiati non possono essere recuperati; SAMSUNG non &
responsabile per la perdita di dati. Assicurarsi di eseguire il backup dei file
importanti separatamente su un PC

Le schede MiniSD/RS-MMC devono essere inserite in uno speciale
adattatore per essere utilizzate.

Veillez a bien insérer les cartes de type Mini SD ou RS-MMC

WE i Terminal
dans I'adaptateur prévu a cet effet avant de les utiliser. erminais

‘E-‘jDDDDDDDD

%+ Assicurarsi di inserire le schede miniSD/RS-MMC nell’

a Adapt A apposito adattatore prima dell'uso. Se si inserisce una
Liinsertion d'une carte dans le caméscope Sport sans Protection ——— A scheda nella videocamera Sport senza 'adattatore, la
adaptateur risque d'endommager appareil ou la carte. Tab videocamera Sport o la scheda possono danneggiarsi.
g‘;gﬁerﬁé f;:s‘ig‘é%gt?gggstgiﬁ ‘égjﬁsdlg”falrﬁ écga(:rggzcope Label % Non inserire un adattatore vuoto nella videocamera
Sport lors de l'insertion ou du retrait des cartes de type Mini S%?l\rjl.l\}lrg?\?m:sgia?r?lj’g\égrt]ti‘t)olg Sn(g};d\?igg]ga/era
SD ou RS-MMC ; cela risquerait en effet de provoquer un <SD/MMC>

dysfonctionnement au niveau de I'appareil.

della videocamera Sport.

Sport. Questo potrebbe provocare un malfunzionamento @



Premiers pas Guida introduttiva

Insertion/Ejection de la carte mémoire (SD/MMC) (non fournie) | Inserimento/estrazione della scheda di memoria (SD/MMC) (non fornita in dotazione)
Insertion d’'une carte mémoire \
1. Ouvrez le cache avant.

x Inserimento della scheda di memoria
1. Aprire il coperchio anteriore.

2. Insérez la carte mémoire dans son Label .
. . . pasting portion
logement jusqu’a ce que vous entendiez un
léger déclic.

“| 2. Inserire la scheda di memoria nell’apposito
alloggiamento finché si avverte un clic.

3. Chiudere il coperchio anteriore.
3. Fermez le cache avant.

Attention : I'écran ci-contre s'affiche si vous insérez la
carte mémoire alors que I'appareil est sous
tension.
¢ Sivous sélectionnez <OK>, le type

de mémoire bascule vers ‘External
Externe) et si vous sélectionnez<Cancel>
Annul.), les fichiers sont stockés dans
a mémoire interne.

Attenzione: Questa schermata viene visualizzata se la
scheda di memoria viene inserita mentre la
videocamera & accesa.
¢ Selezionando <OK>, viene impostato

il tipo di memoria ‘External’ (Esterna).
Selezionando invece <Cancel> (Annul) i file
vengono memorizzati nella memoria interna.
¢ Sivous insérez une carte mémoire ¢ :ﬂserendo una scheda di memoria
NAn PieA T > occata, viene visualizzata l'icona [@]
verrouillée, l'icone [&] saffiche & o allindicatore del oo di !
coté du témoin du type de mémoire. accanto all'indicatore del tipo di memoria.

Ejection d’une carte mémoire Estrazione della scheda di memoria

1. Ouvrez le cache avant. 1. Aprire il coperchio anteriore.

2. Poussez légérement la carte mémoire
vers l'intérieur jusqu’a ce qu’elle s’éjecte
automatiquement.

2. Spingere delicatamente la scheda di
memoria in avanti per sbloccarla.

3. Retirez la carte mémoire de son logement

3. Estrarre la scheda di memoria e chiudere il
et refermez le cache avant. ’

coperchio anteriore.

SRS
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J Mode Movie (Vidéo)
‘A

Enregistrement s .36
Enregistrement ... .36
Zoom avant et arriere....... .37

Lecture.........c.coocvrvininnnns .38

Lecture de Fichiers vidéo sur 'écran LCD
Lecture de plusieurs fichiers vidéo .....

Réglage des options d’enregistrement
Réglage de la taille du fichier vidéo ....
Réglage de la qualité du fichier vidéo .
Réglage de la fonction White Balance (Bal. Blancs)..
Réglage de la fonction Program AE

(exposition automatique programmable(Prog. AE)) .......c.ccverreeenee 44
Réglage des effets SPECIAUX...........ueierrerreerereereireeisisiseieeeieenns 45
Réglage de la fonction EIS

(stabilisateur électronique d'iMage(SEl))..............wmmmmmmmeememeins 46

Réglage de la mise au point
Réglage de la fonction BLC (compensation de contre- -jour(CCJ)) ...
Réglage du zoom NUMENIQUE .........ccrvereererenns 49
Réglage du mode Record (Enreg.) .........
Réglage de I'entrée et de la sortie de ligne
Réglage des options d’affichage.......................

Suppression de fichiers vidéo
Réglage du mode Play (Lect.)
Verrouillage de fichiers vidéo e
Copie de fiChiers VIJEO ..o 55

€ Sauvegardez les données et enregistrements importants sur un autre
support afin d’éviter les pertes accidentelles provoquées par une
défaillance du systéme ou toute autre raison.

Comment régler le mode Movie (Vidéo)

w
v |Bouton
Power

MODE:

1. Appuyez sur le bouton [POWER] 2. L’écran lMovie Record
pour allumer le caméscope Sport. (Enreg. vidéo) apparait.

Modalita
J Movie (Video)
7

Registrazione
Registrazione...
Zoom Avanti e indietro..

Riproduzione....................
Riproduzione dei file Video sul display LCD .
Riproduzione di piu file video..........ccccvuuene. .39

Impostazione delle opzioni di registrazione.
Impostazione delle dimensioni video.....
Impostazione delle qualita video........
Impostazione del bilanciamento bianco
Impostazione dell’AE Programm
(Esposizione Automatica Programmata)...
Impostazione degli effetti ..
Impostazione dellEIS (Stabil. g .
Impostazione della messa a fuoco .........cccccvevrreeenee.
Impostazione della BLC (Compensazione controluce)............
Impostazione dello zoom digitale...................... .49
Impostazione della Modalita di registrazione
Impostazione di /O iN€a ..........cccovvvevrevririciennne
Impostazione delle opzioni di visualizzazione .
Eliminazione dei file Video.............ocvvvuvriennnne .52
Impostazione della modalita di riproduzione
Blocco dei file video ......

Copia dei file video...

4 Salvare datl/reglstrazmnl importanti separatamente su altrl
supporti, per evitare la perdita accidentale causata da guasti al
sistema o da altre ragioni.

Modalita Movie (Video)

(@)

e

Tasto di
accensione

MODE

1. Per attivare la videocamera Sport, 2. Viene visualizzata la schermata
premere il tasto di accensione.

di registrazione Movie (Video). ﬁ



Mode Movie (Vidéo) : Enregistrement

Modalita Movie (Video): Registrazione

Enregistrement

Vous pouvez enregistrer un film et le stocker dans la mémoire.
Reportez-vous a la page 119 pour effectuer un enregistrement vidéo & l'aide du
module caméra externe.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L’écran Movie Record (Enregistrement de film) apparait.
4 Vous pouvez sélectionner le mode Movie (Vidéo) ou b
Previous (Préc.) comme mode de démarrage dans System %
Settings (Réglage syst.). =page 109
2. Appuyez sur le bouton [Record/Stop] pour démarrer
I'enregistrement.
4 Le témoin [@] s'affiche sur 'écran LCD.
4 Le temps écoulé et le temps restant s'affichent et
I'enregistrement commence.
3. Appuyez de nouveau sur le bouton [Record/Stop] pour
arréter I'enregistrement.
4 L'enregistrement commence.
4. Apres I'enregistrement, appuyez sur le bouton [POWER]
pour éteindre le caméscope Sport et ne pas épuiser la
batterie inutilement.

Lecture du compteur

4 Lestampille temporelle est enregistrée en méme temps
que le film afin d’accélérer les opérations de recherche.

¢ Temps écoulé Temps restant
00:02:00)4 ‘03
[ Remarques ]

Si la fonction Auto Shut Off (Extinct. auto) est activée, le caméscope Sport se
met automatiquement hors tension au bout de 5 minutes.

Retirez la batterie a la fin de 'enregistrement afin d’éviter toute consommation
inutile dénergie.

dans le mode System Settings (Réglage syst.). =page 102

L

Si vous effectuez un enregistrement alors que I'écran LCD est rabattu vers

I'extérieur, le microphone est alors bloqué a I'intérieur, ce qui peut provoquer une

détérioration de la puissance du son et générer des bruits. Assurez-vous que le
microphone est ouvert vers I'extérieur avant d'effectuer un enregistrement.

Pour ajuster la luminosité de 'écran LCD, réglez <LCD Brightness> (Lumin. LCD)

La luminosité de I'écran LCD n’a aucune incidence sur celle de I'enregistrement.

Registrazione

E possibile registrare video e memorizzarli nella memoria.
Per la registrazione dei video con il modulo videocamera esterna vedere pagina 119.
= 1. Per attivare la videocamera Sport, premere il tasto di
[ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione
video.
4 E possibile selezionare la modalita Movie (Video) o
Previous (Precedente) come modalita di avviamento
in System Settings (Imp di sistema). =pagina 109
2. Per avviare la registrazione premere il tasto di
[registrazione/arresto].
4 Sul display LCD viene visualizzato l'indicatore [@]
4 Vengono visualizzati il tempo trascorso e il tempo
restante e viene avviata la registrazione.
3. Premere nuovamente il tasto di [registrazione/arresto]
per interrompere la registrazione.
4 La videocamera Sport arresta la registrazione.
i 4. Al termine della registrazione, premere il tasto di
accensione per spegnere la videocamera Sport e
ridurre il consumo della batteria.

Contatore

& Per consentire una ricerca piu rapida, insieme al video
viene registrato l'indicatore del tempo.

| ¢ Tempo trascorso Tempo restante

® 00y ;0@ 4@?613'_' '_1_[’11"!]’]‘]
- )| _’rw

[ Note ]

< Se la funzione Auto Shut Off (Spegn Autom) ¢ attiva, la videocamera Sport si
spegne automaticamente dopo 5 minuti.

< Al termine della registrazione, scollegare il gruppo batterie, per evitare che
si consumi inutiimente.

< Perregolare la luminosita del display LCD, impostare <LCD Brightness>
(Lumin. LCD) in modalita System Settings (Imp di sistema). wpagina 102

< La luminosita del display LCD non influenza la luminosita della registrazione.

< Se si sta eseguendo una registrazione con il pannello LCD chiuso verso
I'esterno, il microfono viene bloccato allinterno, provocandoun indebolimento
del suono e dei rumori. Durante la registrazione, assicurarsi quindi che il
microfono sia aperto verso l'esterno.



Mode Movie (Vidéo): Enregistrement

Modalita Movie (Video): Registrazione

Zoom avant et arriére

Le zoom vous permet de modifier la taille du sujet photographié.
Tirez profit de l'objectif de zoom optique x10 a déplacement électronique.
1. Appuyez sur le bouton [POWER] pour allumer le caméscope Sport.

@ L’écran Movie Record (Enregistrement de film) apparait.

4 Vous pouvez sélectionner le mode Movie (Film) ou Previous
(Préc.) comme mode de démarrage dans System Settings
(Réglage syst.). =wpage 109

2. Appuyez sur le bouton [Record/Stop] pour commencer I’
enregistrement.

Déplacez I'interrupteur [W/
T] vers le haut pour zoomer
vers larriére.

@ La taille du sujet photographié
est réduite et vous pouvez
enregistrer des films comme
si vous étiez éloigné du sujet.

® La fleche se déplace vers W sur lindicateur

du zoom affiché a 'écran.

® Le niveau de zoom le plus bas est le niveau

par défaut (résolution originale du sujet).

Déplacez I'interrupteur [W/
T] vers le bas pour zoomer
vers I'avant.

@ Le sujet est plus grand et vous
pouvez enregistrer des films
comme si vous en étiez proche.

o Lafleche se déplace vers T sur
lindicateur du zoom.

@ Le coefficient de zoom le plus élevé est 10x.

[ Remarques ]

« L'utilisation fréquente du zoom peut
accélérer 'épuisement de la batterie.

< Le zoom optique permet de préserver la
qualité de I'image.

% Reportez-vous a la page 49 pour plus d’informations sur le zoom
numérique.

Zoom Out

Zoom In

Zoom Avanti e indietro

Lo zoom permette di modificare le dimensioni del soggetto in una scena
consentendo di sfruttare i vantaggi offerti dallo zoom ottico motorizzato 10x.

1. Per attivare la videocamera Sport, premere il tasto di [ACCENSIONE].

¢ Viene visualizzata la schermata di registrazione video.
@ E possibile selezionare la modalita Movie (Video) o Previous
(Precedente) come modalita di avviamento in System Settings
(Imp di sistema). =pagina 109
2. Per avviare la registrazione premere il tasto di [registrazione/
arresto].
g e Far scorrere I'interruttore

[W/T] su per eseguire lo

Zoom indietro.

@ La dimensione del soggetto
ripreso viene ridotta ed e
possibile registrare video

come se si fosse distanti dal soggetto.

Nellindicazione dello zoom sullo schermo

LCD, la freccia si sposta su W.

La velocita piu bassa per lo Zoom avanti &

quella predefinita (risoluzione originale del

soggetto).
)
video come se si fosse
vicini al soggetto.
Nell'indicazione dello zoom, la freccia si
#  spostasuT.
“ ® |l rapporto massimo dello zoom ottico & di 10x.

Note ]

% L'uso frequente dello zoom riduce la durata
della batteria.

% Lo zoom ottico mantiene la qualita del'immagine.

% Per informazioni sullo zoom digitale vedere pagina 49.

Far scorrere l'interruttore

[WIT] giu per eseguire lo

Zoom avanti

o |l soggetto viene ingrandito
ed é possibile registrare

Ng

A



Mode Movie (Vidéo): Lecture

Modalita Movie (Video): Riproduzione

Lecture de Fichiers vidéo sur I’écran LCD

Vous pouvez lire vos fichiers vidéo sur I'écran LCD.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.

2. Appuyez sur le bouton [PLAY] ou sur
[Joystick(OK)].

Riproduzione dei file Video sul display LCD

E possibile visualizzare la riproduzione dei file video sul display LCD.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione
video.

2. Premere il tasto [PLAY] o [Joystick(OK)].
¢ Passa alla modalita di riproduzione Video.

4 Permet de basculer en mode Movie Play
(Lecture vidéo).

3. Déplacez le [Joystick] vers la gauche/droite
pour trouver le fichier vidéo que vous souhaitez
voir.

4 Chaque déplacement du [Joystick] permet d’
accéder au film précédent/suivant.

LPLAY] 3. Spostare il [Joystick] a sinistra / a destra
utton . o g . . -
per ricercare il file video che si desidera
visualizzare.
4 Ad ogni movimento del [Joystick] si passa al
video precedente/successivo.

4. Appuyez sur le bouton [PLAY] ou sur
[Joystick(OK)] pour lire le fichier vidéo de
votrechoix.

4 Chaque pression sur le bouton [PLAY] ou sur
le [Joystick(OK)] permet alternativement de lire
le fichier ou de passer en mode Pause.

[ Remarques ]

< Pour régler le volume, déplacez le [Joystick] vers
le haut/bas pendant la lecture.

% Si aucun fichier n'est enregistré, le message <No
Files...> (0 FCH) apparait.

A

il 4. Premere il tasto [PLAY] o [Joystick(OK)] per

A riprodurre il file video desiderato.

¢ Ogni volta che si preme il tasto [PLAY] o
[Joystick(OK)] si selezionano la riproduzione o
la pausa.

1 [ Note |



Mode Movie (Vidéo): Lecture

Modalita Movie (Video): Riproduzione

Lecture de plusieurs fichiers vidéo

Lorsque vous utilisez l'interrupteur [W/T] en mode Movie Play (Lecture
vidéo), vous pouvez afficher plusieurs images sur I'écran LCD.
Vous pouvez également sélectionner et lire le fichier
vidéo en affichage multiple.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L'écran Movie Record (Enregistrement de film)
apparait.

2. Appuyez sur le bouton [PLAY] ou sur
[Joystick(OK)] et déplacez I'interrupteur [W/T]
sur W (WIDE).

@ L’écran a affichage multiple apparait.

3. Déplacez le [Joystick] vers la gauche, la droite,
le haut ou le bas pour trouver le fichier vidéo
que vous souhaitez lire.

4. Appuyez sur le bouton [PLAY] ou sur
[Joystick(OK)] pour lire le fichier vidéo de
votre choix.

4 Chaque pression sur le bouton [PLAY] ou sur
[Joystick(OK)] permet alternativement de lire le
fichier ou de passer en mode Pause. Bviove

[ Remarques ]

« Si aucun fichier n’est enregistré, le message
<No Files...> (0 FCH) apparait.

< Lorsque les écouteurs, le cable audio/vidéo ou le
module caméra externe sont branchés sur le
caméscope Sport, le haut-parleur intégré est
automatiquement désactivé.
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Riproduzione di piu file video

Se si utilizza linterruttore [W/T] nella modalita di riproduzione video, &
possibile visualizzare pit immagini sul display LCD.

E anche possibile selezionare e riprodurre il file video
desiderato con la schermata di visualizzazione multipla.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione
video.

2. Premere il tasto [PLAY] o [Joystick(OK)] e
spostare l'interruttore [W/T] su W (LARGO).
@ Appare la schermata con visualizzazioni
multiple.

3. Spostare il [Joystick] a sinistra/destra/su/giu
per ricercare il file video da riprodurre.

4. Premere il tasto [PLAY] o [Joystick(OK)] per
riprodurre il file video desiderato.
¢ Ogni volta che si preme il tasto [PLAY] o
[Joystick(OK)] si selezionano la riproduzione o
la pausa.

I3 Play

[ Note ]

< Se non vi sono file memorizzati da visualizzare,
appare il messaggio <No Files...> (No file...).

Se alla videocamera Sport vengono collegate delle
cuffie, dei cavi audio/video modulo videocamera
esterna, l'altoparlante integrato si spegne
automaticamente.
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Mode Movie (Vidéo): Lecture

Modalita Movie (Video): Riproduzione

Boutons utilisés pour la lecture du fichier vidéo

Bouton [PLAY] ou [Joystick(OK)] : permet de lire ou de mettre en pause le
fichier vidéo.
Interrupteur [W] : I'écran a affichage multiple apparait.
[Joystick] (gauche) : En mode Movie Play (Lecture vidéo) : appuyez pour
aller au fichier précédent. Appuyez longuement pour

utiliser la fonction RPS (Recherche en lecture arriére).

(vitesses : 2x—4x—8x—16x—32x—64x—128x)

[Joystick] (droite) : En mode Movie Play (Lecture vidéo) : appuyez pour

aller au fichier suivant. Appuyez longuement pour

utiliser la fonction RPS (Recherche en lecture avant)

(vitesses : 2x—4x—+8x—16x—32x—64x—128x)

En mode Movie Play (Lecture vidéo) : appuyez

longuement pour lire a vitesse lente en mode Pause.

Appuyez pour aller a 'image suivante en mode Pause.

Réglage du volume sonore

1. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)]
pour lire le fichier vidéo en mode Movie play (Lecture
vidéo).

2. Déplacez le [Joystick] vers le haut pour augmenter le
volume.

4 Chaque fois que vous déplacez le [Joystick] vers le
haut, le volume augmente d’'un cran et le son devient
plus fort.

4 L'échelle du volume sonore disparait apres une a
deux secondes.

3. Déplacez le [Joystick] vers le bas pour réduire le
volume.

4 Chaque fois que vous déplacez le [Joystick] vers le bas,
le volume diminue d’un cran et le son devient moins fort.

4 L’échelle du volume sonore disparait apres une a deux
secondes.

[ Remarques ]

% Léchelle de réglage du volume sonore comporte 10 paliers.

< Vous pouvez également lire les fichiers vidéo sur un écran de

télévision en connectant le caméscope Sport a un téléviseur. wpage 127

< Un codec vidéo est nécessaire pour la lecture sur ordinateur des fichiers
vidéo enregistrés par le caméscope Sport.

L'installation du CODEC se fait automatiquement dans votre systéme

lorsque le logiciel est installé a I'aide du CD fourni. Si vous ne disposez

pas du CD, recherchez le nom de modéle de I'appareil dans le centre de
recherche de la page d’accueil Samsung Electronics

(www.samsung.com) pour obtenir le fichier d'installation du CODEC.

@ =page 124

Comandi per la riproduzione dei file video

Tasto [PLAY] o [Joystick(OK)] : Riprodurre o mettere in pausa il file video
Interruttore [W] : Si apre la schermata
Multiplay.

[Joystick] (a sinistra) : In modalita di riproduzione video : Premere il tasto
per passare al file precedente. Tenerlo premuto per
utilizzare la funzione RPS (Riproduzione a ritroso).
(Livello RPS : 2x—4x—8x—16x—32x—64x—128x)

[Joystick] (a destra) : In modalita di riproduzione video : Premere il tasto

per passare al file successivo. Tenerlo premuto per

utilizzare la funzione FPS (Riproduzione in avanti)

(Livello FPS : 2x—4x—8x—16x—32x—64x—128x)

In modalita di riproduzione video : Tenere premuto il

tasto per riprodurre il video al rallentatore quando

€ in pausa. Tenere premuto il tasto per passare al

fotogramma successivo, quando il video & in pausa.

Regolazione dell’audio

d 1. Premere il tasto [PLAY] o [Joystick(OK)] per
riprodurre il file video in modalita di riproduzione
video.

2. Spostare il [Joystick] su per alzare il volume.
¢ Ogni volta che si sposta il [Joystick] su, la barra del
volume si alza ed il livello del volume aumenta.
¢ La barra del volume scompare dopo 1~2 secondi.

| 3. Spostare il [Joystick] giu per abbassare il volume.

. ¢ Ogni volta che si sposta il [Joystick] giu, la barra del
volume si abbassa e il livello del volume diminuisce.

@ La barra del volume scompare dopo 1~2 secondi.

[ Note ]

< Esistono 10 livelli di regolazione del volume.

< E anche possibile riprodurre il file video sullo schermo
di un televisore collegando la videocamera Sport al

. televisore. wpagina 127

< E necessario un video codec per riprodurre su un computer i file video
registrati sulla videocamera Sport.
Installare il software fornito con il CD per avere il CODEC direttamente
installato nel sistema. Se non si possiede il CD, ricercare il nome del
modello del prodotto nel Download Centre del sito internet di Samsung
Electronics (www.samsung.com) per ottenere il file per linstallazione
del CODEC. =pagina 124



Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de la taille du fichier vidéo

Vous pouvez choisir la taille de vos fichiers vidéo. La capacité de
stockage de fichiers dépend de la capacité de la mémoire et de la
taille des fichiers vidéo.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)

apparait.

2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <Size> (Dim.).

3. Déplacez le [Joystick] vers le haut ou vers
le bas pour sélectionner une option, puis
appuyez sur [Joystick(OK)].
@ Les options suivantes sont disponibles :

21 .88 Movie

Impostazione delle dimensioni video

E possibile impostare la dimensione dei file video. La capacita di
memorizzazione dei file dipende dalla capacita della memoria e dalla

. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

¢ Viene visualizzata la schermata di registrazione
video.

2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Size> (Dim).

. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
@ Le opzioni disponibili sono: <720x576> /<352X288>

<720x576> / <352X288>
4. Pour quitter le menu, appuyez sur le bouton 350x288 . Premere il tasto [MENU] per uscire dal menu.
[MENU]. ¢ Viene visualizzata l'icona della funzione
4 L'icone de la fonction sélectionnée s'affiche. selezionata.
= Move [Select [EM Exit
[ Remarques ] [ Note ]

3 &8 Viovie
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% Si <TV> est sélectionné en <Record Mode>
(Mode Enreg.), la taille est réglée sur 720i
uniquement. Si <PC> est sélectionné en <Record
Mode> (Mode Enreg.), la taille est réglée sur 720p
ou 352p.

< Pour des informations détaillées sur la capacité en
image. =page 31.

< Une plus haute résolution nécessite plus d’espace
mémoire, ce qui réduit la durée d’enregistrement
maximale.

% Lorsque la taille de I'écran est réglée sur 352
(352X288), la taille de lecture sur ordinateur est
inférieure a 720 (720X576).

< Lorsque I'écran de menu s’affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

720x576

=S Move

352x288 352

[ISelect

e IR & Selezionando <TV> in <Record Mode> (Mod
registraz), la dimensione & impostata solo su 720i.
Selezionando <PC> in <Record Mode> (Mod
registraz), la dimensione & impostata su 720p o
352p.

« Per informazioni dettagliate sulle capacita di
memorizzazione delle immagini =pagina 31.

< Una risoluzione piu alta richiede piu spazio in
memoria, riducendo il tempo di registrazione massimo.
< Quando il formato dello schermo & impostato su
352 (352X288), la riproduzione sul PC avviene in
una dimensione inferiore a 720 (720X576).

i< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.

(= Exit
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Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de la qualité du fichier vidéo

Vous pouvez choisir la qualité de vos fichiers vidéo. La capacité de
stockage de fichiers dépend de la capacité de la mémoire et de la
qualité des fichiers vidéo.

Impostazione delle qualita video

E possibile impostare la qualita dei file video. La capacita di
memorizzazione dei file dipende dalla capacita della memoria e dalla
qualita dei file video.

1| PSR FSENE000:00/00840
1. Appuyez sur le bouton [POWER] pour allumer 1. Per attivare la videocamera Sport, premere il
le caméscope Sport. = C«ib tasto di [ACCENSIONE].
@ L’écran Movie Record (Enregistrement de film) s S ¢ Viene visualizzata la schermata di registrazione
apparait. “5 video.

2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <Quality> (Qualité).

3. Déplacez le [Joystick] vers le haut ou vers le
bas pour sélectionner une option, puis appuyez
sur [Joystick(OK)].
@ Les options suivantes sont disponibles : <Super

Fine> (Super Fin) / <Fine> (Fin) / <Normal>

Normal

= ove

4. Pour quitter le menu, appuyez sur le bouton
[MENU].

4 L'icone de la fonction sélectionnée s'affiche.

K} a8 [Movie

[ Remarques ]

< Pour des informations détaillées sur la capacité en
image =page 31.

< Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

Fine
Normal

Super Fine B
Fine 2%

] <Fine> / <Normal> (Normale)

EI3Select

[I3Select

2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Quality> (Qualita).

3. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
@ Le opzioni disponibili sono : <Super Fine> /

= R - @D Y
Quality:
Super Fine RS

SE
..]

LewI=0B 4. Premere il tasto [MENU] per uscire dal menu.
4 Viene visualizzata I'icona della funzione
W selezionata.
[ Note ]
o % Per informazioni dettagliate sulle capacita di

memorizzazione delle immagini =pagina 31.

< Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/arresto
si passa alla modalita di registrazione video.

(MENU =T



Mode Movie (Vidéo):

Modalita Movie (Video):

Réglage des options d’enregistrement | Impostazione delle opzioni di registrazione

Réglage de la fonction White Balance (Bal. Blancs) | Impostazione del bilanciamento bianco

La balance des blancs se regle en fonction des conditions d
éclairage. La balance des blancs est utilisée pour préserver
les couleurs naturelles sous différents éclairages.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.

4 L'écran Movie Record (Enregistrement de film) apparait.

2. Appuyez sur le bouton [MENU].

Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <White Balance> (Bal. Blancs).

3. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)].

4 Pour régler la fonction Custom (Person.), orientez I
objectif du caméscope Sport vers une zone blanche
(un mur, par exemple), de facon a ce que I'écran
LCD soit blanc. Appuyez sur [Joystick(OK)] pour
sélectionner les options.Le réglage s’applique aux
films enregistrés apres le réglage de la fonction
Custom (Person.).

Le réglage se fait automatiquement en fonction

Auto des conditions d’enregistrement.
Daylight [La couleur est réglée en fonction de la lumiere du
(Jour) jour, a l'intérieur ou a I'extérieur.
Cette option convient parfaitement lorsque la

Fluorescent lumiére est fluorescente.
Tungsten | Cette option convient parfaitement lorsque la
(Tungst.) [lumiére estincandescente.

Vous pouvez régler la balance des blancs comme
il vous convient en fonction des conditions d’
enregistrement.

Custom
(Person.)

4. Pour quitter le menu, appuyez sur le bouton [MENU].
4 L'icone de la fonction sélectionnée s’affiche.
4 Aucune icone ne s'affiche lorsque le mode <Auto>
est sélectionné.
[ Remarques ]
L3

Lorsque vous effectuez des enregistrements en extérieur,

I'option <Auto> permet d'obtenir de meilleurs résultats.

< Comme les conditions d’éclairage changent, réglez la
balance des blancs convenablement avant d’effectuer un
enregistrement.

Le sujet utilisé avec la fonction <Custom> (Person.) doit étre blanc. Si tel n’est

pas le cas, la balance des couleurs ne sera pas naturelle.

Lorsque I'écran de menu s’affiche, le fait d’appuyer sur le bouton [Record /
Stop] permet d’accéder au mode Movie Record (Enregistrement de film).

Il bilanciamento del bianco pud variare a seconda delle
W\ ondizioni di illuminazione. Il bilanciamento del bianco &
utilizzato per conservare i colori naturali a diverse condizioni di
illuminazione.

| 1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione video.
2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <White Balance> (Bilan. Bianco).
3. Spostare il [Joystick] su / giu per selezionare un’
opzione, quindi premere [Joystick(OK)].
4 Per impostare Custom (Personalizzato), inquadrare
con la videocamera Sport un’area bianca (come
una parete), riempiendo il display LCD con il colore
bianco. Premere [Joystick(OK)] per confermare I’
Daylight impostazione.| video registrati con limpostazione
Fluoresce Custom(Personalizzato) attiva vengono influenzati da
v questa impostazione.
(B Vove [Select [EM Exit

Imposta automaticamente a seconda dell
ambiente di registrazione .

Daylight |Regolail colore in base alla luce diurna, a quella
(Luce diurna)|interna e a quella esterna.

Fluorescent E adatto ad un ambiente in cui & presente un’
(A fluorescenza) | illuminazione fluorescente.

Davlight Tungsten |E adatto ad un ambiente in cui & presente un’
V9 as (Tungsteno) |illuminazione incandescente.

Fluorescent &=

A4

Auto

E possibile regolare il bilanciamento del bianco
a proprio piacimento a seconda dell’ambiente di
registrazione.

Custom
D Move [lSelect [EM Exit (Personalizzatp)

4. Premere il tasto [MENU] per uscire dal menu.
¢ Viene visualizzata l'cona della funzione selezionata.
4 Selezionando <Auto>, non viene visualizzata nessuna icona.

[ Note ]

« Registrando all'aperto, l'impostazione <Auto> consente di
ottenere i risultati migliori.

< Se variano le condizioni d'illuminazione, prima di registrare
impostare il corretto bilanciamento dei bianchi.

< Il soggetto per cui viene utilizzato <Custom> (Personalizzatp)
deve essere bianco. In caso contrario i colori non sono
naturali.

< Quando viene visualizzata la schermata del menu, premendo il tasto di
registrazione/arresto si passa alla modalita di registrazione video.

A



Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de la fonction Program AE (exposition automatique programmable (Prog. AE))

Les modes Program AE (Prog. AE) sont des modes
d’exposition automatique basés sur un programme
informatique interne. Cette fonction vous permet d’
adapter I'ouverture aux conditions de la prise de photo.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L'écran Movie Record (Enregistrement de film) apparait.
2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <Program AE> (Prog. AE).
3. Déplacez le [Joystick] vers le haut ou vers le
bas pour sélectionner une option, puis appuyez
sur [Joystick(OK)]

2| &8 Viovie

1| PR EEEN00%00:00/006 05 ]

R I R
Program AE
o

Impostazione dell’AE Programm (Esposizione Automatica Programmata)

Le modalita del Programma AE permettono di

) b reimpostare delle modalita di esposizione automatica
sulla base di un programma interno.

E possibile regolare I'apertura dell'obbiettivo in base
alle condizioni di ripresa.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
# Viene visualizzata la schermata di registrazione
video.
2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Program AE> (Ae Program).

4. Pour quitter le menu, appuyez sur le bouton [MENU].
4 L'icone de la fonction sélectionnée s’affiche.
4 Aucune icdne ne s'affiche lorsque le mode

<Auto> est sélectionné.
[ Remarque ]
L3 Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au mode Mowe

Record (Enregistrement de film).

Aut &5 u A PRy .
La balance se fait automatiquement entre SNS 3. Spostare il [Joystick] su / giu per selezionare
A le SHJ'et et l’aﬁri‘erel_-plan Pourdpalrv?)nir au S:Jollight a un’opzione, quindi premere [Joystick(OK)].
uto meilleur résultat. La vitesse de 'obturateur =
varie automatiquement de 1/50 & 1/250 par A4 : Auto _biIgn_cimento tra il soggetto e lo sfondo. La
seconde en fonction de la scéne. E3Move [WSelect  OEM Exil Auto velocnda di otturan&enéo I\llama tra 1/50 e 1/250 per
Permet d’enregistrer des personnes ou Secondo, 8 _secon a e_ a scer?a.
des objets se déplag ant rapidement. Cette o [ovie Sports  |Per oggem/persong in movimento. Ideale per
Sports  |fonction convient particuliérement aux Ow N (Sport) |sport e ripresa dall'automobile.
ggﬁgggtgggniss SI’Fi)r?tger:Sret;’Srl:: sgiﬁ?éstrements Progam AE Spotlight Compelnsa la Iuc?ddi llm soggetto che appare
- r troppo luminoso. Ideale per concerti e
Permet de compenser une trop forte Auto (Riflettore) pel?fgrmance al chiuso. P
. luminosité due a une exposition directe a Sand/Snow |Usare quando la luce ' molto forte, come al
Spotlight |une puissante source d'éclairage (projecteur, Spotlight @ (Sabbia/Neve) |mare o sulla neve.
(Spot)  [par exemple). Cette fonction convient A 4
particuliérement aux concerts et aux [T oI =258 4. Premere il tasto [MENU] per uscire dal menu.
représentations scolaires. # Viene visualizzata licona della funzione
Sand/Snow | Utile lorsque la lumiére est crue, comme sur sele2|_onata. ] ] i
(Sab./neig) |une plage ou dans un paysage enneige. ¢ Selezionando <Auto>, non viene visualizzata

? nessuna icona.
[ Nota ]
< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.



Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video)
Impostazione delle opzioni di registrazione

Réglage des effets spéciaux

Vous pouvez appliquer différents effets numériques a vos enregistrements.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)

apparait.

2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <Effect> (Effet).

3. Déplacez le [Joystick] vers le haut ou vers le
bas pour sélectionner une option, puis appuyez
sur [Joystick(OK)].

2| & lovie

Impostazione degli effetti
E possibile applicare alla registrazione diversi effetti digitali.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
# Viene visualizzata la schermata di registrazione
1 video.
2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Effect> (Effetto).

3. Spostare il [Joystick] su / giu per selezionare

4. Pour quitter le menu, appuyez sur le bouton

B R Y- s . . i
Off |Permet d'annuler Teffet appliqué. un’opzione, quindi premere [Joystick(OK)].
At |Permet d'appliquer des effets artistiques & Off  |Annulla gli effetti.
votre fichier vidéo. Art Art  |Aggiunge effetti artistici al file video.
.. |Permet I r une tram Mosai . o
Mosaic ssmb%b(t guuﬂiﬁggaﬁui éavo?re fichier S Mosaic |Sul file video appare una struttura a
(Mosaiq) vidéo. & Move [hSelect  [EM Exit (Mosaico) | mosaico.
Sepia [Permet de donner & 'image une teinte Sepia |L'immagine appare con un colore seppia
(Sépia) |sépia rappelant les photos anciennes. 3 &8 Movie (Seppia) |simile alle vecchie fotografie.
Negative |Permet d'inverser les couleurs afin de = PR V- Negative |Inverte i colori, creando cosi un'immagine
(Négatif) |donner Paspect d'un négatif. — (Negativo) |al negativo.
Mirror |Ce mode scinde limage en deux par un Negriive Mirror | Taglia limmagine a meta con un effetto a
(Miroir) |effet miroir. (Specchio) | specchio.
B&W
(I'B‘liVBV) Permet d'afficher 'image en noir et blanc. Biove  [Select B&W (B/N)|Converte le immagini in bianco e nero.

. Premere il tasto [MENU] per uscire dal menu.

[MENU].
@ L'effet sélectionné et licone correspondante s'affichent.
4 Aucune icone ne s'affiche lorsque <Off> est
sélectionné.

[ Remarque ]

% Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

¢ Vengono visualizzati I'effetto e I'icona selezionati.
# Selezionando <Off>, non viene visualizzata
nessuna icona.

[ Nota]
< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.

a
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Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de Ia fonction EIS (stabilisateur électronique d’image (SEI))

Le stabilisateur électronique d'image permet de compenser le
tremblement des mains, ou tout autre mouvement, en cours
d’enregistrement. La fonction EIS (SEI) permet d’obtenir une image
plus stable dans les situations suivantes :

4 enregistrement avec zoom ;

¢ enregistrement de petits objets ;

@ enregistrement en marchant ou en bougeant ;

@ enregistrement par la fenétre d’'un véhicule.

. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.
. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <EIS> (SEI).

Déplacez le [Joystick] vers le haut ou vers le

bas pour sélectionner une option, puis appuyez

sur [Joystick(OK)].

4 <On> : permet d’activer la fonction EIS (SEI).

& <Off> : permet de désactiver la fonction EIS
(SEI).

Pour quitter le menu, appuyez sur le bouton

[MENU].

¢ Licone EIS (SEI) ( 4mp ) s'affiche lorsque <On>
est sélectionné.

@ Aucune icone ne s'affiche lorsque <Off> est
sélectionné.

[ Remarque ]

% Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

EDMave

EDMove

3 sty oo p-hoR R i
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Impostazione dell’EIS (Stabil. immagine elettronico)

Lo stabilizzatore digitale delle immagini consente di compensare i
tremolii e i movimenti involontari della mano durante le riprese.
EIS conferisoe alle immagini una maggiore stabilita quando:

1 ;{fj STBY 00008 0010(9 4@

Si registra con lo zoom

Si riprendono oggetti di piccole dimensioni

Si effettua la ripresa camminando o mentre si
€ in movimento

Si effettua la ripresa dal finestrino di un veicolo

. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
# Viene visualizzata la schermata di registrazione
video.

. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <EIS>.

(@ Select

. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
4 <On>: Attiva la funzione EIS.
4 <Off> : Disattiva la funzione EIS.

. Premere il tasto [MENU] per uscire dal menu.
4 Selezionando <On>, viene visualizzata I'icona
EIS (7).
& Selezionando <Off>, non viene visualizzata
nessuna icona.
[ Nota ]
< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.

(I3 Select



Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de la mise au point

Vous pouvez régler la mise au point sur le sujet ou sur l'arriere-plan.

Dans la plupart des cas, il est conseillé d'utiliser la fonction AF (mise

au point automatique).

1. Appuyez sur le bouton [POWER] pour allumer

le caméscope Sport.

@ L’écran Movie Record (Enregistrement de film)
apparait.

Appuyez sur le bouton [MENU].

Déplacez le [Joystick] vers la gauche ou la

droite pour sélectionner <Focus> (Régl.).

Déplacez le [Joystick] vers le haut ou vers

le bas pour sélectionner une option, puis

appuyez sur [Joystick(OK)].

@ <AF> : la mise au point se fait automatiquement.

& <MF> (FM) : la mise au point se fait
manuellement.

Pour quitter le menu, appuyez sur le bouton [MENU].

@ L'icone de la fonction sélectionnée s’affiche.

@ Sivous sélectionnez <AF>, aucune icéne ne
s'affiche.

4.

ED\ove

Mise au point manuelle <MF> (FM)

Réglez la mise au point en déplacant le [Joystick]
vers le haut ou vers le bas pour zoomer
manuellement vers I'avant ou vers I'arriére.
4 Cas ou la scéne comporte des éléments a la
fois proches et éloignés du caméscope Sport.
4 Cas d'un sujet dans la brume ou sur fond
enneige.

[ Remarques ]

La mise au point se regle automathuement sur
<AF> lorsque le caméscope Sport est mis hors
tension.

Lorsque I'écran de menu s'affiche, le fait d'appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

Impostazione della messa a fuoco

E possibile impostare la messa a fuoco a seconda del soggetto o
del’ambiente. Nella maggior parte dei casié meglio utilizzare la messa
a fuoco automatica.

. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

¢ Viene visualizzata la schermata di registrazione
video.

Premere il tasto [MENU].

Spostare il [Joystick] a sinistra / a destra per

selezionare <Focus> (Fuoco).

Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK)].

@ <AF> : Imposta la messa a fuoco automatica.

& <MF> (KF) : Imposta la messa a fuoco manuale.

Premere il tasto [MENU] per uscire dal menu.

¢ Viene visualizzata l'icona della funzione
selezionata.

¢ Selezionando <AF>, non viene visualizzata
nessuna icona.

Messa a fuoco manuale <MF> (KF)

Regolare la messa a fuoco spostando il [Joystick]
su / giu per effettuare manualmente lo zoom in
avanti o indietro.
¢ Quando un’immagine contiene oggetti vicini e
lontani dalla videocamera Sport.
4 Quando una persona ¢ avvolta dalla nebbia o
da una coltre di neve.

[(3Select [EMY Exit

[E3Select [EM Exit

[ Note ]

La messa a fuoco € impostata automaticamente
su <AF> se la videocamera Sport & spenta.
Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.

L3
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Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de la fonction BLC (compensation de contre-jour (CCJ))

La fonction de compensation du contre-jour permet de rendre le sujet
plus clair lorsqu’il se trouve devant une fenétre ou lorsqu'il est trop
sombre pour le distinguer. Vous pouvez utiliser cette
fonction lorsque vous utilisez le caméscope Sport
pour filmer une scéne dont l'arriere-plan est lumineux
ou enneigeé.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enregistrement de
film) apparait.

2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <BLC> (CCJ).

3. Déplacez le [Joystick] vers le haut ou vers
le bas pour sélectionner une option, puis

e sTeY @0:00/0@ o5 i
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Impostazione della BLC (Compensazione controluce)

La funzione di compensazione del controluce aiuta a rendere piu
luminoso il soggetto quando questo si trova davanti ad una finestra o
quando é troppo scuro per distinguerlo. E possibile
utilizzare questa funzione quando si utilizza la

+ videocamera Sport in ambienti luminosi o innevati.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione
video.

. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <BLC>.

. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].

appuyez sur [Joystick(OK)]. EMove  [@Select [EExit 4 <On> : Attiva la funzione di compensazione

4 <On> : permet d'activer la fonction BLC <CCJ>. del controluce.

¢ <Off> : permet de désactiver la fonction BLC +&8 Movie E N 4 <Off> : Annulla la funzione di compensazione
<CCJ>. > G- P - ) - del controluce.

4. Pour quitter le menu, appuyez sur le bouton 4. Premere il tasto [MENU] per uscire dal menu.

[MENU]. o , G @ Viene visualizzata I'icona della funzione

¢ L'icone de la fonction sélectionnée ( & ) s selezionata ()
affiche. ) : . —

& Aucune icone ne s'affiche lorsque <Offs est EMove  [Select [EW Exit L 4 Selezwna}ndo <Off>, non viene visualizzata
sélectionné. nessuna icona.

[ Remarques ]

% La fonction BLC (CCJ) est automatiquement
désactivée lorsque le caméscope Sport est mis
hors tension.

% Lorsque I'écran de menu s'affiche, le fait d’
appuyer sur le bouton [Record / Stop] permet o’
accéder au mode Movie Record (Enregistrement

A ceiim).

M [ Note ]

i <+ La funzione BLC e impostata su <Off> se la

,. videocamera Sport € spenta.

# < Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.



Mode Movie (Vidéo): Modalita Movie (Video):
Réglage des options d’enregistrement | Impostazione delle opzioni di registrazione

Réglage du zoom numérique Impostazione dello zoom digitale

Le zoom numérique permet de grossir plus de 10 fois, et jusqua 100 | Le zoomate superiori a 10x sono effettuate digitalmente e possono
fois lorsqu'il est associé au zoom optique. arrivare fino a 100x in combinazione con uno zoom ottico.

Le zoom numérique traite les données pour agrandir [ Y STEY Q00 R O Lo zoom digitale elabora i dati per ingrandire la

la partie centrale de image de maniéere a remplir le
cadre. Il peut produire une image moins détaillée et
présentant un léger grain.

ani| parte centrale dellimmagine in modo da riempire I
=] inquadratura. Pud produrre un’immagine meno
{ dettagliata e leggermente sgranata.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione
video.

2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Digital Zoom> (Zoom num.).

2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Digital Zoom> (Zoom Digitale).

3. Déplacez le [Joystick] vers le haut ou vers 3. s p : s :
A : - v - . Spostare il [Joystick] su / giu per selezionare
s B e e OPtion, puis TSt urvopzione, quind premere [Joystick(OK)L
ppug Zsu !t,dl t( )I ¢ <On> : Attiva lo zoom digitale. Se si tenta di
<On> : permet d'activer le zoom numérique. utilizzare lo zoom a piu di 10x, viene

Lorsque vous essayez deffectuer un zoom automaticamente applicato lo zoom digitale.
10x, le zoom numérique est automatiquement (fino a 100x)

appl|que (jusqua 1QOX)'. . ¢ <Off> : Disattiva lo zoom digitale. Per lo zoom
& <Off> : permet de désactiver le zoom numérique. ) )
viene supportato solo lo zoom ottico 10x

Seul le zoom optique 10x est pris en charge.

[WSelect [EWU Exit

4. Premere il tasto [MENU] per uscire dal menu.
i ¢ Se si utilizza linterruttore di zoom digitale, sulla
schermata viene visualizzato un indicatore di
zoom digitale.

4. Pour quitter le menu, appuyez sur le bouton
[MENU].

4 Lorsque vous utilisez l'interrupteur du zoom

numérique, un indicateur s’affiche a I'écran.

[ Nota ]

% Lorsque lécran de menu saffiche, le fait d’appuyer ¢ Quando vigne visuglizzgta Ia.schermata dql menu,
premendo il tasto di registrazione/arresto si passa

sur le bouton [Record / Stop] permet d’accéder au " e - :
mode Movie Record (Enregistrement de film). ' ' alla modalita di registrazione video. z

[ Remarque ]



Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage du mode Record (Enreg.)

Vous pouvez régler le mode d’enregistrement adéquat
avant de démarrer 'enregistrement des fichiers vidéo.

1. Appuyez sur le bouton [POWER] pour allumer le
cameéscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.

2. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Record Mode> (Mode Enreg.).

3. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)]. PC.
& <TV>: Le systéme génére des images claires lors
de la lecture sur le téléviseur.

@ <PC>: Le systéme génére des images claires lors
de la lecture sur l'ordinateur.

4 Nous vous recommandons de copier le fichier
sur l'ordinateur ou de brancher le caméscope
Sport sur le téléviseur pour obtenir une meilleure
qualité d'image.

EMove

v
4. Pour quitter le menu, appuyez sur le bouton [MENU].
4 Sivous sélectionnez <TV>, <i> s'affiche avec
l'icone des dimensions.
4 Sivous sélectionnez <PC>, <i> s’affiche avec
l'icone des dimensions.

ESMove

—

Remarques ]

Si <TV> est sélectionné comme mode d’enregistrement,
la taille se régle sur 720i uniquement.

Si <PC> est sélectionné comme mode d’enregistrement,
la taille se régle sur 720p ou 352p.

Lorsque la taille est réglée sur 352(352X288), <PC>
est automatiquement sélectionné pour 'enregistrement
des fichiers vidéo.

LIS 3

% Lorsque I'écran de menu s'affiche, le fait d'appuyer sur le bouton [Record

/ Stop] permet d'accéder au mode Movie Record (Enregistrement de film).

QAN =) &= - Rl - 3.
Record Mode

[¥Select [EM Exit *

@ AN =) @ - s
Record Mode

[D3Select

Impostazione della Modalita di registrazione

1 BB ool Prima di iniziare a registrare file video, & possibile

impostare la modalita di registrazione opportuna.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazionevideo.

2. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Record Mode> (Mod registraz).

Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK)].

@ <TV>: |l sistema genera immagini nitide
riprodotte su un televisore.

4 <PC> : Il sistema genera immagini nitide riprodotte

su un PC.

Per una migliore riproduzione dellimmagine si

consiglia di copiare il file su un PC o di connettere

£ INfami] la videocamera Sport ad un televisore.

4. Premere il tasto [MENU] per uscire dal menu.

4 Selezionando <TV>, accanto all'icona relativa
alle dimensioni viene visualizzato <i>.

@ Selezionando <PC>, accanto all'icona relativa

= E xit alle dimensioni viene visualizzato <p>.

[ Note ]

< Se come modalita di registrazione si seleziona <TV>,
la dimensione & impostata solo su 720i.

< Se come modalita di registrazione si seleziona <PC>,
la dimensione & impostata su 720p o 352p.

< Quando la dimensione & impostata su 352(352X288),
per la registrazione di file video viene selezionato
automaticamente <PC>.

< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.



Mode Movie (Vidéo):
Réglage des options d’enregistrement

Modalita Movie (Video):
Impostazione delle opzioni di registrazione

Réglage de I'entrée et de la sortie de ligne

Vous pouvez enregistrer ou lire le contenu du caméscope Sport sur un

appareil externe et vice-versa. =page 127 & 129

1. Appuyez sur le bouton [POWER] pour allumer

le caméscope Sport.

4 L’écran Movie Record (Enregistrement de film)
apparait.

Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <Line In/Out> (En/Srt).

Déplacez le [Joystick] vers le haut ou vers

le bas pour sélectionner une option, puis
appuyez sur [Joystick(OK)].

<In> (En) : sélectionnez cette option

lorsque vous enregistrez le contenu d’'un
appareil externe sur le caméscope Sport.
<Out> (Srt) : sélectionnez cette option lorsque
vous enregistrez ou lisez le contenu du
caméscope Sport sur un appareil externe.

&S Move

3| &8 Movie

Pour quitter le menu, appuyez sur le bouton
[MENU].
@ Le caméscope Sport bascule sur le réglage

sélectionné.
S Move

[ Remarque ]

% Lorsque I'écran de menu s'affiche, le fait d’appuyer sur le bouton
[Record / Stop] permet d’accéder au mode Movie Record
(Enregistrement de film).

) STBY 00:0aHu:

EI3Select

Impostazione di I/O linea

E possibile registrare o riprodurre i contenuti della videocamera Sport
su un dispositivo esterno e viceversa. =pagina 127~129

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione
video.

. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Line In/Out> (/O linea).

. Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK)].

¢ <In>: Selezionarlo durante la registrazione dei
contenuti di un dispositivo esterno sulla
videocamera Sport.

¢ <Out>: Selezionarlo durante la registrazione
o riproduzione dei contenuti della videocamera
Sport su un dispositivo esterno.

[E0 Exit

. Premere il tasto [MENU] per uscire dal menu.
¢ La videocamera Sport & impostata sull’
impostazione selezionata.

[I3Select  [EY Exit

[ Nota ]
% Quando viene visualizzata la schermata del menu, premendo il tasto di
registrazione/arresto si passa alla modalita di registrazione video.

A



Mode Movie (Vidéo):
Réglage des options d’affichage

Modalita Movie (Video):
Impostazione delle opzioni di visualizzazione

Suppression de fichiers vidéo

Eliminazione dei file video

Vous pouvez supprimer des fichiers vidéo enregistrés.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.

E possibile eliminare i file video salvati.
1. Per attivare la videocamera Sport, premere il

4 L’écran Movie Record (Enregistrement de film)
apparait.

Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].

4 Permet de basculer en mode Movie Play (Lecture vidéo).

@ Sélectionnez le fichier vidéo de votre choix a l'aide

PLAY
g@\ . Lunon] tasto di [ACCENSIONE].
’2\@// N @ Viene visuali3 la schermata di registrazionevideo.
2. Premere il tasto [PLAY] o [J oystick(OK)].
4 Passa alla modalita di riproduzione Video.
[oystick(OK)| @ Utilizzando il [Joystick], spostarsi sul file video
[ desiderato.

du [Joystick].
Suppression de fichiers vidéo en affichage plein écran

3. Appuyez sur le bouton [DELETE] de I'écran LCD.
4. Sélectionnez une option en déplacant le [Joystick]
vers le haut ou vers le bas puis appuyez sur
[Joystick(OK)].
4 <OK>: permet de supprimer le fichier vidéo
sélectionné.
4 <Cancel> (Annul.) : permet d'annuler la suppression.

Suppression de fichiers vidéo en affichage multiple

3. Déplacez l'interrupteur [W/T] sur W (WIDE).

4 L'écran a affichage multiple apparait.

Appuyez sur le bouton [DELETE] de I’écran LCD.

Sélectionnez une option en déplacant le [Joystick]

vers le haut ou vers le bas puis appuyez sur

[Joystick(OK)].

4 <OK> : permet de supprimer le fichier vidéo

sélectionné a l'aide du [Joystick(OK)].

<Multi Select> (Sélect multi) : plusieurs fichiers

vidéo peuvent étre sélectionnés en méme temps

a l'aide du [Joystick(OK)]. Le témoin < ¢/ >

apparait sur les fichiers sélectionnés. Appuyez

sur le bouton [PLAY] pour supprimer les fichiers.
4 <All> (Tt) : tous les fichiers vidéo sont supprimés.
4 <Cancel> (Annul.) : permet d’annuler la suppression.

[ Remarques ]

< Les fichiers verrouillés ne seront pas supprimés.

% Lorsque I'écran de menu s’affiche, le fait d'appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

4.
5.

(= Vove K]

*
()

(01,4
Multi Select
All

B [ove K|

Eliminazione dei file video a schermo intero

. Premere il tasto [DELETE] sul display LCD.
§4. Selezionare un’opzione spostando il [Joystick]
su / giu, quindi premere [Joystick(OK)].

¢ <OK> : Elimina il file video selezionato.

¢ <Cancel> (Annul) : Annulla I'eliminazione.

Eliminazione dei file video in visualizzazione multipla

Spostare l'interruttore [W/T] su W (LARGO).
¢ La schermata passa alla visualizzazione multipla.
. Premere il tasto [DELETE] sul display LCD.
. Selezionare un’opzione spostando il [Joystick]
su / giu, quindi premere [Joystick(OK)].
¢ <OK> : Elimina il file video selezionato
utilizzando [Joystick(OK)].
<Multi Select> (Multi selez.) : Utilizzando
[Joystick(OK)] si possono selezionare piu file
video. Sui file selezionati viene visualizzato
lindicatore < v >. Per eseguire 'eliminazione,
premere il tasto [PLAY] .

Play ¢

100-0003  WN:I[1]

I ¢ <All> (Tutti) : Tutti i file video vengono eliminati.
¢ <Cancel> (Annul) : Annulla I'eliminazione.
[ Note ]

« | file bloccati non vengono eliminati.

< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa
alla modalita di registrazione video.

Select



Mode Movie (Vidéo):
Réglage des options d’affichage

Modalita Movie (Video):
Impostazione delle opzioni di visualizzazione

Réglage du mode Play (Lect.)

Vous pouvez lire tous les fichiers en continu ou simplement lire le
fichier sélectionné. Vous pouvez également régler I'option de répétition
pour tous les fichiers.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.

@ L’écran Movie Record (Enregistrement de film)
apparait.

2. Appuyez sur le bouton [PLAY] ou sur

[Joystick(OK)].

4 Permet de basculer en mode Movie Play
(Lecture vidéo).

3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Play Mode> (Mode Lect).
4. Déplacez le [Joystick] vers le haut ou vers le
bas pour sélectionner une option, puis appuyez
sur [Joystick(OK)].

@ <Play One> (Lire un) : le fichier vidéo
sélectionné est lu.

@ <Play All> (Lire tt) : Permet de lancer la 4
lecture depuis le fichier sélectionné jusqu'au
demier fichier.

¢ <Repeat One> (Répéter un) : le fichier vidéo
sélectionné est lu de facon répétée.

¢ <Repeat All> (Rép. tout) : tous les fichiers
vidéo sont lus de fagon répétée.

5. Pour quitter le menu, appuyez sur le bouton

[MENU]. Appuyez sur le bouton [PLAY].

4 L'option sélectionnée s’applique.

N
Play One
Play All

Hl\lo Ve

Play One

Wov
E oy i

[ Remarque ]

% Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Movie Record (Enregistrement de film).

Play Mode

EESeIecl

Play l\llode
FS

Play All

Repeal One [] =

EZSelecl

Impostazione della modalita di riproduzione

E possibile riprodurre tutti i file a ciclo continuo oppure solo un file
selezionato. E inoltre possibile impostare I'opzione di ripetizione per
tutti i file.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di
registrazione video.

2. Premere il tasto [PLAY] o [Joystick(OK)].
4 Passa alla modalita di riproduzione Video.

3. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Play Mode> (Mod ripr).

{ 4. Spostare il [Joystick] su / gil per selezionare

p un’opzione, quindi premere [Joystick(OK)].

’E o= *
Repe'nt One [ &

<Play One> (Riproduci uno): Il file video
selezionato viene riprodotto.

<Play All> (Riproduci tutto): La riproduzione
dei file viene effettuata da quello selezionato
fino allultimo.

¢ <Repeat One> (Ripeti uno): Il file video
selezionato viene riprodotto ripetutamente.

mEm *

I?‘

e ¢ <Repeat All> (Ripeti tutto): Tutti i file video

vengono riprodotti ripetutamente.

5. Premere il tasto [MENU] per uscire dal menu.
Premere il tasto [PLAY].
@ L'opzione selezionata viene applicata.

mﬁn_!JExn

i [ Nota]

% Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/arresto
si passa alla modalita di registrazione video.



Mode Movie (Vidéo):
Réglage des options d’affichage

Modalita Movie (Video):
Impostazione delle opzioni di visualizzazione

Verrouillage de fichiers vidéo

Vous pouvez protéger les fichiers vidéo enregistrés
importants contre la suppression accidentelle. Les fichiers
protégés ne peuvent étre supprimés, sauf si vous retirez la
protection ou formatez la mémoire.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.
2. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].
4 Permet de basculer en mode Movie Play (Lecture vidéo).
4 Sélectionnez le fichier vidéo de votre choix a I'aide
du [Joystick].

Verrouillage de fichiers vidéo en affichage plein écran

3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Lock> (Verr).

4. Appuyez sur [Joystick(OK)] pour verrouiller le fichier.
& Le fichier vidéo sélectionné est verrouillé.

Verrouillage de fichiers vidéo en affichage multiple

3. Déplacez I'interrupteur [W/T] sur W (WIDE).
4 L'écran a affichage multiple apparait.

4. Appuyez sur le bouton [MENU].

Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Lock> (Verr).

5. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)].

& <Lock> (Verr) : permet de verrouiller le fichier vidéo
sélectionné a I'aide du [Joystick(OK)].
4 <Multi Select> (Sélect multi) : plusieurs fichiers

vidéo peuvent étre sélectionnés en méme temps a | & o> LI 100-0002 FM{IIT)

Iaide du [Joystick(OK)]. Le témoin < (&) > apparait sur
les fichiers sélectionnés. Appuyez sur le bouton [PLAY]
pour verrouiller les fichiers.
@ <Lock All> (Ver. tt) : tous les fichiers vidéo sont verrouillés.
4 <Unlock All> (Dév. Tout) : déverrouillage de tous les
fichiers vidéo.

[ Remarques ]
% Llicone < &> s'affiche sur le fichier verrouillé.

Blocco dei file video

E possibile proteggere da eliminazioni accidentali gli
importanti file video salvati. | file protetti non vengono
eliminati a meno che la protezione non venga sbloccata o
la memoria non venga formattata.
1. Per attivare la videocamera Sport, premere il tasto

di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazionevideo.
2. Premere il tasto [PLAY] o [Joystick(OK)].

4 Passa alla modalita di riproduzione Video.

4 Utilizzando il [Joystick], spostarsi sul file video

desiderato

Blocco dei file video a schermo intero

3. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Lock> (Prot).

4. Premere [Joystick(OK)] per bloccarlo.
4 |l file video selezionato & bloccato.

Blocco dei file video in visualizzazione multipla

3. Spostare l'interruttore [W/T] su W (LARGO).
4 La schermata passa alla visualizzazione multipla.
4. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Lock> (Prot).
5. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
& <Lock> (Prot): Blocca il file video selezionato

wliiove  oPly utilizzando [Joystick(OK)].

4 <Multi Select> (Multi selez.): Utilizzando
[Joystick(OK)] si possono selezionare piu file video.
Sui file selezionati viene visualizzato l'indicatore <(@>.
Premere il tasto [PLAY] perbloccarli.

a 4 <Lock All> (Blocca tutto): Tutti i file video sono

Lock

bloccati.
Multi Select 4 <Unlock All> (Shlocca tutto): Sblocca tutti i file video.
Ck All [ Note ] . . . ' .
% Sul file bloccato viene visualizzata Iicona <(@ >.

EMove CI3Select [EY Exit

% Quando viene visualizzata la schermata del menu,

% Lorsque I'écran de menu s'affiche, le fait d’appuyer sur le bouton [Record / premendo il tasto di registrazione/arresto si passa alla
a Stop] permet d’accéder au mode Movie Record (Enregistrement de film). modalita di registrazione video.



Mode Movie (Vidéo):
Réglage des options d’affichage

Modalita Movie (Video):
Impostazione delle opzioni di visualizzazione

Copie de fichiers vidéo

Copia dei file video

Vous pouvez copier des fichiers enregistrés de la mémoire
interne vers la carte mémoire et vice-versa.

1. Insérez une carte mémoire dans le caméscope Sport, par
la fente prévue a cet effet.

2. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L’écran Movie Record (Enregistrement de film) apparait.
3. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].

4 Permet de basculer en mode Movie Play (Lecture vidéo). Biiore

El3Select

| file archiviati possono essere copiati dalla memoria interna
a una scheda di memoria e viceversa.

1. Inserire la scheda di memoria nell’apposito
alloggiamento della videocamera Sport.

2. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione video.

Premere il tasto [PLAY] o [Joystick(OK)].

4 3.
e 2 4 Passa alla modalita di riproduzione Video.

4 Sélectionnez le fichier vidéo de votre choix a I'aide du
[Joystick].

Copie des fichiers vidéo en affichage plein écran

4. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Copy To> (Cop sur).

5. Appuyez sur [Joystick(OK)] pour copier le fichier.
4 Permet de copier le fichier vidéo sélectionné.

Copie des fichiers vidéo en affichage multiple

4. Déplacez I'interrupteur [W/T] sur W (WIDE).

4 L'écran a affichage multiple apparait.

5. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche o u la droite pour
sélectionner <Copy To> (Cop sur).
6. Déplacez le [Joystick] vers le haut ou vers le bas pour
sélectionner une option, puis appuyez sur [Joystick(OK)].

4 <OK> : permet de copier le fichier vidéo selectionné.

4 <Multi Select> (Sélect multi) : plusieurs fichiers
vidéo peuvent étre sélectionnés en méme temps a l'aide
du [Joystick(OK)]. Le témoin < ¢ > apparait sur les
fichiers sélectionnés. Appuyez sur le bouton [PLAY]
pour copier les fichiers.

& <All> (Tt) : Tous les fichiers vidéo sont copiés.

D Move

= iove

5 &3 Movie

[ Remarques |
Le caméscope Sport permet de copier & partir de la mémoire
en cours d'utilisation vers une autre mémoire. Si la mémoire
interne était utilisée, la copie est effectuée vers une carte
mémoire.

Si la carte mémoire n'est pas insérée, vous ne pouvez pas
utiliser la fonction <Copy To> (Cop sur).

Lorsque I'écran de menu s’affiche, le fait d’appuyer sur le bouton [Record /
Stop] permet d’accéder au mode Movie Record (Enregistrement de film).

Multi'Select:
All

S Move

. Copying file(s)...

V0005.AVI
 F——

Press OK to cancel.

[D3Select

I3 Play

(I3 Select

4 Utilizzando il [Joystick], spostarsi sul file video
desiderato.

Copia dei file video a schermo intero

4. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Copy To> (Copia su).

5. Premere [Joystick(OK)] per copiarlo.
4 Copia il file video selezionato.

Copia dei file video in visualizzazione multipla

4. Spostare l'interruttore [W/T] su W (LARGO).
4 La schermata passa alla visualizzazione multipla.
5. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Copy To> (Copia su).
6. Spostare il [Joystick] su / giu per selezionare un’
opzione, quindi premere [Joystick(OK)].
& <OK>: Copia il file video selezionato.
4 <Multi Select> (Multi selez.): Utilizzando
[Joystick(OK)] si possono selezionare pi file video.
Sui file selezionati viene visualizzato I'indicatore
< v >. Per copiare, premere il tasto [PLAY].
@ <All> (Tutti) : Tutti i file video vengono copiati.

[ Note ]
Con la videocamera Sport & possibile copiare dalla
memoria utilizzata correntemente su un’altra memoria.
Se la memoria interna € utilizzata, la copia viene eseguita
su una scheda di memoria.
Se non viene inserita una scheda di memoria, la funzione
<Copy To> (Copia su) non puo essere eseguita.
Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/arresto si passa alla
modalita di registrazione video.

IMENUNSE
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J Mode Photo

PriSe d'iMAGES .....cuvieciieieireet et
Z00M QVaNt 81 AITIEIE .......c..cvurercireereiseieeeeeeeee e
ViSionNnage............coccvieinicnencsecses .
Affichage de fichiers photo sur 'écran LCD ..........ccccovvuvniviviinciniicins
Affichage de plusieurs fichiers photo...........
Réglage des options de prise ..............c.coooeene. .
Réglage de la fonction White Balance (Bal. Blancs)..........c.cuvueueenee
Réglage de la fonction Program AE
(exposition automatique programmable (Prog. AE))
Réglage des effets spéciaux............ovuerverurennee
Réglage du flash................ » -
Réglage de la prise de photos en contlnu .............................................
Réglage de la fonction EIS (stabilisateur électronique d'image(SEl)) ..
Réglage de la mise au point .............cocvvriennee
Réglage de la fonction BLC (compensation de contre- Jour(CCJ
Réglage du zoom numeérique...........cocvuerveneee
Réglage des options d’affichage..........................
Suppression de fichiers photo..........c.ccccveeeecee
Réglage du diaporama............ccccoveereerieniennenens
Réglage de la fonction DPOF (Digital Print Order Format -
protocole de commande d'impressionnumérique)
Verrouillage de fichiers photo..........ccocveveennee
Copie de fichiers photo..........coeeerercererieeenieens

¢ Sauvegardez les données et enregistrements importants sur un autre

support afin d'éviter les pertes accidentelles provoquées par une défaillance

du systeme ou toute autre raison.

Comment régler le mode Photo

\LL]\‘—( W
el Bouton
RoA O Power
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o

@ Photo» ( (8] ) B0
AR\ \ODE
H ¢
Al

1. Appuyez sur le bouton
[POWER] pour allumer le
caméscope Sport.

2. Sélectionnez le mode
Photo en appuyant sur
le bouton [MODE].

A

Modalita Photo (Foto)

Ripresa delle immagini..
Zoom avanti e indietro...
Visualizzazione
Riproduzione di file di immagine sul display LCD
Visualizzazione di piu file di immagine
Impostazione delle opzioni di ripresa
Impostazione del bilanciamento del bianco............ccccccvevreerienienee.
Impostazione di Program AE
(Esposizione Automatica Programmata)
Impostazione degli effetti.........
Impostazione del flash............
Impostazione dello scatto continuo

Impostazione dellEIS (Stabil. immagine elettronico) 66
Impostazione della messa a fuoco ...........cceueeeee .67
Impostazione della BLC (compensazione controluce) ................... 68

Impostazione dello zoom digitale
Impostazione delle opzioni di visualizzazione......
Eliminazione dei file di immagine
Impostazione della proiezione delle dlap03|t|ve
Impostazione della funzione DPOF (Digital Print Order Format)...72
Protezione dei file di immagine...........c.ccocuvvvunnenee .73
Copia dei file di immagine.............cocreereeriereeneeenns .74

& Salvare dati/registrazioni importanti separatamente su altri supporti,
per evitare la perdita accidentale causata da guasti al sistema o da
altre ragioni.

Modalita Photo (Foto)

‘ \\@
g '
A MO Tastodi
. accensione

I: ﬁ

- Y

Photo» ( (@) ) B

2. Premendo il tasto
[MODE], impostare la
modalita Photo (Foto).

1. Per attivare la videocamera
Sport, premere il tasto di
accensione.



Mode Photo : Prise

Modalita Photo (Foto): Cattura

Prise d’images

Ripresa delle immagini

Votre caméscope vous permet d’enregistrer des
fichiers vidéo mais également de prendre des photos.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L'écran Movie Record (Enregistrement de film)
apparait.

((\ Oltre a registrare file video, & anche possibile
\ riprendere delle immagini.

N
| | Power ) ) _
button 1. Per attivare la videocamera Sport, premere il

MoR tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione
video.

2. Sélectionnez le mode Photo en appuyant sur
le bouton [MODE].
@ L’écran Photo Capture (Prise photo) apparait.

3. Appuyez de nouveau sur le bouton [Record /
Stop] pour prendre une photo.

4. Apres avoir pris la photo, appuyez sur le
bouton [POWER] pour éteindre le caméscope
Sport et ne pas épuiser la batterie inutilement.

[ Remarques ]

< En cas de batterie faible, le flash ne s’activera pas
automatiquement.

< Pour prendre des photos et les enregistrer sur la carte mémoire,
insérez une carte mémoire et réglez le type de stockage sur
<External> (Externe). wpage 97

2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
4 Viene visualizzata la schermata Photo
Capture (Cattura foto).

3. Premere il tasto di registrazione/arresto per
scattare una foto.

4. Al termine premere il tasto di accensione per
spegnere la videocamera Sport e ridurre il
consumo della batteria.

[ Note ]

% Se la batteria & scarica, il flash non si attiva automaticamente.
% Per scattare fotografie sulla scheda di memoria, inserirne una,
quindi impostare il tipo di memoria su <External> (Esterna).

=pagina 97



Mode Photo : Prise

Modalita Photo (Foto): Ripresa

Zoom avant et arriére

Le zoom vous permet de modifier la taille du sujet photographié.
Tirez profit de 'objectif de zoom optique x10 a déplacement électronique.

1. Appuyez sur le bouton [POWER] pour allumer le caméscope Sport.

4 L'écran Movie Record (Enregistrement de film) apparait.

2. Sélectionnez le mode Photo en appuyant sur le bouton [MODE].
@ L'écran Photo Capture (Prise photo) apparait.

Déplacez linterrupteur [W/T]  Zoom Out
vers le haut pour zoomer vers
I'arriére.

@ La taille du sujet photographié
est réduite et vous pouvez
prendre des photos comme si
vous étiez éloigné du sujet.

@ La fleche se déplace vers W sur
lindicateur du zoom affiché a I'écran.

@ Le niveau de zoom le plus bas est le
niveau par défaut (résolution originale du
sujet).

Déplacez I'interrupteur [W/T]

vers le bas pour zoomer vers

I'avant.

@ Le sujet est plus grand et
vous pouvez prendre des
photos comme si vous en
étiez proche.

® La fleche se déplace vers T sur
l'indicateur du zoom.

@ Le niveau de zoom le plus haut est 10x.
C’est le maximum pour un zoom de base.

Remarques ]

L'utilisation fréquente du zoom peut accélérer
I'épuisement de la batterie.

Pour bénéficier d'un zoom 100x, vous pouvez combiner le zoom
numeérique 10x et et le zoom optique 10x.

Le zoom optique permet de préserver la qualité de limage.

Zoom In

LS

A

Zoom avanti e indietro

Lo zoom permette di cambiare la dimensione del soggetto catturato in

una scenaconsentendo di sfruttare i vantaggi offerti dallo zoom ottico

motorizzato 10x.
Per attivare la videocamera Sport, premere il tasto di
[ACCENSIONE].
@ Viene visualizzata la schermata di registrazione video.

2. Premendo il tasto [MODE], impostare la modalita Photo (Foto).

4 Viene visualizzata la schermata Photo
Capture (Cattura foto).

Far scorrere l'interruttore

[W/T] su per eseguire lo

Zoom indietro.

® La dimensione del
soggetto ripreso viene
ridotta e I'immagine pud
essere ripresa come se si fosse distanti
dal soggetto.

@ Nellindicazione dello zoom sul display
LCD, la freccia si sposta su W.

@ La velocita piu bassa per lo Zoom avanti
e quella predefinita
(risoluzione originale del soggetto).

Far scorrere l'interruttore

[W/T] giu per eseguire lo

Zoom avanti

@ |l soggetto viene ingrandito
e limmagine pud
essereripresa come se Si
fosse vicini alsoggetto.
@ Nell'indicazione dello zoom, la freccia si

sposta su T.
@ |l rapporto massimo dello zoom ottico &
di 10x (il pit grande fra gli zoom di base).

[ Note ]

« |l frequente uso dello zoom puo' velocizzare
il consumo della batteri.

% Sipuo' sommare lo zoom ottico allo zoom digitale per un totale zoom
di 100x.

% Lo zoom ottico preserva la qualita’ dellimmagine




Mode Photo : Visionnage

Modalita Photo (Foto): Visualizzazione

Affichage de fichiers photo sur I’écran LCD

Il est pratique de pouvoir visionner les photos sur 'écran LCD dans
des endroits tels que votre voiture, a lintérieur ou a I'extérieur.

Riproduzione di file di immagine sul display LCD

Il display LCD & molto pratico per visualizzare i file video e pud essere
utilizzato in luoghi come 'auto o in ambienti interni o esterni.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enregistrement de film)
apparait.

2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
@ L'écran Photo Capture (Prise photo) apparait.

1. Per attivare la videocamera Sport, premere
@ il tasto di [ACCENSIONE].
‘ @ Viene visualizzata la schermata di

W 1e VISt ;
y registrazione video.

@ Power
button

[pg 2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).

4 Viene visualizzata la schermata Photo

Capture (Cattura foto).

3. Appuyez sur le bouton [PLAY] ou sur
[Joystick(OK)].
@ Permet d’activer le mode Photo view (Aff. photo).

4. Déplacez le [Joystick] vers la gauche ou la
droite pour trouver la photo que vous souhaitez
voir.

4 Chaque déplacement du joystick permet d’
accéder au film précédent/suivant.

[ Remarques ]

< Si aucun fichier n’est enregistré, le message <No

Files...> (0 FCH) apparait.

Déplacer le [Joystick] & droite de la derniére photo

vous permet d’accéder a la premiere photo.

Déplacer le [Joystick] & gauche de la premiere

photo vous permet d’accéder a la derniére photo.

En déplagant le [Joystick] vers la gauche ou vers

la droite et en maintenant la position pendant au

moins une seconde, vous pouvez effectuer une

recherche rapide.

% Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo)

LI 4]

3. Premere il tasto [PLAY] o [Joystick(OK)].
# Sipassa alla modalita Photo View (Visual.
foto).

4. Spostare il [Joystick] a sinistra / a destra
per ricercare la foto che si desidera
visualizzare.
¢ Ad ogni movimento del joystick si passa

alla foto precedente/successiva.

| [Note]

< Se non vi sono file memorizzati da visualizzare,
appare il messaggio <No Files...> (No file...).

% Spostando il [Joystick] a destra sull'ultima foto,
si torna alla prima foto.

< Spostando il [Joystick] a sinistra sulla prima
foto, si passa all'ultima foto.

< Spostando il [Joystick] a sinistra/a destra per
piu di 1 secondo, viene avviata la ricerca
veloce.

< Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).

A



Mode Photo : Visionnage

M

odalita Photo (Foto): Visualizzazione

Affichage de plusieurs fichiers photo

Lorsque vous utilisez I'interrupteur [W/T] en mode Photo View (Aff.
photo), vous pouvez afficher plusieurs images sur un seul écran LCD.

. Appuyez sur le bouton [POWER] pour allumer

. Appuyez sur le bouton [PLAY] ou sur

le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.

Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
@ L’écran Photo Capture (Prise photo) apparait.

Appuyez sur le bouton [PLAY] ou sur
[Joystick(OK)] et faites glisser I'interrupteur
[W/T] sur W (WIDE).

@ L'écran a affichage multiple apparait.

que vous souhaitez voir.

[Joystick(OK)] pour voir le fichier photo de
votre choix.
@ Le plein écran s’affiche.

[ Remarques ]
< Siaucun fichier n'est enregistré, le message <No Files...> (0 FCH)

L)

L)

A

apparait.

La durée de chargement de la photo peut varier en fonction de sa
taille.

Il se peut que les images modifiées ou passées dans le programme
de visualisation d’images de votre ordinateur ne s’affichent pas.

Visualizzazione di piu file di immagine

Util
sul

izzando l'interruttore [W/T] nella modalita Photo View (Visual. foto),
display LCD possono essere visualizzate pitl immagini.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di
registrazione video.

2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
@ Viene visualizzata la schermata Photo
Capture (Cattura foto).

3. Premere il tasto [PLAY] o il [Joystick(OK)] e
far scorrere I'interruttore [W/T] su W (LARGO).
@ Appare la schermata con visualizzazioni
multiple.

4. Spostare il [Joystick] a sinistra / a destra o in
alto / in basso per ricercare il file di immagine
che si desidera visualizzare.

5. Premere il tasto [PLAY] o [Joystick(OK)] per
visualizzare il file di immagine desiderato.
@ La visualizzazione & a schermo intero.

Se non vi sono file memorizzati da visualizzare, appare il
messaggio <No Files...> (No file...).

Il tempo di visualizzazione varia a seconda delle dimensioni
dellimmagine.

Le immagini modificate su PC con il programma Image Viewer
potrebbero non essere visualizzate.
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Réglage de la fonction White Balance (Bal. Blancs)

La balance des blancs vous permet de régler les couleurs de la photo en
fonction des conditions d’éclairage. Nous vous recommandons de régler la
balance des blancs avant chaque prise de photo.

Impostazione del bilanciamento del bianco

Il bilanciamento del bianco permette di calibrare l'immagine per ottenere una
fedele riproduzione dei colori in diverse condizioni illuminazione. Si raccomanda di
impostare il bilanciamento del bianco prima di riprendere qualsiasi immagine.

1.

Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.

[MODE].

4 L’écran Photo Capture (Prise photo) apparait.

Appuyez sur le bouton [MENU].

Déplacez le [Joystick] vers la gauche ou la droite pour

sélectionner <White Balance> (Bal. Blancs).

Déplacez le [Joystick] vers le haut ou vers le bas

pour sélectionner une option, puis appuyez sur

[Joystick(OK)].

@ Pour régler les options Custom (Person.), orientez
I'objectif du caméscope Sport vers une zone blanche
(un mur, par exemple), de facon a ce que I'écran
LCD soit blanc. Appuyez sur [Joystick(OK)] pour

Sélectionnez le mode Photo en appuyant sur le bouton

3 @ Photo E_INGIII]

&« P[E- P 7 T
White Balance
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1.

Per attivare la videocamera Sport, premere il tasto

di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione video.

Premendo il tasto [MODE], impostare la modalita

Photo (Foto).

4 Vien e visualizzata la schermata Photo Capture
(Catturafoto).

Premere il tasto [MENU]. Spostare il [Joystick]

a sinistra / a destra per selezionare <White Balance>

(Bilan. Bianco).

Spostare il [Joystick] su / giu per selezionare un’opzione,

quindi premere [Joystick(OK)].

4 Perimpostare Custom (Personalizzato), inquadrare
con la videocamera Sport un’area bianca (come
una parete), riempiendo il display LCD con il colore
bianco. Premere [Joystick(OK)] per confermare

5.

—

L

sélectionner les options. P limpostazione.
ayligh m - Ny
Le réglage se fait automatiquement en fonction Auto Esegue unimpostazione automatica a seconda
Auto des conditions d’enregistrement. Euorescem dell'ambiente di ripresa.
. La couleur est réglée en fonction de la lumiére du B ove f@select W Exit Daylight |Regolail colore in base alla luce diuma, a quella
Daylight (Jour) jour, a lintérieur gu A Pextérieur. i (Luce diurna) {nterna eaquella esterna.
- - " Fluorescent |E adatto ad un ambiente in cui & presente
Fluorescent Efé}grgpetlsolr}lﬁg?gggmea. rfaitement lorsque la 4 ‘1 Photo E_INJIIE (A fluorescenza) |un'iluminazi one fluorescente.
- . . . Ig . . Ly
Tungsten | Cette option convient parfaitement lorsque la LQ s s B - ¢ - % Tungsten  |E g\_(lilanq adun amb'enée in cui & presente
(Tungst)  |lumiére estincandescente. I ite Balance: (Tungsteno) |un’illuminazione incandescente.
Custom |Labalance des blancs est réglée en fonction des Auto Custom _(Regola il bilanciamento del bianco in base
(Person.) [conditions d’enregistrement. Daylight (Personalizzatp) | all'ambiente di ripresa.

Pour quitter le menu, appuyez sur le bouton [MENU].

4 Licone de la fonction sélectionnée saffiche.

4 Aucune icone ne s'affiche lorsque le mode <Auto> est
sélectionné.

Remarques ]

Lorsque vous prenez des photos en extérieur, 'option

<Auto> permet d’obtenir de meilleurs résultats.

Comme les conditions d’éclairage changent, réglez la

balance des blancs convenablement avant de prendre une photo.

Le sujet utilisé avec la fonction <Custom WB>

(Personnaliser la balance des blancs) doit étre blanc. Si tel

n'est pas le cas, la balance des couleurs ne sera pas naturelle.

Lorsque I'écran de menu s’affiche, le fait d’appuyer sur

le bouton [Record / Stop] permet d’accéder au mode Photo

Capture (Prise photo).

Fluerescent
v
D Vove

[IiSelect  [EMM Exit

5. Premere il tasto [MENU] per uscire dal menu.
4 Viene visualizzata I'icona della funzione selezionata.
4 Selezionando <Auto>, non viene visualizzata

nessun’icona.

[ Note ]

% Riprendendo immagini all'aperto, limpostazione <Auto>
consente di ottenere i risultati migliori.

% Se variano le condizioni d'illuminazione, prima di riprendere
un'immagine, impostare il bilanciamento del bianco corretto.

% Il soggetto per cui viene utilizzato <Custom> (Personalizzatp)
deve essere bianco. In caso contrario i colori non sono naturali.

% Quando viene visualizzata la schermata del menu, premendo
il tasto di registrazione/di arresto si passa alla modalita Photo

Capture (Cattura foto). i
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Réglage de la fonction Program AE (exposition automatique programmable (Prog. AE))

Les modes Program AE (Prog. AE) sont des modes d’exposition
automatique basés sur un programme informatique interne. Cette fonction
vous permet d’adapter 'ouverture aux conditions de la prise de photo.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.
2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
4 L’écran Photo Capture (Prise photo) apparait.
3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Program AE> (Prog. AE).
4. Déplacez le [Joystick] vers le haut ou vers le bas

pour sélectionner une option, puis appuyez sur | <} il

Impostazione di Program AE (Esposizione Automatica Programmata)

Le modalita Program AE (AE Program) permettono di preimpostare delle
modalita di esposizione automatica sulla base di un programma interno.
Program AE (Ae Program) permette di regolare 'impostazione di apertura

per adattarsi alle varie condizioni.

. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione
video.
2. Premendo il tasto [MODE], impostare la modalita
Photo (Foto).
4 Viene visualizzata la schermata Photo Capture
(Catturafoto).
3. Premere il tasto [MENU]. Spostare il [Joystick] a
sinistra / a destra per selezionare <Program AE>
(Ae Program).

[Joystick(OK)]. "“ c T W 4. Spostare il [Joystick] su / gil per selezionare
La balance se fait automatiquement entre = regram un’opzione, quindi premere [Joystick(OK)].
le sujet et l'arriere-plan pour parvenir au AUto
Auto meilleur résultat. La vitesse de l'obturateur Esegue un bilanciamento automatico tra soggetto e
varieautomatiquement de 1/50 & 1/250 par Sports &S Auto sfondo per ottenere il risultato migliore. La velocita
seconde en fonction de la scene. Spotlight (o) di scatto varia automaticamente da 1/50 a 1/250, a
Permet denregistrer des personnes ou des % seconda della scena.
objets se déplacant rapidement. Cette fonction [ Viove [ISelect [EM Exit Per la registrazione di persone o di oggetti
Sports convient particuliérement aux manifestations Sports che si muovono rapidamente. Questa opzione
sportives et aux enregistrements réalisés (Sport) & adatta per eventi sportivie se ci si trova all
depuis lintérieur d’'une voiture. esterno in automobile.
Permet de compenser une trop forte luminosité = < L R Esegue una compensazione per un soggetto
Spotlight |dUe & une exposition directe & une puissante Program AE Spotlight [che, per via di forte luce diretta, appare troppo
?S 0% source d'éclairage (projecteur, par exemple). K i (Riflettore) |luminoso (ad es. un riflettore).
P Cette fonction convient particuliérement aux Hte - E adatta per concerti e spettacoli scolastici.
concerts et aux représentations scolaires. Sand/Snow | Viene utilizzata quando la luce & molto forte
Sand/Zow | Utile lorsque la lumiere est crue, comme sur Spotlight (2) (Sabbia/Neve) |come in spiaggia o sulla neve.
(Sab./neig) |une plage ou dans un paysage enneigé. v N N
i Eiove [RSelect D&M Exit 5. Premere il tasto [MENU] per uscire dal menu.
5. Pour quitter le menu, appuyez sur le bouton @ Viene visualizzata lcona della funzione
[MENU]. selezionata.

4 Licone de la fonction sélectionnée s’affiche.
4 Sivous sélectionnez le mode <Auto>, aucune
icdne ne s'affiche.

[ Remarque ]

% Lorsque I'écran de menu s’affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

@ Selezionando <Auto>, non viene visualizzata
nessuna icona.

[ Nota ]

< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa
alla modalita Photo Capture (Cattura foto).
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Réglage des effets spéciaux

Vous pouvez appliquer différents effets numériques a vos photos.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)

apparait.

2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
4 L’écran Photo Capture (Prise photo) apparait.

3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Effect> (Effet).

4. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)].

Off Permet d’annuler I'effet appliqué.
Permet d'appliquer des effets artistiques

Art a votre fichier photo.
Mosaic Permet de superposer une trame
(Mosaiq) semblable a une mosaique a votre fichier

photo.
Sepia  |Permet de donner a 'image une teinte
(Sépia) |sépia rappelant les photos anciennes.

Negative |Permet d'inverser les couleurs afin de
(Négatif) |donner 'aspect d’un négatif.

Mirror  |Ce mode scinde image en deux par un
(Miroir)  |effet miroir.

B&W (N&B) |Permet d’afficher 'image en noir et blanc.

5. Pour quitter le menu, appuyez sur le bouton
[MENU].
& L'effet sélectionné et icone correspondante s'affichent.
4 Aucune icone ne s'affiche lorsque <Off> est

sélectionné.

[ Remarque ]

< Lorsque I'écran de menu s’affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

3 @ Photo

AR % [EECER)
Effect

A
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v
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Impostazione degli effetti

Sulle foto si possono applicare diversi effetti digitali.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].

@ Viene visualizzata la schermata di
registrazione video.

2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).

@ Viene visualizzata la schermata Photo
Capture (Cattura foto).

3. Premere il tasto [MENU]. Spostare il [Joystick]
a sinistra / a destra per selezionare
<Effect> (Effetto).

4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].

Off Gli effetti vengono annullati.
Art Aggiunge effetti artistici al file di immagine.
(Mnizskzaig:o) Crea sullimmagine una struttura a mosaico.

Sepia Conferisce allimmagine un colore seppia
(Seppia) |simile alle vecchie fotografie.

Negative |Inverte i colori, creando cosi un’immagine al
(Negativo) |negativo.

Mirror Taglia 'immagine a meta con un effetto a
(Specchio) |specchio.

B&W (B/N) [Converte le immagini in bianco e nero.

5. Premere il tasto [MENU] per uscire dal menu.
¢ Vengono visualizzati I'effetto e l'icona selezionati.
4 Selezionando <Off>, non viene visualizzata
nessuna icona.

[ Nota ]

% Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).

A



Mode Photo :
Réglage des options de prise

Modalita Photo (Foto):
Impostazione delle opzioni di ripresa

Réglage du flash

Le flash est tres utile, non seulement la nuit, pour photographier des
sujets plus clairs, mais aussi le jour, si le sujet n’est pas assez éclairé
(par exemple s'il est a 'ombre, a lintérieur ou a contre-jour).

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.
2. Sélectionnez le mode Photo en appuyant sur
le bouton [MODE].
@ L'écran Photo Capture (Prise photo) apparait.
3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <Flash>.
4. Déplacez le [Joystick] vers le haut ou vers
le bas pour sélectionner une option, puis
appuyez sur [Joystick(OK)].

3 @ Photo

On permet d'activer le flash.

permet d’activer automatiquement le flash
en fonction des conditions d’éclairage.

Auto EBMove

4| @ Photo

le flash ne sera pas activé. Sélectionnez cette
Off option dans des lieux ol vous ne pouvez pas
utiliser le flash (dans un musée, par exemple).

5. Pour quitter le menu, appuyez sur le bouton
[MENU].
@ L'icone de la fonction sélectionnée s'affiche.

[ Remarques ]

< En cas de batterie faible, le flash ne s’activera pas
automatiquement.

Le flash n’est pas aussi efficace qu'une lumiere
stroboscopique normale.

Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

L

On

) <> B W 4t [
(e]j] %

3
Off: @)

[I3Select:

(T3 Select

Impostazione del flash

Il flash & molto utile per effettuare riprese piu chiare dei soggetti non
solo di notte, ma anche di giorno se manca un’illuminazione sufficiente
(ombra, ambienti interni e situazioni di retroilluminazione).

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di
registrazione video.
2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
4 Viene visualizzata la schermata Photo
Capture (Cattura foto).
3. Premere il tasto [MENU]. Spostare il [Joystick]
a sinistra / a destra per selezionare <Flash>.
Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].

Il flash si accende.

Il flash viene impostato automaticamente in

Auto A
base alle condizioni dellilluminazione.

[ Exit - "
Il flash non si accende. Questa opzione

viene selezionata se il flash non pud
Off 2 1 nnc )

essere utilizzato in determinati luoghi
(ad esempio un museo)

5. Premere il tasto [MENU] per uscire dal menu.

4 Viene visualizzata I'icona della funzione
selezionata.

[E Exit [ Note ]

% Se la batteria & scarica, il flash non si attiva
automaticamente.

% Il flash non ¢ efficace come una normale luce
stroboscopica.

< Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).
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Réglage de la prise de photos en continu

Vous pouvez prendre une série de photos les unes apres les autres
simplement en appuyant une seule fois sur I'obturateur.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.

2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
4 L’écran Photo Capture (Prise photo) apparait.

3. Appuyez sur le bouton [MENU].

Déplacez le [Joystick] vers la gauche ou la droite 3| BIPnoto

' e s 3. Premere il tasto [MENU]. Spostare il [Joystick] a

4. Déplacez le [Joystick] vers le haut ou vers le bas 3 shots

pour sélectionner <Continuous Shot> (Phot. en
continu).

pour sélectionner une option, puis appuyez sur
[Joystick(OK)].
*

<Off> : permet de désactiver la fonction EMove

Continuous Shot (Phot. en continu) et de prendre
une photo a la fois.

4 <3 shots> (3 phot.) : permet d’activer la fonction
Continuous shot (Phot. en continu) et de prendre
3 photos d'affilée. off

5. Pour quitter le menu, appuyez sur le bouton
[MENU].

@ Licone de la fonction sélectionnée s'affiche. EB\ove

4 Aucune icone ne s'affiche lorsque le mode <Off>
est sélectionné.

[ Remarques ]

% Lorsque vous sélectionnez <Continuous Shot> (Phot.
en continu), vous ne pouvez pas utiliser le flash.

< Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

@&

[3Select  [EMExit

4 @& Photo

LR K ROK
Continuous Shot

[¥Select [EMExit

Impostazione dello scatto continuo

E possibile riprendere una serie di immagini con continuita, semplicemente
con uno scatto.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di
registrazionevideo.

2. Premendo il tasto [MODE], impostare la modalita
Photo (Foto).
4 Viene visualizzata la schermata Photo Capture
(Cattura foto).

sinistra / a destra per selezionare <Continuous
Shot> (Scatto continuo).

4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
4 <Off> : Disabilita Continuous shot (Scatto
continuo) e consente di scattare una foto per volta.
4 <3 Shots> (3 scatti) : Continuous shot (Scatto
continuo) viene attivato, consentendo di
scattare 3 foto consecutivamente.

5. Premere il tasto [MENU] per uscire dal menu.

4 Viene visualizzata l'icona della funzione
selezionata.

4 Selezionando <Off>, non viene visualizzata
nessun’icona.

[ Note ]

% Impostando <Continuous Shot> (Scatto continuo),
non ¢ possibile utilizzare il flash.

% Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si
passa alla modalita Photo Capture (Cattura foto).

A
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Réglage de la fonction EIS (stabilisateur électronique d’image(SEl))

La fonction Electronic Image Stabilizer (stabilisateur électronique d’ image)
permet de compenser le tremblement des mains, ou tout autre
mouvement, lors de la prise de photos.La fonction EIS
(SEI) permet d’obtenir une image plus stable dans les
situations suivantes :

prise de photos avec le zoom ;

prise d’objets de petite taille ;

enregistrement en marchant ou en bougeant ;
prise depuis 'intérieur d'un véhicule en
mouvement ;

L 2R 2R 2R 4

caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.

2. Sélectionnez le mode Photo en appuyant sur le off
bouton [MODE].

4 L’écran Photo Capture (Prise photo) apparait.

3. Appuyez sur le bouton [MENU].

Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <EIS> (SElI).

4. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)]. On
4 <On>: permet d'activer la fonction EIS (SEI).

& <Off> : permet d’activer la fonction EIS (SEI).

5. Pour quitter le menu, appuyez sur le bouton [MENU].

4 L'icone EIS (SEI) () s'affiche lorsque <On> est
sélectionné.

4 Aucune icone ne s'affiche lorsque <Off> est
sélectionné.

= iove

4 & Photo

EZMove

[ Remarque ]

< Lorsque 'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

A

[I3Select

5

[I3Select

Impostazione dell’EIS (Stabil. inmagine elettronico)

Lo stabilizzatore digitale delle immagini consente di compensare i tremolii

ei mowmentl involontari della mano durante la ripresa delle immagini EIS
’ conferisce alle foto una maggiore stabilita:

Nelle riprese con lo zoom

Nella ripresa di oggetti piccoli

Nelle riprese in movimento

Nelle riprese dal finestrino di un veicolo in

movimento

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.
2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
@ Viene visualizzata la schermata Photo Capture
(Cattura foto).
Premere il tasto [MENU].Spostare il [Joystick]
a sinistra / a destra per selezionare <EIS>.
4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
4 <On> : La funzione EIS viene attivata.
& <Off> : La funzione EIS viene disattivata.
. Premere il tasto [MENU] per uscire dal menu.
@ Selezionando <On>, viene visualizzata I
icona EIS ().
@ Selezionando <Off>, non viene visualizzata
nessun’icona.

O Exit 3.

[ Exit

[ Nota]

% Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).
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Réglage de la mise au point

Pour obtenir les meilleurs résultats, sélectionnez une méthode de mise
au point appropriée.
1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L'écran Movie Record (Enregistrement de film)
apparait.
2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
4 L’écran Photo Capture (Prise photo) apparait.
3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <Focus> (Régl.).
4. Déplacez le [Joystick] vers le haut ou vers
le bas pour sélectionner une option, puis
appuyez sur [Joystick(OK)].
@ <AF> : la mise au point se fait automatiquement.
& <MF> (FM) : la mise au point se fait manuellement.
5. Pour quitter le menu, appuyez sur le bouton [MENU].
@ Sivous sélectionnez <MF> (FM), l'icéne (%3)
s'affiche.
4 Aucune icone ne s'affiche lorsque <AF> est
sélectionné.

Enove

Mise au point manuelle <MF> (FM)

Réglez la mise au point en déplacant le [Joystick]
vers le haut ou vers le bas pour zoomer vers
I'avant ou vers I'arriere manuellement.
4 Cas ou la scene comporte des éléments a la
fois proches et éloignés du caméscope Sport.
4 Cas d'un sujet dans la brume ou sur fond
enneigeé.

D iMove

[ Remarque ]

% Lorsque I'écran de menu s’affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

CI3Select

[T3Select

Impostazione della messa a fuoco

Permette di selezionare un metodo di messa a fuoco appropriato per
ottenere i risultati migliori.
; 1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di
1 registrazionevideo.
2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
4 Viene visualizzata la schermata Photo
Capture (Cattura foto).
3. Premere il tasto [MENU].Spostare il [Joystick] a
sinistra / a destra per selezionare <Focus> (Fuoco).
4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
@ <AF> : Imposta la messa a fuoco automatica.
@ <MF> (KF) : Imposta la messa a fuoco manuale.
5. Premere il tasto [MENU] per uscire dal menu.
4 Se si seleziona il <MF> (KF), viene
visualizzata l'icona (%c3).
@ Se si seleziona<AF>, non viene visualizzata
nessun’icona.

Messa a fuoco manuale <MF> (KF)

Per effettuare manualmente lo zoo m avanti o
indietro, regolare il movimento della messa a
fuoco spostando il [Joystick] su/giu.
4 Se in un'immagine vi sono soggetti vicini o
lontani dalla videocamera Sport
4 Quando una persona € avvolta dalla nebbia
0 da una coltre di neve

[ Nota ]

%+ Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).

A



Mode Photo :
Réglage des options de prise

Modalita Photo (Foto):
Impostazione delle opzioni di ripresa

Réglage de la fonction BLC (compensation de contre-jour(CCJ))

La fonction de compensation du contre-jour permet
de rendre le sujet plus clair lorsqu’il se trouve devant
une fenétre ou lorsqu'il est trop sombre pour le
distinguer. Vous pouvez utiliser cette fonction lorsque
vous utilisez le caméscope Sport pour filmer une
scéne dont l'arriere-plan est lumineux ou enneigé.
1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L'écran Movie Record (Enregistrement de film)
apparait.
2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
4 L’écran Photo Capture (Prise photo) apparait.

3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la
droite pour sélectionner <BLC> (CCJ).

4. Déplacez le [Joystick] vers le haut ou vers le

bas pour sélectionner une option, puis appuyez |4 OIS

sur [Joystick(OK)].

@ <On> : permet d’activer la fonction BLC (CCJ).

& <Off> : permet de désactiver la fonction BLC
(CCY).

5. Pour quitter le menu, appuyez sur le bouton
[MENU].

@ L'icone de la fonction sélectionnée (@) s’
affiche.

@ Aucune icone ne s'affiche lorsque <Off> est
sélectionné.

[ Remarques ]

% La fonction BLC (CCJ) est automatiquement
désactivée lorsque le caméscope Sport est mis
hors tension.

% Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).
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Impostazione della BLC (compensazione controluce)

La funzione di compensazione del controluce aiuta
a rendere piu luminoso il soggetto quando questo
si trova davanti ad una finestra o quando & troppo
scuro per essere distinto. E possibile utilizzare
questa funzione quando si utilizza la videocamera
su uno sfondo molto luminoso (ad esempio scene
con la neve) .

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di
registrazionevideo.
2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
@ Viene visualizzata la schermata Photo
Capture (Cattura foto).
3. Premere il tasto [MENU]. Spostare il [Joystick]
a sinistra / a destra per selezionare <BLC>
4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
4 <On> : La funzione di compensazione del
controluce viene attivata.
& <Off> : La funzione di compensazione del
controluce viene annullata.
5. Premere il tasto [MENU] per uscire dal menu.
@ Viene visualizzata l'icona della funzione
selezionata (
@ Selezionando <Off>, non viene visualizzata
nessun’icona.

[ Note ]

% La funzione BLC & impostata su <Off> se la
videocamera Sport € spenta.

< Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).



Mode Photo :
Réglage des options de prise

Modalita Photo (Foto):
Impostazione delle opzioni di ripresa

Réglage du zoom numérique

Comme pour le zoom optique 10x, ce camescope Sport o éz/A

prend en charge le zoom numériqu e10x, qui permet d’
obtenir au total un zoom 100x. Endépassant la limite du
zoom optique, vousactiverez automatiquement le zoom
numeérique, s'il est disponible. Les photos obtenues a
I'aide du zoom numérique peuvent présenter un grain.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L'écran Movie Record (Enregistrement de film)
apparait.

2. Sélectionnez le mode Photo en appuyant sur le
bouton [MODE].
4 L’écran Photo Capture (Prise photo) apparait.

3. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <Digital Zoom>
(Zoom num.).

4. Déplacez le [Joystick] vers le haut ou vers

le bas pour sélectionner une option, puis

appuyez sur [Joystick(OK)].

4 <On>: permet d’activer le zoom numérique.
Lorsque vous essayez d’effectuer un zoom
10x, le zoom numérique est automatiquement
appliqué (grossissement jusqu’a 100x)

& <Off> : permet de désactiver le zoom numérique.
Seul le zoom optique 10x est pris en charge.

5. Pour quitter le menu, appuyez sur le bouton
[MENU].

@ Lorsque vous utilisez 'interrupteur du zoom

numérique, un indicateur s’affiche a I'écran.

&Remarque ]
Lorsque I'écran de menu s'affiche, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Photo Capture (Prise photo).

Impostazione dello zoom digitale

Oltre allo zoom ottico 10x, questa videocamera
Sport supporta uno zoom digitale 10x che produce
uno zoom totale di 100x. Se lo zoom ottico supera

il limite, lo zoom digitale (se disponibile) si attiva

i automaticamente. Lo zoom digitale pud produrre un’
immagine sgranata.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di
registrazionevideo.

2. Premendo il tasto [MODE], impostare la
modalita Photo (Foto).
@ Viene visualizzata la schermata Photo
Capture (Cattura foto).

3. Premere il tasto [MENU]. Spostare il [Joystick]
GDMove  EDSelect EEMExit a sinistra / a destra per selezionare <Digital
Zoom> (Zoom Digitale).

4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
4 <On> : Lo zoom digitale viene attivato. Se si
tenta di utilizzare lo zoom a piu di 10x, viene
O automaticamente applicato lo zoom digitale
(fino a 100x).
Eiove  [MSelect [EWExit & <Off> : Lo zoom digitale viene disattivato.
Per lo zoom viene supportato solo lo zoom
ottico 10x

5. Premere il tasto [MENU] per uscire dal menu.
@ Se si utilizza l'interruttore di zoom digitale,
sulla schermata viene visualizzato un
indicatore di zoom digitale.

[ Nota ]

< Quando viene visualizzata la schermata del
menu, premendo il tasto di registrazione/di
arresto si passa alla modalita Photo Capture
(Cattura foto).

Dlgltal Zoom
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Mode Photo : Modalita Photo (Foto):

, . y . . A T I . .
Réglage des options d’affichage Impostazione delle opzioni di visualizzazione
Suppression de fichiers photo Eliminazione dei file di immagine
Vous pouvez supprimer des fichiers photo enregistrés. E possibile eliminare i file di immagine salvati.
1. Appuyez sur le bouton [POWER] pour allumer le —~ [PLAY]| 1. Per attivare la videocamera Sport, premere il tasto di
caméscope Sport. ,y button [ACCENSIONE].
4 L’écran Movie Record (Enregistrement de film) 4 v 4 Viene visualizzata la schermata di registrazione video.
apparait. @/ 2. Premendo il tasto [MODE], impostare la modalita
2. Sélectionnez le mode Photo en appuyant sur le Photo (Foto).
bouton [MODE]. . ¢ Viene visualizzata la schermata Photo Capture
@ L’écran Photo Capture (Prise photo) apparait. [Joystick(OK)] (Cattura foto).
3. Appuyez sur le bouton [PLAY] ou [Joystick(OK)]. 3. Premere il tasto [PLAY] o [Joystick(OK)].

4 Permet d'activer le mode Photo View (Aff. photo).
4 Sélectionnez la photo de votre choix & I'aide du [Joystick].

Suppression de fichiers photo en affichage plein écran
Appuyez sur le bouton [DELETE] de I’écran LCD.

5. Sélectionnez une option en déplacant le [Joystick]
vers le haut ou vers le bas puis appuyez sur
[Joystick(OK)].

4 <OK>: permet de supprimer le fichier photo
sélectionné a I'aide de [Joystick(OK)].
4 <Cancel> (Annul.) : permet d’annuler la suppression.

6. Pour quitter le menu, appuyez sur le bouton [MENU].

4 Sipassa alla modalita Photo View (Visual. foto).
4 Utilizzando il [Joystick], spostarsi sul file di immagine
desiderato.

Eliminazione dei file di immagine a schermo intero

4. Premere il tasto [DELETE] sul display LCD.
5. Selezionare un’opzione spostando il [Joystick] su o
giu, quindi premere [Joystick(OK)].
4 <OK> : L'immagine selezionata viene eliminata
utilizzando [Joystick(OK)].
4 <Cancel> (Annul) : L’eliminazione viene annullata.
6. Premere il tasto [MENU] per uscire dal menu.

Suppression de fichiers photo en affichage multiple [“"{{[c] Eliminazione dei file di immagine in visualizzazione multipla

4. Faites glisser I'interrupteur [W/T] sur W (WIDE). 4. Far scorrere l'interruttore [W/T] su W (LARGO).

4 L'écran a affichage multiple apparait. 4 La schermata passa alla visualizzazione multipla.

Appuyez sur le bouton [DELETE] de I'écran LCD. Premere il tasto [DELETE] sul display LCD.

Sélectionnez une option en déplacant le [Joystick] Selezionare un’opzione spostando il [Joystick] su/

vers le haut ou vers le bas puis appuyez sur giu, quindi premere [Joystick(OK)].

[Joystick(OK)]. & <OK> : Il file di immagine selezionato viene eliminato.

* <('TK> : permet de supprimer le fichier photo Eove X View ¢ <Multi Select> (Multi selez.): Utilizzando il
sélectionné. . . ' . [Joystick(OK)] si possono selezionare pili file di

* <r|\]/|lil|t' SeIeCtrA(tsele’(Tt "t!um)j plusieurs fl(t?h'ETS or immagine. < v > viene visualizzato sui file selezionati.
pnoto peuvent etre selectionnes en meme temps a Per eseguire I'eliminazione, premere il tasto [PLAY] .
aide de [Joystick(OK)]. Le témoin < v > apparait sur @ <All> (Tutti) : Tutti i file di immagine vengono eliminati.
les fichiers sélectionnés. Appuyez sur le bouton [PLAY] ¢ <Cancel> (Annul) : L'eliminazione viene annullata.
pour supprimer les fichiers.

@ <All> (Tt) : Tous les fichiers photos sont supprimés.

4 <Cancel> (Annul.) : permet d’annuler la suppression.

[ Remarques ]

< Les fichiers verrouillés ne seront pas supprimés.

< Lorsque 'écran de menu s’affiche, le fait d’appuyer sur le
bouton [Record / Stop] permet d’accéder au mode Photo

t Capture (Prise photo).

5.
6.

oo

[ Note ]

% | file bloccati non vengono eliminati.

< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa alla
modalita Photo Capture (Cattura foto).

EBMove I3 Select




Mode Photo :
Réglage des options d’affichage

Modalita Photo (Foto):
Impostazione delle opzioni di visualizzazione

Réglage du diaporama

Vous pouvez activer un diaporama et également en régler les options d'intervalle

Impostazione della proiezione delle diapositive

E possibile impostare una proiezione delle diapositive e le relative opzioni

et de répétition.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
# L’écran Movie Record (Enregistrement de film) apparait.
2. Sélectionnez le mode Photo en appuyant sur le bouton
[MODE].
4 L'écran Photo Capture (Prise photo) apparait.
3. Appuyez sur le bouton [PLAY] ou [Joystick(OK)].
4 Permet d'activer le mode Photo View (Aff. photo).
4 Sélectionnez la photo de votre choix a I'aide du [Joystick].
4. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Slide> (Diapo).
5. Sélectionnez <Interval (sec.)> (Interv. (s.)) en déplacant
le [Joystick] vers le haut ou vers le bas puis appuyez sur
[Joystick(OK)].
6. Réglez I'intervalle en déplacant le [Joystick] vers le haut
ou vers le bas puis appuyez sur [Joystick(OK)].
4 Intervalles possibles : 1 ~ 10 secondes.
7. Sélectionnez <Repeat> (Répét.) en déplacant le [Joystick]
vers le haut ou vers le bas puis appuyez sur [Joystick(OK)]
8. Réglez I'option de répétition en déplacant le [Joystick]
vers le haut ou vers le bas puis appuyez sur
[Joystick(OK)].
4 <Off>: Ainsi réglée, cette fonction évite la répétition du
diaporama.
4 <On>: Ainsi réglée, cette fonction permet la répétition du
diaporama.
9. Sélectionnez <Start> (Dém.) en déplacant le [Joystick]
vers le haut ou vers le bas puis appuyez sur [Joystick(OK)]
4 Le diaporama démarre. Pour arréter le diaporama,
appuyez sur [Joystick(OK)].

Remarques ]

L'intervalle entre les photos peut varier en fonction de la taille
des photos.

Le diaporama commence dés la premiére photo affichée.

Le diaporama ne peut pas démarrer & partir d'un fichier photo

P B

Lorsque I'écran de menu s'affiche, le fait d’appuyer sur le
bouton [Record / Stop] permet d’accéder au mode Photo
Capture (Prise photo).

endommagé. Le diaporama sautera les photos endommagées.

(intervallo e ripetizione).
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Per attivare la videocamera Sport, premere il tasto di

[ACCENSIONE].

4 Viene visualizzata la schermata di registrazione video.

Premendo il tasto [MODE], impostare la modalita

Photo (Foto).

4 Viene visualizzata la schermata Photo Capture (Cattura foto).

Premere il tasto [PLAY] o [Joystick(OK)].

4 Sipassa alla modalita Photo View (Visual. foto).

4 Utilizzando il [Joystick], spostarsi sul file di immagine
desiderato

Premere il tasto [MENU]. Spostare il [Joystick] a

sinistra / a destra per selezionare <Slide> (Diapositiva).

Selezionare <Interval (sec.)> spostando il [Joystick]

su /giu, quindi premere [Joystick(OK)].

Impostare l'intervallo spostando il [Joystick] su / giu

quindi premere [Joystick(OK)].

4 Range intervallo: 1 ~ 10 secondi.

Selezionare <Repeat> (Ripetiz.) spostando il [Joystick]

su /giu, quindi premere [Joystick(OK)].

Impostare I'opzione di ripetizione spostando il

[Joystick] su/giu, quindi premere [Joystick(OK)].

4 <Off> : Imposta 'opzione di non ripetizione della
proiezione delle diapositive.

4 <On> : Imposta I'opzione di ripetizione della proiezione
delle diapositive

Selezionare <Start> (Avvia) spostando il [Joystick]

su /giu, quindi premere [Joystick(OK)].

4 Viene awviata la proiezione delle diapositive Per arrestare
la proiezione delle diapositive, premere [Joystick(OK)].

[ Note ]

L'intervallo tra le immagini puo variare a seconda della
dimensione della foto.

La proiezione delle diapositive parte dallimmagine
visualizzata in un determinato momento.

La proiezione delle diapositive non pud partire da un file
di immagine danneggiato. Durante la proiezione delle
diapositive le immagini danneggiate vengono saltate.
Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa alla
modalita Photo Capture (Cattura foto).



Mode Photo :
Réglage des options d’affichage

Modalita Photo (Foto):
Impostazione delle opzioni di visualizzazione

Réglage de Ia fonction DPOF (Digital Print Order Format -
protocole de commande d’impression numeérique)

Vous pouvez imprimer automatiquement un fichier photo enregistré si votre
imprimante prend en charge la fonction DPOF.
La fonction DPOF (Digital Print Order Format - protocole de commande d'
impression numérique) n'est disponible que lorsque vous utilisez une carte
mémoire.
Insérez la carte mémoire dans le caméscope Sport, par la fente prévue a cet effet.
2. Appuyez sur le bouton [POWER] pour allumer le caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.
3. Sélectionnez le mode Photo en appuyant sur le bouton [MODE].
4 L'écran Photo Capture (Prise photo) apparait.
4.  Appuyez sur le bouton [PLAY] ou [Joystick(OK)].
4 Permet d'activer le mode Photo View (Aff. photo).
4 Sélectionnez la photo de votre choix a l'aide du [Joystick].

Réglage de la fonction DPOF (Digital Print Order Format - protocole
de commande d'impression numérique) en affichage plein écran

5. Appuyez sur le bouton [MENU]. Déplacez le [Joystick] vers la gauche ou

la droite pour sélectionner <DPOF>. F

6. Sélectionnez une option en deplagant le [Joystick] vers le haut ou vers le &
bas puis appuyez sur [Joystick(OK]

4 <Copies>: Déplacez le [Joysﬁck] vers le haut ou vers le bas pour
sélectionner le nombre de copies que vous souhaitez imprimer et appuyez
sur [Joystick(OK)]. (nombre de copies possible : 0 ~30)

4 <Off> : permet d'annuler limpression avec la fonction DPOF.

7. Pour quitter le menu, appuyez sur le bouton [MENU].

Réglage de la fonction DPOF (Digital Print Order Format - protocole
de commande d’impression numérique) en affichage multiple

5. Faites glisser I'interrupteur [W/T] sur W (WIDE).
4 L'écran a affichage multiple apparait.
6.  Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour sélectionner
<DPOF>.
7. Sélectionnez une option en deplagant le [Joystick] vers le haut ou vers le
bas puis appuyez sur [Joystick(OK
<Copies> : Déplacez le [Joysllck] vers le haut ou vers le bas pour
sélectionner le nombre de copies que vous souhaitez imprimer et
appuyez sur [Joystick(OK)]. (nombre de copies possible : 0 ~ 30)
4 <set All> (Déf. tt) : Tous les fichiers photo seront repérés par le symbole
de l'impression DPOF.
4 <Reset All> (Réinit. Tt) : Tous les fichiers photos sont réinitialisés.
8.  Pour quitter le menu, appuyez sur le bouton [MENU].

[ Remarques ]

% Licone < &> de la fonction DPOF s'affiche sur les photos concemées.

% Reportez-vous & la page 130 pour plus de détails sur l'impression des fichiers
a 'aide de la fonction DPOF.

4  Lorsque I'écran de menu s'affiche, le fait d’appuyer sur le bouton [Record /
Stop] permet d'accéder au mode Photo Capture (Prise photo).

Impostazione della funzione DPOF (Digital Print Order Format)

Un file di immagine memorizzato pud essere automaticamente
stampato con una stampante che supporti il formato DPOF.
L'impostazione di DPOF ¢ disponibile solo se si utilizza una
scheda di memoria.
1. Inserire la scheda nello slot per la scheda di memoria della
videocamera Sport.
2. Per attivare la videocamera Sport, premere il tasto di
[ACCENSIONE].
4 Viene visualizzata la schermata di registrazione video.
3. Premendo il tasto [MODE], impostare la modalita Photo (Foto).
4 Viene visualizzata la schermata Photo Capture (Cattura foto).
4. Premere il tasto [PLAY] o [Joystick(OK)].
4 Sipassa alla modalita Photo View (Visual. foto).
¢ Utilizzando il Joystick, spostarsi sul file di immagine desiderato

Impostazione di DPOF a schermo intero
5. Premere il tasto [MENU]. Sy e il [Joystick] a sinistra/ a
destra per selezionare <DPOF>.
6. Selezionare un’opzione spostando il [Joystick] su o giu,
quindi premere [Joystick(OK)].

4 <Copies> (Copie) : Spostare il [Joystick] su / gil per
selezionare il numero di copie da stampare e premere
[Joystick(OK)]. (copie: 0 ~ 30)
<Off> : La stampa DPOF viene annullata.

7. Premere il tasto [MENU] per uscire dal menu.

Impostazione di DPOF in visualizzazione multipla

5. Far scorrere I'interruttore [W/T] su W (LARGO).
4 Laschermata passa alla visualizzazione multipla.
6. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per selezionare <DPOF>,
7. lezi ‘e un’opzi P do il [Joystick] su o giu,
quindi premere [Joystick(OK)].

4 <Copies> (Copie) : Spostare il [Joystick] su / g per
selezionare il numero di copie da stampare e premere
[Joystick(OK)]. (copia: 0 ~ 30)

4 <Set All> (Imposta tutto) : Tutti i file di immagine vengono
marcati con la stampa DPOF.

4 <Reset All> (Reimposta tutto) : Tutte le immagini vengono
reimpostate.

8. Premere il tasto [MENU] per uscire dal menu.

[ Note ]

% < [ > viene visualizzata sulle immagini con impostazione DPOF.

< Per ulteriori dettagli sulla stampa dei file DPOF, vedere a pagina 130.

4 Quando viene visualizzata la schermata del menu, premendo il tasto di registrazione/
di arresto si passa alla modalita Photo Capture (Cattura foto).




Mode Photo :
Réglage des options d’affichage

Modalita Photo (Foto):
Impostazione delle opzioni di visualizzazione

Verrouillage de fichiers photo

Vous pouvez protéger les fichiers photos enregistrés importants
contre la suppression accidentelle. Les fichiers protégés ne
peuvent étre supprimés, sauf si vous retirez la protection ou
formatez la mémoire.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L’écran Movie Record (Enregistrement de film) apparait.
2. Sélectionnez le mode Photo en appuyant sur le bouton
[MODE].
4 L’écran Photo Capture (Prise photo) apparait.
3. Appuyez sur le bouton [PLAY] ou [Joystick(OK)].
4 Permet d'activer le mode Photo View (Aff. photo).
4 Sélectionnez la photo de votre choix a 'aide du [Joystick].

Verrouillage des fichiers photo en affichage plein écran
4. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Lock> (Verr).

5. Appuyez sur [Joystick(OK
pp Zrmet de[ ve‘r’rounller le pchler photo sélectionné.

0 Appuyez sur le bouton [MENU] a nouveau pour le
déverrouiller.

Verrouillage des fichiers photo en affichage multiple

4. Faites glisser I'interrupteur [W/T] sur W (WIDE).
4 L’écran a affichage multiple apparait.
5. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Lock> (Verr).
6. Sélectionnez une option en déplacant le [Joystick] vers
le haut ou vers le bas puis appuyez sur [Joystick(OK)].
4 <Lock> (Verr) : Permet de verroviller le fichier photo
sélectionné a I'aide de [Joystick(OK)].
4 <Multi Select> (Sélect multi) : plusieurs fichiers
photo peuvent étre sélectionnés en méme temps a I’
aide de [Joystick(OK)]. Le témoin <& > apparait sur
les fichiers sélectionnés. Appuyez sur le bouton [PLAY]
pour verrouiller les fichiers.
@ <Lock All> (Ver. tt) : tous les fichiers photo sont verrouillés.
4 <Unlock All> (Dév. Tout) : déverrouillage de tous les
fichiers photos.
[ Remarques ]
% Llicone < @& > s'affiche sur le fichier verrouillé.
% Lorsque I'écran de menu s’affiche, le fait d'appuyer sur

le bouton [Record / Stop] permet d’accéder au mode Photo Capture (Prise

photo).

EBSelect ([EW ﬁ[{it

Protezione dei file di immagine

Importanti file di immagine archiviati possono essere protetti
da eliminazioni accidentali | file protetti non vengono eliminati
a meno che la protezione non venga sbloccata o la memoria
4 non venga formattata.

1. Per attivare la videocamera Sport, premere il tasto di
[ACCENSIONE].
4 Viene visualizzata la schermata di registrazione video.
2. Premendo il tasto [MODE], impostare la modalita Photo (Foto).
4 Viene visualizzata la schermata Photo Capture (Cattura foto).
3. Premere il tasto [PLAY] o [Joystick(OK)].
4 Sipassa alla modalita Photo View (Visual. foto).
4 Utilizzando il Joystick, spostarsi sul file di immagine desiderato

Protezione dei file di immagine a schermo intero

# 4. Premere il tasto [MENU]. Spostare il [Joystick] a
sinistra / a destra per selezionare <Lock> (Prot).
5. Premere [Joystick(OK)].
4 Blocca il file di immagine selezionato.
4 Premere nuovamente il tasto [MENU] per impostare lo
sblocco.

Protezione dei file di immagine in visualizzazione multipla

4. Far scorrere l'interruttore [W/T] su W (LARGO).

4 La schermata passa alla visualizzazione multipla.

5. Premere il tasto [MENU].

Spostare il [Joystick] a sinistra / a destra per

selezionare <Lock> (Prot).

6. Selezionare un’opzione spostando il [Joystick] su o
giu, quindi premere [Joystick(OK)].

4 <Lock> (Prot) : Il file di immagine selezionato viene
bloccato utilizzando [Joystick(OK)].

4 <Multi Select> (Multi selez.) : Il file di immagine
selezionato viene selezionato utilizzando [Joystick(OK)].
Premere il tasto [PLAY] per applicare il blocco< &) >.

4 <Lock All> (Blocca tutto) : Protegge tutti i file di
immagine.

4 <Unlock All> (Sblocca tutto) : Sblocca tutti i file di
immagine.

Note ]

Sul file bloccato viene visualizzata licona < (3 >.

* Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa alla modalita Photo Capture

(Cattura foto). E

CTView



Mode Photo :
Réglage des options d’affichage

Modalita Photo (Foto):
Impostazione delle opzioni di visualizzazione

Copie de fichiers photo

Vous pouvez copier des fichiers enregistrés de la mémoire
interne vers la carte mémoire et vice-versa.

1. Insérez la carte mémoire dans le caméscope Sport, par
la fente prévue a cet effet.

2. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L’écran Movie Record (Enregistrement de film) apparait.

3. Sélectionnez le mode Photo en appuyant sur le bouton
ODE;

4 L’écran Photo Capture (Prise photo) apparait.
3. Appuyez sur le bouton [PLAY] ou [Joystick(OK)].
4 Permet d'activer le mode Photo View (Aff. photo).
4 Sélectionnez la photo de votre choix a l'aide du [Joystick].

Copie des fichiers photo en affichage plein écran

5. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Copy To> (Cop sur).

6. Appuyez sur [Joystick(OK)].
4 Permet de copier le fichier photo sélectionné.

Copie des fichiers photo en affichage multiple

5. Faites glisser I'interrupteur [W/T] sur W (WIDE).

4 L’écran a affichage multiple apparait.
6. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Copy To> (Cop sur).
7. Sélectionnez une option en déplacant le [Joystick] vers
le haut ou vers le bas puis appuyez sur [Joystick(OK)].
4 <OK>: permet de copier le fichier photo s€lectionné.
4 <Multi Select> (Sélect multi) : Plusieurs fichiers
photo peuvent étre sélectionnés en méme temps a I
aide de [Joystick(OK)]. Le témoin < v > apparait sur
les fichiers sélectionnés. Appuyez sur le bouton [PLAY]
pour copier les fichiers.
4 <All> (Tt) : Tous les fichiers photo sont copiés.

[ Remarques ]
Le caméscope Sport permet de copier a partir de la mémoire

Copia dei file di immagine

=T | file archiviati possono essere copiati dalla memoria interna a
100%01; una scheda di memoria e viceversa.
1. Inserire la scheda nello slot per la scheda di memoria
della videocamera Sport.
v 2. Per attivare la videocamera Sport, premere il tasto di
[ACCENSIONE].
4 Viene visualizzata la schermata di registrazione video.
3. Premendo il tasto [MODE], impostare la modalita Photo
(Foto).
¢ Viene visualizzata la schermata Photo Capture (Catturafoto).
4. Premere il tasto [PLAY] o [Joystick(OK)]
4 Sipassa alla modalita Photo View (Visual. foto).
4 Utilizzando il Joystick, spostarsi sul file di immagine
desiderato

Copia dei file di immagine a schermo intero
5. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Copy To> (Copia su).
Premere [Joystick(OK)].
4 |l file di immagine selezionato viene copiato.

Copia dei file di inmagine in visualizzazione multipla

5. Far scorrere I'interruttore [W/T] su W (LARGO).
4 Laschermata passa alla visualizzazione multipla.
6. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per
selezionare <Copy To> (Copia su).
7. Selezionare un’opzione spostando il [Joystick] su o
glu quindi premere [Joystick(OK)].
<OK> : Il file di immagine selezionato viene copiato.
0 <Multi Select> (Multi selez.) : Utilizzando il
[Joystick(OK)] si possono selezionare piu file di
immagine. < ¢ > viene visualizzato sui file selezionati.
Per copiare, premere il tasto [PLAY].
4 <All> (Tutti) : Tutti i file di immagini vengono copiati.

[ Note ]

< Con la videocamera Sport & possibile copiare dalla
memoria utilizzata correntemente su un‘altra memoria. Se
la memoria interna & utilizzata, la copia viene eseguita su

en cours d'utilisation vers une autre mémoire. Si la mémoire Prese Ot sl una scheda di memoria.

interne était utilisée, la copie est effectuée vers une carte [ Cancel M| < Se non viene inserita una scheda di memoria, la funzione
meémoire. o . <Copy To> (Copia su) non puo essere eseguita.

Si la carte mémoire n'est pas insérée, vous ne pouvez pas S Move [WSelect  [EMExit % Quando viene visualizzata la schermata del menu, premendo

utiliser la fonction <Copy To> (Cop sur).
Lorsque I'écran de menu s'affiche, le fait d’appuyer sur le bouton [Record /
A Stop] permet d’accéder au mode Photo Capture (Prise photo).

il tasto di registrazione/di arresto si passa alla modalita Photo
Capture (Cattura foto).



3 3 ) Mode WP3
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Enregistrement des fichiers MP3 dans le caméscope Sport...76
Copie de fichiers MP3 Dans le caméscope Sport.. .76
LeCture ..o 77
Lecture de fichiers MP3

Réglage des options de lecture MP3 .78
Suppression de fichiers MP3 ... 78
Réglage de la fonction de lecture répétée...........ccoovieuninnnne. 79
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Verrouillage de fichiers MP3 ... 81
Copie de fichiers MP3........cccoiririnecsecseseeeeecinenes 82

¢ Sauvegardez les données et enregistrements importants sur un
autre support afin d’éviter les pertes accidentelles provoquées
par une défaillance du systéme ou toute autre raison.

Comment régler le mode MP3

@)
vew [ Bouton
. Power
u“ @) s
Moo
@)
1. Appuyez sur le bouton 2. Sélectionnez le mode
[POWER] pour allumer le MP3 en appuyant sur le
caméscope Sport. bouton [MODE].

3 3 ) Modalita MP3
al

Archiviare file MP3 nella Sports camcorder................... 76
Copiare file MP3 nella Sports Camcorder ............c..c.... 76
RIProduzione ... 77
Riproduzione file MP3..........cccoocvuvicnnee. 77
Impostare le opzioni di riproduzione MP3 ... .. 78
Cancellare file MP3 ........cccocoovviviierrennes .. 78
Impoostare la riproduzione Repeat...........cccoecueuvicericens 79
Impostare 'equalizzatore...........ccoceerrrrencecsinssnens 80
Bloccare i file MP3 ... 81
Copiare i file MP3........cooiircrcntericnceeeens 82

4 Salvare dati/registrazioni importanti separatamente su
altri supporti, per evitare la perdita accidentale causata da
guasti al sistema o da altre ragioni.

Modalita MP3

‘ w
o v | Tastoci
.-‘,:‘ N\ accensione

1. Per attivare la videocamera 2. Premendo il tasto
Sport, premere il tasto di [MODE], impostare
accensione. la modalita MP3.

PN



Mode MP3 : Enregistrement des
fichiers MP3 dans le caméscope Sport

Modalita MP3: Archiviare file
MP3 nella Sports camcorder

Copie de fichiers MP3 Dans le caméscope Sport

Vous pouvez copier des fichiers mp3 d'un ordinateur vers le caméscope Sport si les
deux appareils sont reliés a I'aide d’un cable USB.

Copiare file MP3 nella Sports Camcorder

Collegando la videocamera Sport al PC con un cavo USB & possibile copiare file MP3 .

Prima di iniziare!

Avant de commencer !

4 Vous pouvez copier des fichiers MP3 lorsque
<USB Mode> (Mode USB) est réglé sur <Mass
Storage> (Mém. aux.) =page 98

Appuyez sur le bouton [POWER] pour allumer le

caméscope Sport.

4 L’écran Movie Record (Enregistrement de film)
apparait.

2. Raccordez le éscope Sport a I'ordi a

I'aide du cable USB fourni.

@ A - Reliez le cable USB au caméscope Sport.

4 B - Reliez l'autre extrémité du cable USB a
l'ordinateur.

3. Faites un double-clic sur le nouveau lecteur
amovible pour I'ouvrir.
4. Sélectionnez le dossier MUSIC et faites un double-

¢ | file MP3 possono essere copiati impostando
<USB Mode (Mod. USB)> su <Mass Storage>
w=Pagina 98
1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione video.
2. Collegare la videocamera Sport al PC utilizzando
il cavo USB fornito.
4 A-Collegare il cavo USB alla videocamera
Sport.
4 B-Collegare altra estremita del cavo USB al PC.
3. Fare doppio clic sulla nuova unita removibile per
aprirla.
4. Selezionare la cartella MUSIC e fare doppio clic

clic pour y accéder.
5. Faites un glisser-déposer du fichier MP3 contenu
dans votre ordinateur vers le dossier MUSIC.
4 La mémoire musicale a une capacité maximale
de 2 000 fichiers MP3.

Débranchement du cable USB
Une fois le transfert de données achevé, vous devez
debrancher le cable comme suit.

Cliquez avec le bouton droit de la souris sur 'icéne
du disque amovible et sélectionnez ‘Safely Remove

Hardware’ (Retirer le périphérique en toute sécurité). _"'-* =3 e
2. Sélectionnez ‘Stop’ (Arrét) et débranchez le cable =t
USB lorsque la fenétre contextuelle disparait. ] dimaaenciliy
[ Avertissement ] LT
% La copie et la redistribution des fichiersMP3 peuvent | =

constituer une violation de la Iégislation sur les droits
d'auteur.

per aprirla.
5. Trascinare il file MP3 dal PC alla cartella MUSIC.
4 La capacita di memoria per la musica € di max.
2000 file MP3.

Scollegare il cavo USB

Una volta completato il trasferimento dei dati, scollegare il

cavo nel modo seguente.

1. Selezionare licona del disco rimovibile, fare clic con il
tasto destro del mouse, quindi selezionare ‘Rimozione
sicura del’hardware’.

2. Selezionare ‘Stop’ e scollegare il cavo USB quando
viene visualizzata la finestra a comparsa.

[Avvertenza]
< La copia e la distribuzione di file MP3 potrebbero

rappresentare una violazione della legge sul copyright.
% Non & possibile creare una nuova cartella nella

< Vous ne pouvez pas créer un nouveau dossier sur
votre caméscope Sport.

[ Remarques ]

< Vous pouvez copier un dossier sur votre caméscope Sport.

< Pour connaitre la capacité des fichiers MP3
correspondant a celle de la mémoire du caméscope
Sport =page 32.

& Il'est recommandeé d'utiliser un adaptateur CA durant

videocamera Sport.

[ Note ]

% E possibile copiare una cartella nella videocamera Sport.

< Per vedere la capacita del file MP3 in relazione alla
capacita di memoria della videocamera Sport.
=Pagina 32.

< Durante il trasferimento si raccomanda di utilizzare
un alimentatore CA per evitare un’interruzione

le transfert des fichiers pour éviter tout risque
A d'interruption de I'appareil involontaire en cas de
batterie faible.

involontaria dell'alimentazione dovuta alla batteria
scarica.



Mode MP3 : Lecture

Modalita MP3: Riproduzione

Lecture de fichiers MP3

Vous pouvez lire des fichiers MP3 enregistrés.
1. Appuyez sur le bouton [POWER] pour allumer le caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.
2. Sélectionnez le mode //P3 en appuyant sur le bouton [MODE].
4 Laliste de lecture MP3 s'affiche.
4 Siaucun fichier MP3 n'est enregistré, le message “No Files....”
(0 FCH) apparait.
3.  Sélectionnez le fichier MP3 que vous voulez lire en déplacant le

[Joystick] vers le haut ou vers le bas, puis appuyez sur [Joystick(OK)].

4.  Le fichier MP3 sélectionné est lu.
4 Chagque pression sur le bouton [PLAY] ou sur [Jostick(OK)] permet
alternativement de lire le fichier et de passer en mode Pause.

4 Pour régler le volume, déplacez le [Joystick] vers le haut ou vers le bas.

L'échelle de volume apparait et disparait aprés quelques secondes.

Utilisation du joystick (gauche/droite)

Déplacez le [Joystick] vers la gauche
4 Aubout de 2 secondes de lecture : le fichier précédent est lu.
4 Enmode Pause/Stop (Pause/Arrét) : le fichier précédent s’
affiche.
4 Aubout de 2 secondes de lecture : le fichier en cours est relu
depuis le début.
Déplacez le [Joystick] vers la droite
En cours de lecture : le fichier suivant est lu.
¢ Enmode Pause/Stop (Pause/Arrét) : le fichier suivant s'affiche.
4 Pendant la lecture, appuyez longuement sur [Joystick(OK)] vers
la gauche ou vers la droite pour effectuer une recherche vers
I'avant ou vers |'arriére sur le fichier MP3 en cours de lecture.

Riproduzione file MP3

| file MP3 memorizzati possono essere riprodotti.

EINfI 1. Per attivare la videocamera Sport, premere il tasto di
[ACCENSIONE].
v - 4 Viene visualizzata la schermata di registrazione video.

& Lifeis cool.mp3 2. Premendo il tasto [MODE], impostare la modalita 1P3.
& Everytime.mp3 4 Viene visualizzata la sequenza di brani MP3.
& Toxic.mp3 ¢ Se non e stato memorizzato nessun file MP3, viene visualizzato il

< messaggio “No Files..." (No file...).
¢ Don't push me.mp3 3. Selezionare un file MP3 da riprodurre spostando il [Joystick] su o
& Love you.mp3 giu, quindi premere [Joystick(OK)].

4. Il file MP3 selezionato viene riprodotto.
Biilove EI3 Play: 4 Ogni volta che si preme il tasto [PLAY] o [Joystick(OK)] si

selezionano la riproduzione o la pausa. o
4 Perregolare il volume, spostare il [Joystick] su o giu. Viene

n visualizzato l'indicatore del volume, che scompare dopo pochi
secondi.

Life is cool.mp3 Utilizzo del Joystick (sinistro/destro)

Sweethox o Spostamemo del [Joystick] a sinistra

Entro 2 secondi dall'inizio della riproduzione - Viene riprodotto il

file precedente.

4 Nella modalita “Pause/Stop (Pausa/Arresta)” - Viene visualizzato
il file precedente.

4 2 secondi dopo ['inizio della riproduzione - Viene riavviato il file
corrente.

Spostamento del [Joystick] a destra

¢ Durante la riproduzione - Viene riprodotto il file successivo.

4 Nella modalita “Pause/Stop (Pausa/Arresta)” - Viene visualizzato
il file successivo.

¢ Durante la riproduzione, premere e tenere premuto [Joystick(OK)]

caméra externe HOLD) Hold
verrouillés, a I'exception du bouton Power et du bouton de volume.

cable External Camera Module (Module caméra externe) est branché.

Actionnement de I'interrupteur - [MP3/ External Camera Module HOLD] (MP3/ Module file MP3 riprodotto correntemente.

Si vous placez l'interrupteur [MP3/ External Camera Module HOLD], tous les boutons sont

Linterrupteur [MP3/ External Camera Module HOLD] ne fonctionne qu’en mode MP3 ou si le Facendo scorrere linterruttore HOLD [MP3/Modulo videocamera esterna ], tutti i tasti, tranne quelli

a destra/a sinistra per eseguire la ricerca in avanti o indietro sul

Impostazione della pausa - interruttore Hold - [MP3/Modulo videocamera esterna]

dellalimentazione e del volume, vengono bloccati.

[ Remarques ]

Les fichiers MP3 accompagnés d'étiquettes informatives affichent le nom de lartiste. Pour les

autres, 'élément reste vide.

LR

artiste risque de s'afficher de fagon erronée.

<

désactivé.
Le caméscope Sport ne prend en charge que les fichiers au format MP3.

pas étre lus. ) o )
La lecture ne démarre pas si le premier fichier est endommagé.

est le chinois.

de lecture et d'enregistrement peuvent différer des chiffres affichés.

B b P B

8 et 320Kbps.

Si un nom de fichier non reconnu s'affiche, essayez de le renommer sur un ordinateur. . e - 2
Si la langue définie est différente de celle des étiquettes informatives du fichier MP3, le nom de I informazioni sui tag lasciano lo spazio vuoto.

Lorsque les écouteurs, le cable audio/vidéo ou le cable External Camera Module (Module caméra
externe) sont branchés sur le caméscope Sport, le haut-parleur intégré est automatiquement

Les fichiers MP3 endommagés ou non conformes peuvent ne pas s'afficher correctement ou ne

Il est possible que e titre ne s'affiche pas si la langue n'est pas prise en charge ou si la langue
Les fichiers MP3 avec définition VBR s'affichent sous la forme VBR sur 'écran LCD. Les durées

Si le titre d’'une plage est trop long, il risque de ne pas apparaitre entierement sur 'écran LCD.
Le débit binaire et le débit binaire variable pris en charge pour un fichier MP3 sont compris entre

L'interruttore [HOLD MP3/Modulo videocamera esterna] & disponibile solo nella modalita MP3 o se
si collega un modulo videocamera esterna.

Note ]
Il file MP3 con le informazioni sui tag visualizza il nome dell'artista. | file MP3 che non contengono

Se viene visualizzato un nome file interrotto, provare a rinominarlo sul PC.

Se la lingua impostata non & la stessa di quella delle informazioni sul tag del file MP3, le
informazioni sull'artista potrebbero non essere visualizzate correttamente.

Se alla videocamera Sport vengono collegate delle cuffie, dei cavi audio/video o il cavo di un
modulo videocamera esterna, I'altoparlante integrato viene automaticamente disattivato.

La videocamera Sport supporta solo il formato file MP3.

| file MP3 danneggiati o non standardizzati potrebbero non essere visualizzati o riprodotti
correttamente.

La riproduzione non viene avviata se il primo file & danneggiato.

Il titolo pud non essere visualizzato se la lingua non & supportata o si tratta del cinese.

| file MP3 con impostazione VBR vengono visualizzati sul display LCD come VBR e l'ora di
riproduzione e quella di registrazione possono essere diverse dallo schema visualizzato.

Se il titolo di una traccia & troppo lungo, sul display LCD pud essere visualizzato tagliato. a

Sl Bl P P

Le velocita di trasmissione supportate per i file MP3 sono 8Kbps~320Kbps e VBR.




Mode MP3 :
Réglage des options de lecture MP3

Modalita MP3 : Impostare le

opzioni di riproduzione MP3

Suppression de fichiers MP3

Vous pouvez supprimer un fichier ou un groupe de fichiers MP3

sélectionnés.

1. Appuyez sur le bouton [POWER] pour allumer le

caméscope Sport.

4 L’écran Movie Record (Enregistrement de film)
apparait.

Sélectionnez le mode 11P3 en appuyant sur le

bouton [MODE].

4 La liste de lecture MP3 s’affiche.

@ Sélectionnez le fichier MP3 de votre choix a l'aide
du [Joystick].

& Don't
& Love

[EMove

Ji

Suppression de fichiers MP3 dans la liste de lecture MP3

3. Appuyez sur le bouton [DELETE] de I'écran LCD
en mode pause. Sélectionnez une option en
déplacant le [Joystick] vers le haut ou vers le bas
puis appuyez sur [Joystick(OK)F.

@ <OK> : permet de supprimer [e fichier MP3
sélectionné.

<Multi Select> (Sélect muilti) : plusieurs fichiers

MP3 peuvent étre sélectionnés en méme temps

en appuyant sur [iJoystick(OK)]. Le témoin< v >

apparait sur les fichiers sélectionnés. Appuyez

sur le bouton [PLAY].

¢ <All> (Tt) : Tous les fichiers MP3 sont supprimés.

4 <Cancel> (Annul.) : permet d'annuler la suppression.

OK
Multi Select
All

* EMove

Jd

Suppression de fichiers MP3 en plein écran St

3. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].
@ Le fichier MP3 sélectionné est lu.

4. Appuyez sur le bouton [DELETE] de I'écran LCD
en mode pause. Sélectionnez une option en
déplacant le [Joystick] vers le haut ou vers le bas
puis appuyez sur [Joystick(OK)].
@ <OK>: permet de supprimer le fichier MP3 sélectionné.
4 <Cancel> (Annul.) : permet d'annuler la suppression.

[ Remarques ]

% Les fichiers verrouillés ne seront pas supprimés.

< Vous ne pouvez pas accéder au menu pendant la
lecture.

a

(&S Search

|
OK

EMove

& Life is cool.mp3 i
& Everytime.mp3
& Toxic.mp3

T3 Play

 Stereo 144.1KHz[192Kbps|

» 00:00:00/00:03:27

| Cancel __jin

Cancellare file MP3
E possibile eliminare un file MP3 selezionato o un gruppo di file MP3.

1. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione
video.

Premendo il tasto [MODE], impostare la modalita

MP3.

4 Viene visualizzata la sequenza di brani MP3.

4 Utilizzando il [Joystick], spostarsi sul file MP3
desiderato.

£ NI

push me.mp3
you.mp3

Eliminazione dei file MP3 nella sequenza di brani MP3

3. Premere il tasto [DELETE] sul display LCD
mentre I'apparecchiatura e in pausa. Selezionare
un’opzione spostando il [Joystick] su o giu,
quindi premere [Joystick(OK)].

& <OK> : |l file MP3 selezionato viene eliminato.
4 <Multi Select> (Multi selez.) : Utilizzando il

[Joystick(OK)] si possono selezionare piu

file MP3. < ¢ > viene visualizzato sui file

selezionati. Premere il tasto [PLAY].

<All> (Tutti) : Tutti i file MP3 vengono eliminati.

<Cancel> (Annul) : L’eliminazione viene

annullata.

X3 Select

L R 4

Life is cool.mp3

Eliminazione dei file MP3 a schermo intero

3. Premere il tasto [PLAY] o [Joystick (OK)].
4 |l file MP3 selezionato viene riprodotto.
4. Premere il tasto [DELETE] sul display LCD
mentre I'apparecchiatura e in pausa. Selezionare
un’opzione spostando il [Joystick] su o gil,
quindi premere [Joystick(OK)].
4 <OK>: |l file MP3 selezionato viene eliminato.
4 <Cancel> (Annul) : L'eliminazione viene
annullata.

List [ Pause

Note ]
% | file bloccati non vengono eliminati.
% Durante la riproduzione non & possibile accedere al

ESelect menu.



Mode MP3 :

Réglage des options de lecture MP3

Modalita MP3: Impostare le
opzioni di riproduzione MP3

Réglage de la fonction de lecture répétée

Vous pouvez répéter un fichier MP3 sélectionné ou un groupe de
fichiers MP3 sélectionné ou lire les fichiers MP3 dans un ordre
aléatoire.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.
2. Sélectionnez le mode 11P3 en appuyant sur le bouton
[MODE].
4 Laliste de lecture MP3 s'affiche.
3. Appuyez sur le bouton [MENU] en mode pause.
Déplacez le [Joystick] vers la gauche ou vers la droite
pour sélectionner <Repeat> (Répét.).
4. Sélectionnez une option en déplacant le [Joystick] vers
le haut ou vers le bas puis appuyez sur [Joystick(OK)].
@ <Off> : Aucune répétition, chaque titre est lu une fois,
dans l'ordre du fichier MP3sélectionné.
<Repeat One> (Répéter un) : le fichier MP3
sélectionné est lu en continu.
<Repeat Folder> (Rép. dossier) : Tous les fichiers
contenus dans le dossier sont lus en continu.
<Repeat All> (Rép. tout) : Tous les fichiers MP3 sont lus
en boucle a partir du premier, dans le méme ordre.
<Shuffle Folder> (Lect. al. doss.) : Tous les fichiers
contenus dans le dossier sont lus dans un ordre aléatoire.
<Shuffle All> (Lect. al. tt) : tous les fichiers MP3 sont lus
une fois dans un ordre aléatoire.
ur quitter le menu, appuyez sur le bouton [MENU].
Sélectionnez le fichier MP3 du dossier souhaité a I'aide du
[Joystick].
L'option sélectionnée sera activée pendant la lecture du
fichier MP3.
Lorsque vous sélectionnez <Continuous Shot> (Phot. en
continu), vous ne pouvez pas utiliser le flash.
Lorsque I'écran de menu s'affiche, le fait d’appuyer sur le
bouton [Record / Stop] permet d’accéder au mode Photo
Capture (Prise photo).

* & & 6T & & o o o

[ Remarques ]

< Lorsque les écouteurs, le cable audio/vidéo ou le cable
External Camera Module (Module caméra externe) sont
branchés sur le caméscope Sport, le haut-parleur intégré est
automatiquement désactivé.

< Vous ne pouvez pas accéder au menu pendant la lecture.

E I

i
& Everytime.mp3
& Toxic.mp3
& Don't push me.mp3
& Love you.mp3
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Impoostare la riproduzione Repeat

E possibile ripetere un file MP3 o un gruppo di file MP3
selezionati o riprodurre i file MP3 in modo casuale.

1. Per attivare la videocamera Sport, premere il tasto
di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione video.

2. Premendo il tasto [MODE], impostare la modalita V/P3.
4 Viene visualizzata la sequenza di brani MP3.

3. Premere il tasto [MENU] mentre I'apparecchiatura &
in pausa. Spostare il [Joystick] a sinistra / a destra
per selezionare <Repeat> (Ripetiz.).

4. Selezionare un’opzione spostando il [Joystick] su o
giu, quindi premere [Joystick(OK)].
¢ <Off>: Non viene eseguita la ripetizione, ogni titolo

viene riprodotto una volta in sequenza dal file MP3
selezionato.
<Repeat One> (Ripeti uno) : Un file MP3
selezionato viene riprodotto ripetutamente.
<Repeat Folder> (Ripeti cartella) : Tutti i file nella
cartella vengono riprodotti ripetutamente.
<Repeat All> (Ripeti tutto) : Tutti i file MP3 vengono
riprodotti in ordine, per ripartire poi dall'inizio.
<Shuffle Folder> (Cartella casuale) : Tutti i file
nella cartella vengono riprodotti in modo casuale.
<Shuffle All> (Tutti casuali) : Tutti i file MP3
vengono riprodotti solo una volta in modo casuale.
remere il tasto [MENU] per uscire dal menu.

Spostare il file MP3 della cartella desiderata

utilizzando il [Joystick].

Durante la riproduzione del file MP3, viene applicata

I'opzione selezionata.

Viene visualizzata l'icona della funzione selezionata.

Selezionando <Off>, non viene visualizzata nessun’

icona

T ¢ ¢ ¢ o o

*e o o

[ Note ]

% Se alla videocamera Sport vengono collegate delle
cuffie, dei cavi audio/video o il cavo di un modulo
videocamera esterna, I'altoparlante integrato non
funziona.

% Durante la riproduzione non & possibile accedere al
menu.

a



Mode MP3 :

Réglage des options de lecture MP3

Modalita MP3: Impostare le
opzioni di riproduzione MP3

Réglage de I'égaliseur

Vous pouvez choisir un mode Equalizer (Egaliseur) selon les différents

types de musique.

1.

Appuyez sur le bouton [POWER] pour

allumer le caméscope Sport.

@ L’écran Movie Record (Enregistrement de
film) apparait.

Sélectionnez le mode /1P3 en appuyant sur
le bouton [MODE].
@ Laliste de lecture MP3 s’affiche.

Appuyez sur le bouton [MENU] en mode
pause. Déplacez le [Joystick] vers la gauche
ou la droite pour sélectionner <Equalizer>
(Egaliseur).

Sélectionnez une option en déplacant le

[Joystick] vers le haut ou vers le bas puis

appuyez sur [Joystick(OK)].

& <Off>/ <Pop> / <Classic> (Class.) /
<Jazz>

Pour quitter le menu, appuyez sur le bouton

[MENU].

4 Loption sélectionnée est désormais active.

@ Aucune icone ne s'affiche lorsque le mode
<Off> est sélectionné.

[ Remarque ]

L

A

Vous ne pouvez pas accéder au menu pendant
la lecture.
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Impostare I'equalizzatore
E possibile scegliere una modalita di equalizzatore per vari tipi di musica.

. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione
video.

. Premendo il tasto [MODE], impostare la

modalita 11P3.
@ Viene visualizzata la sequenza di brani MP3.

. Premere il tasto [MENU] mentre I'apparecchiatura

€ in pausa.
Spostare il [Joystick] a sinistra / a destra per
selezionare <Equalizer> (Equalizzatore).

. Selezionare un’opzione spostando il [Joystick]

su o giu, quindi premere [Joystick(OK)].
& <Off> / <Pop> / <Classic> (Classica) /
<Jazz>

. Premere il tasto [MENU] per uscire dal menu.

4 Viene applicata 'opzione selezionata.
@ Selezionando <Off>, non viene visualizzata
nessun’icona.

[ Nota ]
%+ Durante la riproduzione non & possibile accedere

al menu.



Mode MP3 :

Réglage des options de lecture MP3

Modalita MP3: Impostare le
opzioni di riproduzione MP3

Verrouillage de fichiers MP3

Vous pouvez protéger les fichiers MP3 enregistrés importants contre la
suppression accidentelle. Les fichiers proteges ne peuvent étre supprimés, sauf

si vous retirez la protection ou formatez la mémoire.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film)
apparait.
2. Sélectionnez le mode /P3 en appuyant sur le
bouton [MODE].
4 La liste de lecture MP3 s’affiche.

£ INERARN)

& Life is cool.mp3 3

& Everytime.mp3

& Toxic.mp3

& Don't push me.mp3
& Love you.mp3

Bloccare i file MP3

Importanti file MP3 archiviati possono essere protetti da eliminazioni
accidentali. | file protetti non vengono eliminati a meno che la protezione

non venga sbloccata o la memoria non venga formattata.

1.

Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione video.

Premendo il tasto [MODE], impostare la modalita 1/P3.

4 Viene visualizzata la sequenza di brani MP3.

4 Utilizzando il [Joystick], spostarsi sul file MP3
desiderato.

4 Sélectionnez le fichier MP3 souhaité a I'aide du
[Joystick].

Verrouillage des fichiers MP3 dans la liste de lecture MP3

3. Appuyez sur le bouton [MENU] en mode pause .
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Lock> (Verr).

4. Sélectionnez une option en déplacant le [Joystick]
vers le haut ou vers le bas puis appuyez sur
[Joystick(OK)].

@ <Lock> (Verr) : le fichier MP3 sélectionné est verrouillé.
4 <Multi Select> (Sélect multi) : plusieurs fichiers
MP3 peuvent étre sélectionnés en méme temps en
appuyant sur [Joystick(OK)].
Le témoin <@> saffiche sur les fichiers sélectionnés. Jd
Appuyez sur le bouton [PLAY].
@ <Lock All> (Ver. tt) : Tous les fichiers MP3 sont verrouillés.
4 <Unlock All> (Dév. Tout) : permet de déverrouiller
tous les fichiers MP3.

Verrouillage des fichiers MP3 en plein écran

3. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].
4 Le fichier MP3 sélectionné est lu.

4. Appuyez sur le bouton [MENU] en mode pause .
Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Lock> (Verr).

5. Appuyez sur [Joystick(OK)].

& Le fichier MP3 sélectionné est verrouillé.

Bove

ﬂ MP3

EZMove

Sweethox

L& Searich

[ Remarques ]
% Llicdne < > s'affiche sur le fichier verrouillé.
< Vous ne pouvez pas accéder au menu pendant la

lecture. EVove

CI3Play

NultitSelect
Lock Al
v

ESelect

Life is cool.mp3

 Stereo 144.1KHz]192Kbps| 3.
» 00:00:00/00:03:27
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Protezione dei file MP3 nella sequenza di brani MP3

3. Premere il tasto [MENU] mentre I'apparecchiatura
¢ in pausa.Spostare il [Joystick] a sinistra/a
destra per selezionare <Lock > (Prot).

4. Selezionare un’opzione spostando il [Joystick]
su o giu, quindi premere [Joystick(OK)].
¢ <Lock> (Prot) : Il file MP3 selezionato & bloccato.

4 <Multi Select> (Multi selez.) : Utilizzando il
[Joystick(OK)] si possono selezionare piu file
MP3. <& > viene visualizzato sui file selezionati.
Premere il tasto [PLAY].

4 <Lock All> (Blocca tutto) : Tutti i file MP3 sono
bloccati.

4 <Unlock All> (Sblocca tutto) : Sblocca tutti i fileMP3.

Protezione dei file MP3 a schermo intero

Premere il tasto [PLAY] o [Joystick(OK)].

¢ |l file MP3 selezionato viene riprodotto.

4. Premere il tasto [MENU] mentre I'apparecchiatura
¢ in pausa. Spostare il [Joystick] a sinistra / a
destra per selezionare <Lock> (Prot).

5. Premere [Joystick(OK)].

4 |l file MP3 selezionato & bloccato.

[ Note ]

% Sul file bloccato viene visualizzata licona < & >.

% Durante la riproduzione non & possibile accedere al
menu.

(MENU =S

L3 Pause

[ED Exit

A



Mode MP3 :
Réglage des options de lecture MP3

Modalita MP3: Impostare le

opzioni di riproduzione MP3

Copie de fichiers MP3

Vous pouvez copier des fichiers enregistrés dans la mémoire ip)

interne vers la carte mémoire et vice-versa.

1. Insérez la carte mémoire dans le caméscope Sport,
par la fente prévue a cet effet.

2. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enregistrement de film) apparait.

3. Sélectionnez le mode /1P3 en appuyant sur le bouton

[MODE]. EVove

4 Laliste de lecture MP3 s’affiche.
4 Sélectionnez le fichier MP3 de votre choix a

l'aide du [Joystick]. 8

4. Appuyez sur le bouton [MENU] en mode pause.
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Copy To> (Cop sur). Al

5. Sélectionnez une option en déplacant le [Joystick] vers le

haut ou vers le bas puis appuyez sur [Joystick(OK)]. Eilove

4 <OK>: permet de copier le fichier MP3 sélectionné.

& <Multi Select> (Sélect multi) : plusieurs fichiers MP3
peuvent étre sélectionnés en méme temps en appuyant sur
[Joystick(OK)]. Le témoin < ¢ > apparait sur les fichiers
sélectionnés. Appuyez sur le bouton [PLAY].

Copie de fichiers MP3 en plein écran

4. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].
4 Le fichier MP3 sélectionné est Iu.

5. Appuyez sur le bouton [MENU] en mode pause. B Move

Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Copy To> (Cop sur).
6. Appuyez sur [Joystick(OK)].
4 Permet de copier le fichier MP3 sélectionné.
[ Remarques ]
% Le caméscope Sport permet de copier a partir de la
mémoire en cours d'utilisation vers une autre mémoire.
Si la mémoire interne est en cours d'utilisation, la copie
est effectuée vers une carte mémoire.
Si la carte mémoire n’est pas insérée, vous ne pouvez pas
utiliser la fonction <Copy To> (Cop sur).
Vous ne pouvez pas accéder au menu pendant la lecture.

A

ESelect  [EM Exit

S JImp3

[Select [EW Exit

LTI Select =Y EXi

Copiare i file MP3

| file archiviati possono essere copiati dalla memoria interna

£ alla scheda di memoria e viceversa.

i 1. Inserire la scheda nello slot per la scheda di memoria
& Everytime.mp3
& Toxic.mp3
& Don't push me.mp3
& Love you.mp3

della videocamera Sport.
2. Per attivare la videocamera Sport, premere il tasto
di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione video.
3. Premendo il tasto [MODE], impostare la modalita /1P3.

I3 Play; 4 Viene visualizzata la sequenza di brani MP3.
4 Utilizzando il [Joystick], spostare il file MP3
desiderato.

R Copia dei file MP3 nella sequenza di brani MP3
Copie de fichiers MP3 dans la liste de lecture MP3 Copy To j

MultifSelect:

4. Premere il tasto [MENU] mentre I'apparecchiatura &
in pausa. Spostare il [Joystick] a sinistra / a destra
per selezionare <Copy To> (Copia su).
5. Selezionare un’opzione spostando il [Joystick] su o
glu quindi premere [Joystick(OK)].
<OK> : Il file MP3 selezionato viene copiato.

0 <Multi Select> (Multi selez.) : Utilizzando il
[Joystick(OK)] si possono selezionare piu file MP3.
< ¥ > viene visualizzato sui file selezionati.

16 I Premere il tasto [PLAY].

b O] fd -+ - @ <All> (Tutti) : Tutti i file MP3 vengono copiati.
& <All> (Tt) : Tous les fichiers MP3 sont copiés. Copy To

Copia dei file MP3 a schermo intero

4. Premere il tasto [PLAY] o [Joystick(OK)].
4 |l file MP3 selezionato viene riprodotto.

5. Premere il tasto [MENU] mentre I'apparecchiatura &
in pausa. Spostare il [Joystick] a sinistra / a destra
per selezionare <Copy To> (Copia su).

6. Premere [Joystick(OK)].

4 Copia il file MP3 selezionato.

| Copying file(s)...
- Life is cool.mp3 [ Note ]

Con la videocamera Sport & possibile copiare dalla
memoria utilizzata correntemente su un’altra memoria.
Se la memoria interna é utilizzata, la copia viene
eseguita su una scheda di memoria.

Se non viene inserita una scheda di memoria, la funzione
<Copy To> (Copia su) non puod essere eseguita.

Durante la riproduzione non & possibile accedere al menu.



, Mode Voice Recorder
4J(Enreg Voix)

, Modalita Voice
4-/ Recorder (Registr. Voce)

Enregistrement................cccooeiinniinicncncece 84
Enregistrement de fichiers voCauX...........ccoeeeerieeuriennn. 84
LECIUIE ... 85

Lecture de fichiers VOCAUX ..........ccovviuriurenicinieinriicees 85

Réglage des options Voice Play (Lect voix) ... 86
Suppression de fichiers VOCauX ..........coevvveeerereerrerenne. 86
Réglage du mode Play (LeCt.) ......ccoviueurecinicininicrrienne 87
Verrouillage de fichiers vocaux ..

Copie de fiChiers VOCAUX .......cceurvrrrererereeerersenssesessssesesenns 89

@ Sauvegardez les données et enregistrements importants
sur un autre support afin d’éviter les pertes accidentelles
provoquées par une défaillance du systeme ou toute autre
raison.

Comment régler le mode Voice Recorder (Enreg. Voix)

@
N Bouton B
‘::‘:l; n\ @ Voice Recorder » Q ]

Power

\W)%DE s

1. Appuyez sur le bouton
[POWER] pour allumer le
caméscope Sport.

2. Sélectionnez le mode
Voice Recorder (Enreg.
Voix) en appuyant sur
le bouton [MODE].

Registrazione...............cccccuvieiniiinniccncsceeae 84
Registrare file VOCE .......ccviveiriieiriircesicsce e 84
Riproduzione............. .85

Riprodurre file Voce ...
Impostare le opzioni della riprod. del file Voce . .
Cancella i file VOCE.......ccvueereirricirierieeseee s 86
Impostare le modalita' di iproduzione ............ccevecveniecineees 87
Bloccare i file Voce .
Copiare i file VOCE .....cueveereeereriereieieiesseseesseeeees s

4 Salvare dati/registrazioni importanti separatamente su altri
supporti, per evitare la perdita accidentale causata da guasti
al sistema o da altre ragioni.

Modalita Voice Recorder (Registr. Voce)

‘ @)

U
W U Tasto di _ e
‘.iln, I\ ) i Voice Recorder > Q L]

) accensione
1. Per attivare la videocamera 2. Premendo il tasto
Sport, premere il tasto di [MODE], impostare la
accensione. modalita Voice Recorder

(Registr. Voce).

A



Mode Voice Recorder
(Enreg. Voix) : Enregistrement

Modalita Voice Recorder
(Registr. Voce) : Registrazione

Enregistrement de fichiers vocaux

Le microphone intégré permet aux utilisateurs d’effectuer des
enregistrements vocaux sans appareils supplémentaires.

Registrare file Voce

Il microfono integrato permette agli utenti di registrare le voci senza
altri dispositivi.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enregistrement de
film) apparait.

2. Sélectionnez le mode Voice Recorder (Enreg.
Voix) en appuyant sur le bouton [MODE].
@ L'écran Voice Record (Enreg. voix) s'affiche.

3. Appuyez sur le bouton [Record / Stop] pour
commencer I'enregistrement.
& L'icone < @> s'affiche a 'écran et I
enregistrement commence.

4. Appuyez de nouveau sur le bouton [Record
| Stop] pour arréter I'enregistrement.

[ Remarques ]

% Les fichiers vocaux enregistrés sont automatiquement sauvegardés

dans une liste.

< Vous ne pouvez pas accéder au menu pendant I'enregistrement

A

vocal ou en mode Voice Record (Enreg. voix).

SWAV0001.WAV

[ Stereo 8.0KHz | 64Kbps |
M 00:00:00/35:00:00

SWAV0001.W
2006/01/01 12:00:00 AlA

 Stereo] 8.0KHz | 64Kbps |
® 00:00:12/34:59:48

¢

SWAV0002.WAV

 Stereo] 8.0KHz] 64Kbps |
W 00:00:12/34:59:48

[ Note ]

1.

Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

@ Viene visualizzata la schermata di registrazione
video.

Premendo il tasto [MODE], impostare la

modalita Voice Recorder (Registr. Voce).

@ Viene visualizzata la schermata Voice Record
(Registr. voce).

Premere il tasto di registrazione/di arresto

per avviare la registrazione.

4 Sulla schermata viene visualizzata I'icona
< @ > e parte la registrazione.

Per interrompere la registrazione, premere
nuovamente il tasto di registrazione/di arresto.

% | file vocali archiviati vengono salvati automaticamente in un
elenco.

%+ Durante la registrazione vocale o nella modalita di registrazione
vocale, non si pud accedere al menu.



Mode Voice Recorder (Enreg. Voix) : Lecture

Modalita Voice Recorder
(Registr. Voce) : Riproduzione

Lecture de fichiers vocaux

Vous pouvez lire les fichiers vocaux enregistrés a 'aide du haut-parleur

intégré ou des écouteurs.

1.

Appuyez sur le bouton [POWER] pour allumer le

caméscope Sport.

@ L'écran Movie Record (Enregistrement de film)
apparait.

Sélectionnez le mode Voice Recorder (Enreg.

Voix) en appuyant sur le bouton [MODE].

@ L'écran Voice Record (Enreg. voix) s'affiche.

Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)].

4 L'écran Voice Playlist (Liste de lecture des
enregistrements vocaux) s'affiche a I'écran.
Sélectionnez le fichier vocal que vous souhaitez

lire en déplacant le [Joystick] vers le haut ou vers

le bas, puis appuyez sur [Joystick(OK)].

Le fichier vocal sélectionné est lu.

4 Pour interrompre la lecture, appuyez sur
[Joystick(OK)].

@ Pour une recherche avant/arriere, déplacez le
[Joystick] vers la gauche ou vers la droite.

Pour régler le volume, déplacez le [Joystick]

vers le haut ou vers le bas.

@ L'échelle de volume apparait et disparait au
bout de quelques secondes.

[ Remarques ]
-

Lorsque vous enregistrez un fichier vocal apres
avoir réglé 'horodatage, la date et 'heure saffichant
sur 'écran LCD correspondent a celles du début de
I'enregistrement.

Lorsque les écouteurs, le cable audio/vidéo ou le
cable External Camera Module (Module caméra
externe) sont branchés sur le caméscope Sport, le
haut-parleur intégré est automatiquement désactivé.
Vous ne pouvez pas accéder au menu pendant la
lecture de données vocales.

Lorsque le menu s'affiche a I'écran, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Voice Record (Enreg. voix).

integrato.
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Riprodurre file Voce

| file vocali registrati possono essere riprodotti utilizzando I'altoparlante

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la modalita
Voice Recorder (Registr. Voce).
4 Viene visualizzata la schermata Voice Record
(Registr. voce).

3. Premere il tasto [PLAY] o [Joystick(OK)].
4 Viene visualizzata la schermata con la sequenza
di brani vocali.

4. Selezionare un file vocale da riprodurre spostando il
[Joystick] su/giu, quindi premere [Joystick(OK)].

5. Il file vocale selezionato viene riprodotto.
4 Per mettere in pausa la riproduzione, premere
[Joystick(OK)].
& Per effettuare la ricerca in avanti/indietro,
spostare il [Joystick] a destra/sinistra.

6. Per regolare il volume, spostare il [Joystick] su
o gil.
4 Viene visualizzato l'indicatore del volume, che
scompare dopo pochi secondi.

[ Note ]

% Quando si registra il file vocale dopo avere
impostato la data e l'ora, la data e I'ora visualizzate
sul display LCD indicano quelle a cui € iniziata la
registrazione.

< Se alla videocamera Sport vengono collegate delle
cuffie, dei cavi audio/video o il cavo di un modulo
videocamera esterna, I'altoparlante integrato non
funziona.

% Durante la riproduzione vocale non ¢ possibile
accedere al menu.

< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa
alla modalita di registrazione vocale. A



Mode Voice Recorder (Enreg. Voix) :
Réglage des options Voice Play (Lect voix)

Modalita Voice Recorder (Registr. Voce):
Impostare le opzioni della riprod. del file Voce

Suppression de fichiers vocaux

Vous pouvez supprimer un fichier vocal ou un groupe de fichiers

vocaux sélectionné.

1. Appuyez sur le bouton [POWER] pour allumer

le caméscope Sport.

@ L'écran Movie Record (Enregistrement de film)
apparait.

. Sélectionnez le mode Voice Recorder (Enreg.

Voix) en appuyant sur le bouton [MODE].

@ L'écran Voice Record (Enreg. voix) s'affiche.

Appuyez sur le bouton [PLAY] ou sur

[Joystick(OK)].

@ L'écran Voice Playlist (Liste de lecture des
enregistrements vocaux) s'affiche a I'écran.

4 Sélectionnez le fichier vocal de votre choix a I
aide du [Joystick].

Appuyez sur le bouton [DELETE] de I'écran

LCD en mode pause. Sélectionnez une option

en déplacant le [Joystick] vers le haut ou vers

le bas puis appuyez sur [Joystick(OK)].

@ <OK> : permet de supprimer le fichier vocal

sélectionné.

<Multi Select> (Sélect multi) : plusieurs

fichiers vocaux peuvent étre sélectionnés en

méme temps a l'aide de [Joystick(OK)].

Le témoin < v > apparait sur les fichiers

sélectionnés. Appuyez sur le bouton [PLAY].

@ <All> (Tt) : tous les fichiers vocaux sont supprimés.

@ <Cancel> (Annul.) : permet d’annuler la suppression.

@é

E3Move

* OK

Multi Select
All

EMove

[ Remarques ]

% Les fichiers verrouillés ne seront pas supprimés.

< Vous ne pouvez pas accéder au menu pendant la lecture de
données vocales.

% Lorsque le menu s’affiche a I'écran, le fait d’appuyer sur le bouton

[Record / Stop] permet d’accéder au mode Voice Record (Enreg. voix).

SWAV0004.WAV.
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Cancella i file Voce

E possibile eliminare un file o un gruppo di file vocali selezionati.

1. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione
video.

Premendo il tasto [MODE], impostare la

modalita Voice Recorder (Registr. Voce).

@ Viene visualizzata la schermata Voice Record
(Registr. voce).

Premere il tasto [PLAY] o [Joystick(OK)].

@ Viene visualizzata la schermata con la
sequenza di brani vocali.

@ Utilizzando il [Joystick], spostarsi sul file
vocale desiderato.

Premere il tasto [DELETE] sullo display

LCD mentre I'apparecchiatura € in pausa.

Selezionare un’opzione spostando il [Joystick]

su o giu, quindi premere [Joystick(OK)].

<OK> : Il file vocale selezionato viene eliminato.

<Multi Select> (Multi selez.) : Utilizzando il

[Joystick(OK)] si possono selezionare piu

file vocali. < > viene visualizzato sui file

selezionati. Premere il tasto [PLAY].

<All> (Tutti) : Tutti i file vocali vengono eliminati.

<Cancel> (Annul) : L'eliminazione viene

annullata.
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[ Note ]
< | file bloccati non vengono eliminati.
< Durante la riproduzione vocale non € possibile accedere al menu.
% Quando viene visualizzata la schermata del menu, premendo
il tasto di registrazione/di arresto si passa alla modalita di
registrazione vocale.




Mode Voice Recorder (Enreg. Voix) :
Réglage des options Voice Play (Lect voix)

Modalita Voice Recorder (Registr. Voce):
Impostare le opzioni della riprod. del file Voce

Réglage du mode Play (Lect)

Vous pouvez lire tous les fichiers en continu ou simplement lire le fichier
sélectionné. Vous pouvez également régler 'option de répétition.

1.

Appuyez sur le bouton [POWER] pour allumer le

caméscope Sport.

4 L’écran Movie Record (Enregistrement de film)
apparait.

Sélectionnez le mode Voice Recorder (Enreg. Voix)

en appuyant sur le bouton [MODE].

4 L’écran Voice Record (Enreg. voix) apparait.

Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)]

& Permet d'afficher 'écran Voice Playlist (Liste de
lecture des enregistrements vocaux).

4 Sélectionnez le fichier vocal de votre choix a
I'aide du [Joystick].

Appuyez sur le bouton [MENU]. Déplacez le

[Joystick] vers la gauche ou la droite pour

sélectionner <Play Mode> (Mode Lect).

Déplacez le [Joystick] vers le haut ou vers le bas

pour sélectionner une option, puis appuyez sur

[Joystick(OK)].

4 <Play One> (Lire un) : le fichier vocal sélectionné
est lu.

¢ <Play All> (Lire tt) : Permet de lancer la lecture
depuis le fichier sélectionné jusqu'au dernier
fichier.

4 <Repeat One> (Répéter un) : le fichier vocal
sélectionné est lu en continu.

4 <Repeat All> (Rép. tout) : tous les fichiers
vocaux sont lus en continu.

Pour quitter le menu, appuyez sur le bouton [MENU].

4 L'option sélectionnée est activée pendant la
lecture du fichier.

4 L'icone de la fonction sélectionnée s'affiche.

[ Remarques ]
< Vous ne pouvez pas accéder au menu pendant la

lecture de données vocales.

< Lorsque le menu s’affiche a I'écran, le fait d’appuyer

sur le bouton [Record / Stop] permet d’accéder au
mode Voice Record (Enreg. voix).
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Impostare le modalita’ di riproduzione

E possibile riprodurre tutti i file a ciclo continuo oppure solo un file
selezionato. E possibile impostare I'opzione di ripetizione.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la modalita
Voice Recorder (Registr. Voce).

4 Viene visualizzata la schermata Voice Record
(Registr. voce).

3. Premere il tasto [PLAY] o [Joystick(OK)]
¢ Sipassa alla schermata con la sequenza di

brani vocali.

¢ Utilizzando il [Joystick], spostarsi sul file
vocale desiderato.

4. Premere il tasto [MENU]. Spostare il [Joystick]
a sinistra / a destra per selezionare <Play Mode>
(Mod ripr).

5. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].

4 <Play One> (Riproduci uno) : Il file vocale
selezionato viene riprodotto.

4 <Play All> (Riproduci tutto) : La riproduzione
dei file viene effettuata da quello selezionato
fino allultimo.

4 <Repeat One> (Ripeti uno) : Il file vocale
selezionato viene riprodotto ripetutamente.

4 <Repeat All> (Ripeti tutto) : Tutti i file vocali
vengono riprodotti ripetutamente.

6. Premere il tasto [MENU] per uscire dal menu.

4 Durante la riproduzione, viene applicata I'opzione
selezionata.

@ Viene visualizzata l'icona della funzione
selezionata.

[ Note ]

< Durante la riproduzione vocale non & possibile
accedere al menu.

< Quando viene visualizzata la schermata del menu,

premendo il tasto di registrazione/di arresto si passa ﬁ

alla modalita di registrazione vocale.



Mode Voice Recorder (Enreg. Voix) :

Réglage des options Voice Play (Lect voix)

Modalita Voice Recorder (Registr. Voce):
Impostare le opzioni della riprod. del file Voce

Verrouillage de fichiers vocaux

Bloccare i file Voce

Vous pouvez protéger les fichiers vocaux enregistrés importants contre
la suppression accidentelle. Les fichiers protégés ne peuvent étre
supprimés, sauf si vous retirez la protection ou formatez la mémoire.

LR

Remarques ]

Appuyez sur le bouton [POWER] pour allumer le

caméscope Sport.

4 L’écran Movie Record (Enregistrement de film)
apparait.

Sélectionnez le mode Voice Recorder (Enreg. Voix)
en appuyant sur le bouton [MODE].
4 L’ecran Voice Record (Enreg. voix) apparait.

Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)]

4 Permet d'afficher 'écran Voice Playlist (Liste de
lecture des enregistrements vocaux).

@ A laide du joystick, sélectionnez le fichier vocal
de votre choix.

Appuyez sur le bouton [MENU]. Déplacez le
[Joystick] vers la gauche ou la droite pour
sélectionner <Lock> (Verr).

Déplacez le [Joystick] vers le haut ou vers le bas pour

sélectionner une option, puis appuyez sur [Joystick(OK)].

@ <Lock> (Verr) : le fichier vocal sélectionné est
verrouillé.

¢ <Multi Select> (Sélect multi) : plusieurs fichiers
vocaux peuvent étre sélectionnés en méme temps
4 laide de [Joystick(OK)]. Le témoin < &) > &'
affiche sur les fichiers sélectionnés. Appuyez sur
le bouton [PLAY]

@ <Lock All> (Ver. tt) : tous les fichiers vocaux sont
verrouillés.

4 <Unlock All> (Dév. Tout) : tous les fichiers
vocaux sont déverrouillés.

L'icone < @ > s'affiche sur le fichier verrouille.

Vous ne pouvez pas accéder au menu pendant la
lecture de données vocales.

Lorsque le menu s’affiche a I'écran, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Voice Record (Enreg. voix).
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[ Note

Importanti file vocali archiviati possono essere protetti da eliminazioni
accidentali. | file protetti non vengono eliminati a meno che la protezione
non venga shloccata o la memoria non venga formattata.

. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE]
4 Viene visualizzata la schermata di registrazione
video.

. Premendo il tasto [MODE], impostare la modalita

Voice Recorder (Registr. Voce).
4 Viene visualizzata la schermata Voice Record
(Registr. voce).

. Premere il tasto [PLAY] o [Joystick(OK)]

4 Sipassa alla schermata con la sequenza di
brani vocali.

¢ Utilizzando il [Joystick], spostarsi sul file vocale
desiderato.

. Premere il tasto [MENU].

Spostare il [Joystick] a sinistra / a destra per
selezionare <Lock> (Prot).

. Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick (OK)].

@ <Lock> (Prot) : Protegge il file vocale
selezionato.

¢ <Multi Select> (Multi selez.) : Utilizzando il
[Joystick(OK)] si possono selezionare piu
file vocali. < (&> viene visualizzato sui file
selezionati. Premere il tasto [PLAY]

* <Lock All> (Blocca tutto) : Protegge tutti i file

* <UnIock All> (Sblocca tutto) : Tutti i file vocali
vengono sbloccati.

e ]
Sul file bloccato viene visualizzata 'icona < (& >.
Durante la riproduzione vocale non & possibile
accedere al menu.
Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa
alla modalita di registrazione vocale.



Mode Voice Recorder (Enreg. Voix) :
Réglage des options Voice Play (Lect voix)

Modalita Voice Recorder (Registr. Voce):
Impostare le opzioni della riprod. del file Voce

Copie de fichiers vocaux

Vous pouvez copier des fichiers enregistrés dans la mémoire interne vers
une carte mémoire et vice-versa.

Copiare i file Voce

| file archiviati possono essere copiati dalla memoria interna alla scheda di
memoria e viceversa.

1. Insérez la carte mémoire dans le caméscope 1. Inserire la scheda nello slot per la scheda di

Sport, par la fente prévue a cet effet. memoria della videocamera Sport.

2. Appuyez sur le bouton [POWER] pour allumer le 2. Per attivare la videocamera Sport, premere il
caméscope Sport. . . - > tasto di [ACCENSIONE].

¢ ';;;;?QHMOV'e Record (Enregistrement de film) : 322021 g: ;?;0 o @ Viene visualizzata la schermata di registrazione video.

. 2006/ :00:! . . P
3. Sélectionnez le mode Voice Recorder (Enreg. Voix) 8. PVLe’_:;eggg ;I"tja;tz?[eM?sI;)rE]‘,/;?sostare la modalita
en appuyant sur le bouton [MODE]. * Viene visualizzata'? la schermata Voice Record

4 L’écran Voice Record (Enreg. voix) apparait. EMove 3 Play Reaist

4, Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)]. 4 P ( eglglr. voce).PL AY ick(OK

& Permet d'afficher I'écran Voice Playlist (Liste de 5 ] - Premere il tasto [ 1 0 [Joystick(OK)].
lecture des enregistrements vocaux). & Voice Recorder 13 AW ¢ Sipassa alla schermata con la sequenza di

A laide du [Joystick], sélectionnez le fichier vocal branivocali. . A
de votre choix. * UtlIl;zando il [Joystick], spostarsi sul file vocale

5. Appuyez sur le bouton [MENU] en mode pause desiderato , .

(Pause). Déplacez le [Joystick] vers la gauche ou TR 5. Premere il tasto [MENU] mentre 'apparecchiatura

la droite pour sélectionner <Copy To> (Cop sur). Al e in pausa.Spostare il [Joystick] a sinistra/ a

6. Sélectionnez une option en déplagant le [Joystick] vers destra per selezionare <Copy To> (Copia su).

le haut ou vers le bas puis appuyez sur [Joystick(OK)]. o el 6. Selezionare un’opzione spostando il [Joystick]

4 <OK> : le fichier vocal sélectionné est copie. su o giu, quindi premere [Joystick(OK)].

4 <Multi Select> (Sélect multi) : plusieurs fichiers . ' 4 <OK> : |l file vocale selezionato viene copiato.
vocaux peuvent étre sélectionnés en méme 6 @', ol Rm'ie r 13 AW 4 <Multi Select> (Multi selez.) : Utilizzando il
temps & l'aide de [Joystick(OK)]. Le témoin < v/ > ok . [Joystick(OK)] si possono selezionare pil file
Iapgaraiﬁt SFFEIleASY Sichiers sélectionnés. Appuyez sur vocali. < ¢ > viene visualizzato l'indicatore sui
e bouton N B file selezionati. Premere il tasto [PLAY].

@ <All> (Tt) : tous les fichiers vocaux sont copiés. IEEEEH!- # <All> (Tutti) : Tutti i file vocali vengono copiati.

[ Note ]

[ Remarques ]

< Le caméscope Sport permet de copier a partir de
la mémoire en cours d'utilisation vers une autre
mémoire. Si la mémoire interne était utilisée, la copie
est effectuée vers une carte mémoire.

< Sila carte mémoire n'est pas insérée, vous ne pouvez
pas utiliser la fonction <Copy To> (Cop sur).

< Vous ne pouvez pas accéder au menu pendant la
lecture de données vocales.

< Lorsque le menu s’affiche a I'écran, le fait d’appuyer
sur le bouton [Record / Stop] permet d’accéder au
mode Voice Record (Enreg. voix).

D Move

| Copying fil
SWAVEQO!

K= Viovel

®  VoiceRecorder 1/3 WD

Press OK to cancel.

% Con la videocamera Sport & possibile copiare

dalla memoria utilizzata correntemente su un’altra

memoria. Se la memoria interna ¢ utilizzata, la

copia viene eseguita su una scheda di memoria.

Se non viene inserita una scheda di memoria, la

funzione <Copy To> (Copia su) non puo essere

eseguita.

< Durante la riproduzione vocale non € possibile
accedere al menu.

< Quando viene visualizzata la schermata del menu,
premendo il tasto di registrazione/di arresto si passa
alla modalita di registrazione vocale. E

(3Select [EMW Exit

S)..

Cl3Select  [EY Exit



G Utilisation de la fonction
J File Browser (Explorateur)

A

Affichage de fichiers ou de dossiers .................c.cc..c.....
Suppression de fichiers ou de dossiers .
Verrouillage de fichiers............cc.ccovivinnicnninnccene
Copie de fichiers ou de dossiers..........c...cocovveririennnne
Affichage des informations relatives aux fichiers......... 95

4 Sauvegardez les données et enregistrements importants
sur un autre support afin d’éviter les pertes accidentelles
provoquées par une défaillance du systeme ou toute autre
raison.

Comment régler le mode File Browser (Explorateur)

\u»\‘—( w

ugw ¢ 0
Bouton

‘::':“ N O Power File Browser » [ ) ()

) % v &
1. Appuyez sur le bouton 2. Sélectionnez le mode File

[POWER] pour allumer le
caméscope Sport.

Browser (Explorateur) en
appuyant sur le bouton [MODE].

G Uso del File

J Browser (Scorri file)
Visualizzazione di file o cartelle
Eliminazione di file o cartelle.....
Protezione deifile ...

Copia di file o cartelle.............ccccevvvrieeccecrreee
Visualizzazione delle informazioni dei file .................... 95

¢ Salvare dati/registrazioni importanti separatamente su altri
supporti, per evitare la perdita accidentale causata da guasti
al sistema o da altre ragioni.

Impostazione della modalita File Browser (Scorri file)

‘ (@
AN ¢ 0
o y Tastodi
A accensione File Browser » ( [ (93
)
Q) MoDE o @

1. Per attivare la videocamera 2, Premendo il tasto [MODE],
Sport, premere il tasto di impostare la modalita File
accensione. Browser (Scorri file).



Utilisation de la fonction File Browser (Explorateur)

Uso del File Browser (Scorri file)

Affichage de fichiers ou de dossiers

Vous pouvez lire les fichiers enregistrés (au format AVI, JPEG, MP3
ou WAV) dans le caméscope Sport.

1. Appuyez sur le bouton [POWER] pour allumer

Visualizzazione di file o cartelle

Nella videocamera Sport si possono riprodurre i file memorizzati
(AVI, JPEG, MP3, WAV).

le caméscope Sport.
4 L’écran Movie Record (Enregistrement de film)
apparait.

M MISC

M MUSIC
M VIDEO
M VOICE

1. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.

2. Sélectionnez le mode File Browser (Explorateur)
en appuyant sur le bouton [MODE].
@ L'écran File Browser (Explorateur) apparait.

BElilove

3. Sélectionnez le dossier de votre choix en
déplacant le [Joystick] vers le haut ou vers le
bas puis appuyez sur [Joystick(OK)].

4 Répétez 'ensemble de ces étapes jusqu'a ce
que le fichier que vous souhaitez voir s’affiche.
B ove
4. Le fichier sélectionné est lu.

&

(I3 Play

(I3 Play

2. Premendo il tasto [MODE], impostare la
modalita File Browser (Scorri file).
4 Viene visualizzata la schermata File Browser

E N (Scorri file).

/DCIVI i

M= 100SSDVC

3. Selezionare la cartella o il file desiderati
spostando il [Joystick] su o giu, quindi
premere [Joystick(OK)].

@ Eseguire questi passi ripetutamente finché
non compare il file da visualizzare.

1/4 AT [

Il file selezionato viene riprodotto.

i@ /DCIM/100SSDVC
@ DCAMO0002.JPG
@ DCAMO003.JPG

[ Remarques ]

< Sivous faites glisser linterrupteur [W/T] sur W
(WIDE) en mode Play (Lect), la liste des fichiers
réapparait a I'écran.

< Sivous déplacez le [Joystick] vers la gauche, le
dossier précédent apparait a I'écran.

B iove

@ DCAMO0004.JPG
(I3 Play

[ Note ]

% Facendo scorrere l'interruttore [W/T] su
W(LARGO) nella modalita di riproduzione, si
ritorna alla schermata con I'elenco dei file.

% Spostando il [Joystick] a sinistra, viene
visualizzata la schermata precedente con le
cartelle.



Utilisation de la fonction File Browser (Explorateur)

Uso del File Browser (Scorri file)

Suppression de fichiers ou de dossiers

Vous pouvez supprimer des fichiers (au format AVI, MP3, JPEG, WAV) ou
dossiers que vous avez enregistrés.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.

¢ L'écran Movie Record (Enregistrement de film) 3
apparait. M \IISC
M \USIC
2. Sélectionnez le mode File Browser (Explorateur) en M VIDEO
appuyant sur le bouton [MODE]. m VOICE

4 L'écran File Browser (Explorateur) apparait.
EXMove
3. A laide du [Joystick], sélectionnez le fichier ou le
dossier de votre choix. 7
4 Déplacez le [Joystick] vers le haut ou vers le bas et
appuyez sur [Joystick(OK)] en continu jusqu’a ce qu’
apparaisse le fichier ou le dossier de votre choix.

OK
Multi Select
All

4. Appuyez sur le bouton [DELETE] de I'écran LCD .
Sélectionnez une option en déplacant le [Joystick]
vers le haut ou vers le bas, puis appuyez sur

[Joystick(OK)]. EMove X Select
& <OK>: Le fichier ou le dossier sélectionné est
supprime. )

4 <Multi Select> (Sélect multi) : plusieurs fichiers
ou dossiers peuvent étre sélectionnés en méme
temps a l'aide de [Joystick(OK)]. Le témoin < v/ >

Eliminazione di file o cartelle
| file (AVI, JPEG, MP3, WAV) o le cartelle registrati possono essere eliminati.

JER NI 4 per attivare la videocamera Sport, premere il tasto

di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione video.

2. Premendo il tasto [MODE], impostare la modalita
File Browser (Scorri file).
¢ Viene visualizzata la schermata File Browser (Scorri file).

I3 Play

3. Selezionare il file desiderato o la cartella utilizzando il
[Joystick].
4 Spostare il [Joystick] su/giu e premere ripetutamente
[Joystick(OK)] finché non vengono visualizzati il file o
la cartella desiderati.

4. Premere il tasto [DELETE] sul display LCD.
Selezionare un’opzione spostando il [Joystick] su /
glu quindi premere [Joystick(OK)].
<OK> : Il file o la cartella selezionati vengono
eliminati.

& <Multi Select> (Multi selez.) : Utilizzando il
[Joystick(OK)] si possono selezionare piu file o
cartelle. < v > viene visualizzato sui file selezionati.

bouton [PLAY]. Led o

<All> (Tt) : Tous les fichiers ou dossiers sont Cancel

supprimés.

<Cancel> (Annul.) : permet d’annuler la suppression Ellove [0 Select

des fichiers ou dossiers.

]
[ Remarques ] "
% Sivous faites glisser linterrupteur [W/T] sur W (WIDE)
en mode Play (Lect), I'écran précédent apparait. m MUSIC

% Les fichiers verrouillés ne seront pas supprimés. M VIDEO
% Le dossier comportant un fichier verrouillé ne sera M VOICE

<

apparait sur les fichiers sélectionnés. Appuyez sur le

pas supprimé. Seuls les fichiers déverrouillés seront
supprimés.

Si vous déplacez le [Joystick] vers la gauche, le dossier
précédent apparait a 'écran.

B |ilove (I3 Play,

Premere il tasto [PLAY].

@ <All> (Tutti) : Tutti i file o tutte le cartelle vengono
eliminati.

4 <Cancel> (Annul) : L’eliminazione dei file o delle
cartelle viene annullata.

[ Note ]
% Facendo scorrere l'interruttore [W/T] su W(LARGO)

nella modalita di riproduzione, si ritorna alla schermata
precedente.

| file bloccati non vengono eliminati.

La cartella contenente un file bloccato non viene
eliminata. Solo i file sbloccati vengono eliminati.
Spostando il [Joystick] a sinistra, viene visualizzata la
schermata precedente con le cartelle.



Utilisation de la fonction File Browser (Explorateur)

Uso del File Browser (Scorri file)

Verrouillage de fichiers

Vous pouvez verrouiller les fichiers importants pour étre sir qu'ils ne soient
pas supprimés.

Protezione dei file
| file importanti possono essere protetti in modo da non essere cancellati.

1. Appuyez sur le bouton [POWER] pour allumer le 7 B NN 1, Per attivare la videocamera Sport, premere il
caméscope Sport. ) ) . tasto di [ACCENSIONE].
¢ Lécran Movie Record (Enregistrement de film) @ Viene visualizzata la schermata di registrazione
apparait. M \ISC video.

M VUSIC
M= VIDEO
M= VOICE

2. Sélectionnez le mode File Browser (Explorateur)
en appuyant sur le bouton [MODE].
4 L'ecran File Browser (Explorateur) apparait.

2. Premendo il tasto [MODE], impostare la modalita
File Browser (Scorri file).
4 Viene visualizzata la schermata File Browser

3. A laide du [Joystick], sélectionnez le fichier ou le Eliove  EWPlay (Scorri file).

dossier de votre choix.
4 Déplacez le [Joystick] vers le haut ou vers le bas )
et appuyez sur [Joystick(OK)] en continu jusqu’a

3. Selezionare il file desiderato o la cartella
AR N utilizzando il [Joystick].
4 Spostare il [Joystick] su/giu e premere

ce quapparaisse le fichier souhaité. I Dl ripetutamente [Joystick(OK)] finché non viene
4. Appuyez sur le bouton [MENU]. visualizzato il file desiderato.

Déplacez le [Joystick] vers la gauche ou la droite
pour sélectionner <Lock> (Verr).

5. Déplacez le [Joystick] vers le haut ou vers le

@ DCAN0002.JPG :
@ DCAMO003.JPG | 4. Premere il tasto [MENU].

@ DCAM0004.JPG

Spostare il [Joystick] a sinistra / a destra per
selezionare <Lock> (Prot).

bas pour sélectionner une option, puis appuyez  (SEINCERY 5. Spostare il [Joystick] su / gili per selezionare

sur [Joystick(OK)].
¢ <Lock> (Verr) : le fichier sélectionné est verrouillé. S ISP

un’opzione, quindi premere [Joystick(OK)].
1/4  EM{ID 4 <Lock> (Prot) : Proteggere il file selezionato.

@ <Multi Select> (Sélect multi) : plusieurs fichiers o I # <Multi Select> (Multi selez.) : Utilizzando il
peuvent étre sélectionnés en méme temps & l'aide [Joystick(OK)] si possono selezionare pit file.
de [Joystick(OK)]. Le témoin < (&1 > apparait sur les S LIEG < B> viene visualizzato sui file selezionati.
fichiers sélectionnés. Appuyez sur le bouton [PLAY]. Lock Premere il tasto [PLAY].

¢ <|-°°k_|ﬁ"> (Ver. tt) : tous les fichiers sont t'““k' i:'e“ @ <Lock All> (Blocca tutto) : Proteggere tutti i file.
verrouillés. 0C 4 <Unlock All> (Sblocca tutto) : Tutti i file

4 <Unlock All> (Dév. Tout) : permet de déverrouiller b4 vengono sbloc(cati )
tous les fichiers. S Move E@Select [EMD Exit g :

ﬁ /a1 [ Note ]
[ Remarques ] o ) < Non ¢ possibile proteggere le cartelle
% Vous ne pouvez pas verrouiller les dossiers. O IDCIAEYE il file & iene visualizzata I
% Lictne <&> saffche lorsque e fchier 6t verrouilé U At
% Si vous faites glisser linterrupteur [W/T] sur W (WIDE) en O DN nella modalita di riproduzione, si ritorna alla

mode Play (Lect), la liste des fichiers réapparait a Fécran. C DGO 17 schermata con I’elgnco dei file.

# Sivous déplacez le [Joystick] vers la gauche, le = DCANO00LIRC % Spostando il [Joystick] a sinistra, viene visualizzata
dossier précédent apparait a 'écran. Eilove  EIPlay la schermata precedente con le cartelle.

A



Utilisation de la fonction File Browser (Explorateur)

Uso del File Browser (Scorri file)

Copie de fichiers ou de dossiers

Vous pouvez copier le fichier ou dossier vers la mémoire interne ou externe.

Copia di file o cartelle

E possibile copiare un file o una cartella nella memoria interna o esterna.

1.

Insérez la carte mémoire dans le caméscope Sport,

1. Inserire la scheda nello slot per la scheda di

par la fente prévue a cet effet.

2. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.

4 L'écran Movie Record (Enregistrement de film) apparait.

3. Sélectionnez le mode File Browser (Explorateur) en
appuyant sur le bouton [MODE].

4 L'écran File Browser (Explorateur) apparait.

4. A Taide du [Joystick], sélectionnez le fichier ou le
dossier de votre choix.

& Déplacez le [Joystick] vers le haut ou vers le bas et
appuyez sur [Joystick(OK)] en continu jusqu’a ce qu’
apparaisse le fichier ou le dossier de votre choix.

5. Appuyez sur le bouton [MENU]. Déplacez le
[Joystick] vers la gauche ou la droite pour
sélectionner <Copy To> (Cop sur).

6. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)].

& <OK>: le fichier ou le dossier sélectionné est copié.

& <Multi Select> (Sélect multi) : plusieurs fichiers ou
dossiers peuvent étre sélectionnés en méme temps
a 'aide de [Joystick(OK)]. Le témoin < v > apparait
sur les fichiers ou dossiers sélectionnés.

Appuyez sur le bouton [PLAY].
@ <All> (Tt) : tous les fichiers ou dossiers sont copiés.

[ Remarques ]

< Le caméscope Sport permet de copier a partir de la
mémoire en cours d'utilisation vers une autre mémoire.
Si la mémoire interne était utilisée, la copie est effectuée
vers une carte mémoire.
Si la carte mémoire n'est pas insérée, vous ne pouvez
pas utiliser la fonction <Copy To> (Cop sur).
Si vous faites glisser l'interrupteur [W/T] sur W (WIDE) en
mode Play (Lect), la liste des fichiers s’affiche a I'écran
du caméscope Sport.

< Sivous déplacez le [Joystick] vers la gauche, le dossier

.a précédent apparait a I'écran.

) E INfI]
i

M \IISC

M \USIC
M VIDEO
I VOICE

Elove CI3Play

1/5

/4 A

i@ /DCIM/100SSDVC
@ DCAMO0002.JPG
@ DCAMO0003.JPG
& DCAMO004.JPG

B ove CLiplay
1/4

5 B File Browser E_INGII}

a 4»[3 .

MultifSelect:
Al =

Eilove EESelect [EW Exit

6 ﬁ File Browser

Press OK to cancel.

(=L |ove [ISelect  [EMExXit

[N
@

memoria della videocamera Sport.

Per attivare la videocamera Sport, premere il tasto

di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazione video.

Premendo il tasto [MODE], impostare la modalita

File Browser (Scorri file).

@ Viene visualizzata la schermata File Browser (Scorri file).

Selezionare il file desiderato o la cartella utilizzando

il [Joystick].

4 Spostare il [Joystick] su/giu e premere ripetutamente
[Joystick(OK)] finché non vengono visualizzati il file
o la cartella desiderati.

Premere il tasto [MENU].

Spostare il [Joystick] a sinistra / a destra per

selezionare <Copy To> (Copia su).

Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK)].

¢ <OK>: lIfile o la cartella selezionati vengono copiati.

4 <Multi Select> (Multi selez.) : Utilizzando il
[Joystick(OK)] si possono selezionare pit file o
cartelle. < v > viene visualizzato sui file o sulle
cartelle selezionati. Premere il tasto [PLAY].

4 <All> (Tutti) : Tutti i file o tutte le cartelle vengono
copiati.

ote ]

Con la videocamera Sport & possibile copiare dalla
memoria utilizzata correntemente su un’altra memoria.
Se la memoria interna é utilizzata, la copia viene
eseguita su una scheda di memoria.

Se non viene inserita una scheda di memoria, la funzione
<Copy To> (Copia su) non pud essere eseguita.
Facendo scorrere l'interruttore [W/T] su W(LARGO)
nella modalita di riproduzione, la videocamera ritorna
alla schermata con I'elenco dei file.

Spostando il [Joystick] a sinistra, viene visualizzata la
schermata precedente con le cartelle.



Utilisation de la fonction File Browser (Explorateur)

Uso del File Browser (Scorri file)

Affichage des informations relatives aux fichiers

Vous pouvez afficher le nom d’un fichier, son format, sa taille et sa date de

Visualizzazione delle informazioni dei file

E possibile visualizzare il nome, il formato, le dimensioni e la data di un file.

création.
/! |
1. Appuyez sur le bouton [POWER] pour allumer le ) st N Per attivare la videocamera Sport, premere il tasto
caméscope Sport. B di [ACCENSIONE].
4 L’écran Movie Record (Enregistrement de film) M NISC 4 Viene visualizzata la schermata di registrazione
apparait. M \IUSIC video.
M VIDEO
2. Sélectionnez le mode File Browser (Explorateur) M VOICE Premendo il tasto [MODE], impostare la modalita
en appuyant sur le bouton [MODE]. - File Browser (Scorri file).
& L'écran File Browser (Explorateur) apparait. <oy oPley & Viene visualizzata la schermata File Browser
(Scorri file).
3. Sélectionnez la liste des fichiers de votre choix a
Iaide du [Joystick]. Selezionare I'elenco di file desiderato utilizzando
Déplacez le [Joystick] vers le haut ou vers le bas & /DCIM/100SSDVC il [Joystick]. Spostare il [Joystick] su o giu per
si vous souhaitez afficher les informations sur le DCAMO001.JPG visualizzare le informazioni sul file.
fichier. @ DCAMO0002.JPG 4 Spostare il [Joystick] su/giu e premere ripetutamente
¢ Déplacez le [Joystick] vers le haut ou vers le bas @ DCAMO0003.JPG [Joystick(OK)] finché non viene visualizzato I'elenco
et appuyez sur [Joystick(OK)] en continu jusqu’a @ DCAMO0004.JPG di file desiderato.
ce qu'apparaisse la liste des fichiers souhaitée. Biiove xS
. Premere il tasto [MENU].
4. Appuyez sur le bouton [MENU]. ~ Spostare il [Joystick] a sinistra / a destra per
Déplacez le [Joystick] vers la gauche ou vers la 48 W File Browser 113 WY selezionare <File Info>. (Info file).
droite pour sélectionner <File Info.> (Info fich.). - < b @ - o
5. Appuyez sur [Joystick(OK)] pour consulter les J Premere [Joystick(OK)] per visualizzare le
informations sur le fichier. informazioni sul file.
4 Lenom, la taille, la date de création et I'option de 4 Viene visualizzata la schermata con il nome, la
verrouillage du fichier apparaissent a I'écran. dimensione, la data e lo stato bloccato del file.
6. Appuyez sur [Joystick(OK)] pour faire disparaitre Eilove fSelect EERE!

les informations relatives au fichier.

S| Bl File Browser
—— -~
& DCAM0001.JPG
Size

Premere [Joystick(OK)] per terminare la
visualizzazione delle informazioni sul file.

[ Remarques ]

< Vous ne pouvez pas voir les informations relatives au
dossier, mais uniquement celles relatives au fichier. B

< Sivous déplacez le [Joystick] vers la gauche, le ESViove
dossier précédent apparait a 'écran.

[ Note ]
< Non é possibile visualizzare le informazioni delle cartelle.
Si possono visualizzare soltanto le informazioni dei file.
<+ Spostando il [Joystick] a sinistra, viene visualizzata la
A

Close : OK

ChiSelect)  [EW Exit

schermata precedente con le cartelle.
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Réglage de I'affichage de la date et de Iheure..........cccovevrervncrrneris 107 Impostazione della visualizzazione di data/ora ...........ccccocueeveerrnreene 107
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Réglage du mode Start-up (Démarr.) 109 Impostazione della modalita di accensione...
Réinitialisation du caméscope Sport 110 Reimpostazione della videocamera Sport
Selezione della lingua

Choix de la langue 11
Réglage de la fonction Auto Shut off (Extinct. auto) .

Réglage de la fonction Demonstration (Démonstration)
Affichage des informations sur la version

Impostazione dello spegnimento automatico ....
Impostazione della funzione Demonstration (Di
Visualizzazione delle informazioni sulla versione

Mode USB 115 Utilizzo della modalita USB
Transfert de fichiers vers un ordinateur 115 Trasferimento di file ad un computer
Impression PictBridge 116 Stampa con PictBridge.
Utilisation de la fonction PC Cam (Webcam) .............oueeveeueereesnerersineens 117 Utilizzo della funzione PC Cam 117

4 Sauvegardez les données et enregistrements importants sur un autre
support afin d’éviter les pertes accidentelles provoquées par une défaillance
du systéme ou toute autre raison.

Comment régler le mode System Settings (Réglage syst.)

w
vew [ | Bouton -
@ Power System Settings » O,/ JJ

MoDE l & @

1.

Appuyez sur le bouton [POWER] 2. Sélectionnez le mode

4 Salvare dati/registrazioni importanti separatamente su altri supporti, per
evitare la perdita accidentale causata da guasti al sistema o da altre
ragioni.

Modalita System Settings (Imp di sistema)

\LL'L( W
Vel T | Tasto di
' O accensione,

System Settings >

@)%E Fr

1. Per attivare la videocamera

2. Premendo il tasto [MODE],
impostare la modalita System
Settings (Imp di sistema).

pour allumer le caméscope System Settings (Réglage
Sport. syst.) en appuyant sur le
bouton [MODE].

Sport, premere il tasto di
accensione.




Réglage du caméscope Sport
: Réglages de la mémoire

Impostazione della videocamera
Sport: Impostazione della memoria

Choix du type de stockage

Vous pouvez régler le type de stockage sur la mémoire interne ou la carte
mémoire (non fournie).

1.

[ Remarques ]
&

Appuyez sur le bouton [POWER] pour allumer le

Selezione del tipo di memoria

La memorizzazione puo essere impostata sulla memoria interna o sulla
scheda di memoria (non fornita in dotazione).

1. Per attivare la videocamera Sport, premere il

caméscope Sport. 3| 2P System Settings ! tasto di [ACCENSIONE].
4 L’écran Movie Record (Enregistrement de film) < =R ¢ Viene visualizzata la schermata di registrazione
apparait. Storage Type video.
2. Premendo il tasto [MODE], impostare la modalita

Sélectionnez le mode System Settings (Réglage External
syst.) en appuyant sur le bouton [MODE].
@ L’écran System Settings (Réglage syst.) apparait.

EMove [D3Select

Déplacez le [Joystick] vers la gauche ou vers la

System Settings (Imp di sistema).
¢ Viene visualizzata la schermata System Settings
(Imp di sistema).

3. Spostare il [Joystick] a sinistra / a destra per

droite pour sélectionner <Storage Type> (Type 2P System Settings [ selezionare <Storage Type> (Tipo memoria).
stock.). ”ag:T iy - - 4. Spostare il [Joystick] su / gil per selezionare

. . un’opzione, quindi premere [Joystick(OK)].
Déplacez le [Joystick] vers le haut ou vers le bas Irprermel * <'I°nterna;|(>‘ (InterFr’\a) g file[vid‘(lao, di (imm)allgine,
pour sélectionner une option, puis appuyez sur musicali e vocali sono salvati nella memoria

[Joystick(OK)].

4 <Internal> (Interne) : les fichiers vidéo, photo,
musicaux et vocaux sont enregistrés dans la
mémoire interne.

& <External> (Externe) : les fichiers vidéo, photo,
musicaux et vocaux sont enregistrés dans la
mémoire externe (SD/MMC).

Une fois les réglages terminés, allez au mode
souhaité en appuyant sur le bouton [MODE].

Si vous insérez une carte mémoire alors que le
caméscope Sport est sous tension, un message contextuel s aﬁlche
automatiquement et vous invite & sélectionner le type de stockage.

Si aucune carte mémoire n'est insérée, seule I'option <Internal> (Interne)
est disponible.

Le systéme nécessite peu d’espace mémoire. La capacité de stockage
réelle peut différer de la capacité de mémoire indiquée.

La durée d’enregistrement maximale et la capacité en images varient
en fonction du support utilisé. =pages 31, 32

interna.

¢ <External> (Esterna) : | file video, di immagine,
musicali e vocali sono salvati nella memoria
esterna (SD/MMC)

5. Al termine delle impostazioni, spostarsi alla
modalita desiderata premendo il tasto [MODE].

[ Note ]

< Se siinserisce una scheda di memoria quando la
videocamera Sport & accesa, il menu di scelta rapida
richiede automaticamente di selezionare il tipo di
memoria.

%+ Se non ¢ stata inserita nessuna scheda di memoria, & disponibile solo
I'opzione <Internal> (Interna).

% |l sistema richiede una piccola parte dello spazio di memoria; la capacita
di memorizzazione effettiva puo essere diversa dalla capacita
della memoria stampata.

< Il tempo di registrazione e la capacita di memorizzazione delle immagini
massimi sono soggetti a variazioni in base al tipo di supporto utilizzato.

=Pagina 31, 32 2



Réglage du caméscope Sport

: Réglage du mode USB

Impostazione della videocamera[lZYNIXY]
Sport: Impostazione della modalita USB

Réglage du mode USB

Avant de relier le caméscope Sport & un ordinateur ou une imprimante

a l'aide du cable USB, veuillez sélectionner le mode USB adéquat.

Impostazione della modalita USB

Prima di collegare la videocamera Sport ad un computer o ad una
stampante via USB, impostare il modo USB corretto.

1. Appuyez sur le bouton [POWER] pour allumer (5 SIt_—" ! 1. Per attivare la videocamera Sport, premere il
le caméscope Sport. iy ) e O tasto di [ACCENSIONE].
4 L'écran Movie Record (Enreg. vidéo) apparait. @ Viene visualizzata la schermata di registrazione
. , video.
2. Sélectionnez le mode System Settings (Réglage PiciBridge
syst.) en appuyant sur le bouton [MODE]. pC-Cain 2. Premendo il tasto [MODE], impostare la

@ L’écran System Settings (Réglage syst.)

apparait. Eiove

3. Déplacez le [Joystick] vers la gauche ou vers | . AVEERESTNNS
@ -Sﬁo - 10 - 3. Spostare il [Joystick] a sinistra / a destra per

la droite pour sélectionner <USB Mode> (Mode
USB).
Mass Storage
4. Déplacez le [Joystick] vers le haut ou vers le PictBridge

bas pour sélectionner une option, puis appuyez
sur [Joystick(OK)].

B Vove

[I3Select

modalita System Settings (Imp di sistema).
@ Viene visualizzata la schermata System
Settings (Imp di sistema).

selezionare <USB Mode> (Mod. USB).

4. Spostare il [Joystick] su / giu per selezionare
ESelect un’opzione, quindi premere [Joystick(OK)].

Mass Storage

Transfert de fichiers du caméscope Sport vers votre
ordinateur wpage 115

Trasferimento dei file dalla videocamera Sport al computer

Mass Storage wPagina 115

PictBridge

En connectant le caméscope Sport a une imprimante
compatible Pictbridge (vendue séparément), vous pouvez
envoyer des images a partir de la mémoire interne ou de la
mémoire externe (SD/MMC) directement vers I'imprimante en
effectuant quelques opérations simples. wpage 116

Collegando la videocamera Sport a una stampante con
supporto PictBridge (acquistabile a parte) & possibile inviare
PictBridge |direttamente alla stampante, con poche e semplici operazioni,
le immagini registrate nella memoria interna o esterna (SD/
MMC =Pagina 116

PC-Cam
(Webcam)

Vous pouvez utiliser votre caméscope Sport comme Web cam
pour participer a des conversations en ligne, communiquer
par visioconférence, etc. wpage 117

E possibile utilizzare I'apparecchiatura come una videocamera
PC-Cam |per PC per chat, video conferenze e altre applicazioni video
per PC =Pagina 117

A




Réglage du caméscope Sport
: Réglages de la mémoire

Impostazione della videocamera
Sport: Impostazione della memoria

Réglage de la fonction File No (N° FCH)

Vous pouvez régler la numérotation des fichiers afin qu’elle soit réinitialisée
chaque fois que la carte mémoire est formatée ou incrémentée de fagon
continue.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L’écran Movie Record (Enreg. vidéo) apparait.

< <

SIEES

2. Sélectionnez le mode System Settings (Réglage
syst.) en appuyant sur le bouton [MODE].
@ L’écran System Settings (Réglage syst.) apparait. i
3. Déplacez le [Joystick] vers la gauche ou vers la 4

droite pour sélectionner <File No.> (N° FCH).
<> <
. . File No:
4, Déplacez le [Joystick] vers le haut ou vers le bas —

pour sélectionner une option, puis appuyez sur

[Joystick(OK)].

@ <Series> (Série) : permet de numéroter les
fichiers en continu d’une carte mémoire a une
autre. Ainsi, le numéro du premier fichier stocké
sur une nouvelle carte mémoire est incrémenté de 1 par rapport
au numéro du dernier fichier enregistré sur la carte mémoire
précédente.

4 <Reset> (Ré-in) : lorsque la mémoire de stockage est formatée, le
numéro de fichier est ramené a sa valeur par défaut (100-0001).

Reset:

EZMove

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

[ Remarque ]

< Lorsque vous réglez <File No.> (N° FCH) sur <Series> (Série), chaque
fichier recoit un numéro différent afin d’éviter la duplication des noms
de fichier. Cela est pratique lorsque vous souhaitez gérer vos fichiers
sur ordinateur.

3 Q/ System Settings
> T -

[I3Select

O,/ System Settings
\on- - B9 B 3

Series

[I3Select

Impostazione della funzione File No (N. File)

E possibile impostare i numeri dei file in modo che vengano resettati ogni
volta che la scheda di memoria viene formattata, o che vengano contati in
modo continuo.

£ IN{I] 1.
W-E3-E

Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

¢ Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la modalita
System Settings (Imp di sistema).
¢ \Viene visualizzata la schermata System Settings
— (Imp di sistema).
. Spostare il [Joystick] a sinistra / a destra per
selezionare <File No.> (N. File).

4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
¢ <Series> (Serie) : La numerazione tra le schede
di memoria & continua; il primo numero di file
assegnato su una nuova scheda di memoria &
maggiore di 1 rispetto all'ultimo numero di file
assegnato sulla scheda di memoria precedente.
4 <Reset> (Reimp) : Quando si formatta la memoria, viene
ripristinato il numero di file predefinito (100-0001)

5. Alla fine, spostarsi alla modalita desiderata premendo il tasto [MODE].
[ Nota ]
% Impostando <File No.> (N.File) su <Series> (Serie), ad ogni file &

assegnato un numero diverso in modo da evitare la duplicazione dei
nomi dei file. Questa opzione ¢ utile per gestire i file su un PC.

A
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Formatage de la mémoire

Le formatage de la mémoire interne ou de la carte mémoire permet o’
effacer tous les fichiers.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.

4 L’écran Movie Record (Enreg. vidéo) apparait.

2. Sélectionnez le mode System Settings (Réglage
syst.) en appuyant sur le bouton [MODE].

4 L’écran System Settings (Réglage syst.) apparait.

3. Déplacez le [Joystick] vers la gauche ou vers la
droite pour sélectionner <Format>.

4. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner une option, puis appuyez sur
[Joystick(OK)].

4 <Internal> (Interne) : permet de formater la
mémoire interne.

<External> (Externe) : permet de formater

la mémoire externe.Le message contextuel

apparait lorsque vous appuyez sur [Joystick(OK)].

Sélectionnez <OK> ou <Cancel> (Annul.) en

déplacant le [Joystick] vers le haut ou vers le bas

et appuyez sur [Joystick(OK)].

5. Une fois les réglages terminés, allez au mode
souhaité en appuyant sur le bouton [MODE].

External

D Move

Internal
*

B Vove

[ Avertissement ]

% Les informations précédentes ne peuvent pas étre
récupérées apres le formatage.

[ Remarques ]

¢ Le fonctionnement d’une carte mémoire non formatée

sur le caméscope Sport n'est pas garanti. Veillez a

formater votre carte mémoire sur le caméscope Sport

avant de ['utiliser

Si aucune carte mémoire n'est insérée, 'option

<External> (Externe) ne s’affiche pas.

E=swiove

Formatting

&S Move

3 9/ System Settings

iy QUIS m-EB3-E- 9
Format

2

[IiSelect 3

4 i?/Syslem Settings

W QLN W-EA-E- 9
Format

[ISelect

i}/ System Settings

LY SEIECT

2% System Settings

external memory...

[I3Select

Formattazione della memoria

E possibile formattare la memoria interna o la scheda di memoria per
cancellare tutti i file.

£ INGIII ‘ 1. Per attivare la videocamera Sport, premere il

tasto di [ACCENSIONE].

4 Viene visualizzata la schermata di registrazionevideo.

Premendo il tasto [MODE], impostare la modalita

System Settings (Imp di sistema).

¢ Viene visualizzata la schermata System Settings
(Imp di sistema).

. Spostare il [Joystick] a sinistra / a destra per

selezionare <Format> (Formatta).

4. Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK)].

£_INIIN

¢ <Internal> (Interna) : La memoria interna viene
formattata.
¢ <External> (Esterna) : La memoria esterna

viene formattata. Premendo [Joystick(OK)],
viene visualizzato il messaggio pop-up.
Selezionare <OK> 0 <Cancel> (Annul)
spostando il [Joystick] su / gil,, e quindi premere
[Joystick(OK)].
5. Al termine delle impostazioni, spostarsi alla
modalita desiderata premendo il tasto [MODE].

[Avvertenza]
« Dopo aver eseguito la formattazione le informazioni
precedenti non possono essere ripristinate.

[ Note ]

< Non si garantisce il funzionamento di una scheda
di memoria che non e stata formattata sulla
videocamera Sport. Prima dell'utilizzo, assicurarsi
di aver formattato la scheda di memoria sulla
videocamera Sport.

Se la scheda di memoria non é stata inserita, I
opzione <External> (Esterna) non & visualizzata.
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Affichage de I’espace mémoire

Vous pouvez vérifier 'espace mémoire utilisé ainsi que I'espace
mémoire total du caméscope Sport.

1. Appuyez sur le bouton [POWER] pour
allumer le caméscope Sport.
4 L’écran Movie Record (Enreg. vidéo)

apparait.

4 £ System Settings

Internal

External

Sélectionnez le mode System Settings

(Réglage syst.) en appuyant sur le bouton

[MODE].

@ L’écran System Settings (Réglage syst.)
apparait.

EMove

Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <Memory Space>
(Espace mém.).

L’espace mémoire utilisé ainsi que I'espace mémoire total s’
affichent.

Apres I'affichage de I'espace mémoire, allez au mode souhaité
en appuyant sur le bouton [MODE].

[ Remarques ]

< Le systeme nécessite peu d’espace mémoire. La capacité de
stockage réelle peut différer de la capacité de mémoire indiquée.
Si aucune carte mémoire n’est insérée, 'option <External>
(Externe) ne s’affiche pas.

Les témoins d’affichage & 'écran de ce manuel sont basés sur le
modele VP-X210L.

<

<

an SEON E-E- 9
Memory Space

Memory Space

1
@ Used memory capacity indicator g3,
@ Total memory capacity indicator

Visualizzazione dello spazio della memoria

E possibile controllare lo spazio di memoria utilizzato e lo spazio di
memoria totale della videocamera Sport.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.

£ NI

3MB'983MB

. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
@ Viene visualizzata la schermata System

Settings (Imp di sistema).

O0MB'243MB

Spostare il [Joystick] a sinistra / a destra
per selezionare <Memory Space> (Spazio
memoria).

4. Vengono visualizzate la memoria utilizzata e la memoria totale

5. Dopo aver visualizzato lo spazio della memoria, spostarsi alla
modalita desiderata premendo il tasto [MODE].

[ Note ]

< |l sistema richiede una piccola parte dello spazio di memoria, la
capacita di memorizzazione effettiva pud essere diversa dalla
capacita della memoria stampata .

% Se la scheda di memoria non ¢ stata inserita, 'opzione <External>
(Esterna) non ¢ visualizzata.

< Gli indicatori OSD di questo manuale si basano sul modello
VP-X210L.
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Réglage de la luminosité de I’écran LCD

Vous pouvez régler la luminosité de I'écran LCD pour compenser I
éclairage ambiant.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo) apparait.

K}

2. Sélectionnez le mode System Settings (Réglage
syst.) en appuyant sur le bouton [MODE].

4 L'écran System Settings (Réglage syst.)
apparait. W ove

3. Déplacez le [Joystick] vers la gauche ou vers |
la droite pour sélectionner <LCD Brightness>

(Lumin. LCD).

4. Déplacez le [Joystick] vers le haut ou vers le
bas pour régler la luminosité, puis appuyez sur
[Joystick(OK)].

@ Déplacer le [Joystick] vers le haut permet
éclairer I'écran et le déplacer vers le bas permet de 'assombrir.

¢ Plage de luminosité : vous pouvez faire varier la luminosité de I
écran LCD de 0 a 100 %.

L= Tove

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

[ Remarques ]

% Un écran LCD trés lumineux consomme davantage d’énergie.

% Reéglez la luminosité de 'écran LCD lorsque I'éclairage ambiant est
trop lumineux et I'écran difficilement visible.

La luminosité de I'écran LCD n’affecte en rien la luminosité des
images enregistrées.

s

L

Regolazione della luminosita del display LCD

E possibile regolare la luminosita del display LCD, nel caso in cui I
ambiente sia poco illuminato.

23 System Settings
i QNN E- Q-
LCD Brightness

—— T

EB Adjust

= Adjust)

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
@ Viene visualizzata la schermata System
Settings (Imp di sistema).

EI3Set

1Y SystemiSettings

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <LCD Brightness> (Lumin. LCD).

4. Spostare il [Joystick] su / giu per regolare la
luminosita, quindi premere [Joystick(OK)].

@ Spostando il [Joystick] su, si rende la
schermata luminosa, mentre spostandolo
verso il basso si rende la schermata piu scura.

@ Valori di luminosita: | valori di luminosita del display LCD

possono essere impostati da 0% a 100%.

OK[SIER

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].

[ Note ]

Un'impostazione piu chiara del display LCD consuma una
maggiore quantita di energia delle batterie.

Regolare la luminosita del display LCD quando ['illuminazione
ambiente & troppo luminosa ed é piu difficile vedere il monitor.
Luminosita del display LCD non incide sulla luminosita delle
immagini da memorizzare.

KX
<
£
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Réglage de la couleur de I’écran LCD

Vous pouvez régler la couleur de I'écran LCD en fonction des
conditions.

1. Appuyez sur le bouton [POWER] pour

allumer le caméscope Sport. 3

4 L’écran Movie Record (Enreg. vidéo)
apparait.

2. Sélectionnez le mode System Settings
(Réglage syst.) en appuyant sur le bouton
[MODE].

4 L'écran System Settings (Réglage syst.)
apparait. 4

[ Move

3. Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <LCD Colour>
(Coul. LCD).

4. Déplacez le [Joystick] vers le haut ou vers
le bas pour régler la couleur de I'écran LCD,
puis appuyez sur [Joystick(OK)].

4 \Vous pouvez faire varier la couleur de 'écran LCD de 0 a
100 %.

(& Move

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

Q/ System Settings |
Ed < » Q- - Q-
LCD Colour

] 505

EB Adjust

Q System Settings

B Wl @ = - @ -
LCD Colour

EBAdjust

Regolazione del colore del display LCD

E possibile regolare il colore del display LCD, a seconda delle condizioni.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di
registrazione video.

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
@ Viene visualizzata la schermata System
Settings (Imp di sistema).

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <LCD Colour> (Colore LCD).

e 4. Spostare il [Joystick] su / giu per regolare

il colore del display LCD, quindi premere
. [Joystick(OK)].
@ E possibile regolare il colore LCD da 0% a 100%.

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].
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Réglage de la date et de I’heure

Ce menu vous permet de régler la date et I'heure.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo) apparait.

2. Sélectionnez le mode System Settings
(Réglage syst.) en appuyant sur le bouton
[MODE].

@ L'écran System Settings (Réglage syst.) apparait. Eiove

3. Déplacez le [Joystick] vers la gauche ou vers | )
la droite pour sélectionner <Date/TimeSet>
(Régl. date/hr), puis appuyez sur [Joystick(OK)].

4. Réglez la valeur souhaitée en déplacant le
[Joystick] vers le haut ou vers le bas.

5. Accédez a 'élément suivant en déplacant le Biiove

[Joystick] vers la gauche ou vers la droite,

puis réglez les valeurs en déplacant le [Joystick] vers le haut

ou vers le bas.

@ Les éléments s'affichent dans 'ordre du format de la date.

¢ |Is s'affichent par défaut dans l'ordre suivant : année, mois,
date, heure, minute et AM/PM.

6. Une fois le dernier élément réglé, appuyez sur [Joystick(OK)]
pour terminer les réglages.

7. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

[ Remarques ]

% Reportez-vous a la page 107 pour régler la date et 'heure a
afficher sur 'écran LCD.

< Vous pouvez régler 'horloge jusqu’a 'an 2037.

3 Q/ System Settings

B N =2 B -
Date/Time Set:

2006 01 01
12: 000 AM

I3 Set

Q/ System Settings

R 9 -
Date/Time Set

2006 /NN

1200 Al

B Adjust

Impostazione di data e ora

E possibile impostare la data/'ora utilizzando questo menu.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
4 Viene visualizzata la schermata System
Settings (Imp di sistema).
E NI . . -
3. Spostare il [Joystick] a sinistra / a destra per

selezionare <Date/Time Set>(Imp Data/Ora) e
quindi premere [Joystick(OK)].

4. Impostare il valore desiderato spostando il
[Joystick] su / giu.

(D3 Set . .
5. Spostarsi alla voce successiva spostando

il [Joystick] a sinistra / a destra, quindi
impostare i valori spostando il [Joystick] su / giu
¢ Le voci sono visualizzate nell'ordine del formato data.
@ Per impostazione predefinita, 'ordine di visualizzazione & anno,
mese, giorno, ora, minuti e AM/PM.

6. Dopo avere impostato I'ultima voce, premere [Joystick(OK)]
per terminare I'impostazione.

7. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].

[ Note ]
% Per limpostazione di <data/ora> sul display LCD, vedere a pagina 107.
%+ E possibile impostare I'anno fino a 2037.
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Réglage du format de la date

Vous pouvez choisir le format d’affichage de la date.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo) apparait.

3

DD/MMAYY
NVIN/DDAY Y

2. Sélectionnez le mode System Settings (Réglage
syst.) en appuyant sur le bouton [MODE].
@ L’écran System Settings (Réglage syst.)

N EMove
apparait.

4 i}System Settings
Q « I = e IR G

3. Déplacez le [Joystick] vers la g auche ou vers
la droite pour sélectionner <Date Format>
(Format date).

Date Format
YY/MIN/DD

DD/MM/YY

. . MN/DDIYY
. Déplacez le [Joystick] vers le haut ou vers le ‘

bas pour sélectionner une option, puis appuyez
sur [Joystick(OK)].

4 <YY/MM/DD> : la date s’affiche au format année/mois/jour.
¢ <DD/MM/YY> : la date s'affiche au format jour/mois/année.
& <MM/DD/YY> : la date s’affiche au format mois/jour/année.

B Move

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

2% System Settings

Q « » @Bl (Y
Date Format

YY/\14/DD

EI3Select

Impostazione del formato della data

E possibile selezionare il formato della data da visualizzare.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione
video.

£ INjNI}

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp. di sistema).
@ Viene visualizzata la schermata System

AL Settings (Imp di sistema).

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <Date Format> (Formato data).

[I3Select

4. Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
¢ <YY/MM/DD> : La data appare nell'ordine anno/mese/giorno.
¢ <DD/MM/YY> : La data appare nell'ordine giorno/mese/anno.
¢ <MM/DD/YY> : La data appare nell'ordine mese/giorno/anno.

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].
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Réglage du format de I’heure

Vous pouvez choisir le format d’affichage de I'heure.

1. Appuyez sur le bouton [POWER] pour allumer )
le caméscope Sport.

2% System Settings

Impostazione del formato dell’'ora

E possibile selezionare il formato dell'ora da visualizzare.

S\l 1. Per attivare la videocamera Sport, premere il

, _ o ) El s G o tasto di [ACCENSIONE].
4 L'écran Movie Record (Enreg. vidéo) apparait. = 4 Viene visualizzata la schermata di registrazione
video.

24 Hour
2. Sélectionnez le mode System Settings (Réglage o

syst.) en appuyant sur le bouton [MODE].
4 L'écran System Settings (Réglage syst.) & Move
apparait.

4 2% System Settings AN 0

gl 2

3. Déplacez le [Joystick] vers la gauche ou vers la
droite pour sélectionner <Time Format> (Format
Hr).

12 Hour

EEMove

4. Déplacez le [Joystick] vers le haut ou vers le
bas pour sélectionner une option, puis appuyez sur
[Joystick(OK)].
¢ <12 Hour> (12 h) : I'heure saffiche au format 12 heures.
@ <24 Hour> (24 h) : 'heure s’affiche au format 24 heures.

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
¢ Viene visualizzata la schermata System

Settings (Imp di sistema).

[I3Select

b Ege ol (-

Time Format:

3. Spostare il [Joystick] a sinistra / a destra per

selezionare <Time Format> (Form orario).

[I3Select

4. Spostare il [Joystick] su / giu per selezionare un’opzione,
quindi premere [Joystick (OK)].
¢ <12 Hour> (12 Ore) : L'ora € visualizzata in unita da 12 ore.
¢ <24 Hour> (24 Ore) : L'ora ¢ visualizzata nel formato 24 ore.

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].
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Réglage de I’affichage de la date et de I’heure

Vous pouvez régler I'affichage de la date et de I'heure sur I'écran LCD.

1. Appuyez sur le bouton [POWER] pour allumer

Impostazione della visualizzazione di data/ora

E possibile impostare la visualizzazione di data e ora sul display LCD.

1. Per attivare la videocamera Sport, premere il

le caméscope Sport. | SPSEmSege Ny tasto di [ACCENSIONE].
# L’écran Movie Record (Enreg. vidéo) apparait. ‘ G- & - i @ Viene visualizzata la schermata di registrazione

A

video.

2. Sélectionnez le mode System Settings (Réglage

syst.) en appuyant sur le bouton [MODE]. Date
@ L'écran System Settings (Réglage syst.) Jime
apparait' D ove

2. Premendo il tasto [MODE], impostare la

(T Select modalita System Settings (Imp di sistema).

# Viene visualizzata la schermata System

3. Déplacez le [Joystick] vers la gauche ou vers | [EAIEEREEINES E INfuin| Settings (Imp di sistema).

Hr).
Date
4. Déplacez le [Joystick] vers le haut ou vers le Time

la droite pour sélectionner <Date/Time> (Date/ 2 -a A RRCORE X -
Date/Time

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <Date/Time> (Data/Ora).

bas pour sélectionner une option, puis appuyez

v

sur [Joystick(OK)]. Eilove  [@Selest

¢ <Off>: la date et I'heure ne s'affichent pas. 4. Spostare il [Joystick] su / giu per selezionare
& <Date> : la date saffiche. un’opzione, quindi premere [Joystick(OK)]

@ <Time> (Hr) : I'heure s’affiche. & <Off> : Date (Data) e Time (Ora) non sono
¢ <Date/Time> (Date/Hr) : la date et I'heure visualizzati.

affichent.

5. Une fois les réglages terminés, allez au mode
souhaité en appuyant sur le bouton [MODE].
4 Ladate et 'heure sélectionnées s’affichent en
mode Movie ou Photo.

<Date> (Data) : Viene visualizzata la data.
<Time> (Ora) : Viene visualizzata l'ora.
<Date/Time> (Data/Ora) : Vengono
visualizzate la data e l'ora.

L R R 4

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].
¢ La data/l'ora selezionate vengono visualizzate nelle modalita
di foto.
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Réglage du signal sonore

Vous pouvez activer ou désactiver le signal sonore. Lorsque cette
fonction est activée, un signal sonore retentit & chaque fois que vous
appuyez sur un bouton.

1. Appuyez sur le bouton [POWER] pour 3
allumer le caméscope Sport.

0{ System Settings

Impostazione del suono bip

E possibile impostare il suono bip su on (attivo) o off (disattivo) Se &
attivo, viene emesso un bip ogni volta che si preme un tasto.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
4 Viene visualizzata la schermata di registrazione

@ L’écran Movie Record (Enreg. vidéo) apparait. ' ) video.
2. Sélectionnez le mode System Settings Zgﬁ_
(Réglage syst.) en appuyant sur le bouton 2. Premendo il tasto [MODE], impostare la
[MODE]. modalita System Settings (Imp di sistema).
¢ L'écran System Settings (Réglage syst.) &DMove  [I3Select 4 Viene visualizzata la schermata System
apparait. Settings (Imp di sistema).

3. Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <Beep Sound> =
(Signal son).

4. Déplacez le [Joystick] vers le haut ou vers
le bas pour sélectionner une option, puis
appuyez sur [Joystick(OK)].

4 <On>: permet d’activer le signal sonore.
& <Off> : permet de désactiver le signal sonore.

S Move

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

[ Remarque ]

< Lorsque les écouteurs, le cable audio/vidéo ou le module caméra
externe sont branchés sur le caméscope Sport, la fonction <Beep
Sound> (Signal son) n’est pas disponible.

dha

4y 1% System Settings

= —( 3
Beep Sound

(I Select 4.

£ IN[In|

Q- €

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <Beep Sound> (Suono Bip).

Spostare il [Joystick] su / giu per selezionare
un’opzione, quindi premere [Joystick(OK)].
4 <On> : |l suono bip viene attivato.

@ <Off> : Il suono bip viene disattivato.

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].

[ Nota ]

< Se alla videocamera Sport vengono collegate delle cuffie, dei
cavi audio/video modulo videocamera esterna, la funzione <Beep
Sound> (Suono Bip) non ¢ abilitata.
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Réglage du mode Start-up (Démarr.)

Vous pouvez choisir le mode a afficher lorsque vous allumez votre
caméscope Sport.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.

@ L’écran Movie Record (Enreg. vidéo) apparait.

3

2 System Settin

. Sélectionnez le mode System Settings (Réglage Previous Mode
syst.) en appuyant sur le bouton [MODE].
@ L’écran System Settings (Réglage syst.)

" = Move
apparait.

4
Déplacez le [Joystick] vers la gauche ou

vers la droite pour sélectionner <Start-up>
(Démarr.).

ol <

Movie Mode

Déplacez le [Joystick] vers le haut ou vers
le bas pour sélectionner une option, puis
appuyez sur [Joystick(OK)].

4 <Mode Movie> (Vidéo) : le caméscope Sport démarre en
mode Movie (Vidéo).

<Previous Mode> (Mode préc.) : le caméscope Sport
démarre dans le dernier mode actif.

EZMove

*

Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

[ Remarque ]
% Assurez-vous que le mode de démarrage est réglé sur le mode
sélectionné lorsque vous rallumez votre caméscope Sport.

A ﬁﬁﬂ Lald

EI3Select

1% System Settings

3 -0

Impostazione della modalita di accensione

E possibile selezionare la modalita di avvio visualizzata allaccensione
della videocamera Sport

95 1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione

video.

Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
¢ Viene visualizzata la schermata System

[ ) Settings (Imp di sistema).

Spostare il [Joystick] a sinistra / a destra per
selezionare <Start-up> (Accens).

[I3Select

Spostare il [Joystick] su / gil per selezionare un’opzione,
qumdn premere [Joystick(OK)].

<Movie Mode> (Modalita Film) : La videocamera Sport viene
avviata in Movie Mode (Modalita film).

<Previous Mode> (Mod. preced.) : La videocamera Sport
viene avviata nellultima modalita utilizzata.

*

Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].

[ Nota ]
< Quando si riaccende la videocamera Sport, assicurarsi che sia
impostata la modalita di accensione desiderata.

A
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Réinitialisation du caméscope Sport

Vous pouvez réinitialiser le caméscope Sport sur les parametres par
défaut.

1. Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo) apparait.

2. Sélectionnez le mode System Settings
(Réglage syst.) en appuyant sur le bouton
[MODE].

@ L’écran System Settings (Réglage syst.)
apparait.

D iove

3. Déplacez le [Joystick] vers la gauche ou vers la droite pour
sélectionner <Reset> (Ré-in), puis appuyez sur [Joystick(OK)].
@ Le caméscope Sport est réinitialisé sur les parametres par
défaut.

[ Avertissement ]
< Sivous réinitialisez votre caméscope Sport, toutes les fonctions
reviennent aux parameétres par défaut.

[ Remarque ]
< Une fois votre caméscope Sport réinitialisé, réglez la fonction
<Date/Time Set> (Régl. date/hr). wpage 104

M

B £ System Seltings

O < QAEE
Reset:

[I3Select

Reimpostazione della videocamera Sport

La videocamera Sport puo essere reimpostata con le impostazioni
predefinite (di fabbrica).

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
@ Viene visualizzata la schermata System
Settings (Imp di sistema).

3. Spostare il [Joystick] a sinistra / a destra per selezionare
<Reset> (Reimp) e quindi premere [Joystick(OK)].
¢ La videocamera Sport viene inizializzata alle impostazioni
predefinite.

[Avvertenza)
< Reimpostando la videocamera Sport, tutte le funzioni vengono
reinizializzate con quelle predefinite (di fabbrica).

[ Nota ]
<+ Dopo avere ripristinato la videocamera Sport, impostare
<Date/Time Set>(Imp Data/Ora). =Pagina 104
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Choix de la langue

Vous pouvez choisir la langue de votre caméscope Sport.

1. Appuyez sur le bouton [POWER] pour

allumer le caméscope Sport. 3

@ L’écran Movie Record (Enreg. vidéo)
apparait.

Espanol

2. Sélectionnez le mode Sysiem Seitings Jiancais

(Réglage syst.) en appuyant sur le bouton S Move
[MODE].
¢ L’écran System Settings (Réglage syst.) 4 2y njustes sistema
apparait. & - > €D
Language

a
English

3. Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <Language>. _Francais

[ Mover

4. Déplacez le [Joystick] vers le haut ou vers le bas pour
sélectionner la langue souhaitée, puis appuyez sur
[Joystick(OK)].
¢ English / Espafiol / Frangais / Portugués / Deutsch / Italiano /

Nederlands / Polski / Pycckuit / S+=0{ / H3Z / Iran / Arab /
Magyar / ‘Ing / YkpaiHcbka / Svenska

5. Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

¥ System Settings

£« > €
Language
a

English

[I3Select

EI3Selec.

Selezione della lingua

E possibile selezionare la lingua della videocamera Sport desiderata.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di registrazione
video.

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
¢ Viene visualizzata la schermata System

Settings (Imp di sistema).

Espanol

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <Language>.

4. Spostare il [Joystick] su / giu per selezionare la lingua
desiderata , quindi premere [Joystick(OK)].
4 English / Espafiol / Frangais / Portugués / Deutsch / Italiano /
Nederlands / Polski / Pycckuii / =10 / HR3Z/ Iran / Arab /
Magyar / ng / YkpaiHcbka / Svenska

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].
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Réglage de la fonction Auto Shut off (Extinct. auto)

Pour économiser I'énergie de la batterie, vous pouvez activer la
fonction <Auto Shut off> (Extinct. auto) qui permet de mettre le
caméscope Sport hors tension lorsque aucune opération n'est
effectuée pendant une durée définie.

1. 3

Appuyez sur le bouton [POWER] pour allumer
le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo) apparait.

Sélectionnez le mode Sysiem Settings (Reéglage
syst.) en appuyant sur le bouton [MODE].
@ L'écran System Settings (Réglage syst.) apparait.

= ove
Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner <Auto Shut off>
(Extinct. auto).

Déplacez le [Joystick] vers le haut ou vers le

bas pour sélectionner une option, puis appuyez

sur [Joystick(OK)].

& <Off> : permet d'annuler la fonction <Auto
Shut off > (Extinct. auto).

4 <5 Minutes> (5 min) : le caméscope s’éteint
automatiquement au bout de 5 minutes.

EDinove

Une fois les réglages terminés, allez au mode souhaité en
appuyant sur le bouton [MODE].

[ Remarques ]

% La fonction <Auto Shut off> (Extinct. auto) n’est pas disponible
lorsque vous branchez I'adaptateur CA sur le caméscope Sport.
La fonction <Auto Shut off> (Extinct. auto) est disponible
uniquement lorsque la batterie est la seule source d’alimentation.

% La fonction <Auto Shut Off> (Extinct. auto) n’est disponible que
lorsque vous la réglez en mode System Settings (Réglage syst.).

< Appuyez sur le bouton [POWER] pour réactiver le caméscope
Sport.

Q System Settings

Auto Shut off

i?/ System Settings

e
Auto Shut off

Off

5 Minutes

Impostazione dello spegnimento automatico

Per risparmiare energia, € possibile impostare la funzione <Auto Shut
off> (Spegn autom) che, se non viene eseguita alcuna operazione per
un determinato periodo di tempo, spegne la videocamera Sport.

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione

video.

Premendo il tasto [MODE], impostare la

modalita System Settings (Imp di sistema).

@ Viene visualizzata la schermata System
Settings (Imp di sistema).

[T3Select

Spostare il [Joystick] a sinistra / a destra per
selezionare <Auto Shut off> (Spegn autom).

Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK)].

& <Off> : La funzione <Auto Shut off> (Spegn
autom) viene annullata.

¢ <5 Minutes> (5 minuti) : La videocamera viene spenta
automaticamente dopo 5 minuti.

CHSelect

5. Al termine delle impostazioni, spostarsi alla modalita
desiderata premendo il tasto [MODE].

[ Note ]

% La funzione <Auto Shut off> (Spegn autom) ¢ disattivata quando
si collega I'alimentatore CA alla videocamera Sport, ma funziona
quando il gruppo batterie & 'unica fonte di alimentazione.

% La funzione <Auto Shut off> (Spegn autom) & attiva solo se
impostata in modalita System Settings (Imp di sistema).

< Premere il tasto di accensione per riattivare la videocamera Sport.
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Réglage de la fonction Demonstration (Démonstration)

La fonction Demonstration (Démonstration) vous permet de découvrir
toutes les fonctions dont le caméscope Sport est équipé.

1. Appuyez sur le bouton [POWER] pour

3 Q/ System Settings

Impostazione della funzione Demonstration (Dimostrazione)

La funzione Demonstration (Dimostrazione) permette di visualizzare
tutte le funzioni supportate dalla videocamera Sport.

e 1. Per attivare la videocamera Sport, premere il

allumer le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo)
apparait.

Sélectionnez le mode System Settings

(Réglage syst.) en appuyant sur le bouton

[MODE].

@ L’écran System Settings (Réglage syst.)
apparait.

. Déplacez le [Joystick] vers la gauche

ou vers la droite pour sélectionner
<Demonstration> (Démonstration).

. Déplacez le [Joystick] vers le haut ou vers

le bas pour sélectionner une option, puis

appuyez sur [Joystick(OK)].

& <Off> : permet d’annuler la fonction
Demonstration (Démonstration)

@ <5 Minutes> (5 min) : permet d’activer la
fonction Demonstration (Démonstration) au
bout de 5 minutes.

& <Play Now> (Lire) : permet d'activer la
fonction Demonstration (Démonstration)
sans délai.

[ Remarque ]

€ Wil M- - by
Demonstration

Off
S Minutes

Play Now

S Move (I3 Select

Demonstration

5 Minutes
Play Now

B VMove [I3Select

a8 STBY 00:00:00/00:40:05 WN{[I]]

0 Functions
1. Digital Camcorder
2. Digital Camera
3. MP3 Player
4. Stereo Audio Recorder
5. PC-Camera
6. Data Storage

[ Nota ]

tasto di [ACCENSIONE].
@ Viene visualizzata la schermata di registrazione
video.

Premendo il tasto [MODE], impostare la

modalita System Settings (Imp di sistema).

4 Viene visualizzata la schermata System
Settings (Imp di sistema).

. Spostare il [Joystick] a sinistra / a destra per

selezionare <Demonstration> (Dimostrazione).

. Spostare il [Joystick] su / giu per selezionare

un’opzione, quindi premere [Joystick(OK).

& <Off> : La funzione Demonstration
(Dimostrazione) viene annullata.

¢ <5 Minutes> (5 Minuti) : La funzione
Demonstration (Dimostrazione) viene avviata
dopo 5 minuti.

@ <Play Now> (Ripr ora) : La funzione
Demonstration (Dimostrazione) viene avviata
immediatamente.

< Sivous activez la fonction Demonstration (Démonstration), celle-ci
ne fonctionnera qu’en mode Video Record (Enreg. vidéo).

% La funzione Demonstration (Dimostrazione) funziona solo in modalita
Movie Record (Registr. video).

da
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Affichage des informations sur la version
Vous pouvez consulter les informations relatives a la version du

Visualizzazione delle informazioni sulla versione

E possibile visualizzare le informazioni sulla versione firmware.

micrologiciel.

1. Appuygz sur le bouton [POWER] pour allumer |} [ ASEEREETES ‘ 1. Per attivare la videocamera Sport, premere il
le ca!rpescope Sport. o a i El w@-e<- b - tasto di [ACCENSIONE].
4 L’écran Movie Record (Enreg. vidéo) apparait. Veislonlino @ Viene visualizzata la schermata di registrazione

Samsung Elec: Co. LTD video.
SIW1.00 Fel>i 16 2006/ 00:20: 10

2. Sélectionnez le mode System Settings (Réglage
syst.) en appuyant sur le bouton [MODE].
@ L'écran System Settings (Réglage syst.)
apparait.

(& love

3. Déplacez le [Joystick] vers la gauche ou vers la droite pour
sélectionner <Version Info> (Info version).
4 La version du micrologiciel du caméscope Sport s'affiche.

4. Apres avoir consulté les informations relatives a la version,
allez au mode souhaité en appuyant sur le bouton [MODE].

Syscon 1.00/Feb 17 2006108:53:39

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
@ Viene visualizzata la schermata System
Settings (Imp di sistema).

3. Spostare il [Joystick] a sinistra / a destra per selezionare
<Version Info> (Info versione).
# Viene visualizzata la versione firmware della videocamera Sport.

4. Dopo aver visualizzato le informazioni sulla versione,
spostarsi alla modalita desiderata premendo il tasto [MODE].
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Transfert de fichiers vers un ordinateur
Vous pouvez transférer des fichiers photo et vidéo sur votre ordinateur.

Avant de commencer !

Vous pouvez copier des fichiers MP3 lorsque
<USB Mode> (Mode USB) est réglé sur <Mass
Storage> (Mém. aux.) =page 98

1. Allumez votre ordinateur.

2. Appuyez sur le bouton [POWER] pour
allumer le caméscope Sport.
@ L’écran Movie Record (Enreg. vidéo) apparait.

3. Branchez le caméscope Sport sur votre
ordinateur a I'aide du cable USB.

4. Copiez le fichier souhaité du caméscope
Sport sur votre ordinateur.

5. Une fois terminé, débranchez le cable
USB.

[ Remarques ]

% Sivous débranchez le cable USB pendant
le transfert des données, ce dernier s’
interrompt et les données enregistrées
risquent d’étre endommageées.

% |l est possible que des erreurs de

communication / d'installation se produisent | :

lorsque plusieurs périphériques USB
sont reliés a un ordinateur ou que des
concentrateurs USB sont utilisés.

Open the front cover and /7
connect the USB cable.

(=

USB cable

Trasferimento di file ad un computer

E possibile trasferire foto e video al PC

Prima di iniziare !

Puoi copiare i file quando la <USB Mode>
€' impostata su <Mass Storage> =pag 98

1.

2.

Accendere il PC.

Per attivare la videocamera Sport,

premere il tasto di [ACCENSIONE].

¢ Viene visualizzata la schermata di
registrazione video.

Collegare la videocamera Sport al PC
con il cavo USB.

Copiare il file desiderato dalla
videocamera Sport al PC.

Quindi scollegare il cavo USB.

[ Note ]
< Se si scollega il cavo USB durante

il trasferimento dei dati, questo si
interrompe e i dati memorizzati
potrebbero danneggiarsi.

Se al PC vengono collegati piu dispositivi
USB o si utilizzano pit hub USB,
possono verificarsi degli errori nella
comunicazione/installazione con la
videocamera Sport.

da
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Impression PictBridge

Gréce au cable USB et a une imprimante compatible PictBridge, vous pouvez imprimer
vos photos directement et sans branchement préalable sur un ordinateur.

Stampa con PictBridge

Con il cavo USB in dotazione e una stampante PictBridge compatibile, & possibile
stampare le foto direttamente senza collegarsi ad un PC.

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.
4 L'écran Movie Record (Enreg. vidéo) apparait.

2. Sélectionnez le mode System Settings (Réglage
syst.) en appuyant sur le bouton [MODE].
4 L'écran System Settings (Réglage syst.) apparait.

3. Déplacez le [Joystick] vers la gauche ou vers la
droite pour sélectionner <USB Mode> (Mode USB).

4. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner <PictBridge>, puis appuyez
sur [Joystick(OK)].

(sold separately)

PictBridge Supporting Printer

1. Per attivare la videocamera Sport, premere il
tasto di [ACCENSIONE].
¢ Viene visualizzata la schermata di

registrazione video.

2. Premendo il tasto [MODE], impostare la
modalita System Settings (Imp di sistema).
¢ Viene visualizzata la schermata System

Settings (Imp di sistema).

3. Spostare il [Joystick] a sinistra / a destra per
selezionare <USB Mode> (Mod. USB).

4. Spostare il [Joystick] su / giu per selezionare

5. Reliez le caméscope Sport et I'imprimante
compatible PictBridge a I'aide du cable USB.

6. Déplacez le [Joystick] vers la gauche ou vers
la droite pour sélectionner le fichier que vous
souhaitez imprimer.

7. Déplacez le [Joystick] vers le haut ou vers le bas
pour définir le nombre de copies.

<PictBridge>, quindi premere [Joystick(OK)].

5. Collegare la videocamera Sport alla
stampante PictBridge compatibile con un
cavo USB.

6. Spostare il [Joystick] a sinistra / a destra per
selezionare il file da stampare.

7. Spostare il [Joystick] su / giu per impostare il

4 Etendue des possibilités : 01 ~ 30
8. Appuyez sur [Joystick(OK)] pour démarrer I'impression.
9. Une fois terminé, débranchez le cable USB.

[ Avertissement ]
< Cette fonction n’est disponible qu'avec une imprimante
compatible PictBridge.
PC-Cam

[ Remarques ]
% Veuillez vous reporter au manuel d'utilisation de 'imprimante
pour plus de détails concernant les options d'impression.

< Selon le modéle d'imprimante, des problemes d'impression
peuvent apparaitre. Dans ce cas, téléchargez les fichiers au
format JPEG directement sur 'ordinateur et imprimez-les.

< En fonction de 'imprimante utilisée, I'option de la date et de
I'heure peut ne pas étre prise en charge. Dans ce cas, le
menu comportant la date et 'heure ne s'affiche pas.

D Move

2 System Settings

@ EES) By - o - du) - B} 8.
USB Mode 9.

Mass Storage

PictBridge

numero di copie.

¢ Possibilita: 01 ~ 30

Premere [Joystick(OK)] per avviare la stampa.
Quindi scollegare il cavo USB.

£_INJIN]

[Avvertenza]
« Questa funzione & disponibile solo con stampanti che
supportano PictBridge.

CISelect

[ Note ]
< Per informazioni sulla stampa, fare riferimento al
Manuale utente della stampante.

< A seconda della stampante, & possibile che questa
non funzioni. In questo caso, scaricare i file JPEG
direttamente sul PC e stamparii.

< A seconda della stampante, & possibile che le opzioni
di data e ora non siano supportate In questo caso non
vengono visualizzati i relativi menu.
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Utilisation de Ila fonction PC Cam (Webcam)

Vous pouvez utiliser votre caméscope comme Web cam pour participer a des
conversations vidéo en ligne, communiquer par visioconférence, etc.

Utilizzo della funzione PC Cam

E possibile utilizzare 'apparecchio come una videocamera per PC per chat,
video conferenze e altre applicazioni video per PC.

Avant de commencer ! 3 £ System Settings £ INGIIE Prima di iniziare !

4 Pour utiliser la Web cam, installez le pilote DV.=page 124 el .-e > 8w - on - 30 - BR @ Per utilizzare PC Cam ¢ necessario installare il

1. Appuyez sur le bouton [POWER] pour allumer le USB lllode driver DV.=Pagina 124
caméscope Sport. 1. Per attivare la videocamera Sport, premere il tasto
4 L’écran Movie Record (Enreg. vidéo) apparait. PictBridge di [A(_:CENSIONE]. o )

2. Sélectionnez le mode System Settings (Réglage FC-Cam @ Viene visualizzata la schermata di registrazione
syst.) en appuyant sur le bouton [MODE]. video. . . =
& L’écran System Settings (Réglage syst.) apparait. EMove  [@Select 2. Premendo il tasto [MODE], impostare la modalita

3. Déplacez le [Joystick] vers la gauche ou vers la

System Settings (Imp di sistema).

droite pour sélectionner <USB Mode> (Mode USB). |2/ [IESRSyRISENo, BT 4 Viene visualizzata la schermata System Settings

4. Déplacez le [Joystick] vers le haut ou vers le bas
pour sélectionner <PC-Cam> (Webcam), puis USB Node
appuyez sur [Joystick(OK)].

Allumez votre ordinateur.

Branchez le caméscope Sport sur votre ordinateur a

Mass Storage
RictBridge

oo

= = =

(Imp di sistema).
Spostare il [Joystick] a sinistra / a destra per
selezionare <USB Mode> (Mod. USB).

4. Spostare il [Joystick] su / giu per selezionare
<PC-Cam>, quindi premere [Joystick(OK)].

- - - B3 3.

Faide du cable USB. 5. Accendere il PC.

7. Le caméscope Sport peut faire office de Web cam
lorsque vous utilisez des logiciels comme Windows

E\ove RSelect 6. Collegare la videocamera Sport al PC con il cavo USB.

7. Lavideocamera Sport puo essere utilizzata

Messenger.

4 Différentes applications bénéficient de la Open the front cover and
connect the USB cable.

fonction PC Cam (Webcam). Pour plus de
détails, reportez-vous a la documentation
accompagnant chaque appareil.

8. Une fois terminé, débranchez le cable USB.

[ Remarques ]

% Vous devez installer le pilote DV. wpage 124

< Lorsque la connexion du port USB est modifiée,
la réinstallation du pilote DV peut s’avérer

come videocamera per PC per programmi

come Windows Messenger.

¢ Diverse applicazioni possono utilizzare
la funzione PC Cam. Per ulteriori dettagli
fare riferimento alla documentazione del
prodotto.

8. Quindi scollegare il cavo USB.

[ Note ]
< E necessario installare il driver DV. wPagina 124
< Quando la connessione alla porta USB cambia,

nécessaire. wpage 124

% Il est recommandé d'utiliser un adaptateur CA
durant le transfert des données afin d’éviter toute
coupure involontaire.

% Microsoft Windows 98 SE ou les systémes
d’exploitation ultérieurs prennent en charge la

potrebbe essere necessario reinstallare il driver
DV. wPagina 124
% Durante il trasferimento dei dati si consiglia di
utilizzare un alimentatore CA per evitare
un’interruzione involontaria dellalimentazione.
< La funzione PC Cam e supportata da Microsoft

fonction PC Cam (Webcam).

Windows 98 SE o sistemi operativi successivi.

M



Usare il modulo di

camera esterna
/.

Utilisation du module

caméra externe
Z

Enregistrement avec le module caméra externe....................... Registrare con il modulo di camera esterna............................ 119
Enregistrement vidéo a I'aide du module caméra externe........ 119 Registrare il video usando il modulo esterno della camera...... 119
Porter le module caméra externe................ccocoveunrinrinrinerinnnens 120 Indossare il modulo esterno della camera...............cccccovvnenee 120
Fixation du module caméra externe sur le support antivibratoire .. Montare il modulo esterno della camera sul Rubber Mount.... 120
Utilisation des bandes de fixation longues Usare la banda Long Mount 121

Sauvegardez les données et enregistrements importants
sur un autre support afin d’éviter les pertes accidentelles
provoquées par une défaillance du systeme ou toute autre
raison.

4 Salvare dati importanti separatamente su altri supporti per
evitare perdite accidentali dovuti ad eventuali guasti del
sistema o altri motivi.



Utilisation du module caméra externe :
Enregistrement avec le module caméra externe

Usare il modulo di camera esterna :
Registrare con il modulo di camera esterna

Enregistrement vidéo a I'aide du module caméra externe

Registrare il video usando il modulo esterno della camera

Votre caméscope Sport vous permet d'immortaliser
les épisodes les plus passionnants de votre vie.
Que vous soyez en train de faire du snowboard ou
du ski, vous pouvezeffectuer vos enregistrements
a l'aide du module caméra externe et des
accessoires.

1. Branchez le cable du module caméra
externe sur la prise multifonction du
caméscope Sport.

4 Vous pouvez fixer le module caméra
externe a 'aide d'un trépied (non fourni),
d'un support antivibratoire ou d'une bande
de fixation.

2. Appuyez sur le bouton [POWER/Record

[POWER/
Record /Stop] button

La videocamera Sport offre la possibilita di
registrare i momenti emozionanti. Se si sta
sciando sullo snowboard o sugli sci, & possibile
registrare questi momenti con il modulo
videocamera esterna e gli altri accessori.

1. Collegare il cavo del modulo
videocamera esterna al multijack della
videocamera Sport.

@ E possibile fissare il modulo videocamera
esterna utilizzando un treppiede (non
fornito), un supporto in gomma o una
cinghia di supporto.

2. Tenere p o il tasto di [ ione/

/Stop] du module caméra externe pendant plus de
2 secondes.

4 Le caméscope Sport et le module caméra externe sont mis
sous tension.

4 Sivous appuyez uniquement sur le bouton [POWER] du
caméscope Sport, seul le caméscope est mis sous tension.

3. Orientez le systeme de rotation de I'image dans la direction
souhaitée.

4 Le systéme de rotation de I'image tourne de 90 degrés vers
la gauche ou vers la droite et vous permet ainsi de choisir
votre angle de vue.

4. Appuyez sur le bouton [POWER/Record/Stop] du Module
caméra externe pour démarrer I'enregistrement.

4 LaLED s’allume en rouge.
4 Appuyez sur le bouton [Record /Stop] du caméscope Sport
pour commencer I'enregistrement.

5. Appuyez sur le bouton [POWER/Record /Stop] du Module
caméra externe pour arréter I'enregistrement.

4 L'enregistrement s'arréte et le caméscope Sport est a
nouveau prét.

6. Une fois I'enregistrement terminé, et pour éviter I'épuisement
de la batterie, appuyez pendant plus de 2 secondes sur le
bouton [POWER/Record /Stop] du module caméra externe
pour I'éteindre.

4 Le caméscope Sport et le module caméra externe sont mis
hors tension.

4 Sivous appuyez uniquement sur le bouton [POWER] du
caméscope Sport, seul le caméscope est mis hors tension.

registrazione/arresto] del modulo

videocamera esterna per piu di 2 secondi.

4 Lavideocamera Sport e il modulo videocamera esterna si
accendono.

4 Premendo il tasto di [accensione] della videocamera Sport, si
accende solo questultima.

. Girare il rotatore nella direzione desiderata.

4 |l rotatore gira di 90 gradi a sinistra o a destra per selezionare
I'angolo di immagine desiderato.

. Premere il tasto di [accensione/registrazione/arresto] del

Modulo videocamera esterna per avviare la registrazione.

4 Siaccende il LED rosso.

4 Premere il tasto di [registrazione/arresto] della videocamera
Sport per avviare la reg|stra2|one

Premere il tasto di [: ione/arresto] del

Modulo vndeocamera esterna per arrestare la reglstrazwne

¢ Laregistrazione si arresta e la videocamera Sport &
nuovamente pronta per I'uso.

. Dopo la registrazione, per ridurre il consumo della batteria,

tenere premuto il tasto di [accensione/registrazione/arresto]
del modulo videocamera esterna per piu di 2 secondi per
spegnerlo
La videocamera Sport e il modulo videocamera esterna si
spengono.
4 Sesipreme il tasto di [accensione] della videocamera Sport,
si spegne solo quest'ultima.

[ Note ]
[ Remarques ] 3
% Le module caméra externe est disponible pour 'enregistrement vidéo uniquement. &
< Vous pouvez utiliser le bouton [POWER/Record /Stop] du module caméra externe pour
mettre sous/hors tension et démarrer/arréter I'enregistrement simultanément. EX
< La prise multifonction sert de prise écouteurs, de prise entrée/sortie AV et de prise pour esterna.

le module caméra externe.

Il modulo videocamera esterna ¢ disponibile solo per la registrazione dei video.

E possibile utilizzare il tasto di [accensione/registrazione/arresto] del modulo videocamera
esterna per accendere/spegnere e avviare/arrestare contemporaneamente la registrazione.
Il multijack & utilizzato come jack cuffie, jack ingresso/uscita AV e jack modulo videocamera

M



Utilisation du module caméra externe :
Porter le module caméra externe

Usare il modulo di camera esterna:
Indossare il modulo esterno della camera

Fixation du module caméra externe sur le support antivibratoire

Montare il modulo esterno della camera sul Rubber Mount

Rubber Mount receptacle

@

1. Placez le support antivibratoire du module caméra externe sur
la vis.

2. Tournez la vis du support antivibratoire vers la droite pour la
serrer.

[ Remarque ]

< Attention a ne pas faire tomber votre module caméra externe
et a ne pas le cogner contre d’autres objets car cela risquerait
de 'endommager. Vous devez fixer 'appareil sur le support
antivibratoire lors de son utilisation et éviter de le faire tomber ou
de le cogner.

-

Posizionare la predisposizione supporto in gomma del modulo
videocamera esterna sulla vite del supporto in gomma.

2. Girare la vite del supporto in gomma verso destra per fissarlo.

[ Nota ]

¢ La caduta del modulo videocamera esterna o 'urto con altri oggetti
puo provocare il guasto del dispositivo. Se si utilizza il dispositivo,
attaccarlo al supporto in gomma e prestare attenzione che non
cada o urti altri oggetti.



Utilisation du module caméraexterne :
Porter le module caméra externe

Usare il modulo di camera esterna:
Indossare il modulo esterno della camera

Utilisation des bandes de fixation longues

Lorsque votre caméscope Sport est placé dans un étui ou dans
un sac a dos, vous pouvez fixer le module caméra externe sur le
support antivibratoire a I'aide des bandes de fixation longues.

Usare la banda Long Mount

Mentre la videocamera Sport € all'interno della borsa da
trasporto o dello zaino, il modulo videocamera esterna pud
essere montato con il supporto in gomma sulla cinghia di
supporto lunga.

1. Faites passer la bande de fixation
longue a travers les deux fentes
situées sur le support antivibratoire
comme le montre l'illustration.

4 Vous pouvez utiliser la partie courte

1. Far passare la cinghia di supporto
lunga in entrambe le fessure del
supporto in gomma come illustrato.

@ E possibile utilizzare sia la parte

et la partie longue du support

corta sia la parte lunga del supporto

antivibratoire comme fentes.

2. Faites passer la sangle a travers la
boucle pour ajuster sa tension.

3. Fixez la sangle.

in gomma come fessura.

2. Far scorrere la cinghia nella fibbia
per regolare la tenuta.

3. Fissare la cinghia.

[ Remarques ]

< Attention a ne pas faire tomber votre
module caméra externe et a ne pas
le cogner contre d’autres objets car
cela risquerait de 'endommager. Vous
devez fixer I'appareil sur le support
antivibratoire lors de son utilisation et
éviter de le faire tomber ou de le cogner.

<+ Un contact direct et prolongé du
support antivibratoire avec votre
peau peut provoquer des irritations
ou provoquer une allergie. Evitez les
contacts prolongés.

[ Note ]

¢ La caduta del modulo videocamera
esterna o I'urto con altri oggetti puo
provocare il guasto del dispositivo.
Se si utilizza il dispositivo, attaccarlo
al supporto in gomma e prestare
attenzione che non cada o urti altri
oggetti.

¢ Il contatto diretto del supporto in gomma
con la pelle per un lungo periodo di
tempo pud provocare irritazione o
allergie. Evitare il contatto a lungo
termine.
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Divers Informations :
Environnement de I'interface USB

Informazioni varie: Interfaccia USB

Connexion USB a un ordinateur

L'USB & haut débit n'est pas garanti si le pilote fourni est installé sur un SE autre que Microsoft Windows

ou Mac OS X d'Apple.

% Windows 98SE/ME : USB haut débit
< Windows 2000 : Service Pack 4 ou version plus récente - USB haut débit
< Windows XP : Service Pack 1 ou version plus récente - USB haut débit

<% Mac OS X : 10.3 ou version plus récente - USB haut débit

Configuration systéme

Connessione ad un computer attraverso la porta USB

Lo standard USB ad alta velocita non € garantito se il driver fornito & installato su un sistema operativo
diverso da Microsoft (Windows) o Apple (Mac OS X).
< Windows 98SE/ME: USB a piena velocita

< Windows 2000: Service Pack 4 o versione successiva - High Speed USB
< Windows XP: Service Pack 1 o versione successiva - High Speed USB

% Mac OS X: 10.3 o versione successiva - High Speed USB

Ambiente di sistema

Environnement Windows Ambiente Windows
C Configuration recommandée Minimo Consigliato
Processeur Pentium Ill & 600 MHz Pentium 4 & 2 GHz Processore Pentium |11, 600MHz Pentium 4, 2GHz
SE Windows 98SE/ME Windows 2000/XP Sistema operativo Windows 98SE/ME Windows 2000/XP
Mémoire 128Mo 512 Mo ou plus Memoria 128MB Almeno 512 MB
" 200 Mo (pour les applications - 200 MB (solo per le applicazioni)
Eng?seqll'::zj:" le uniquement) dans les autres cas, 2 Go ou plus S?gglo Ilb_e_rg Oltre a questo, Almeno 2GB
1 Go ou plus d'espace libre sul disco rigido almeno 1 GB di spazio libero
5 : ' 800 x 600 points 1024 x 768 points . . . 800x600 punti 1024x768 punti
Résolution de I'écran Couleur 16 bits Couleur 24 bits Risoluzione del display Colore a 16 bit Colore a 24 bit
usB USB 1.1 USB 2.0 & haut débit usB USB 1.1 USB 2.0 ad alta velocita
Environnement osh A osh
Configuration minimale C 14 Minimo Consigli
- Processore G3 500MHz Processore G4
Processeur G3 2 500 MHz Processeur G4 Sistema operativo Mac 0S 10.2 Mac 0S 10.3
SE Mac 0S 10.2 Mac 08 10.3 Memoria 1288 Almeno 512 MB
Mémoire 128 Mo 512 Mo ou plus Spazio libero 200 MB (solo per le applicazioni) Almeno 2GB
Espace libre sur le 200 Mo (pour les applications uniquement) 2Go ou plus sul disco rigido Oltre a questo, almeno 1 GB di spazio libero
disque dur 1 Go ou plus d’espace libre dans les autres cas i ‘one del disnla 800x600 punti 1024x768 punti
Résolution de I'écran 800 x 600 points 1024 x 768 points i play Colore a 16-bit Colore a 24 bit
Couleur 16 bits Couleur 24 bits USB USB 1.1 USB 2.0 ad alta velocita
usB USB 1.1 USB 2.0 a haut débit
[ Note ]
< Non si garantisce il funzionamento su tutti i PC configurati come indicato in precedenza.
[ Remarques ]
% Les indications ci-dessus noffrent aucune garantie quant au fonctionnement correct de Fappareil. | % L@ connessione USB che utilizza un hub USB esterno o una daughterboard USB aggiuntiva
% Le fonctionnement de la connexion USB au moyen d’un concentrateur USB externe ou d'une non ¢ garantita.
carte fille USB supplémentaire n’est pas garanti. < Se il sistema operativo & Windows 2000/XP, accedere come amministratore (0 come utente
% Sivous utilisez Windows 2000/XP, connectez-vous en tant qu'administrateur (administrateur de con privilegi equivalenti) per eseguire lnstallazione.
lordinateur ou utiisateur bénéficiant de droits d'acces équivalents) pour installer le pilote. % Seil PC non & molto potente, i file video potrebbero non essere riprodotti normalmente,
< E(\) Ir?n g?epniglrt\? gs ég;?lsr]::fare effé (f]ilgﬁrlleﬁft possible que le fichier vidéo ne soit pas Iu oppure potrebbero venire interrotti spesso
% Sila capacité de votre ordinateur est faible, 'édition des fichiers vidéo prendra plus de temps. : IST ':g%”op e mﬁlli'OM pOt'e:’nIe,t‘potfezlbrtine essere necis.sg‘rllo ;"?hco tempotper modicare i fil video.
< Intel® Pentium III™ ou Pentium 4™ sont des marques déposées d'Intel Corporation. ntert Fentium € rentium sono marcni ¢l fte! Lorporation
% Mac, Macintosh et Mac OS sont des marques déposées d'Apple Computer, Inc.  Mac, Macintosh e Mac OS sono marchi di Apple Computer, Inc.
% Windows® est une marque déposée de Microsoft® Corporation. % Windows® & un marchio registrato di Microsoft® Corporation
< Toutes les autres appellations et marques commerciales appartiennent a leurs propriétaires respectifs. < Tutti gli altri nomi e marchi sono di proprieta delle rispettive case costruttrici.

N



Divers Informations :
Installation du logiciel

Informazioni varie:
Installazione dei software

Installation du programme DV Media Pro 1.0

Pour pouvoir lire sur votre ordinateur les fichiers vidéo enregistrés ou les données
transférées depuis le caméscope Sport a l'aide du cable USB, vous devez
installer DV MediaOPro 1.0.

Avant de commencer !

4 Allumez votre ordinateur. Quittez toutes les autres applications.

4 Insérez le CD fourni dans le lecteur de CD-ROM de votre ordinateur.
L'écran d'installation s'affiche automatiquement apres I'insertion du CD.
Si cet écran ne s'affiche pas, cliquez sur la bouton “Start” (Démarrez)
situé dans le coin inférieur gauche et sélectionnez “Run” (Exécuter) pour
afficher la boite de dialogue. Saisissez “D:\autorun.exe” et appuyez sur
ENTER, si votre lecteur de CD-ROM est relié a “D:Drive” .

Installation de pilotes - DV Driver (Pilote DV) et DirectX 9.0

& DV Driver (Pilote DV) est un pilote nécessaire pour la prise en charge d'une
connexion avec un ordinateur (S'il n’est pas installé, certaines fonctions ne
seront pas prises en charge).

1. Cliquez sur “DV Driver” (Pilote DV) sur I'écran d’installation.

& Le logiciel du pilote nécessaire est installé automatiquement.
Les pilotes suivants sont installés :
- Pilote du disque amovible USB (Windows 98 SE uniquement)
- Pilote WEB CAM USB

2. Cliquez sur <Confirm> (Conf.) pour terminer I'installation du pilote.
¢ Les utilisateurs de Windows 98 SE doivent redémarrer leur ordinateur.

3. Si “DirectX 9.0" n’est pas installé, il le sera automatiquement apres le
réglage de “DV Driver” (Pilote DV).
¢ Apres l'installation de DirectX 9.0, vous devez redémarrer votre ordinateur.
¢ SiDirectX 9.0 est déja installé, vous n'avez pas besoin de redémarrer Fordinateur.

Installation d’application - Video Codec (Codec vidéo)

4 Cliquez sur “Video Codec” (Codec Vidéo) sur I'écran Setup (Installation).
La fonction Video Codec (Codec vidéo) est nécessaire pour la lecture sur
ordinateur de fichiers vidéo enregistrés par le caméscope Sport.

[ Remarque ]
< Sile message “Digital Signature not found” (Signature numérique introuvable)
ou un message similaire s'affiche, ignorez-le et poursuivez l'installation.

B

Installazione di DV Media Pro 1.0

Per riprodurre file video registrati o i dati trasferiti dalla videocamera al PC con il
cavo USB & necessario installare DV Media Pro 1.0

Prima di iniziare !

4 Accendere il PC. Chiudere tutte le altre applicazioni in esecuzione.

¢ Inserire il CD fornito nell'unita CD-Rom.
La schermata di installazione appare automaticamente poco dopo aver
inserito il CD. Se la schermata di installazione non viene visualizzata,
fare clic su “Start” sullangolo inferiore sinistro e selezionare “Esegui”
per visualizzare un dialogo. Digitare “D:\autorun.exe” e quindi premere
INVIO, se l'unita CD-ROM & “D".

Installazione di Driver - Driver DV e DirectX 9.0

¢ Driver DV ¢ un driver software necessario per la connessione al PC.
(Se non ¢ installato, alcune funzioni non sono disponibili).

1. Fare clic su “DV driver” sulla schermata di installazione
& |l driver software richiesto viene installato automaticamente.
Vengono installati i seguenti driver
- Driver del disco removibile USB (solo Windows 98 SE)
- Driver PC-cam USB

2. Fare clic su <Confirm> (Conf.) per ultimare I'installazione del driver.
¢ Gli utenti di Windows 98 SE devono riavviare il PC.

3. Se “DirectX 9.0” non & installato, viene installato automaticamente dopo
aver impostato “DirectX 9.0”.
4 Dopo avere installato DirectX 9.0, il PC deve essere riavviato.
4 Se DirectX 9.0 ¢ gia installato, non € necessario riavviare il PC

Installazione dell’applicazione - Video Codec

¢ Fare clic su “Video Codec” sulla schermata di installazione.
Video Codec & necessario per riprodurre su un PC i filmati registrati dalla
videocamera Sport.

[ Nota ]
< Se viene visualizzato un messaggio che dice “Firma digitale non trovata” o
con un contenuto simile, ignorarlo e continuare con l'installazione.



Divers Informations : Informazioni varie:

Installation du logiciel Installazione dei software
Installation d’application - Photo Express Installazione dell’applicazione — Photo Express
1. Cliquez sur “Photo Express” sur écran Setup (Installation). 1. Fare clic su “Photo Express” sulla schermata di installazione.

4 Cet outil de retouche de photos permet aux utilisateurs de
modifier des images.
Installation d’application — Quick Time
1. Cliquez sur “Quick Time” sur I'’écran Setup (Installation).

¢ QuickTime est une technologie mise au point par Apple utilisée | 1- Fare clic su “Quick Time” sulla schermata di installazione.
pour le traitement de vidéos, de bandes son, d'animations, 4 QuickTime e un software della tecnologia Apple per modificare

¢ E uno strumento di modifica delle fotografie che permette agli
utenti di modificare le immagini.

Installazione dell’applicazione — Quick Time

de graphiques, de texte, de musique ainsi que de panoramas filmati, suono, aqimazione, groafica, testo, musica e anche
virtuels 360 degrés (VR). scene di realta virtuale a 360°.

Bieadiivealati oo Ulead Video Studio

Réglage du programme Ulead Video Studio Impostazione Ulead Video Studio

L'écran Setup (Installation) s’affiche automatiquement une fois le | popo aver inserito il CD, la schermata di installazione viene
CD inséré. Suivez les indications pour commencer linstallation. | \jgyajizzata automaticamente. Seguire le istruzioni per avviare I

I s’a_git d’un o_uti[ de rgtquche de vidéos permettant a I'utilisateur de installazione.

modifier des fichiers vidéo. E uno strumento di modifica dei video che permette agli utenti di

[ Remarques ] modificare i file video.

Installez ce programme a l'aide du CD [ Note ]

d'installation fourni avec le caméscope Sport. " . " )

Nous ne pouvons garantir la compatibilité avec 1Y, Thembs o et s * ngetm?;eﬂl)'r?ﬁggIE;ﬁ';%;gggg:%i?;'Sop%n'

toutes les versions de CD. " b Non si garantisce la compatibilita di altre versioni
<+ Pour les retouches de photos, utilisez Photo i e e ey del CD

Express_ "‘""‘f“'ﬂc'“\p (Ldres whs b testingis Oyt s . | re Photo

% Pour lire des films sur un ordinateur, installez B e et ot * E)e;;)rrr;(;(:ﬂcare le fotografie, utiizza
les logiciels suivants (dans le méme ordre) : S s e et |4 Per riprodurre video su un PC, installare i
DV Driver (Pilote DV) - DirectX 9.0 - Video P software in questo ordine: DV Driver - DirectX 9.0
Codec (Codec Vidéo) ] B - Video Codec

¢ Pour les retouches sur des films, utilisez Ulead cmssnes | [srrnassea ] | %+ Per modificare i video utilizzare Ulead Video Studio
Video Studio. ) ) ) % Per utilizzare la PC Cam & necessario installare

< Pour utiliser la Web cam, installez DV Driver (Pilote DV). il DV driver.

% Vous devez installer les logiciels “DV Driver (Pilote DV)”, “deeo < Per garantire un corretto funzionamento di DV Media Pro 1.0, &
Codec (Codec vidéo)” et “DirectX 9.0” pour lancer DV Media Pro necessario installare “DV driver”, “Video Codec” e “DirectX 9.0”
correctement. % Se viene visualizzato un messaggio che dice “Firma digitale non

< Sile message “Digital Signature not found” (Signature numérique trovata” o con un contenuto simile, ignorarlo e continuare con I
introuvable) ou un message similaire s’affiche, ignorez-le et installazione.
poursuivez l'installation. a




Divers Informations :
Raccordement a d’autres appareils

Informagzioni varie:
Collegamento ad altri dispositivi

Raccordement a un ordinateur a I'aide du cable USB

Collegamento ad un PC mediante un cavo USB

Reliez 'appareil a un ordinateur & I'aide du cable USB fourni.
Vous pouvez visionner vos fichiers sur votre ordinateur.

Avant de commencer !

Vous pouvez transférer les fichiers lorsque <USB
Mode> (Mode USB) est réglé sur <Mass Storage> (Mém.
aux.) ‘=page 98

Raccordement a un ordinateur - Lecture de fichiers

1. Appuyez sur le bouton [POWER] pour allumer le
caméscope Sport.

Branchez le caméscope Sport sur I'ordinateur a
I'aide du cable USB fourni comme indiqué sur le

2.

Effettuare il collegamento ad un PC con il cavo USB
fornito. E possibile visualizzare i file sul PC.

Prima di iniziare !
Per poter trasferire i file con I'opzione USB selezionare
Mass Storage. =Pagina 98

Connessione ad un PC - Riproduzione di file

Per attivare la videocamera Sport, premere il
tasto di accensione.

Collegare la videocamera Sport al PC con il
cavo USB fornito, come indicato nello schema.

schéma.

Copiez le fichier sur votre ordinateur.

4 Nous vous recommandons de copier les fichiers
sur votre ordinateur afin d’accroftre le confort de
visionnage.

Double-cliquez sur le nom du fichier copié.

La lecture commence.

Déconnexion du caméscope de I'ordinateur

4.

Copiare il file sul PC.

¢ Per una migliore visualizzazione si
raccomanda di copiare i file sul PC.

Fare doppio clic sul nome del file copiato.

La riproduzione viene avviata.

Disconnessione da un PC

1. Cliquez sur I'icone “Safely remove hardware” <Open the front cover and

(Retirer votre périphérique en toute sécurité)

située sur la barre de taches, dans le coin inférieur droit du bureau.

Sélectionnez le périphérique et cliquez sur le bouton “ Stop” (Arrét).

Lorsqu’un message vous indique que vous pouvez retirer le périphérique en

toute sécurité s’affiche, débranchez le cable de I'ordinateur.

[ Avertissement ]

< Lorsque le transfert de données est interrompu par de I'éléctricité statique, un
champ magnétique ou pour une autre raison, redémarrez le programme ou
essayez de débrancher et de rebrancher le cable USB.

[ Remarques ]

< Il est possible que des erreurs de communication / d'installation se produisent

lorsque plusieurs périphériques USB sont reliés a un ordinateur ou que des

concentrateurs USB sont utilisés.

Reportez-vous a la page 123 pour obtenir des informations concernant les

recommandations liées a I'utilisation de la connexion USB. Il est possible que

certains ordinateurs disposant de la configuration requise ne prennent pas en

charge un fonctionnement USB correct, et ce pour diverses raisons. Veuillez vous

reporter a la documentation produit de I'ordinateur pour plus de détails.

Si vous déconnectez le cable USB de l'ordinateur ou du caméscope Sport

pendant le transfert de données, ce dernier s'interrompt et les données risquent d’

étre endommageées.

Il est possible que le caméscope Sport ne fonctionne pas normalement avec la

configuration systéme recommandée sur votre ordinateur.

O Il est par exemple possible que les fichiers vidéo ne soient pas lus normalement.

2.

L)

1. Fare clic su “Rimozione sicura dell’hardware”

sulla barra delle applicazione sul lato inferiore

destro del desktop. Selezionare il dispositivo

e fare clic sul tasto “Stop” (Parar).

2. Quando viene visualizzato il messaggio che indica che I'hardware puo
essere rimosso, scollegare il cavo dal PC.

connect the USB cable.>

[Avvertenza]

< Se la trasmissione dati viene interrotta per via di elettricita statica, di un campo
magnetico o di un altro motivo, riavviare il programma o tentare di scollegare
/ricollegare il cavo di comunicazione (cavo USB).

[ Note ]

< Se al PC vengono collegati piu dispositivi USB o si utilizzano piu hub USB,
possono verificarsi degli errori nella comunicazione/installazione con la
videocamera Sport.

Per indicazioni sull'utilizzo della modalita USB, vedere pagina 123. Alcuni

PC, pur avendo i requisiti, possono non supportare il corretto funzionamento
in USB per varie ragioni. Per ulteriori dettagli, vedere la documentazione di
prodotto del PC.

Se si scollega il cavo USB dal PC o dalla videocamera Sport durante il
trasferimento dei dati, 'operazione viene interrotta, con il rischio di danneggiare i dati.
A seconda del PC la videocamera Sport pud funzionare in modo anomalo nell
ambiente di sistema raccomandato .

Ad esempio, il file video pud essere riprodotto in modo anomalo.

L



Divers Informations :
Raccordement a d’autres appareils

Informazioni varie:
Collegamento ad altri dispositivi

Raccordement a un téléviseur

Vous pouvez brancher votre caméscope Sport directement sur un poste de
telévision. Sélectionnez I'entrée vidéo appropriée lorsque vous visionnez
des fichiers issus du caméscope Sport sur le téléviseur.

Collegamento ad un monitor TV

La videocamera Sport puo essere direttamente collegata ad un televisore.
Impostare 'ingresso video corretto per la visualizzazione della riproduzione
della videocamera Sport sul televisore.

1. Branchez le céble audio/vidéo fourni
sur la prise [Multi jack] (Prise

multifonction) du caméscope Sport. Line Input

VIDEO AUDIO
‘ L ®

| |
| ©

6

2. Branchez l'autre extrémité du
cable sur le téléviseur en
respectant les couleurs des bornes.

3. Allumez le téléviseur et réglez la
<Source> du téléviseur sur

I'entrée externe a laquelle est relié

le caméscope Sport.

4 La <Source> peut étre
représentée par <Line In>,
<Input>, <A/V Input> (Entrée), etc.
selon les fabricants.

4. Appuyez sur le bouton [POWER] pour
allumer le caméscope Sport.
4 Le mode Movie Record (Enreg.

1. Collegare il cavo audio/video fornito
al [multijack] della videocamera Sport .

2. Collegare I'altra estremita del cavo a
il televisore facendo corrispondere i
colori dei terminali.

3. Accendere il televisore e impostare
la <sorgente> TV sull'ingresso
esterno a cui la videocamera Sport
¢ collegata.

4 La <sorgente> puo essere indicata
con <Line In>, <Input>, <A/V Input>,
ecc. a seconda del costruttore.

. Per attivare la videocamera Sport,
premere il tasto di accensione.
4 Viene visualizzata la modalita di
registrazione video sullo schermo
del televisore.

vidéo) s'affiche sur I'écran du
téléviseur.

5. Appuyez sur le bouton [PLAY] ou sur [Joystick(OK)] pour accéder
au mode Movie Play (Lect. vidéo).

6. Déplacez le [Joystick] vers la gauche ou vers la droite pour
sélectionner un film, puis appuyez sur [Joystick(OK)].
4 La lecture commence.
4 Pour interrompre la lecture, appuyez sur [Joystick(OK)].

[ Remarques ]

< Vous pouvez lire des fichiers photo aussi bien que des fichiers vidéo.

< Lorsque vous branchez votre caméscope Sport sur un téléviseur, il est
possible certains indicateurs n'apparaissent que partiellement.

< Si vous souhaitez entrer/sortir une image d’un autre appareil vers le
cameéscope Sport, vous devez tout d'abord régler <Line In/out> (En/Srt)
sur le mode Movie (Vidéo). wpage 51

5. Premere il tasto [PLAY] o il [Joystick(OK)] per passare alla
modalita di riproduzione video.

6. Spostare il [Joystick] a sinistra / a destra per selezionare un video
e premere [Joystick(OK)].
¢ |Inizia la riproduzione.
¢ Per mettere in pausa la riproduzione, premere [Joystick(OK)].

[ Note ]

< E possibile riprodurre file di immagine e file video.

% Collegando la videocamera Sport al televisore, & possibile che alcuni
indicatori non appaiano parzialmente.

% Se si desidera inserire/visualizzare 'immagine di un altro dispositivo
sulla videocamera Sport, impostare innanzitutto <Line In/out> (/O
Linea) in Movie Mode (Modalita film). =Pagina 51

N



Divers Informations :
Raccordement a d’autres appareils

Informagzioni varie:
Collegamento ad altri dispositivi

Raccordement a un enregistreur DVD/magnétoscope

Vous pouvez connecter votre caméscope Sport a un téléviseur via un
enregistreur DVD/magnétoscope.

Collegamento ad un registratore VCR/DVD

La videocamera Sport pud essere collegata ad un televisore attraverso
un registratore DVD/VCR.

1. Branchez le cable audio/
vidéo fourni sur [Multi
jack] (Prise multifonction)
du caméscope Sport.

2. Branchez I'autre extrémité ‘

du céble sur I'enregistreur

DVD/magnétoscope en

respectant les couleurs

des bornes.

3. Branchez le cable audio/
vidéo sur I'entrée du
téléviseur et la sortie vidéo
de I'enregistreur DVD/
magnétoscope.

4. Allumez le téléviseur et
réglez la <Source> sur
I’entrée externe a laquelle

Line Input
VIDEO AUDIO

@O®®©

1. Collegare il cavo audio/
video fornito al [multijack]
della videocamera Sport.

2. Collegare I'altra estremita
del cavo al registratore
DVD/VCR facendo
corrispondere i colori dei
terminali.

O @)
||

3. Collegare il cavo audio/
video dall’ingresso del
televisore all’'uscita video
del registratore DVD/VCR.

Accendere il televisore e
impostare la <sorgente>

all'ingresso esterno a cui
e collegato il registratore
DVD/VCR.

est relié I'enregistreur
DVD/magnétoscope.

5. Allumez I'enregistreur DVD/magnétoscope et réglez la
<Source> sur la source d’entrée externe sur laquelle vous
avez branché le caméscope Sport.

[ Remarques ]
% Vous pouvez lire des fichiers photo aussi bien que des fichiers vidéo.
< Si vous souhaitez entrer/sortir une image d'un autre appareil vers
le caméscope Sport, vous devez tout d’abord régler <Line In/out>
g (En/Srt) sur le mode Movie (Vidéo). =page 51

5. Accendere il registratore DVD/VCR e impostare la <sorgente> alla
sorgente di ingresso esterna a cui e collegata la videocamera Sport.

[ Note ]

% E possibile riprodurre file di immagine e file video.

* Se si desidera inserire/visualizzare Iimmagine di un altro
dispositivo sulla videocamera Sport, impostare innanzitutto <Line
Infout (/O Linea) > in Movie Mode (Modalita film). =Pagina 51



Divers Informations :
Raccordement a d’autres appareils

Informazioni varie: ITALIANO
Collegamento ad altri dispositivi

Enregistrement de signaux décodés depuis d’autres appareils numériques

Vous pouvez connecter d’autres périphériques numériques externes
sur le caméscope Sport afin d’enregistrer des signaux décodés.

Registrazione di contenuti decodificati da altri dispositivi digitali

E possibile collegare altri dispositivi digitali esterni alla videocamera
Sport per registrare contenuti decodificati.

1. Branchez le cable audio/vidéo
fourni sur [Multi jack] (Prise
multifonction) du caméscope
Sport.

2. Branchez le céble audio/vidéo
sur la borne de sortie externe
de votre appareil numérique
(DVD, caméscope numeérique,
etc.) en respectant les couleurs
des bornes.

3. Appuyez sur le bouton
[POWER] pour allumer le

Line Output

@0®

K1

1. Collegare il cavo audio/video
fornito al [multijack] della
videocamera Sport.

2. Collegare il cavo audio/
video al terminale di uscita
esterno dei dispositivi digitali
(DVD, DVC, ecc.) facendo
corrispondere i colori dei
terminali.

3. Per attivare la videocamera
Sport, premere il tasto di
accensione.

4 Viene visualizzata la

caméscope Sport.
¢ L’écran Movie Record (Enregistrement de film) apparait.

4. Appuyez sur le bouton [MENU].
Déplacez le [Joystick] vers la gauche ou la droite pour
sélectionner <Line In/Out> (En/Srt).

5. Déplacez le [Joystick] vers le haut ou vers le bas pour
sélectionner <In> (En), puis appuyez sur [Joystick(OK)].

6. Lancez la lecture des autres appareils numériques.

7. Appuyez sur le bouton [Record/Stop] pour commencer I’
enregistrement.

8. Appuyez de nouveau sur le bouton [Record/Stop] pour arréter
I'enregistrement.

[ Remarque ]

% La qualité du signal d’entrée enregistré grace a la borne d’entrée
ne peut étre garantie que si le signal est émis par un appareil
numérique (DVD, caméscope numérique, etc.).

schermata di registrazione
video.
4. Premere il tasto [MENU].
Spostare il [Joystick] a sinistra / a destra per selezionare
<Line In/Out> (/O linea).
5. Spostare il [Joystick] su / gil per selezionare <In> e quindi
premere [Joystick(OK)].
6. Eseguire la riproduzione dagli altri dispositivi digitali.
7. Per avviare la registrazione premere il tasto di [registrazione/
arresto].
. Per interrompere la registrazione, premere nuovamente il
tasto di registrazione/di arresto.

(=]

[ Nota ]

% La qualita di un segnale d'ingresso registrato attraverso il terminale
della linea di ingresso non puo essere garantito, a meno che
provenga da dispositivi digitali (DVD, DVC, ecc.)

L



Divers Informations :
Impression des photos

Informazioni varie: Stampare le immagini

Impression DPOF

La fonction DPOF (Digital Print Order Format - protocole de commande
d'impression numérique) permet de définir les informations relatives a
I'impression pour chaque photo se trouvant sur la carte mémoire Vous
pouvez facilement imprimer en utilisant une imprimante compatible
DPOF ou commander des copies a des développeurs d'images
numériques.

Impression de fichiers DPOF de la carte mémoire

1. Définissez les informations DPOF concernant la photo que vous
souhaitez imprimer. =page 72

2. Insérez une carte mémoire dans I'imprimante compatible DPOF.

3. Suivez les indications données par 'imprimante pour imprimer vos
photos.

[ Remarques ]

% Pour plus d’informations sur l'impression des photos, reportez-vous
au manuel d'utilisation de votre imprimante.

% Il est possible que I'impression ne fonctionne pas selon le type d’
imprimante.
Dans ce cas, téléchargez les fichiers au format JPEG directement
sur l'ordinateur et imprimez-les.

Stampa con DPOF

DPOF (Digital Printing Order Format) definisce le informazioni di
stampa per ciascuna foto presente sulla scheda di memoria.

E possibile stampare su una stampante compatibile DPOF o ordinare
le copie da sviluppatori di immagini digitali.

Stampa dei file DPOF nella scheda di memoria

1. Impostare le informazioni DPOF per la foto da stampare.
=pagina 72

2. Inserire una scheda di memoria nella stampante che supporta
DPOF

3. Seguire le istruzioni visualizzate per stampare le immagini.

[ Note ]

% Per ulteriori dettagli sulla stampa di fotografie vedere il manuale
dell'utente della stampante.

% Potrebbe non essere possibile stampare su alcune stampanti.
In questo caso, scaricare i file JPEG direttamente sul PC e
stamparli



Entretien : Nettoyage et
entretien du caméscope Sport

Manutenzione: Pulizia e
manutenzione della videocamera Sport

Apreés utilisation du caméscope Sport

L

L R R

Pour préserver votre caméscope Sport, suivez la procédure suivante :
v Eteignez le caméscope Sport.

v Retirez la batterie wpage 22.

v Retirez la carte mémoire wpage 34.

Afin d’éviter d’endommager I'écran LCD, manipulez avec soin les
piéces amovibles de celui-ci.

Ne faites pas tomber le caméscope Sport et protégez-le des chocs.
Pour accroitre la durée de vie de votre caméscope Sport, évitez de I
utiliser dans des endroits trop humides ou trop poussiéreux.

Ne laissez pas votre caméscope Sport dans des endroits exposés a :

AN

4
4

une humidité ou une concentration de vapeur, de suie ou de poussiere excessive ;
des chocs ou des vibrations extrémes ;

des températures extrémement élevées (plus de 50°C ou 122°F) ou
extrémement basses (inférieures a 0°C ou 32°F).

des champs électromagnétiques puissants ;

la lumiére directe du soleil (ne le laissez pas non plus dans une voiture
fermée un jour de chaleur).

Pour une utilisation sans danger de la batterie, suivez les instructions ci-dessous.
v

v

ANAN

Pour préserver la batterie, veillez a éteindre le caméscope Sport apres
chaque utilisation.

La consommation d’énergie peut varier en fonction des conditions d'utilisation.
Des lancements et interruptions d’enregistrement nombreux, de méme qu'une
utilisation fréquente du zoom et la réalisation d’enregistrements dans le froid
raccourcissent la durée réelle d’enregistrement.

Jetez rapidement les batteries usagées. Ne les jetez pas dans le feu.
La batterie chauffe en cours de charge ou de fonctionnement. Il ne s’agit
pas d'un dysfonctionnement.

La batterie a une durée de vie limitée. Si la durée d'utilisation se réduit
notablement aprés une charge normale, cela signifie que la batterie
arrive en fin de vie. Remplacez-la par une batterie neuve.

Pour une utilisation sans danger de la carte mémoire, suivez les
instructions ci-dessous.
v

A NN

La carte mémoire doit étre rangée a I'écart des appareils de chauffage et
de toute autre source de chaleur. Evitez d’exposer vos cartes mémoires
a la lumiére directe du soleil et évitez les champs électromagnétiques.
N’éteignez aucun périphérique lorsque vous transférez des données :
vous risqueriez de les détruire.

Sauvegardez fréquemment vos données sur un disque dur ou sur tout
autre support de stockage permanent.

Formatez la carte mémoire régulierement.

Lorsque vous formatez la carte mémoire, faites-le dans le caméscope Sport.

Dopo aver utilizzato la videocamera Sport

< Per proteggere la videocamera Sport, eseguire queste operazioni

v Spegnere la videocamera Sport.

v Rimuovere il gruppo batterie wPagina 22.

v/ Rimuovere la scheda di memoria =Pagina 34.

Per evitare il rischio di danni al display LCD, non esercitare una forza
eccessiva sulle parti mobili.

Non far cadere né sottoporre ad urti di altro tipo la videocamera Sport.
Evitare I'uso prolungato della videocamera Sport in luoghi estremamente
umidi o polverosi.

Non lasciare la videocamera Sport in luoghi soggetti a:

Una quantita eccessiva di umidita, vapore, fuliggine o polvere.

v Vibrazioni o urti.

v Temperature estremamente alte (superiori a 50°C o 122°F) o

v

L
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estremamente basse (inferiori a 0°C o 32°F).
Forti campi elettromagnetici.
v Luce solare diretta, ad esempio in un’auto chiusa al sole.
< Per un uso sicuro del gruppo batterie, seguire queste indicazioni.
v Per risparmiare la batteria, spegnere sempre la videocamera Sport
quando non & in uso.
v Il consumo della batteria pud variare a seconda delle condizioni d’uso.
Le interruzioni frequenti, I'uso intensivo dello zoom e la registrazione a
basse temperature riducono i tempi effettivi di registrazione
Smaltire in modo appropriato i gruppi batterie usati. Non gettarli nel
fuoco.
Durante la carica e I'uso, il gruppo batterie diventa molto caldo. Non si
tratta di un malfunzionamento.
Il gruppo batterie ha una durata limitata. Se il periodo di utilizzo si riduce
sensibilmente con carica normale, significa che il gruppo batterie &
giunto alla fine del suo ciclo utile.
In questo caso, & necessario sostituirlo con un nuovo gruppo batterie.
< Per un uso sicuro della scheda di memoria osservare quanto segue.
v Lascheda di memoria deve essere conservata lontano da termosifoni
e altre fonti di calore. Evitare di esporre le schede di memoria alla luce
diretta del sole e a campi elettromagnetici.
Non spegnere le apparecchiature durante il trasferimento dei dati. In
caso contrario, i dati potrebbero andare persi.
Eseguire una copia di sicurezza dei dati su disco fisso o su altri supporti
di memorizzazione permanente.
Formattare la scheda di memoria periodicamente.
Eseguire la formattazione della scheda di memoria nella videocamera
Sport.

A NN
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Entretien : Nettoyage et
entretien du caméscope Sport

Manutenzione: Pulizia e
manutenzione della videocamera Sport

Nettoyage du boitier

% Pour nettoyer I'extérieur du caméscope Sport

v Pour nettoyer I'extérieur, utilisez un chiffon doux et sec.
Essuyez doucement le boitier.

N’appuyez pas trop fort lors du nettoyage ; frottez doucement
la surface.

v Nappuyez pas sur la surface de I'écran LCD. Utilisez un chiffon
doux et sec pour en nettoyer la surface.

v En ce qui concerne le nettoyage de I'objectif, utilisez un
souffleur d’air (disponible en option) pour éliminer la saleté et
autres petits dépots. N'essuyez pas I'objectif avec un chiffon
ou avec vos doigts. Si nécessaire, utilisez un papier spécial
pour nettoyage d’objectif.

v Nutilisez pas de solvant, d’alcool ou de benzéne pour le
nettoyage. Vous risqueriez d’endommager les finitions.

v Le nettoyage ne doit s’effectuer qu’une fois la batterie retirée et
les autres sources d’alimentation débranchées.

[ Remarque ]
% Sil'objectif semble trouble, éteignez le caméscope Sport et
attendez pendant une heure environ.

Utilisation de la pile rechargeable intégrée

Le caméscope Sport est pourvu d’une pile au lithium rechargeable qui
permet de conserver la date et les autres réglages en mémoire, méme
lorsque I'adaptateur CA et la batterie sont retirés. Cette pile au lithium
se recharge automatiquement lorsque le caméscope Sport est utilisé.

Charge de la pile interne rechargeable

< Sile caméscope Sport est laissé hors tension plus de 5 jours,
la pile se décharge completement. Dans ce cas, branchez I
adaptateur CA sur le caméscope Sport et appuyez sur le bouton
[POWER] pour I'allumer. Ensuite, laissez-le sous tension pendant
24 heures.
Aprés cela, réglez & nouveau la date et procédez aux autres
réglages.

a

Pulizia della parte esterna

% Pulizia della parte esterna della videocamera Sport

v Per pulire le parti esterne, utilizzare un panno asciutto e soffice.
Pulire il corpo macchina con delicatezza.
Durante la pulizia non applicare una forza eccessiva, ma
strofinare la superficie delicatamente.

v Non esercitare alcuna pressione sulla superficie del display
LCD. Per pulire la superficie usare un panno morbido.
Per pulire 'obiettivo, usare un compressore opzionale per
soffiare via lo sporco e altri piccoli oggetti. Non usare panni o
le dita per pulire I'obiettivo Se necessario, utilizzare i foglietti
speciali per la pulizia degli obiettivi.

v Non utilizzare diluenti, alcol o benzene. In caso contrario, si
puod danneggiare la finitura.
Prima di pulire 'apparecchiatura, estrarre il gruppo batterie e
scollegare tutte le fonti di alimentazione.

[ Nota ]
% Se le lenti appaiono abbaglianti, spegnere la camera Sport e
lasciarla spenta per circa 1 ora.

Uso della batteria ricaricabile integrata

La videocamera Sport dispone di una cella al litio ricaricabile che
conserva la data e le altre impostazioni anche quando si rimuove I
alimentatore CA o la batteria La cella al litio viene automaticamente
ricaricata quando si utilizza la videocamera Sport.

Caricamento della batteria ricaricabile integrata

% Quando non si utilizza la videocamera Sport, la cella si esaurisce
in 5 giorni. In questo caso collegare I'alimentatore CA alla
videocamera Sport e premere il tasto di accensione per accendere
I'apparecchiatura. Lasciare quindi la cella in carica per 24 ore.

Al termine, impostare nuovamente la data e le altre opzioni.



Entretien : Nettoyage et
entretien du caméscope Sport

Manutenzione: Pulizia e
manutenzione della videocamera Sport

A propos de la pile

Les performances de la batterie diminuent lorsque la température

ambiante est inférieure ou égale a 10°C et sa durée de vie est réduite.

Dans ce cas, effectuez I'une des opérations suivantes de maniére a

allonger la durée de vie de la batterie.

- Rangez la batterie dans une poche pour la réchauffer et insérez-la
dans votre caméscope Sport juste avant utilisation.

- Utilisez une batterie de grande capacité.

Veillez a placer le bouton [Power] sur Off lorsque I'appareil n’est pas
en cours de lecture ou d’enregistrement. L’énergie de la batterie est
également consommée lorsque I'appareil est en veille, en pause ou en
cours de lecture.

Lorsque vous préparez vos batteries, prévoyez deux ou trois fois la
durée d’enregistrement prévue, puis procédez a des essais avant
d'effectuer 'enregistrement réel.

Ne mettez pas la batterie en contact avec I'eau : elle n’est pas étanche.

Conservez la batterie hors de portée des enfants.
En cas d'ingestion, consultez immédiatement un médecin.

Essuyez la batterie avec un chiffon propre et sec pour éviter tout
mauvais contact.

Ne manipulez pas la batterie avec des outils métalliques, car cela
risquerait de provoquer un court-circuit.

Ne court-circuitez pas la batterie ou ne la jetez pas au feu.
Ne démontez pas la batterie. Elle pourrait exploser ou prendre feu.

N'utilisez que des batteries et des accessoires recommandés.
L'utilisation de batteries non expressément recommandées pour cet
appareil risque de provoquer une explosion ou une fuite, ce qui pourrait
causer un incendie, des blessures ou des dommages.

Respectez les instructions d'installation de la batterie. Des batteries
installées de maniére incorrecte peuvent endommager le caméscope
Sport.

En cas d'inutilisation prolongée, retirez la batterie.
Dans le cas contraire, elle risque de fuir. Pour éviter dendommager le
produit, prenez soin de la retirer lorsqu’elle est vide.

Informazioni sulla batteria

m Una temperatura ambiente inferiore a 110°C (50°F) diminuisce
le prestazioni della batteria e ne riduce la durata. In questo caso,
scegliere una delle seguenti operazioni per prolungare la durata della
batteria.
- Mettere la batteria in tasca per scaldarla e inserirla nella
videocamera immediatamente prima dell'uso.
- Usare una batteria con una grande capacita di carica.

m Impostare il tasto di accensione su OFF quando non si esegue la
registrazione o la riproduzione. L’energia della batteria si consuma
anche in modalita standby, riproduzione e pausa.

m  Tenere pronto il gruppo batterie per un tempo di registrazione doppio
o triplo rispetto a quello previsto ed eseguire delle prove prima della
registrazione effettiva.

m  Non esporre la batteria allacqua. La batteria non & impermeabile.

m  Tenere la batteria fuori dalla portata dei bambini. In caso di ingestione
accidentale della batteria, consultare immediatamente un medico.

m  Pulire la batteria con un panno asciutto e pulito per garantire il contatto.

m Non afferrare la batteria utilizzando strumenti metallici, poiché potrebbe
verificarsi un cortocircuito.

m Non mettere la batteria in cortocircuito e non smaltirla bruciandola.
Non smontare la batteria. La batteria potrebbe esplodere o incendiarsi.

m  Utilizzare esclusivamente batterie e accessori consigliati.
L'uso di batterie non consigliate espressamente per questo apparecchio pud
provocare un’esplosione, una perdita o un incendio, con conseguenti lesioni
personali e danni al’ambiente.

m Installare la batteria in base alle istruzioni. Le batterie installate in modo
non corretto possono danneggiare la videocamera Sport.

m  Se la videocamera non viene utilizzata per un periodo di tempo

rolungato, rimuovere la batteria. L )
n caso contrario, dalla batteria potrebbero fuoriuscire liquidi. Per evitare

danni allapparecchio, rimuovere la batteria quando & completamente

scarica. !



Entretien : Nettoyage et
entretien du caméscope Sport

Manutenzione: Pulizia e
manutenzione della videocamera Sport

Utilisation du caméscope Sport a I’étranger

< Chaque pays ou zone géographique posséde ses propres normes
électriques et codes de couleurs. (NTSC/PAL)

% Avant d'utiliser votre caméscope Sport a I'étranger, vérifiez les
points suivants.

Sources d’alimentation

% Grace a 'adaptateur CA fourni, vous pouvez utiliser votre caméscope
Sport dans n'importe quel pays ou zone ou I'alimentation secteur est
comprise entre 100 et 240 V (50 ou 60 Hz).

% Utilisez si nécessaire un adaptateur CA disponible dans le
commerce en fonction de la forme des prises murales locales.

Code de couleurs

% Vous pouvez visionner vos fichiers vidéo sur 'écran LCD intégré.
Cependant, pour que vous puissiez visionner vos enregistrements
sur un téléviseur ou les copier vers un magnétoscope (VCR), ces
appareils doivent étre conformes a la norme PAL et étre équipés
des ports audio/vidéo appropriés. Si tel n’est pas le cas, vous
devrez peut-étre utiliser une carte de transcodage vidéo séparée
(convertisseur de format PAL-NTSC).

Pays et zones utilisant la norme PAL

Allemagne, Arabie Saoudite, Australie, Autriche, Belgique, Bulgarie,
Chine, Communauté des Etats indépendants, Danemark, Egypte,
Espagne, Finlande, France, Grande-Bretagne, Grece, Hong Kong,
Hongrie, Inde, Iran, Irak, Koweit, Libye, Malaisie, Mauritanie,
Norvege, Pays-Bas, Roumanie, Singapour, République slovaque,
République tcheque, Suéde, Suisse, Syrie, Thailande, Tunisie, etc.

Pays et zones utilisant la norme NTSC

Amérique centrale, Bahamas, Canada, Etats-Unis, Japon, Mexique,
Philippines, Corée, Taiwan, etc.

a

Uso della videocamera Sport all’estero

< Ogni nazione o area dispone di sistemi elettrici e sistemi di

colore specifici. (NTSC/PAL)

¢ Prima di utilizzare la videocamera Sport all’estero eseguire

i seguenti controlli:
Fonti di alimentazione

% Grazie allalimentatore CA fornito, e possibile utilizzare

la videocamera Sport in ogni nazione o area in cui I
alimentazione & compresa tra 100V - 240V, 50/60Hz.

% Se necessario, utilizzare uno dei vari adattatori CA

disponibili in commercio, a seconda del tipo di presa a muro.

Norma colore

¢ E possibile visualizzare i file video utilizzando il display LCD

incorporato.Tuttavia, per visualizzare le registrazioni su un
televisore o per copiarle su un videoregistratore (VCR),
entrambi devono essere compatibili con PAL e avere porte
audio / video appropriate. In caso contrario, si potra utilizzare
un Convertitore del formato video (PAL-NTSC).

Nazioni/aree compatibili con il sistema PAL

Australia, Austria, Belgio, Bulgaria, Cina, CIS, Repubblica Ceca,
Danimarca, Egitto, Finlandia, Francia, Germania, Grecia, Regno
Unito, Olanda, Hong Kong, Ungheria, India, Iran, Irag, Kuwait, Libia,
Malesia, Mauritius, Norvegia, Romania, Arabia Saudita, Singapore,
Repubblica Slovacca, Spagna, Svezia, Svizzera, Siria, Thailandia,
Tunisia, ecc.

Nazioni/aree compatibili con il sistema NTSC
Bahamas, Canada, America centrale, Giappone, Messico, Filippine,
Corea, Taiwan, Stati Uniti d’America, ecc.



Dépannage

Risoluzione dei problemi

Affichage de I’'auto-diagnostic

Display di autodiagnosi

Affichage

Donne les informations suivantes...

Opérations a effectuer

Display

Informs che...

Aztion

Not enough free space.
(Espace dispo insuff.)

Pas assez d'espace disponible
pour enregistrer les fichiers.

Vérifiez I'espace disponible sur la mémoire
interne ou sur la carte mémoire interne.

Not enough free space.
(Spazio libero insuff.)

Non c'é spazio sufficiente per
salvare i file.

Controllare lo spazio della memoria interna o
della memoria esterna.

Corrupted file.
(FCH corrompu.)

Le fichier est corrompu.

Supprimez le fichier corrompu.

Corrupted file.
(File corrotto.)

Il file & danneggiato.

Cancellare il file danneggiato.

Paper error!
(Err. papier)

Il n'y a plus de papier.

Vérifiez la quantité de papier dans I
imprimante. S'il n'y en pas, insérez du papier.

Paper error!
(Errore carta)

La carta & esaurita.

Controllare la carta nella stampante. Se non ¢’
& carta, inserirla.

Ink error! (Err. encre)

Le niveau d'encre est bas.

Vérifiez le niveau d'encre.

File Error! (Err. FCH)

Le format de fichier est

Vérifiez que le fichier est au format JPEG.

Ink error! (Errore inc)

Il livello dellinchiostro & basso.

Controllare se il livello di inchiostro o di toner
€ basso.

incorrect. File Error! (Errore file) |l file & errato. Controllare che il file sia in formato JPEG.
Communication Error! |Une erreur est survenue lors | Débranchez le cable USB et rebranchez-le. Communication Error! |Si & verificato un errore durante Scollegare e ricollegare il cavo USB.
(Err. communication) |du transfert des données. (Errore comunicaz.) |l imento dei dati.

Low battery Le niveau de la batterie est Chargez la batterie ou branchez Low battery La batteria & scarica. Sostituire il gruppo batterie o collegare
(Batt. Fble) faible. I'adaptateur CA. (Esaurim Bat) I'alimentatore CA.
Holding the key La touche HOLD est Déverrouillez la touche HOLD et faites Holding the key L'interruttore HOLD & bloccato. |Sbloccare l'interruttore HOLD e accendere la

(Verr. touche) verrouillée. fonctionner le caméscope Sport. (Ten prem tasto) videocamera Sport.

Card error (Er. carte) |La carte mémoire est Formatez la carte mémoire ou remplacez-la. Card error (Err scheda) | La scheda di memoria & Formattare la scheda di memoria oppure
corrompue. danneggiata. sostituirla.

Not formatted Formatez la carte mémoire. Formatez la carte mémoire. Not formatted Formattare la scheda di Formattare la scheda di memoria

(Non formatée) (Non formattata) memoria.

Write error (Err. Ecrit.)

Impossible d'écrire.

Vérifiez I'espace mémoire ou formatez la
carte mémoire .

Write error (Err scrittura)

Errore nella scrittura.

Controllare lo spazio della memoria o
formattarla.

Read error (Err. Lect.)

Impossible de lire.

Supprimez le fichier.

Read error (Err lettura)

Errore nella lettura.

Cancellare il file.

Not supported format
(Format non accepté)

Le format n’est pas pris en
charge.

Les fichiers AVI ou JPEG ne sont pas pris en
charge. Vérifiez le format de fichier pris en
charge page 30.

Not supported format
(Formato non support.)

Il formato non & supportato.

| file AVI 0 JPEG non sono supportati.
Controllare i file supportati a pagina 30.

Write protected.
(Protec. écrit.)

La carte mémoire est protégée
en écriture.

Déverrouillez la carte mémoire
(hormis la carte MMC).

Write protected.
(Prot da scrittura)

La scheda di memoria &
protetta dalla scrittura.

Sbloccare la scheda di memoria. (tranne
MMC)

MPEG decoding Error

(Err. décodage MPEG)

Le fichier vidéo est corrompu

Supprimez le fichier corrompu.

MPEG decoding Error

(Err decodifica MPEG)

Il file video & danneggiato.

Cancellare il file danneggiato.

< Sices instructions n'apportent aucune solution a votre probléme, contactez votre
revendeur le plus proche, un technicien ou un centre de service technique agréés

< Sein queste istruzioni non & presente la soluzione del problema, contattare il
concessionario Samsung o il centro servizi autorizzato pit vicini.

Samsung.
Problé Causes possibl Solutiol Sintomo Possibili cause Misura
lIn'y apas d’ Le cable d'alimentation n’est pas | Connectez I'adaptateur CA Non viene fornita I' | L’alimentazione non e collegata Collegare correttamente I
alimentation branché correctement correctement - voir page 25 alimentazione correttamente alimentatore CA, pagina 25
La batterie est usée Remplacez la batterie usée La batteria & esaurita Sostituire il gruppo batterie esaurito
La batterie est trop froide Réchauffez la batterie ou déplacez- La batteria & troppo fredda Riscaldare la batteria o spostarla in
la dans un endroit plus chaud un luogo pit caldo
Date/heure La date et I'heure ne sont pas Réglez la date et I'heure - voir La data/l'ora sono [La data/I'ora non sono impostate  |Impostare Date/Time (Data/Ora),
incorrectes réglées page 104 errate pagina 104

b




Dépannage

Risoluzione dei problemi

Probléme

Causes p

Sintomo

Possibili cause

Misura

La mise au point ne se fait
pas automatiquement

La mise au point est réglée sur le
mode manuel. L'enregistrement est
effectué dans un endroit sombre. La
lentille est couverte de buée.

Réglez la mise au point sur AUTO
Utilisez le flash ou éclairez I
emplacement Nettoyez la lentille
et vérifiez la mise au point

La carte mémoire ne s’
insere pas correctement

La carte mémoire est mal insérée.
Un corps étranger se trouve dans
la fente de la carte mémoire

Insérez la carte mémoire
correctement - voir page 34.
Nettoyez le compartiment de
la carte mémoire

La messa a fuoco non &
regolata automaticamente

La messa a fuoco & impostata nella
modalita manuale

La registrazione viene effettuata in
un luogo scuro

L'obiettivo & stato coperto dalla
condensa

Impostare la messa a fuoco su
AUTO

Utilizzare il flash o illuminare
il luogo Pulire I'obiettivo e
controllare la messa a fuoco

L'équilibrage des couleurs
de limage n’est pas naturel.

La balance des blancs doit étre
ajustée.

Réglez correctement la balance
des blancs - voir page 43, 61

La scheda di memoria non &
caricata correttamente

La scheda di memoria non & nella
posizione corretta

Nello slot per la scheda di memoria &
presente un oggetto estraneo

Inserire la scheda di memoria
correttamente, pagina 34
Liberare lo slot della scheda di
memoria

Le zoom numérique ne
fonctionne pas.

Un effet spécial numérique est
appliqué

Désactivez les effets spéciaux
numériques - voir page 45, 63

| colori dellimmagine non sono
naturali

E richiesta la regolazione del
bilanciamento del bianco

Impostare un adeguato
bilanciamento del bianco, pagina

3,

Les fichiers enregistrés
sur la carte mémoire ne
peuvent pas étre
supprimés.

La carte mémoire est protégée
Le fichier est verrouillé

Retirez la languette de protection
de la carte mémoire (hormis la
carte MMC) Déverrouillez le fichier
- voir pages 54, 73, 81, 88, 93

Lo zoom digitale non
funziona

Sono stati applicati degli effetti (effetti
speciali digitali)

Disattivare gli effetti (speciali
digitali), pagina 45, 63

Les images apparaissent
sombres sur 'écran LCD.

La luminosité est trop importante
La température ambiante est trop
basse

Réglez la luminosité et langle de I
écran LCD Des températures trop
basses peuvent provoguer un
affichage sombre sur 'écran LCD Il ne
s'agit pas d'un dysfonctionnement

I file archiviati nella memoria
non possono essere
cancellati

Memory card protetta, i file sono
bloccati

Rimuovere la protezione (tranne
le MMC). Rimuovere il blocco sul
file pag. 54,73,81,88,93

L'arriere de I'écran LCD
est chaud.

Utilisation prolongée de lécran LCD

Rabattez I'écran LCD pour le
mettre hors tension

ou éteignez votre appareil
pour le laisser refroidir.

Immagini sul monitor LCD
appaiono scure

Ambiente e' troppo luminoso.
Temperatura ambiente e' troppo
bassa.

Aggiusta la luminosita' e l'angolo
dell'LCD.

Bassa temperatura puo' produrre
un display LCD scuro.

Non e' un malfunzionamento.

La lecture, le retour et
I'avance rapide ne
fonctionnent pas.

Le mode Photo est sélectionné

Sélectionnez le mode Movie
et Play (Lire)

Il retro del monitor LCD e'
caldo

Uso prolungato del monitor LCD

Chiudere I'LCD e spegnerlo,
oppure spegnere I'apparecchio e
lasciarlo raffreddare

Play, riavvolgi, e avanti
veloce non funzionano

Modalita' Foto e' selezionata

Seleziona "Movie Mode" e
seleziona "Play"

La carte mémoire ne peut pas
étre lue (Mode Photo)

Le mode Movie (Vidéo) est
sélectionné

Sélectionnez le mode Photo
et View (Voir)

Memory card non puo'
riprodurre (modo Foto)

Il modo Movie €' selezionato

Seleziona modo Foto e seleziona
"vedi/view"

Aucune image n’est prise

Il ne reste pas suffisamment
d’espace disponible dans la
mémoire La carte mémoire a été
formatée par d'autres appareils

Supprimez les fichiers de la carte

mémoire ou de la mémoire intere
Formatez la carte mémoire sur le

caméscope Sport

Non cattura foto

Non c'e' abbastanza memoria libera.
La memory card e' formattata per
congegni differenti.

Cancella i ifle dalla memory card
o dalla memoria interna.
Formatta la memory card per la
camera Sport

Le flash intégré ne
fonctione pas

Le flash a été désactivé
Le flash n’est pas disponible
pendant I'enregistrement

Sélectionnez un autre mode
flash - voir page 64.

La memoria built-in non
brucia

Non c'e' luce disponibile per la
registrazione

Seleziona un modo Flash
diverso, pag 64

Impossibilité d’enregistrer
une vidéo

Le mode Photo est sélectionné

Sélectionnez le mode Movie
(Vidéo)

Non puo' registrare un'
immagine video

Il modo Foto ' selezionato

Selezionate il modo Movie

L’écran LCD s'éteint

Pour réduire la consommation
d'énergie, l'écran LCD et le
caméscope Sport s'éteignent lorsque
aucun bouton n'est actionné pendant
une durée donnée (selon le mode de
fonctionnement)

Le caméscope se remet
automatiquement sous tension
lorsque vous appuyez sur un
bouton Appuyez a nouveau sur le
bouton pour activer la fonction

Il monitor LCD €' spento

Per risparmiare il consumo di energia,
il monitor LCD e la camera Sport si
Spengono se non vengono usati i tasti
per un certo periodo.

Utilizzando qualunque bottone
la Sport camera sara'’ di nuovo
operativa

oy




Utilisation du menu

Utilizzo della memoria

% Vidéo

Size
720x576
352x288

Qualité
Super Fin
Fin
Normal

Bal. Blancs
Auto
Jour
Fluorescent

Tungst.
Person.

Prog. AE
Auto
Sports
Spot

Sab./neig

Effet

off
Art
Mosaiq
Sépia
Négatif
Miroir
N&B
SEI
On
off
Régl.
AF
FM
CCJ
On
Off
Zoom num.
On
off
Mode Enreg.

v
PC

En/Srt

En
Srt

Mode Lect
Lire un
Lire tt
Répéter un
Rép. tout
Verr
Verr
Sélect multi
Ver. it
Dév. tout

Cop sur

OK
Sélect multi

@ Photo

Bal. Blancs
Auto
Jour
Fluorescent
Tungst.
Person.

Prog. AE
Auto
Sports
Spot
Sab./neig

Effet
Off
Art
Mosaiq
Sépia
Négatif
Miroir
N&B

Flash
On
Auto
off

Phot. en continu

Off
3 phot.

SEl

ON
Off

Régl.
AF
MF

ccl

On
Off

Zoom num.

On
Off

Diapo
Dém.
Interv. (s.)
Répét.

DPOF
Copies
Déf. tt
Réinit. tt

Verr
Verr
Sélect multi
Ver. tt
Dév. tout

Cop sur

OK
Sélect multi
Tt

& MP3

Répét.
Off
Répéter un
Rép. dossier
Rép. tout
Lect. al. doss.
Lect. al. tt

Egaliseur
Off
Pop
Class.
Jazz
Verr

Verr

Sélect multi
Ver. tt

Dév. tout

Cop sur

OK
Sélect multi
Tt

& Video

Dim
720x576
352x288
Qualita
Super Fine
Fine
Normale
Bilan. Bianco
Auto
Luce diurna
A fluorescenza
Tungsteno
Personalizzatp
Ae Program
Auto
Sport
Riflettore
Sabbia/Neve
Effetto
Off
Art
Mosaico
Seppia
Negativo
Specchio
BIN

EIS
On
Off
Fuoco
AF
KF
BLC
On
Off
Zoom Digitale
Attiva
Off
Mod registraz
v
PC
1/0 linea
In
Out

Mod ripr
Riproduci uno
Riproduci tutto
Ripeti uno
Ripeti tutto

Prot

Prot

Multi selez.
Blocca tutto
Sblocea tutto

Copia su
OK

Multi selez.
Tutti

@ Foto

Bilan. Bianco

Auto

Luce diurna

A fluorescenza

Tungsteno

Personalizzatp
Ae Program

Auto

Sport
Riflettore
Sabbia/Neve

Effetto

off

Art
Mosaico
Seppia
Negativo
Specchio
BN

Flash

On
Auto
Off

Scatto continuo

Off
3 scatti

EIS
On
off

Fuoco
AF
KF

BLC

On
Off

Zoom Digitale

On
Off

Diapositiva
Awvia
Interval (sec.)
Ripetiz.
DPOF
Copie
Imposta tutto
Reimposta tutto
Prot

Prot

Multi selez.
Blocca tutto
Sblocca tutto

Copia su

OK
Multi selez.
Tutti

d MP3

Ripetiz.
Off
Ripeti uno
Ripeti cartella
Ripeti tutto
Cartella casuale
Tutti causali

Equalizzatore
off
Pop
Classica
Jazz
Prot
Prot
Multi selez.

Blocca tutto
Sblocca tutto

Copia su

OK
Multi selez.
Tutti



FRANCAIS
@ Enreg. £y Reglage ¥ Registr. Voce £%Imp di
Voix syst. sistema
Type stock. Signal son Tipo memoria Suono Bip
Interne On Interna On
Externe Off . Esterna Off
Mode Lect D6 IE) far Accens
Lire un Mode USB ENG Fiprocuci uno Mod. USB .
Lire tt Mém. aux. Mode Film Riproduci tutto Mass Storage Modalita Film
Reépéter un PictBridge Mode préc. Ripeti uno PictBridge Mod. preced.
Rép. tout Webcam Ré-in Ripeti tutto Retan Reimp
Verr N° FCH OK Prot N. File OK
Verr ari Prot -
Sélect mult fgﬁ Language Mult selez. ;::p Language
\[l’er-': . English / Espariol / g';lcca tl:ﬂg English / Espafiol /
. locca (] . o
Sriod Format Frangais / Portugués - B Formatta Frangais / Portugués
Cop sur Interne P Copia su Intena / Deutsch / Italiano /
OK Extemne X OK Esterna Nederlands / Polski /
9 Nederlands / Polski / i
Sélect multi , Multi selez. - - Pycckuit / 82301 / FXC
Tt Espace mém. Pycckuit / 5120 / Tutti Spazio memoria g
= /Iran / Arab / Magyar
000 Mo/000 Mo 000MB/00OMB
T /lran / Arab /"Wl / YkpaiHceka /
Lumin. LCD / Magyar /ne / Lumin. LCD Svenska
& Explorateur ¢ scua Srese & Scorri o Spegn autom
100% Extinct. auto file 100% @i
off 5 minuti
Verr Coul. LCD 5 min Prot Colore LCD Dimostrazione
Ve ) 0% Démonstration Prot 0% off
Sélect multi g off Multi selez. g 5 minuti
Ver. tt 100% 5 mi Blocca tutto 100% Ripr ora
Dév. tout Lirrgm Sblocea tutto :
e Régl. date/hr _ o Imp Data/Ora IDfolVelSione
oK Format date Info version opia su Formato data
) ) YY/MM/DD OK YY/MM/DD
?ﬁ:ﬁd il DDMMYY Multi selez. DDMM/YY
MM/DD/YY Tutt MM/DD/YY
Info fich. Format Hr Info file Form Orario
OK 12h OK 12 ore
24h 24 ore
Date/Hr Data/Ora
Off off
Date Data
Hr Ora
Date/Hr Data/Ora




Spécifications techniques

Specifiche

Nom du modele [vP-x205L/x210L/X220L Nome modello [vP-x205L/x210L/X220L
Systéme du caméscope Sport Il sistema videocamera Sport
Systeme d'enregistrement vidéo | Format MPEG4 AVI Sistema di registrazione video | Formato MPEG4 AVI
Systéme photo JPEG (640x480, DPOF, Exif 2.2) Sistema di registrazione foto | JPEG (640x480, DPOF, Exif 2.2)
MP3 Lecture stéréo MP3 Riproduzione stereo
Voice Enregistremlentllef:tyre de fichiers SON (échantillonnage Sistema vocale Regisltrazione/riproduzione fille WAVE (frequenza di
8 KHz, 16 bits, stéréo) campionamento 8 KHz, 16 bit, stereo)
512Mo (VP-X205L) 512MB (VP-X205L)
Mémoire interne 1Go (VP-X210L) Memoria interna 1GB (VP-X210L)
Mémoire 2Go (VP-X220L) Memoria 2GB (VP-X220L)
Mémoire externe SD Memoria esterna SD
MMC MMC
Pixel CCD CCD 1/6”, 800 K (maximum) Pixel CCD 1/6 inch CCD, 800K (massimo)
Puissance du zoom optique  |x10 Rapporto zoom ottico x10
Longueur focale f=2,4a24 mm,F1,8a24 Lunghezza focale F=2.4~24mm, F1.8~2.4
Luminosité minimale 3,0 lux llluminazione minima 3.0 Lux
Ecran LCD 2,0” Type de tr ansmission : 230 K Display LCD 2,0", tipo di trasmissione 230K
Connecteurs
UsB Type mini-B (USB 2.0 & haut débit) Connessioni
Prise CC Connecteur prioritaire & 3 broches USB Connettore di tipo Mini-B (USB 2.0 ad alta velocita)
o Ecouteurs |2 3.5 Stereo z?mngﬁgi:; |g%resso Connettore a 3 spinotti proprietario
mrlljslt?fonction SE;‘:t'iie;W Vldeo’ (1,0 p_p, 75 Q), audio (-7,5 dBm ; 47 KQ, stéréo) Cuffie 3.5 Stereo
i Caméra CMOS externe Multiack [Ingresso/ | Video (1.0p_p, 750), Audio (-7.5dBm 47KQ, Stereo)
Dlversl uscita AV Videocamera esterna CMOS
Température de 0°C & 40°C — -
fonctionnement Informazioni generali
Humidité de 10%-80% Temperatura di esercizio |0°C-40°C (32°F-104°F)
fonctionnement Umidita operativa 10%-80%
Source d'alimentation 3,8 V (bloc batterie lithium-polymeére), 4,8 V Alimentazione 3,8V (gruppo batteria ai polimeri di litio), 4,8V (adattatore CA)
— (adaptat’eur CA) - Consumo di energia 2.8W (LCD ATTIVO)
Consommation électrique |2,8 W (écran LCD allumé) : . — 61,3 mm x 93,6 mm x 30,3 mm_(compreso il gruppo
Dimensions (L x Hx P) 61,3 mm x 93,6 mm x 30,3 mm (y compris le bloc Dimensioni (LxPxA) batterie)
- batterie) Peso 1509
P(_)'ds — 150 g - —— Microfono incorporato Microfono a condensatore omni-direzionale
Microphone intégré Microphone a condensateur multidirectionnel

a




Spécifications techniques

Specifiche

Nom du modeéle

| VP-X205L/X210L/X220L

Nome modello

| VP-X205L/X210L/X220L

Adaptateur CA

Adattatore CA

Alimentation requise CA 100 a 240V, 50/60 Hz Requisiti di alimentazione CA 100 ~ 240V, 50 / 60 Hz
Sortie CC CC48V;1,0A Uscita CC CC4,8V,10A
Température de fonctionnement | 0°C a 40°C Temperatura di esercizio 0°C (32°F) ~ 40° (104°F)
Dimensions 70 mm x 29,7 mm x 59,1 mm Dimensioni 70 mm x 29.7 mm x 59.1 mm
Poids 85.1g Peso 85.1g

Nom du modéle | xc-L2P Nome modello | xc-L2P

Caméra CMOS externe

Videocamera esterna CMOS

Pixel CMOS CMOS 1/3 pouce, 320K (maximum) Pixel CMOS CMOS da 1/3 pollici, 320K (massimo)

Résolution Vidéo 640x480 (VGA) Risoluzione Video 640x480 (VGA)

Exposition Auto Esposizione Auto

Balance des Blancs Auto Bilanciamento Bianco [ Auto

Type de Mise au point | Fixe Tipo di Messa a fuoco | Fisso

Longueur Focale F=5.56mm, F2.0 Lunghezza Focale F=5.56mm, F2.0

Connecteur Connettori

Sortie AV Vidéo (1,0 Vp_p), audio (-7,5 dBm ; 47 KQ ; Uscits AV Video (1.0Vp_p), Audio (-7.5dBm 47KQ,
entrée : mono) Input : mono)

Divers Informazioni Generli

Température de Fonctionnement

0°a40°C

Temperatura di esercizio

0°C~40°C (32°F~104°F)

Humidité de Fonctionnement

20%~80%

Uumidita Operativa

20%~80%

Source d’Alimentation

B+(32Va48V)

Alimentazione

B+ (3.2V~4.8V)

Consommation d'Energie| 0.7W Consumo di Energia 0.7W
Dimensions (LxHxP) 94.5mm x 34.7mmx33mm Dimensioni (LxAxP) 94.5mm x 34.7mmx33mm
Poids 969 Peso 969

Microphone Intégré

Microphone a condensateur multidirectionnel

Microgfono Integrato

Microfono a condensatore omni-direzionale

La conception et les spécifications du produit sont susceptibles d'étre modifiées

sans préavis pour un meilleu

s

r fonctionnement et une meilleure qualité.

Il progetto e le specifiche del prodotto sono soggetti a modifiche

senza preavviso per otten

rere prestazioni e qualita migliori.



FRANCAIS ITALIANO
Index Indice
-A- -A-
Adaptateur CA ........ccvvvrve Alimentatore CA......... et 13,25
AF Auto Focus (Mise au point automatique) ... AF (Messa a fuoco automatica) ............c...eeeereeeesereesnnneens 47,67
Auto Shut off (Extinct. auto)...... -B-
-B- Bilanciamento del bianco et 43, 61
Bloc batterie .........couererreennenns et nanes 22~25 BLC S e 68
Bouton MODE............ccccoovuuunee s 27 -C-
Bouton MENU. ........cccviiiiirinicissieiiniins 28 Cuffie SO, e 14
BLC (CCJ).. e 68 Caricamento della batteria e .25
Beep Sound (Signal son).......... et sanen 108 Copia su s 55, 74, 82, 89, 94
-C- Colore LCD ... s 103
Charge de la batterie ................ s 25 -D-
Copy To (Cop Sur) .....ceevveeene 55, 74, 82, 89, 94 [)=10 72,130
-D- Dimostrazione............. s ... 113
Digital ZOOM (ZOOM NUM.)....ouuvvvvrminriisssnssiissssssisssssssssssssssssssssss 47,69 DV Media Pro 1.0 c.veeeeeeeveeereeeeeeesseereenne 124,125
DPOF ..ot -E-
Date/Time (Régl. date/nr) ........cccveereereereeneeneenenen. EFQMO oo 45,63
Demonstration (Démonstration) ............cocveereenennes -F-
DV Media Pro 1.0 ..o FOrmattazione ...........cccveueurireiriiienieeeeee s ... 100
DEPaANNAGE......ceverrreciriiieieee s
E 10G
ECOULBUS oo e 14 Gruppo batterie .......... ....I ..... 22~25
Effect (Effef) T 45,63 Impostazione Data/Ora............ccevieerinnne ..104
-F- Informazioni sulla versione SR 114
File Browser (Explorateur)......... s 90
File No. (N° FCH) e 99 . -dJ-
FOMM@ oo 100 Joystick ..o s 28
-1- -L-
Information version e 114 L.ummosna LOD e 102
Lingua TS T PRSPPSO 111




FRANCAIS ITALIANO
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=d)e -M-
JOYSHCK. ..ottt 28 Messa a fuoco manuale ..........ccceeeeeveeeeeeeeeeeeeeeennes .47, 67
-L- Modalita di @CCENSIONE ........c.vvevirriririeiieieei st 109
LOCK (VEIT) .o 54,73, 81, 88, 93 NG
LCD Brightness (LUMIN. LCD)........ccuuiuiiniiniiiniisieniissisesissssisissisiens 102 NI oottt eeen 99
LCD Colour (COUL LCD)....cuurerrrrirriirmereeeenseessesesensssseseseseseseesenens 103 P
Language (LaNQUE) .........v.crvevrrsisssssissssssiissssssssssssissssnnes 111 PIOGIAM AE ..ooreeeeseeesseeesseeesseesssessesses s 44,62
-M- PIOMBZIONG w...vvvvveeeeeeeeeeeee s 54,73, 81, 88, 93
MF(Manual Focus) (FM (Mise au point manuelle)) .........c...oovuurvvrernnrinns 47,67 PictBridge i 116
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PrISE oottt 57 RIPIESA ...t 57
PictBridge (PICtBrAGE).......ccvueeeecereercereereiseiseieecee e 116 REGISITAZIONE VOCAIE......ooooceeeeeesseeeeeeessssessees s sceseessesssseee s oo 84
PC CaM (WEDCAM)....ocovvvotorvtossoose 17 REIMPOSIAZIONE ..o 110
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Quality (QUANIEE) .....eueuceceeieeeeeeeereeesesei e 42 s
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Pour la France uniquement :

Pour toute information ou tout
renseignement complémentaire sur nos
produits, notre service consommateurs

est a votre disposition au :

service consommateurs :

LML) 08 25 08 65 65)

0,15€ TTC/MN

Vous pouvez également vous connecter a notre site Internet:
www.samsung.com/fr

Cet appareil est garanti un an pieces et main d'oeuvre
pour la France (métropolitaine)
La facture d'achat faisant office de bon de garantie.



FRANCE

Cher Client,

Nous vous remercions d’avoir acheté un produit SAMSUNG.
Au cas ou vous auriez besoin de notre service aprés-vente,
nous vous invitons a retourner ce produit au revendeur qui en a
effectué la vente.

Si vous avez un probléme, n’hésitez pas a nous contacter a
I'adresse suivante:

Samsung Service Consommateurs
66 rue des Vanesses
BP 50116 - Villepinte -95950 ROISSY cedex
France
Tel: 08 25 08 65 65 (0,15 € /min),
Fax: 01 48 63 06 38 (0,15 € /min)
www.samsung.com/fr

um GARANTIE

Sans préjudice de la garantie légale du fabricant ou du
vendeur conformément & I'article 1641 du Code Civil, la société
SAMSUNG applique les garanties suivantes:

Par la présente carte, SAMSUNG ELECTRONICS FRANCE
garantit que ce produit est exempt de défaut de matiére et de
fabrication existant lors de I'acquisition par le client chez un
distributeur pour un délai d’'un an (pieces et main d’oeuvre), pour
les appareils audio, vidéo, télévision et micro ondes. La période
de garantie commence le jour de I'achat de I'appareil.

Elle n'est en aucun cas prolongée par I'échange de I'appareil.

Si ce produit s’avére défectueux pendant la période de

garantie en raison de matiére ou de fabrication incorrecte, le
distributeur prendra en charge le produit ou a défaut SAMSUNG
ELECTRONICS FRANCE dans les conditions exposées ci-apres.
Les filiales de SAMSUNG ELECTRONICS CORP. ainsi que ses
distributeurs et les stations techniques agréées des autres états
membres de la C.E.E. honoreront aussi cette garantie selon les
termes et conditions en vigueur dans le pays ou est demandé la
réparation.

= CONDITIONS DE GARANTIE

1. La garantie sera seulement assurée si la facture d’achat et la
carte de garantie remises au consommateur par le distributeur
sont présentées et si elles mentionnent:
a) Le nom de I'acheteur,
b) Le nom, I'adresse et le cachet du distributeur,
¢) Le nom du modéle et le numéro de série du produit acquis
d) La date d’acquisition de ce produit.

En aucun cas, la carte de garantie seule ne fera preuve de
garantie.

2. SAMSUNG ELECTRONICS FRANCE se réserve le droit de
refuser la garantie si tout ou partie de ces mentions a été
enlevé ou modifié aprés I'acquisition du produit par le client
chez le distributeur.



3. Ce produit ne sera jamais considéré comme défectueux en

matiere ou en fabrication s'il doit étre adapté, changé ou réglé

afin d’étre conforme aux standards techniques ou de sécurité

nationaux ou locaux en vigueur dans tout autre pays que celui

pour lequel il a été fabriqué a I'origine.

Cette garantie ne s’applique pas:

a) A ces adaptations, changements ou réglages qu'ils soient
exécutés de fagon correcte ou pas,

b) Aux dommages qui en résulteraient.

. Cette garantie ne couvre pas les cas suivants:
A. Les contrdles périodiques, I'entretien, la réparation et le
remplacement de piéces par suite d’'usure normale;
B. Les frais et les risques de transport directs ou indirects a la
mise en oeuvre de la garantie de ce produit;
C. Le dommage du produit résultant:
1) D’abus et de mauvais usage, en particulier mais non de

fagon exclusive a:

a. La négligence ou faute d'utilisateur (utilisation
contraire aux instructions ou non prévue, fausse
manoeuvre, chute, cassure, félure accidentelle), etc.

b. Linstallation ou I'utilisation de ce produit en
contradiction avec les standards techniques ou de
sécurité en vigueur dans le pays ou le produit est
utilisé;

2) De réparations faites par les réparateurs non agréés;

3) D’accidents, de cas de force majeure ou de toute autre
cause hors du contréle de SAMSUNG ELECTRONICS
FRANCE, en particulier mais non de fagon exclusive :
la foudre, l'inondation, I'incendie, les troubles publics,
des piles qui ont coulé, une mauvaise ventilation, etc....

5. Cette garantie ne limite aucunement les droits statutaires

du client sous les lois nationales en vigueur. Faute de lois
nationales en vigueur, cette garantie ou son application dans
la C.E.E. sera 'unique et exclusif recours légal du client et ni
SAMSUNG ELECTRONICS CORP., ni ses filiales ne seront
tenus pour responsables des dommages directs ou indirects
résultant d’une infraction aux conditions de garantie ci-dessus.

SAMSUNG ELECTRONICS FRANCE



I l ITALIA (ITALY)

Questo prodotto Samsung e’ garantito per un periodo di dodici
(12) mesi dalla data di acquisto, da difetti di fabbricazione o

nei materiali. Nel caso di riparazione, il prodotto dovra’ essere
riportato presso il rivenditore dal quale si e’ effettuato I'acqusito.
Comunque tutti i rivenditori e i centri di assistenza tecnica
autorizzata Samsung presenti nei paesi dell’ europa occidentale
riconosceranno la validita’ di questa garanzia compatibilménté
con le normativé vigenti nel paese interssato.

| centri di assistenza tecnica autorizzata sono gli unici riconosciuti
idonei dalla Sam sung ad effettuare I’ attivita’ di riparazione in
garanzia.

In caso di difficolta’ la preghiamo di rivolgersi alla:

Samsung Electronics ltalia S.p.A
Via C. Donat Cattin, 5
20063, Cernusco Sul Naviglio (M)
Tel. 199 153 153 FAX. 02 92141801
Servizio Clienti: Tel. 199. 153. 153
http://lwww.samsung.com/it

u CONDIZIONI DI GARANZIA

1. La garanzia viene accettata solo nel caso in cui il certificato
risulta completamente compilato ed esibito unitamente alla
fattura comprovante I'acquisto o allo scontrino fiscale; inoltre
nessuna alte-razione o cancellazione dovranno essere
apportate al certificato medesimo.

2. Gli obblighi della Samsung sono limitati alla riparazione o, a
sua discrezione, alla sostituzione del prodotto o delle parti
difettose.

3. Ribadiamo che i centri di assistenza tecnica autorizzata
sono gli unici incaricati dalla Samsung a svolgere I’ attivita’ di
garazia.

4. La garanzia del presente prodotto decadra’ immediatamente
se lo stesso verra’ modificato ed adattato a normative tecniche
e di sicurezza diverse da quelle vigenti nel paese per il quale il
prodotto e’ stato progettato e costruito.

Non sara’ quindi previsto nessun rimborso per danni derivanti

dalle modifiche qui menzionate.

5. La presente garanzia non copre:

a) Periodici controlli, manutenzione, riparazioni o sostituzioni
di parti soggette ad usura.

b) Costi relativi a trasporto, spostamenti o installazione del
presente prodotto.

¢) Uso improprio, errori di utilizzazione o non corretta
istallazione.

d) Danni causati da incendio, acqua, fenomeni naturali,
guerra, moti pubblici, incorretta alimentazione, ventilazione
insufficiente od ogni altra causa non dipendente dalla
Samsung.

6. Questa garanzia e’ valida per ogni persona che prende
possesso formalmente del prodotto durante il periodo di
garanzia.

7. Questa garanzia non influisce sui diritti del cliente prescritti
dalla legge secondo la legislazione nazionale applicabile in
vigore, ne sui diritti del cliente nei confronti del rivenditore
derivanti dal contratto di compra-vendita. In assenza di
legislazione nazionale applicabile questa garanzia sara’ la sola
ed unica salvaguardia del cliente e ne la Samsung ne la sua
consociata o il, suo distributore saranno responsabili per alcun
danno accidentale o indiretto ai prodotti Samsung derivante
dalla violazione dello condizioni di garanzia sin qui descritte.



Comment contacter Samsung dans le monde
Si vous avez des suggestions ou des questions concernant les produits
Samsung, veuillez contacter le Service Consommateurs Samsung.

Contatta SAMSUNG WORLD WIDE
Se avete commenti o domande sui prodotti Samsung, contattate il Servizio
Clienti Samsung

g:f::rny Customer Care Certre Web Site Reglo:ryCoun Customer Care Certre Web Site
CANADA 1-800-SAMSUNG (726-7864) | www.samsung.com/ca CANADA 1-800-SAMSUNG (726-7864) | www.samsung.com/ca
North America| MEXICO 01-800-SAMSUNG (726-7864)| www.samsung.com/mx North America| MEXICO 01-800-SAMSUNG (726-7864)| www.samsung.com/mx
U.SA 1-800-SAMSUNG (726-7864) | www.samsung.com US.A 1-800-SAMSUNG (726-7864) | www.samsung.com
ARGENTINE 0800-333-3733 Www.samsung.com/ar ARGENTINE 0800-333-3733 WWw.samsung.com/ar
BRAZIL 0800-124-42 www.samsung.com/br BRAZIL 0800-124-421 Wwww.samsung.com/br
CHILE 800-726-7864(SAMSUNG) www.samsung.com/cl CHILE 800-726-7864(SAMSUNG) www.samsung.com/cl
COSTARICA 0-800-507-7267 www.samsung.com/latin COSTARICA 0-800-507-7267 www.samsung.com/latin
ECUADOR -800-10-7267 www.samsung.com/latin ECUADOR 1-800-10-7267 www.samsung.com/latin
EL SALVADOR 00-6225 www.samsung.com/latin EL SALVADOR 800-6225 www.samsung.com/latin
Latin America | GUATEMALA -800-299-0013 www.samsung.com/latin Latin America | GUATEMALA 1-800-299-0013 www.samsung.com/latin
AMAICA -800-234-7267 www.samsung.com/latin AMAICA 1-800-234-7267 www.samsung.com/latin
[PANAMA 00-7267 www.samsung.com/latin [PANAMA 800-7267 www.samsung.com/latin
PUERTO RICO -800-682-3180 www.samsung.com/latin PUERTO RICO -800-682-3180 www.samsung.com/latin
[REP. DOMINICA -800-751-2676 www.samsung.com/latin [REP. DOMINICA -800-751-2676 www.samsung.com/latin
TRINIDAD & TOBAGO |1-800-7267-864 www.samsung.com/latin TRINIDAD & TOBAGO | 1-800-7267-864 www.samsung.com/latin
VENEZUELA -800-100-530. www.samsung.com/latin VENEZUELA -800-100-5303 www.samsung.com/latin
BELGIUM 2201 2418 www.samsung.com/be BELGIU 2 201 2418 www.samsung.com/be
CZECH REPUBLIC 844 000 844 WWW.Samsung.com/cz CZECH REPUBLIC 844 000 844 WWWw.samsung.com/cz
DENMARK 38 322 887 www.samsung.com/dk [DENMARK 38 322 887 www.samsung.com/dk
FINLAND 09 693 79 554 www.samsung.com/fi FINLAND 09 693 79 554 www.samsung.com/fi
FRANCE 08 25 08 65 65 (0,15€/Min) www.samsung.com/fr FRANCE 08 25 08 65 65 (0,15€/Min) www.samsung.com/fr
GERMANY 01805 - 121213 (€ 0,12/Min) | www.samsung.de | GERMANY 01805 - 121213 (€ 0,12/Min) _|www.samsung.de
HUNGARY 06 40 985 985 www.samsung.com/hu HUNGARY 06 40 985 985 www.samsung.com/hu
TALIA 199 153 153 www.samsung.com/it TALIA 199 153 153 www.samsung.com/it
Europe  |[LUXEMBURG 02 26103 710 Www.samsung.lu Europe  |LUXEMBURG 02 26103 710 Wwww.samsung.lu
ETHERLANDS 0900 20 200 88 (€ 0.10/Min) | www.samsung.com/nl ETHERLANDS 0900 20 200 88 (€ 0.10/Min) | www.samsung.com/nl
ORWAY 231627 22 WWW.Samsung.com/no ORWAY 231627 22 WWWw.samsung.com/no
POLAND 0801801881 www.samsung.com/pl POLAND 0801801881 www.samsung.com/pl
PORTUGAL 80 8200 128 www.samsung.com/pt PORTUGAL 80 8 200 128 www.samsung.com/pt
SLOVAKIA 850 123 989 www.samsung.com/sk SLOVAKIA 0850 123 989 www.samsung.com/sk
SPAIN 02 10 11 30 Www.samsung.com/es SPAIN 902 10 11 30 www.samsung.com/es
SWEDEN 8 585 367 87 www.samsung.com/se SWEDEN 08 585 367 87 www.samsung.com/se
K 870 242 0303 www.samsung.com/uk UK 0870 242 0303 Www.samsung.com/uk
cls RUSSIA 8-800-200-0400 WWW.samsung.ru cls RUSSIA 8-800-200-0400 WWW.samsung.ru
UKRAINE 8-800-502-0000 www.samsung.com/ur UKRAINE 8-800-502-0000 www.samsung.com/ur
AUSTRALIA 1300 362 603 www.samsung.com/au AUSTRALIA 1300 362 603 www.samsung.com/au
CHINA 800-810-5858, 010- 6475 1880 www.samsung.com.cn CHINA 800-810-5858, 010- 6475 1880 www.samsung.com.cn
HONG KONG 2862 6001 www.samsung.com/hk HONG KONG 2862 6001 www.samsung.com/hk
INDIA 3030 8282 www.samsung.com/in INDIA 3030 8262 www.samsung.com/in
1600 1100 11 ) 9 1600 1100 11 | i
. " INDONESIA 0800-112-8888 www.samsung.com/id . " INDONESIA 0800-112-8888 www.samsung.com/id
Asia Pacific JAPAN 0120-327-527 Www.samsung.com/jp Asia Pacific JAPAN 20-327-527 Wwww.samsung.com/jp
MALAYSIA 00-88-9999 Wwww.samsung.com/my MALAYSIA 00-88-9999 Www.samsung.com/my
PHILIPPINES 00-10-SAMSUNG (7267864) www.samsung.com/ph PHILIPPINES 00-10-SAMSUNG (7267864) www.samsung.com/ph
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CE CAMESCOPE SPORT EST
FABRIQUE PAR :

r Conforme a la directive RoHS

A ’ Notre produit est conforme a la directive RoHS relative a la (La
limitation de ['utilisation de certaines substances dangereuses

el dans les composants électriques et électroniques). Nous

n'utilisons pas les six matiéres dangereuses suivantes dans la

fabrication de nos appareils : cadmium (Cd), plomb (Pb), mercure (Hg),

chrome hexavalent (Cr+6), polybromodiphényles (PBBs) et

polybromodiphényléthers (PBDEs).

pliont

LA VIDEOCAMERA SPORT E
PRODOTTA DA:

Questo apparecchio & fabbricato in conformita al
D.M.28.08.95.N.548 ed in particolare a quanto specificato
nell’ Art. 2, comma 1.

Conformita RoHS
A ’ Il prodotto & conforme con la direttiva RoHS (Restrizione dell'uso

di determinate sostanze pericolose nelle apparecchiature

elettriche ed elettroniche) e nei nostri prodotti non vengono

utilizzati i 6 materiali pericolosi: cadmio (Cd), piombo (Pb),
mercurio (Hg), cromo esavalente (Cr+6), bifenili polibromurati (PBBs), eteri
difenili polibromurati (PBDES).





